
 

 

 

  

Remark Office OMR  
 

Version 8 

User‟s Guide 

 

 

 

 

 

 

 

 

 

 

Remark Products Group 

301 Lindenwood Drive, Suite 100 

Malvern, Pennsylvania, 19355-1772 USA 

www.gravic.com 

http://www.gravic.com


 

Remark Office OMR User’s Guide 

 

Disclaimer 

The information contained in this document is subject to change without notice and should 

not be construed as a commitment by Gravic, Inc., who assumes no responsibility for any 

errors or omissions. Gravic, Inc. reserves the right to revise this document and to make 

changes to the products described herein for the purpose of product improvement at any 

time, without obligation to notify any person of such revisions or changes. 

Notice 

The information contained in this document is the exclusive property of Gravic, Inc. This 

work is protected under United States Copyright Law and other international copyright 

treaties and conventions. No part of this work may be reproduced or transmitted in any 

form or by any means, electronic or mechanical, including photocopying and recording, or 

by any information storage or retrieval system, except as expressly permitted in writing by 

Gravic, Inc. All requests should be sent to: Gravic, Inc., 301 Lindenwood Drive, Suite 100, 

Malvern, PA 19355 USA. Attention: Product Manager. 

Trademarks 

Remark Office OMR, Remark Web Survey, Remark Classic OMR and Remark Quick Stats are 

registered trademarks of Gravic, Inc. Other products mentioned are trademarks of their 

respective holders. 

Copyright 

Copyright © 2010 Gravic, Inc. All Rights Reserved. Specifications subject to change without 

notice. 

 

 

 



 

 

 

 

Contents 

 

 

Remark Office OMR Overview 1 

1.1 What is Included with your Software ........................................ 2 

1.2 New Features in this Version .................................................. 3 

1.3 Technical Support ................................................................. 7 

Installing and Activating Remark Office OMR 9 

2.1 Overview ............................................................................. 9 

2.2 System Requirements ........................................................... 9 

2.3 Installing the Software .......................................................... 10 

2.4 Uninstalling the Software ....................................................... 11 

2.5 Running Remark Office OMR ................................................... 11 

2.5.1 Software Activation .................................................. 12 

2.5.1.a Manual Activation ..................................... 13 

2.5.2 Transferring a License ............................................... 13 

2.5.3 Missing or Corrupt License File ................................... 14 

2.6 Registering the Software ........................................................ 15 

2.7 Updating the Software ........................................................... 15 

Navigating Remark Office OMR 17 

3.1 Overview ............................................................................. 17 

3.2 Remark Office OMR Components ............................................. 17 

3.3 Navigation Tools ................................................................... 18 

3.4 Using the Mouse and Keyboard ............................................... 18 

3.4.1 Using the Mouse ...................................................... 18 

3.4.2 Using the Keyboard .................................................. 18 

3.4.3 Using Keyboard Shortcuts ......................................... 19 

3.4.4 Scrolling ................................................................. 19 

3.5 Menu Items ......................................................................... 20 

3.5.1 File Menu ................................................................ 21 

3.5.2 Edit Menu ................................................................ 23 

3.5.3 View Menu .............................................................. 25 



 

Remark Office OMR User’s Guide 

 

3.5.4 Tools Menu .............................................................. 26 

3.5.5 Page and Region Menus ............................................ 29 

3.5.6 Help Menu ............................................................... 30 

3.6 Accessing the Software Help File ............................................. 31 

Setting Up Your Scanner 33 

4.1 Overview ............................................................................. 33 

4.2 Scanners- General Information ............................................... 33 

4.2.1 Scanner Connections ................................................ 33 

4.2.2 Scanner Drivers ....................................................... 34 

4.3 Selecting Your Scanner .......................................................... 34 

4.3.1 TWAIN Source ......................................................... 34 

4.3.2 Configuring a TWAIN Driver ....................................... 39 

4.3.2.a Controlling the TWAIN User Interface .......... 40 

4.3.2.b Obtaining Updated TWAIN Drivers ............... 41 

4.4 Multi-Functional Peripherals .................................................... 41 

Designing Scannable Forms 43 

5.1 Overview ............................................................................. 43 

5.2 Finding an Application for Designing Forms ............................... 44 

5.3 Mark Selection for OMR (Optical Mark Recognition) .................... 44 

5.4 Character Selection for OCR (Optical Character Recognition) ....... 45 

5.5 Form Spacing ....................................................................... 45 

5.6 Grouping Questions ............................................................... 46 

5.7 Shading ............................................................................... 46 

5.8 Margins ............................................................................... 47 

5.9 Barcodes ............................................................................. 47 

5.9.1 The Code 3 of 9 Barcode ........................................... 48 

5.10 Paper ................................................................................ 49 

5.11 Form Duplication ................................................................. 49 

5.12 Form Testing ...................................................................... 50 

5.13 Form Review Service ........................................................... 50 

Using the Template Editor 51 

6.1 Overview ............................................................................. 51 

6.2 Creating Form Templates ....................................................... 52 

6.2.1 Understanding the Template Editor Interface ................ 52 

6.2.2 Region Types ........................................................... 52 

6.2.3 Beginning the Form Template .................................... 53 

6.2.4 Creating Regions ...................................................... 56 



 

      Contents  

  

6.2.5 OMR (Optical Mark Recognition) Regions ..................... 58 

6.2.5.a OMR Region Types .................................... 58 

6.2.5.b Region Orientation .................................... 64 

6.2.6 Defining the OMR Region ........................................... 64 

6.2.7 Linking OMR Regions ................................................ 67 

6.2.8 OMR Region Colors/Region Positioning ......................... 69 

6.2.9 Image Regions ......................................................... 70 

6.2.10 Barcode Regions ..................................................... 75 

6.2.11 OCR (Optical Character Recognition) Regions ............. 77 

6.3 Advanced Region Options ....................................................... 79 

6.3.1 Region Item Properties .............................................. 79 

6.3.1.a Test Settings ............................................ 79 

6.3.1.b Survey Settings ........................................ 81 

6.3.1.c Special Note for Image Regions ................... 81 

6.3.1.d Analysis Respondent ID ............................. 82 

6.3.1.e Recognition Threshold ............................... 82 

6.3.1.f Blank, Multiple and Duplicate Exception Handling 83 

6.3.1.g Mark Discrimination .................................. 86 

6.3.1.h Required Items......................................... 86 

6.3.2 Question Text and Names .......................................... 87 

6.3.2.a Question Text ........................................... 87 

6.3.2.b Question Names ....................................... 88 

6.3.3 Tracking ................................................................. 89 

6.3.3.a Setting up an Auto Form ID Region ............. 89 

6.3.3.b Setting up a Page ID Region ....................... 90 

6.3.3.c Setting up a Respondent Tracker Region ...... 92 

6.3.4 Database Lookup ..................................................... 93 

6.4 Additional Template Editor Features ......................................... 95 

6.4.1 Copy/Paste .............................................................. 95 

6.4.2 Copy Special/Paste Special ........................................ 96 

6.4.3 Drag/Drop ............................................................... 96 

6.4.4 Deleting Regions ...................................................... 97 

6.4.5 Undo/Redo .............................................................. 97 

6.4.6 Adjusting Region Borders .......................................... 97 

6.4.7 Resetting Form Template Images ............................... 98 

6.4.8 Auto Align ............................................................... 100 

6.4.9 Spell Check ............................................................. 100 

6.4.10 Response Scales ..................................................... 101 

6.4.11 Zoom .................................................................... 102 

6.4.12 File Properties ........................................................ 102 



 

Remark Office OMR User’s Guide 

 

6.5 Saving a Form Template ........................................................ 102 

6.6 Editing an Existing Form Template........................................... 103 

6.6.1 Editing OMR Regions ................................................. 103 

6.7 Template Editor Preferences ................................................... 105 

6.7.1 General Preferences .................................................. 105 

6.7.2 OMR Region Preferences............................................ 106 

6.7.3 Image Region Preferences ......................................... 109 

6.7.4 Barcode Region Preferences ....................................... 111 

6.7.5 OCR Region Preferences ............................................ 112 

Processing Forms 115 

7.1 Overview ............................................................................. 115 

7.2 Opening a Form Template ...................................................... 115 

7.3 The Remark Office OMR Read Wizard ....................................... 117 

7.3.1 Scanning Forms with the Read Wizard ......................... 117 

7.3.1.a Scanning Using Default Settings (Easy Scan)121 

7.3.2 Processing Image Files with the Read Wizard ............... 122 

7.4 Image Viewer ....................................................................... 126 

7.5 Graph Viewer ....................................................................... 127 

7.6 Reviewing Exceptions ............................................................ 128 

7.6.1 Reviewing Exceptions by Modifying Individual Cells ....... 131 

7.6.2 Using Review Exceptions ........................................... 132 

7.6.2.a Using the Review Exceptions Window ......... 135 

7.7 Using Collate Mode (Scanning Double Sided Forms with a Single Side Only 

Scanner) ................................................................................... 136 

7.8 Overwriting Data Records ...................................................... 138 

7.9 Using Form, Page and Respondent Detection ............................ 139 

7.9.1 Auto Form ID ........................................................... 139 

7.9.2 Auto Page ID ........................................................... 140 

7.9.3 Respondent Tracker .................................................. 141 

7.9.4 Reviewing Unrecognized Images ................................. 143 

7.9.5 Using the Unrecognized Image Utility .......................... 144 

7.9.5.a Reviewing Unrecognized Auto Form ID Images145 

7.9.5.b Reviewing Unrecognized Page ID images .... 146 

7.9.5.c Reviewing Unrecognized Respondent Tracker Images

 ...................................................................... 147 

7.10 Batch Processing ................................................................. 149 

7.11 Server Mode ....................................................................... 150 

7.12 Respondent Detection .......................................................... 157 



 

      Contents  

  

7.13 Reviewing Duplicate Responses ............................................. 158 

7.14 Software Recognition Settings ............................................... 160 

7.14.a Threshold Overrides ................................................ 161 

7.14.b Auto Rotate ........................................................... 162 

7.14.c Advanced Settings .................................................. 163 

7.14.d Ignore Large Marks ................................................. 233 

7.14.e Dynamic Brightness Compensation ............................ 234 

7.14.f Blank Page Detection ............................................... 166 

7.14.g Page Error Detection ............................................... 236 

7.14.h Bit Depth Reduction ................................................ 237 

7.14.i Invert Image .......................................................... 238 

7.14.j Deskew Images During Recognition ........................... 169 

7.14.k Despeckle Images During Recognition ....................... 169 

7.15 Recognition Tools ................................................................ 170 

7.15.a Using the Recognition Tools in Conjunction with Recognition 

Settings .......................................................................... 244 

Working with Your Data 245 

8.1 Overview ............................................................................. 245 

8.2 Understanding the Data Grid .................................................. 245 

8.3 Editing the Data Grid ............................................................. 174 

8.3.1 Making Grid Selections .............................................. 174 

8.3.2 Changing Cell Contents ............................................. 248 

8.3.3 Cutting, Copying, Pasting and Deleting ........................ 249 

8.3.4 Resizing, Inserting and Deleting Rows ......................... 177 

8.3.5 Freezing Columns and Rows ....................................... 251 

8.3.6 Using Find and Replace ............................................. 252 

8.4 Sorting Grid Columns ............................................................ 254 

8.5 Spell Checker ....................................................................... 255 

8.6 Saving Data ......................................................................... 256 

8.6.1 Advanced Saving Options .......................................... 261 

8.6.2 Remark Office Archive Format .................................... 186 

8.6.3 Custom Format ........................................................ 265 

8.6.4 Database Update Format ........................................... 268 

8.6.5 Save All Data ........................................................... 191 

8.6.6 Save Data Builder .................................................... 272 

8.7 Printing Data ........................................................................ 274 

8.8 Emailing Data ....................................................................... 275 



 

Remark Office OMR User’s Guide 

 

8.8.1 Email Overview and Set Up ........................................ 275 

8.8.2 Using Email to Send Data Files ................................... 277 

8.9 Send Wizard ........................................................................ 279 

8.10 Opening Data ..................................................................... 288 

8.11 Data Center Logging ............................................................ 206 

Remark Quick Stats – Data Analysis 297 

9.1. Overview ............................................................................ 297 

9.2 Tabulating Surveys with Remark Quick Stats ............................ 212 

9.3 Grading Tests with Remark Quick Stats .................................... 213 

Remark Office OMR Data Center Preferences 301 

10.1 Overview ........................................................................... 301 

10.2 General Preferences ............................................................ 302 

10.3 File Storage Location Preferences .......................................... 304 

10.4 Custom Font Preferences ...................................................... 219 

10.5 Email Preferences ............................................................... 307 

10.6 Change Log ........................................................................ 221 

10.7 Check for Updates ............................................................... 311 

Tips and Helpful Hints 313 

A.1 Overview ............................................................................. 313 

A.2 Scanners ............................................................................. 313 

A.3 Forms ................................................................................. 224 

A.4 Form Templates ................................................................... 316 

A.5 Reading Forms ..................................................................... 318 

A.6 Working with the Data ........................................................... 319 

A.7 Analysis .............................................................................. 228 

Understanding Error Messages 321 

B.1 Error Message Details ............................................................ 321 

 

 

 

 

 



 

      Contents  

  

 

 

 





 

 

 

 1 

Remark Office OMR Overview 

 

Chapter 1 

Remark Office OMR is a software package designed to collect data from marks (bubbles, 

checkboxes) on plain paper forms. In addition, the software recognizes machine printed 

text (OCR) and barcodes. The software works in conjunction with an image scanner to 

collect the data. The software then analyzes that data or allows you to export it to 

various file formats.  

The following overview provides the basic steps to using the software: 

 Create a scannable form in the software package of your choice: word 

processing, survey design, etc. The forms you can use with Remark Office 

OMR vary tremendously, from tests and assessments to surveys and market 

research. Remark Office OMR can read marks (bubbles, checkboxes, etc.), 

machine printed text (OCR) and barcodes. While Remark Office OMR is not a 

form designer, you are allowed a great deal of flexibility in the design process 

because you do not need special marks or drop-out inks, nor do your 

respondents need to use a number 2 pencil to fill in the forms. Because Remark 

Office OMR works with forms that you create, we provide form design guidelines 

to help you get the best results possible. Please refer to Chapter 5 for form 

creation guidelines and tips.  

 Use the Template Editor portion of the Remark Office OMR software to 

create a form template (definition file). The form template tells Remark 

Office OMR how to read your form. To create the form template, scan a blank 

copy of the form into the software and use the mouse to drag boxes around the 

areas you want recognized. You then provide the software with information about 

the area, including what type of data to output. Each form you wish to process 

requires a form template, but the form template is a one-time setup that tells the 

software how to read your particular form. 

 Process filled-in forms using a scanner or saved image files. Remark Office 

OMR provides flexibility in terms of how you process images. For example, you 

can use a desktop scanner connected to the PC running Remark Office OMR, or 

scan with a networked multi-function peripheral (MFP) and save image files on 

your network (which Remark Office OMR will read). Remark Office OMR displays 

the data in a spreadsheet style grid based on the form template you created. 

Each row of this grid corresponds to one scanned form in its entirety and each 

column corresponds to one question or variable on the form. 
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 Correct any exception cases. Remark Office OMR denotes exceptions with 

color-coded data grid cells and by providing a descriptive word in the answer cell 

(e.g., “BLANK” for a question that was not answered). The software provides a 

Review Exceptions function to correct exception cases as you process the forms 

or after the forms are processed. Remark Office OMR assists you in the data 

cleaning process by storing an image of each form as it is processed. The 

software then uses these images to help automate the correction of output errors 

and exception cases without needing to locate the appropriate paper form.  

 Save data and/or use the built-in analysis tool, Remark Quick Stats®. 

Save the data to over 30 output formats, including Access, Excel, SPSS, Oracle, 

SQL Server, ODBC, etc. Or, use the analysis program included with the software, 

Remark Quick Stats, to tabulate your survey or grade your test. If you use 

Remark Quick Stats, you can take advantage of powerful grade results, 

crosstabulations, graphs, charts and more. 

Remark Office OMR works with image scanners, which are the type of scanners that are 

also used for scanning pictures or pages of text and are readily available from your local 

computer dealer or via mail order and online companies. See Chapter 4 for more specific 

information about scanners and their relationship to Remark Office OMR. 

This User‟s Guide is designed to provide information about all of the features of the 

software as well as guidelines for using the software. Software features are not only 

described, but you are also given steps for how to use the features. Items taken directly 

from the software, such as menus, buttons and dialogs, are in bold format whenever 

they are used in an instructional context.  

You are encouraged to read the chapters that follow in this user‟s guide before designing 

your own forms or using the software with your own forms. There are two tutorials 

included with the software, which are accessed by clicking Start|Programs|Remark Office 

OMR 8|Documentation|Tutorials. The tutorials are PDF files that can be printed or read 

on-screen (you need the Adobe Acrobat Reader to use these files: www.adobe.com). 

This User‟s Guide contains answers to many of the common questions and/or problems 

users potentially face, and includes “Understanding Error Messages” and “Tips and 

Helpful Hints” appendices to help you solve and avoid problems. 

1.1 What is Included with your Software 

Each purchase of Remark Office OMR includes the following: 

 One copy of the software on CD-ROM or via download 

    Five user‟s guides, all in PDF format (all files install with the software):  

o Remark Office OMR 8 user‟s guide 

o Remark Quick Stats user‟s guide  

o Remark Office OMR Automation Wizard user‟s guide 

o Remark Office OMR FTP Utility user‟s guide 

o Understanding File Formats user‟s guide 

http://www.adobe.com
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 30 days of free technical support from the date of purchase (see Section 1.3 for 

further details regarding technical support) 

1.2 New Features in this Version 

Remark Office OMR 8 has many new features. The following list provides an overview of 

what is new in this version. Please see the specific sections of this user's guide 

corresponding to the listed feature for complete details. 

All of the new features in this version are too numerous to mention. We have highlighted 

some of the bigger features here. Take some time to review this manual and the 

software to see all of the new enhancements. 

 Recognition Improvements. Many improvements have been made to how your 

forms are recognized. Some of these improvements are behind the scenes and 

some are available for customization in the program‟s recognition options, such 

as: 

o Ignoring Large Marks. If your respondents put a large X through the 

answer choice they did not want to mark and then fill another bubble, you 

can now ignore the large X. You can also instruct respondents to put X 

through bubbles filled by mistake, as opposed to trying to erase them or 

use white out to remove them. 

o Dynamic Brightness Compensation. The software automatically 

compensates for scanned images that are lighter or darker than the form 

template image, leading to fewer recognition issues due to changes in 

image brightness. 

o Blank Page Detection. You can automatically ignore blank pages that 

might have been scanned accidentally. 

o Page Error Detection. Pages that contain more than a customizable 

minimum number of OMR and barcode errors are sent to an unrecognized 

images queue for review at a later time. 

 Recognition Tools. New options have been added to the Task Pane so that you 

can review form template regions on the scanned image and move them to re-

recognize regions that did not read during the initial pass. For example, if form 

images are badly skewed or offset from the template image, you can move the 

regions to the appropriate place on the scanned image and have Remark re-read 

the form. You can even save the newly placed images as a new form template for 

future use. 

 Email. An email option is available in the Remark Office OMR Data Center and 

Remark Quick Stats to email data and reports as attachments. You can use 

Remark‟s built-in email client in conjunction with your SMTP server or Microsoft 

Outlook®. 

 Send Wizard. A Send wizard was added to move files via FTP or email with 

minimal interaction. You send data and reports from a folder on your computer or 

network to an FTP site or via email using your own SMTP server. You can set up 

profiles to be reused as needed. 
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 Microsoft Office 2010 Support. The Access® and Excel® 2010 file formats are 

now supported anywhere database formats are supported (e.g., database lookup, 

saving data, exporting report data). 

 Save Data Builder. You can now customize the data saving process by including 

a field from your data set in the file name. For example, if you are processing 

course evaluations and wanted the data file to be saved by instructor, you could 

use the instructor field from the database as the base name. 

 Delete Images after Renaming. When using the Package and Rename feature 

in the Read Wizard, you may now remove the original images that were 

processed if desired. This leaves you with just the repackaged version of the 

images.  

 Delimited Barcodes as Identifiers. You can now use a delimited barcode (one 

that has multiple pieces of data in it) as form, page and respondent identifiers on 

the form. This feature is useful for processing multiple forms types at one time 

that use barcodes to identify them.  

 Image Clips and Qualitative Coding Set up in One Region. For handwriting, 

you can now create one Image region and apply both an image clip (snapshots of 

handwritten areas) and a qualitative code (a rating you supply after reading the 

handwriting). The two pieces of information are be output separately in the data 

grid, and reported on separately in Remark Quick Stats, allowing you to both 

read the handwritten comments and review the coding using an Item Analysis 

report. 

 Dynamically Naming Image Clips. When setting up Image Clips (snapshots of 

handwritten areas), you can use a Name Builder to pull in data from other areas 

of the form and use it as part of the image clip name. For example, suppose you 

are scanning conference evaluations and the conference session name is a data 

field. If you have a “comments” question on the evaluation and are capturing it 

as an image clip, you can use the session name in the image clip name so your 

comments reflect the session name. 

 Review Exceptions for More than One Exception. If a single data cell has 

more than one exception (e.g., a database lookup error and a MULT), Remark 

Office OMR indicates multiple exceptions were found and you can review all of the 

exceptions. 

 Logging of Changes. Changes to data sets can be logged in a password 

protected Access database. 

 SPSS File Format Enhancements: 

o The eight character region name limit has been removed. Region names 

up to 64 characters are now supported when saving to the SPSS format. 

o You no longer have to set up questions that allow more than one response 

as Boolean regions. The software breaks apart the multiple responses into 

separate questions when saving to the SPSS format. 

o Numeric fields that contain missing data now use the designated missing 

value (e.g., -1, 99, etc.) instead of 0 when exporting to SPSS.  
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o The Advanced window is now available when saving data to the SPSS 

format so that you can chose what regions to include and set field sizes 

for your data set. 

 Saving Images with Data. You may now save images (or other files) into 

databases along with the rest of the scanned data. In order for the file to be 

saved as binary data in the database, you must change the field type of the 

database to Binary using the Advanced window and make sure the field is set to 

be included. If the field corresponds to a page image, the software extracts just 

the individual page from the multiple page image files and stores just the page 

image in the database. 

 Freezing Columns/Rows. You can now freeze columns and rows in the Data 

Center so that when scrolling, they are always visible. 

 Right Click and Paste. The option to right click and choose “Paste” in the 

Template Editor image area has been added. 

 TWAIN Scan Ahead. A checkbox has been added to the Scanner Properties 

window to support the Scan Ahead feature on TWAIN-compatible scanners. If 

your scanner supports this feature in its TWAIN driver, turn on the checkbox in 

Remark Office OMR to take advantage of it. 

 Installation. You can „push‟ out the Remark Office OMR installation to 

computers using active directory when installing multiple licenses of the software.  

 Auto Check for Updates. A method for checking for software updates was 

added to the Help menu and program preferences. 

Remark Quick Stats Improvements:  

New Reports:  

 Question Mean Report. This new survey tabulation report shows each question 

on the form, along with the minimum and maximum responses, mean and a bar 

chart of the mean. 

 Student Response Report. This new test grading report shows a matrix of all 

the students and test questions, the answer chosen, and a color code to indicate 

whether it was the correct response. It provides fast insight into both student and 

question performance. 

 Demographic Grade Report. This new version of the Comparative Grade report 

allows you to compare up to three fields in your data in a table format (as 

compared to the Demographic Comparison Report that is in hierarchical format). 

 Basic Item Analysis/Condensed Test Report. This new report for both tests 

and surveys provides a condensed view of all questions on the form, response 

frequencies and means. For test grading, it optionally shows test score 

information, such as min, max, and mean scores, standard deviation, prevalent 

non-distractors and class performance by upper and lower percentages. 

Enhanced Reports: 

 Detailed Item Analysis Report. Cumulative and Valid Percent statistics can be 

turned off in the Detailed Item Analysis report for surveys. 
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 Student Statistics Report. T-Score, Z-Score, ETS Score, and Dev. IQ have 

been added to the Student Statistics Report (shown optionally). 

 Condensed Item Analysis Report. Colors have been added to the bar charts 

on Condensed Item Analysis report to highlight the correct answer and the 

distracters chosen when performing test grading. 

 Test Item Statistics Report. Several enhancements have been made to the 

Test Item Statistics report to make it more readable, including: renaming 

Benchmark P-Value to Benchmark, changing the P-value to a straight percentage, 

renaming Benchmark % as Percent Correct and changing the value to a straight 

percentage, and adding options for each of the columns to be shown/hidden.  

 Response Reports. Response reports can now be sorted by Respondent ID or 

Response. 

General Features: 

 NA (Non Applicable) Answer Choices. You may now exclude NA answer 

choices from your analysis reports, providing you with more accurate means and 

statistics. For example, if your answer choices are Strongly Agree, Agree, 

Neutral, Disagree, Strongly Disagree, NA: if someone chooses NA, you can have 

it not count in the statistics, but still be able to see how many respondents chose 

the NA response. 

 Scaled Scores. The Grade Wizard supports “scaling” a score, whereby you look 

up grades in a table and then apply the scaled score from the external file. You 

can define a default scaled score lookup for the overall test and for learning 

objectives. Scaled scores can look up by either total score, percent score or 

percentile. The following grade reports support the scaled score: Student 

Statistics Report, Student Grade Report, Comparative Grade Report, 

Demographic Grade Report and Student Response Report. 

 Support for Multiple Versions of an Answer. You can now enter various 

versions of an answer and have them all treated as the correct response. For 

example, if .25 and ¼ are both correct, using the Grade Wizard you can instruct 

the software to allow either answer to be considered correct. 

 Turning Off Subjective Questions Using Easy Grade. When using Easy 

Grade, if a subjective question is left blank or contains non-numeric data, it is 

excluded from the grade operation (marked as not graded/not subjective). 

Otherwise, if the subjective question contains a numeric value, that value is used 

as the total possible subjective points for the question. 

 Screen Captures. You may now access a screen capture utility in Remark Quick 

Stats to capture portions of reports (e.g., graphs to place in other applications). 

 Data Groups. When analyzing multiple data sets together, you can enter a 

descriptive name for each data set. That name can then be used to filter data in 

Remark Quick Stats, as well as on certain reports, such as the Demographic 

Comparison, Comparative Grade and Comparative Item reports. This feature is 

useful for comparing data sets. 
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 Importing and Exporting of Grade Scales: You can now import and export 

grade scales for the purposes of sharing them via the Remark Quick Stats 
Preferences. 

1.3 Technical Support  

Remark Office OMR includes a user‟s guide and online help. You will also find a 

knowledgebase on the Gravic website, where you will find the answers to frequently 

asked questions. In addition, there are two tutorials included with the software 

(Start|Programs|Remark Office OMR 8|Documentation|Tutorials), which we strongly 

recommend you perform before using the software with your forms. Most questions can 

be answered by consulting these reference materials.  

If a problem with Remark Office OMR arises that cannot be solved using the materials 

above, customers may contact Gravic technical support.  

Note: For the first 30 days of ownership, technical support is included for 
free (starts from date of purchase). After 30 days, Gravic, Inc. makes 
support available only to registered users of the Remark Office OMR 
software who hold a valid support agreement. For more information about 
purchasing a support agreement, please go to our website (address 
provided on back of this user's guide). 

Before contacting technical support, please gather the following information: 

 The version and serial number of the Remark Office OMR software (you can find 

this information by selecting the Help menu and then clicking About in the 

software or look in the lower right hand corner of the Data Center) 

 The steps required to reproduce the problem 

 The type, model and configuration of your computer and scanner, if applicable 

Gravic‟s technical support team provides product support to customers with valid 

support agreements via email, web, phone (610.647.8595) and fax (610.647.8771). In 

addition, you will find free support tools on our website. 
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Installing and Activating Remark Office 

OMR  

 

Chapter 2 

2.1 Overview 

This chapter provides system requirements, software installation instructions, activation 

procedures and starting and exiting procedures. Please consult your scanner‟s 

installation guide for specific scanner installation instructions.  

2.2 System Requirements 

The following section provides the system configuration for running Remark Office OMR.  

 Personal computer with 1 GHz or faster processor  

 Windows 32-bit and 64-bit operating systems: 2000 SP4 (32-bit only), XP SP3, 

Vista SP2 and Windows 7 (Note: SP stands for “Service Pack”) 

o Remark Office OMR will run on Windows Server 2003 SP2 and Windows 

2008 SP2, but please note the software is not a client/server application 

 1 GB RAM  

 1 GB free fixed disk space  

 CD-ROM drive (for installation purposes)  

 Screen/monitor resolution of 1024x768 or higher and at least 32-bit color  

 Mouse or other pointing device  

 Supported scanner (recommended) 

 Windows-supported printer (optional) 

 Internet connection recommended for initial software activation (optional) 

 PDF viewer required to view installed documentation (optional) 

 Microsoft Outlook 2007 or greater can be used for email functionality; if not 

present an internal Remark Office OMR email client (using your SMTP server) 

may be used (optional) 
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2.3 Installing the Software 

You must run the Remark Office OMR installation program in order to use the software. 

Install Remark Office OMR on a fixed drive with at least 1GB of free disk space. To scan 

directly into Remark Office OMR, you must install the software on the same system to 

which the scanner is attached. (Note: Scanners can be used if they are not connected to 

the PC running Remark Office OMR. You must first scan forms and save them as image 

files outside of Remark Office OMR. Then the software reads those images.) Before 

installing the software, make sure you are an administrator on your computer. Each 

single license of the software can only be installed on a single computer, which is 

validated through activation of the license after installation. 

If you are upgrading to Remark Office OMR 8 from an earlier version, do not install the 

software in the same directory as your previous version. Once the installation is 

complete, you can copy information from your old installation that you want to use in 

the new version (e.g., form templates, data, etc.).   

Note: Form template files are not backwards compatible. Remark Office 
OMR 8 converts form templates from previous versions of the software 
automatically. However, once a form template has been converted, it cannot 
be opened in a previous version of the software. Always make copies of form 
templates before converting them. 

 

To install Remark Office OMR  

The Remark Office OMR CD-ROM contains an auto play feature so that when it is 

inserted into your CD-ROM drive, the installation begins automatically. This feature is 

only available if your CD-ROM drive‟s auto play feature is enabled. If the software 

installation does not automatically start, use the following instructions to install the 

software. 

 

 Insert the installation CD-ROM into your CD-ROM drive. 1

 Select Start on the taskbar, click Settings and then click Control Panel.  2

Note: Accessing the control panel may vary slightly based on the version of 
Windows you are running. 

 Double click Add or Remove Programs (or Programs, depending on your 3

operating system). 

 Click Install and then follow the on-screen instructions to display the Remark 4

Office OMR Installation window. 

Note: The .NET 2.0 Framework is required to install Remark Office OMR. If 
you do not have it installed on your system, you are prompted to install it. 
Once the .NET 2.0 Framework installation completes, the Remark Office 
OMR installation resumes normally. 

 Follow the on-screen instructions to complete the installation. You are prompted for a 5
serial number and authentication code. You can find this information on a sticker 

on the CD case that came with your software. 
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 Some operating systems may ask whether you 6

wish to install the software for all users or only 
the person currently logged into the computer. 

In most cases, and especially if multiple 
people use this computer and need to use 

Remark Office OMR on this computer, you 
should choose the option for "all users/anyone 

who uses." 

 When the installation completes, click the 7

Finish button to close the installation 

program. 

2.4 Uninstalling the Software 

If you need to uninstall the software in order to reinstall it on the same computer, use 

the Windows Control Panel|Add or Remove Programs function. If you need to uninstall 

the software and reinstall it on another computer, you must transfer your software 

license before you uninstall. Please see Section 2.5.2 for details before proceeding with 

the uninstall. 

Note: When uninstalling the software, all program and default files are 
removed. Files that you created remain on the system. However, for best 
practices purposes, if you plan to reinstall the software, we recommend 
backing up any files you wish to save prior to uninstalling the software. 

 

To uninstall Remark Office OMR 

 Select the Start menu, click Settings and then click Control Panel. 1

Note: Accessing the control panel may vary slightly based on the version of 
Windows you are running. 

 Select the Add or Remove Programs option (or Programs, depending on your 2

operating system). 

 Select Remark Office OMR 8 from the list and then click Remove or Uninstall. 3

 Follow the on-screen instructions to complete the uninstallation. 4

2.5 Running Remark Office OMR  

Use the following procedures to start and exit Remark Office OMR: 

 

To start Remark Office OMR  

 If you chose to install a shortcut on your desktop during installation, double click this 1
shortcut. Otherwise, select Start from the taskbar. 

 Highlight Programs, highlight Remark Office OMR 8 and then click Remark 2

Office OMR Data Center. To go directly to the Template Editor, click Remark 
Office OMR Template Editor. 

Note: Accessing the installed programs may vary slightly based on the 
version of Windows you are running. 
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If you have activated your software, the About Remark Office OMR window displays. 

This informational window remains for a few seconds while the program loads. When 

complete, the main Remark Office OMR window displays. If you have not activated your 

software, continue to the next section. 

2.5.1 Software Activation 

Remark Office OMR requires activation in order to run on your computer. Activation 

means that the copy you have installed is licensed to the computer. Once the software is 

activated, it cannot be installed on another computer without deactivating it from the 

current computer. You may activate your software over the Internet (recommended) or 

through several manual methods.  

The first time the software runs and until you activate your software, you receive a 

message indicating how many uses and/or days you have left to activate the software. If 

you exceed your time, you are not able to use the software any longer without 

activation. 

 

 When the prompt appears to activate your 1

software, click the Activate button. 

 The License Key Entry window appears. 2

Enter your License Key, which appears on 
the CD case. 

 Click the Submit Key button. 3

 The Software Activation window 4

appears. Note that the license key listed in 
this window can be modified by clicking it (in 

case you did not enter it correctly on the 

previous screen). 

 To activate the software automatically over 5

the Internet, click the Activate 
Automatically button. Your license key 

information is sent to a secure server, which 
returns a code to the computer that activates 

the software. This is the fastest way to 
activate your software. This is a one-time 

process, so once the software is activated, 

you do not have to go through this process 
again. 

Note: When transmitting the license key 
over the Internet, no personal information 
is sent to Gravic, Inc. Our server simply 
verifies your license key, and if valid, 
sends the activation code back to your 
computer. The transfer happens via a 
secure server. 

The About Remark Office OMR window displays. This informational window remains 

for a few seconds while the program loads. When complete, the main Remark Office 
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OMR window displays. If you prefer to activate your software manually, continue to the 

next section. 

2.5.1.a Manual Activation 

 If you do not have an Internet connection or do not wish to activate your software 1

automatically, click the link provided in the Activate Software window for manual 
activation. You have three options for activation:  
 Email: You may click the hyperlink Click here to request an activation code 

via email to construct an email message that you can send to Gravic. Once the 

email is received and processed, Gravic or your reseller will send you an email 

with your activation code. Note that you can 

also copy the information about your license 

to the Windows clipboard. If you use a web 

mail client, you can then construct an email 

and paste the license information into the 

email for sending to support. 

 Fax: You may click the print hyperlink to 

generate an HTML document, in which you 

can enter your contact information, and then 

print and fax the document to Gravic or your 

reseller. Once processed, an activation code 

will be sent back to you. 

 Telephone: You may also request an activation code by telephone. Be prepared 
to read the Authorization Request Code you see in the Software Activation 

window when you call. 

Important Note: Automatic activation over the Internet is the fastest way 
to receive your activation code. The manual options rely on processing from 
Gravic or our reseller, based on operational hours.  

 Once you receive your activation code, click the Enter Activation Code button. 2

 Enter the Activation Code exactly as it was given to you. You can use Ctrl+V to 3

paste the information from the Windows clipboard (e.g., if you copied it out of an 
email message). 

 Click the Activate button to activate your software. 4

This is a one-time process, so once the software is activated, you do not have to go 

through this process again. Once activated, the software opens normally for use. 

2.5.2 Transferring a License 

The Gravic software license agreement states that any one copy of the software can only 

be installed on one computer. If you need to transfer your software to another 

computer, you may deactivate the license on one computer, install the software on a 

different computer and then activate the software on the new computer. Note that once 

a license is deactivated on a computer, it cannot be activated on that computer again. 

You need an active Internet connection to transfer a license.  
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Tip: It is very important that you transfer the license before you attempt to 
install it elsewhere. Keep the license transfer in mind if you are getting a 
new computer, are getting ready to reformat your computer or are 
transferring use of the software to another person. In all of these cases you 
should transfer the license before taking any further action. 

Note: If you need to uninstall and reinstall the software on the same 
computer (e.g., for installation issues), you may do so without transferring 
the license. 

 

To transfer a license 

 Select the Help menu and then click Transfer 1
License. 

 A warning message appears that you should 2

read very carefully. It states that you are not 
be able to install the software on this system 

again and that you need an Internet 
connection to continue. You need to agree to 

the terms before proceeding. 

 Click the Continue button. 3

 The License Key Transfer screen appears, 4
detailing the steps that will happen to transfer 

the license. In short, you first transfer the 

license from the current computer. Then you 
install Remark Office OMR on the second 

computer and activate it there using the same 
license key. Once you have read the full 

instructions on this screen, click the Continue 
button. 

The license is transferred. You may now install the 

software on another machine using your original 

license key. Use the activation procedures 

described in Section 2.5.1 to activate the software 

on the new computer. 

2.5.3 Missing or Corrupt License File 

In rare cases, an instance may arise where the main license file is missing or corrupt 

(e.g., if the license file was deleted by mistake). 

If you receive a Missing License error 

message, please contact Gravic technical 

support for assistance. We will diagnose the 

issue and then if applicable, send you a file 

containing the information you need to recover 

your license. In the Missing License window, 

you browse to the file we send you and then 

click OK to recover your license. 

mailto:support@gravic.com
mailto:support@gravic.com
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In the case of a corrupt license you will receive a License Recovery error message. 

Please contact Gravic technical support with the Application license key and 

Recovery request code that you see in the License Recovery error window. We then 

provide you with a recovery code you can enter to restore your license. Once the license 

is recovered you need to activate it again (you are prompted by the software 

automatically). 

2.6 Registering the Software 

You can register your Remark Office OMR software from the Help menu within the 

software. The Register Software link takes you to the Gravic website, where you can fill 

out a short registration form. We encourage you to register your software so that you 

receive important product updates. 

 

To register your software 

 In the Remark Office OMR Data Center, select the Help menu and then click 1

Register Software. You must have an active Internet connection. 

 The registration page of the Gravic website appears in your default web browser. 2

 Fill in the fields requested and then click the Submit button. 3

2.7 Updating the Software 

Remark Office OMR periodically needs to be updated to the latest version when 

maintenance releases are made available. The option to Check for Updates is listed 

under the Help menu. If you are experiencing any problems with Remark Office OMR, we 

advise checking for software updates prior to contacting Remark support. This step 

avoids contacting support for known issues that are already corrected within the 

software. 

In addition, you can have the software automatically check for updates each time it 

starts up. To enable this feature, select Tools|Preference|Check for Updates. Then 

turn on the checkbox for Check for updates when starting. 

The Remark Office OMR Automatic Update collects some system configuration data in 

order to provide you with updates that apply to your installation. This information 

includes: 

 Product Name  Remark Authentication Code 

 License Key  Software Version and Build Number 

 Remark Serial Number  System Finger Print (same as activation) 

Gravic, Inc. is committed to helping protect your privacy. Using the automatic update 

feature does not collect your name, address, email address, or any other form of 

personally identifiable information. Your Internet Protocol (IP) address is logged when 

you connect to the Gravic website, but this address is only used to generate aggregate 

statistics.  

mailto:support@gravic.com
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To check for updates manually 

 Select the Help menu and then click Check for Updates. You must have an active 1
Internet connection. 

 Remark Office OMR goes out to the Gravic website and check for an update for your 2
product. If an update is needed, you are prompted to download and install the 

update. If an update is not needed, you are advised that your software is up to date. 
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Navigating Remark Office OMR 

Chapter 3 

3.1 Overview 

This chapter provides an overview of how to get around in Remark Office OMR, including 

the menu items and tools available in the software. Wizards and other navigation tools 

are also described. Specific functions are explained in more detail in the appropriate 

sections of this user‟s guide. 

3.2 Remark Office OMR Components 

The Remark Office OMR software interacts with you through three main components, 

which can display multiple windows. You may display many windows simultaneously, 

allowing you to use multiple Remark Office OMR documents at one time. 

Remark Office OMR contains a Template Editor component, a Data Center component 

and a Remark Quick Stats component. The Template Editor is used to create form 

templates for each form you want to process in the software. The Data Center is used to 

process forms, clean data and save/export data. Remark Quick Stats is used to grade or 

tabulate processed data. 

A shaded title bar designates the active or current window. Minimize documents on the 

desktop by clicking the minimize button located in the upper, right-hand corner of the 

window. Double clicking the minimized icon causes the document to become the current 

window. 

The software contains a menu bar, a 

toolbar and a status bar. The toolbar 

displays tools that, when selected, perform 

the function of an option under a menu 

pull-down item. Shifting between different 

types of windows causes the menu bar and 

the toolbar to change. Tools and options 

that lack functionality in a particular 

window do not display or are disabled 

(grayed out). The status bar displays 

information about the active document or 

the selected command. 
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3.3 Navigation Tools 

Remark Office OMR includes many wizards and navigation 

shortcuts to help you move through the software. The left 

portion of each component contains a Task Pane that acts as 

a guide to help you decide what you would like to do. Once 

you perform a function, this Task Pane automatically updates 

with new options based on the last function you performed. 

You may use this tool as a way to understand what options 

are available to you at any time. Most options displayed in the 

Task Pane are also available from the menus or tool bar. If 

you would prefer not to use the Task Pane, you may close the 

window by selecting the View menu and disabling the option 

titled Task Pane. You may also close sections of the task 

pane by clicking the title bar of the section.  

In some windows you will also notice an information button 

. When you see this button, hover the mouse over the 

button to view details about the current window, action, etc.  

3.4 Using the Mouse and Keyboard  

This section details the different mouse and keyboard conventions used in the Remark 

Office OMR software. You can use either the mouse or the keyboard to perform functions 

within Remark Office OMR. Occasionally, you might find it easier to combine the mouse 

and keyboard functions. 

3.4.1 Using the Mouse 

In this User‟s Guide, the phrase “the mouse button” refers to the left mouse button, 

unless otherwise stated. The following table lists the different mouse actions and their 

meanings: 

 

Mouse Action Meaning 

Click Press and release the mouse button 

Double click Press and release the mouse button twice 

Right click Press and release the right mouse button 

Press Press and hold the mouse button 

Drag Move the mouse while holding down the mouse button 

3.4.2 Using the Keyboard 

You can use the keyboard or the mouse and the keyboard to make selections and 

perform functions within Remark Office OMR. 
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To use the keyboard to select objects 

 Press Tab to activate the next item in a window. 1

 Press Shift+Tab to activate the previous item. 2

 

3.4.3 Using Keyboard Shortcuts 

Most menu items and window objects provide “shortcut keys” as an alternative to using 

the mouse. An underlined letter in the label indicates the shortcut letter for the 

particular object or menu item. 

 

To pull down a menu item using keyboard shortcuts 

 Press Alt + the shortcut letter of the menu item shown on the menu bar. (For 1

example, press Alt+F to access the File menu.) 

 Press the underlined letter of the desired item from the pull-down menu. 2

Many Remark Office OMR menu pull-down options also employ “hot key” shortcuts (e.g., 

use Ctrl+X for “Cut”). 

3.4.4 Scrolling 

When you select a scrolling list, the Up/Down arrow keys, the Page Up/Page Down keys, 

and the Home/End keys perform the following actions: 

 The arrow keys move the list up or down a line at a time. 

 The Page Up/Page Down keys move up or down a “page” (window) of text at a 

time. 

 The Home/End keys move to the top or bottom of a list. 

Use scroll bars to view additional items in a list or different parts of a window. The 

following table explains how to use the mouse within a vertically oriented scroll bar to 

produce various results: 

 

Mouse Action Result 

Click the arrow at the bottom of the 

scroll bar 

Moves your view in the list down one line 

Click the arrow at the top of the 
scroll bar 

Moves your view in the list up one line 

Drag the elevator on the scroll bar Allows you to see various parts of the window. 
To drag the elevator, point to the elevator with 

your mouse, press the mouse button and drag 

the elevator along the scroll bar 

Click the mouse pointer above the 

elevator in the scroll bar 

Moves the elevator up one section 
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Mouse Action Result 

Click the mouse pointer below the 

elevator in the scroll bar 

Moves the elevator down one section 

3.5 Menu Items 

Context-sensitive help is available for all menu items by highlighting the item in question 

and pressing F1. The following sections provide menu options for the Remark Office OMR 

Template Editor and Data Center. Menu options for Remark Quick Stats are detailed in 

the Remark Quick Stats User‟s Guide, which you can access under 

Start|Programs|Remark Office OMR 8|Documentation. Please see the corresponding 

sections in this user‟s guide for complete descriptions of the features that can be 

accessed from the menus. 

Most menu items can be represented on the toolbar, which is completely customizable. 

You may choose what toolbar buttons to display, whether to display them as images or 

text, and what text to include. You may also drag toolbars using the mouse to the 

desired location. 

 

To customize the tools displayed on the toolbar 

 Right click the toolbar and then click Customize. 1

 On the Toolbars tab, choose the toolbars to display. 2

 On the Commands tab, choose a command you 3

wish to display and drag it to the toolbar to 
permanently place it on the toolbar.  

 On the Keyboard tab, review the keyboard 4
shortcuts for various tools. You may also create 

new toolbar shortcuts. 

 On the Options tab, choose whether to show full 5
menus when dropped down, reset the menu usage, 

display large icons, whether to show ScreenTips on 
toolbars, whether to show shortcut keys in the 

ScreenTips, and whether to use menu animation 
(changes how menus drop down). 

Note: When customizing the toolbar, you can 
see all of available toolbar options. If you 
attempt to drag a button to the toolbar and subsequently do not see the 
item on the toolbar, this means that the item you have selected is not valid 
for your setup (e.g., a disabled feature). 

 

To modify toolbar buttons 

 Right click the toolbar and then click Customize. 1

 Go to the toolbar and right click the button you wish to modify. 2

 Choose the desired option from the menu. 3
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 When you are finished modifying the toolbar, click the Close button on the 4

Customize window.  

 

To delete toolbar buttons 

 Right click the toolbar and then click Customize. 1

 Go to the toolbar and right click the button you wish to remove. 2

 Click the Delete option. 3

 When you are finished modifying the toolbar, click the Close button on the 4

Customize window.  

3.5.1 File Menu 

Use the items in the File menu to perform operations on files. The operations include 

creating, editing, opening, closing, saving, displaying, and printing the data contained in 

these files.  

 

Template Editor: 

 

Tool Menu Pull-
Down Item 

Function 

 

New 
(Ctrl + N) 

Creates a new form template. 

 

Open… 
Template  

(Ctrl + O) 

Opens an existing form template for editing.  

 Close           
(Ctrl + F4) 

Closes the current form template. 

 

Save  
(Ctrl + S) 

Saves the open form template to a new or existing file. 
Clicking the Save button creates a new form template file 

or save the form template to the current file if one has 
already been established. 

 Save As  

(F2) 

Saves an existing form template file under a new name or 

allows you to change the path to which the file saves. 

 Recent Files Displays the most recently used files. Click a file to open 

it. 

 Launch 
Remark 

Office OMR 

Launches the Remark Office OMR Data Center with the 
current form template file open. 

 

Properties 
(F12) 

Displays the properties for the open form template. 

 Exit  
(Alt + F4) 

Exits the Remark Office OMR Template Editor. 
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Data Center:  

 

Tool Menu Pull-
Down Item 

Function 

 

New Form 

Template 

(Ctrl + N) 

Launches the Remark Office OMR Template Editor in the 

new template state so that you may create a new form 

template. 

 

Open Form 

Template  
(Ctrl + O) 

Opens an existing form template for processing forms, 

opening data and running reports. Multiple form 
templates can be opened simultaneously, and the same 

form template can be opened multiple times. 

 

Edit Form 
Template  

(Ctrl + E) 

Launches the Template Editor with the active template 
automatically open for editing. 

 Convert to 

Web Survey 

Converts the form template file to a Remark Web Survey 

file for use in the Remark Web Survey application. This 

option only appears if you have Remark Web Survey 
installed on the same computer as Remark Office OMR. 

 
Open Data 
(Ctrl + O)   

Opens an existing data file and displays the data in the 
current template grid window. Remark Office OMR can 

read and save data in dozens of different file formats. 

 
Open Report 

(Ctrl + R) 

Opens an existing report file that was saved in Remark 

Quick Stats. 

 

Save Data 

(Ctrl + S) 

Saves data from the grid to a new or existing data file. 

Clicking the Save button creates a new data file or save 
the data to the current file if one has already been 

established. 

 Save Data 
As (F2) 

Saves an existing data file under a new name, allows you 
to select an output format, or allows you to change the 

path to which the file saves. 

 Save All 

Data       

(Ctrl + F2) 

Saves all open data files to one master file, allowing you 

to select a file name, output format and the path to which 

the file saves. 

 Save Data 

Builder    
(Ctrl + F3) 

Launches the Data Builder, which allows you to customize 

the data saving process by dynamically building file 
names and locations using information from the active 

data set. 

 
Email Emails the active data set using Microsoft Outlook or the 

built-in email program. 

 
Batch 

Wizard 

Opens the batch wizard so that you can create batch files. 

Batch files allow you to process a header sheet with 
identifying information for the forms that follow.  

 

Print             
(Ctrl + P) 

Prints the contents of the grid or an image.  
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Tool Menu Pull-

Down Item 

Function 

 Recent Files Displays the most recently used files. Click a file to open 
it. 

 Close           
(Ctrl + F4) 

Closes the current data grid. If there are unsaved 
changes, you are prompted. 

 Close All 

Templates 
and Data 

Closes all open data grids. If there are unsaved changes, 

you are prompted. 

 Exit  

(Alt + F4) 

Exits the Remark Office OMR Data Center. 

3.5.2 Edit Menu 

Use the items in the Edit menu to perform common Windows functions on one of the 

Remark Office OMR documents. The operations include typical clipboard operations, such 

as copying and pasting information, and several data manipulation operations, such as 

finding & replacing. 

 

Template Editor: 

 

Tool Menu Pull-
Down Item 

Function 

 

Undo  

(Ctrl + Z) 

Undoes the most recent change to the form template. 

 

Redo  
(Ctrl + Y) 

Redoes the last action to which Undo was applied. 

 

Cut  

(Ctrl + X) 

Moves a selection of text or region from one place to 

another by cutting it from the original position and 

pasting it in a new position (paste is a separate 
command). 

 

Copy  
(Ctrl + C) 

Allows for easy duplication and movement of information. 
You can copy a selected portion of text from a form 

template, or a region from one part of a form template 

(or a different document altogether), and paste it in a 
different part of the form template. 

 

Paste  
(Ctrl + V) 

Pastes information from the clipboard after the selected 
node in the tree view. 

 Paste Before 

(Ctrl + B) 

Pastes information from the clipboard before the selected 

node in the tree view. 
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Tool Menu Pull-

Down Item 

Function 

 Copy Special 
(Ctrl + L) 

When copying and pasting between two instances of the 
Template Editor, use Copy Special to copy a region or 

regions to the clipboard. 

 Paste 
Special  

(Ctrl + U) 

When copying and pasting between two instances of the 
Template Editor, use Paste Special to paste a region or 

regions from the clipboard. (Note: You must use Copy 
Special to copy this information to the clipboard.) 

 

Delete  

(Delete) 

Removes the highlighted information. This operation does 

not use the clipboard, and Remark Office OMR retains no 
copy of the deleted information (except by Undo). 

 

Data Center: 

 

Tool Menu Pull-
Down Item 

Function 

 

Cut  

(Ctrl + X) 

Moves a section of text from one place to another (or to 

another document) by cutting it from the original position 
and pasting it in a new position (paste is a separate 

command). 

 

Copy  
(Ctrl + C) 

Allows for easy duplication and movement of information. 
You can copy a selected portion of text from one part of a 

data grid (or a different document altogether), and paste 
it in a different part of the data grid. 

 

Paste  

(Ctrl + V) 

Whenever a section of text is copied or cut, Remark Office 

OMR places the contents on the clipboard. This 
intermediary holds the information so you can paste it 

(multiple times if desired) until you place something new 
on the clipboard (by cutting or copying something else). 

Data can be copied from a document of one program and 
pasted to a document of another as long as the data are 

compatible. 

 Paste 

Special 

Allows you to paste information from one cell in the data 

grid to multiple cells. 

 

Delete  

(Delete) 

Removes the highlighted information. This operation does 

not use the clipboard, and Remark Office OMR retains no 
copy of the deleted information. 

 
Insert Row 

(Shift + 
Insert) 

Inserts a row into the data grid based upon the active 

cell. The row is added above the row containing the active 
cell. 

 
Delete Row 
(Shift + 

Delete) 

Removes a row in the data grid. The row containing the 
active cell(s) is deleted. This operation cannot be undone. 
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Tool Menu Pull-

Down Item 

Function 

 

Find  
(Ctrl + F) 

Displays a window asking for the search text. Remark 
Office OMR searches forward from the cursor position for 

the text requested. 

 

Find Next  

(F3) 

 

Searches for the next instance of the previous search. If 

Find has not yet been chosen, or could not locate the 

previous search, Find Next disables. 

 
Replace  

(Ctrl + H) 

Displays the Replace text window. The search text box 

contains either the highlighted text or the previous search 
text, and the replace text contains either the previous 

replace text or is blank. You can replace all occurrences of 
the search text by clicking Replace All. 

 Select All  

(Ctrl + A) 

Highlights the entire data grid. This is equivalent to 

clicking the top-left corner of the grid and dragging the 
mouse to the bottom-right, selecting all cells in the 

process. 

 
Sort Allows the sorting of data in ascending or descending 

patterns based on particular regions. 

3.5.3 View Menu 

The View menu allows you to choose which toolbars you would like to display and 

allows you to customize the current view. 

 

Template Editor: 

 

Tool Menu Pull-

Down Item 

Function 

 
Task Pane Displays the Task Pane that is used as a shortcut to 

perform functions (e.g., open, save, etc.) 

 

 

 

 

Zoom  Fit Height: Positions the image portion of the Template 

Editor so that it fits in the entire window in terms of 
height. 

Fit Width: Positions the image portion of the Template 
Editor so that it fits in the entire window in terms of 

width. 

Zoom In: Makes the image portion of the Template 

Editor window larger. 

Zoom Out: Makes the image portion of the Template 
Editor window larger smaller. 

 Theme Allows you to choose a theme for the software, which 

defines colors, fonts, title bars, etc. You may also choose 
whether to display large or small icons on the toolbar. 
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Data Center: 

 

 Menu Pull-
Down Item 

Function 

 
Image 

Viewer 

Displays the Image Viewer in the Data Center to show 

images of forms as they are processed or when clicking 

in a cell. 

 
Graph 

Viewer 

Displays the Graph Viewer in the Data Center to show a 

graph of data as forms are processed or when clicking in 
a cell. 

 
Task Pane Displays the Task Pane in the left side of the Data 

Center, which provides shortcuts to frequently used 
functions (e.g., open, save, etc.). The Task Pane updates 

with appropriate tasks as you perform certain functions 
in the software. 

 Recognition 

Settings 

Displays the current recognition settings in the Task 

Pane. 

 Flag Legend Displays the legend explaining each type of exception 

flag and its associated flag color. 

 Freeze Rows   Freezes grid row(s) so that if you scroll in the data grid, 
the frozen rows still appear. 

 Unfreeze 
Rows 

Unfreezes any row(s) to which you applied the Freeze 
Rows property. 

 Freeze 

Columns   

Freezes the grid column(s) so that if you scroll in the 

data grid, the frozen columns still appear. 

 Unfreeze 

Columns 

Unfreezes any column(s) to which you applied the Freeze 

Columns property. 

 Theme Allows you to choose a theme for the software, which 
defines colors, fonts, title bars, etc. You may also choose 

whether to display large or small icons on the toolbar. 

3.5.4 Tools Menu 

The items available in the Tools menu are the primary Remark Office OMR operations. 

These items vary slightly from the Template Editor to the Data Center. 
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Template Editor: 

 

Tool Menu Pull-
Down Item 

Function 

 

 

Reset 

Images 

(Ctrl + R) 

Resets the open form template‟s images. This feature 

allows you to reacquire images from the scanner or 

image file and is useful if your form has changed slightly 
but you have already created a form template. 

 
Response 

Scales 
(Ctrl + Q) 

Accesses the Scales that have been saved so that you 

may edit them or create new scales. Scales are used as 
Labels when creating OMR regions and Image regions 

using qualitative response codes, and are the output 
you see when processing forms. 

 

Auto Align 

Form 
Template 

Remark Office OMR attempts to align regions based on 

where they were originally created and the current form 
image. This feature is useful after resetting images. If 

there are slight differences between the original image 
and the new image, the regions are adjusted 

accordingly. (Note: You should review the form 
template after aligning to ensure regions are positioned 

correctly.) 

 

Perform 
Spell Check 

(F7) 

Checks the open form template for spelling errors in the 
region names, labels and question text. 

 

Scanner 
Properties 

(F8) 

Accesses the Scanner Properties window so that you 
may set up a scanner or make changes to the current 

setup. 

 

Preferences 

(F9) 

Allows you to modify settings that control the way the 

Template Editor looks, feels and performs. Use the Task 

Pane to perform software customization. Remark Office 
OMR saves any changes you make and applies them to 

future actions. 

 

Data Center Options: 

 

Tool Menu Pull-

Down Item 

Function 

 
Read Wizard 
(F5) 

Opens the Read Wizard so that you may read page(s) 
from a scanner or image files and place the data into 

the data grid. 

 

Easy Scan 

(Ctrl+F12) 

Begins the scanning process based on the last settings 

used in the Read Wizard. Note that you cannot adjust 

the settings. If you are unsure of the last settings 
used, you should use the Read Wizard to scan your 

forms. 



Remark Office OMR User’s Guide 

28 

Tool Menu Pull-

Down Item 

Function 

 Re-read 
Batch 

Processes the entire batch of images again, which is 
particularly useful after you have made adjustments 

using the Recognition Tools. 

 End Read Stops the process when scanning forms or reading 

image files. 

 

Review 
Exceptions 

(F4) 

Searches the open data grid and allows you to correct 
exception cases (e.g., blank or multiple responses) and 

enter image region information. The Task Pane on the 
left shows the available options. 

 

Review 

Duplicates 

Searches the open data grid and allows you to correct 

duplicate entries (e.g., two records in the data set 
belonging to the same respondent based upon the 

respondent ID). The Task Pane on the left shows the 
available options. 

 
Review 

Unrecognized 
Images 

When processing forms with Auto Form ID, Auto Page 

ID or Respondent Tracker regions, unrecognized 
images enter a queue for later review. Use this 

command to review images that Remark Office OMR 
did not recognize when processing the forms.  

 

 

 

 

 

Analysis Accesses the grade and survey options in the software: 

Easy Grade: grades the current data set using the first 
grid row as the answer key and grading options as 

defined in the form template. (F6) 

Grade Wizard: launches the Grade Wizard for 
customized grading. (Ctrl + W) 

Easy Survey: tabulates the current data set using 
tabulation options as defined in the form template. 

(Ctrl + U) 
Survey Wizard: launches the Survey Wizard for 

customized survey tabulation. (Ctrl + I) 
Analysis Preferences: allows you to modify settings 

that control the way Remark Quick Stats looks, feels 

and performs.  

 
Automation 

Wizard 

Launches the Automation Wizard, which allows you to 

set up executable files that automate basic Remark 
Office OMR functions. 

 Send Wizard Launches the Send Wizard, which allows you to email a 

data set or send it to an FTP site. 

 FTP Utility Launches the FTP Utility, which allows you to setup a 

Windows service on your system to move files 
automatically from Remark Office OMR to another 

computer using File Transfer Protocol (FTP). 
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Tool Menu Pull-

Down Item 

Function 

 
Respondent 
Detection 

(F11) 

Allows you to determine which respondents in your 
data have been processed, not been processed or have 

been processed multiple times. This feature is used in 
conjunction with the Database Lookup feature. 

 

Perform Spell 

Check (F7) 

Checks the selected data file for spelling errors. 

 Recognition 
Tools 

Allows you to draw form template regions and re-
recognize regions and entire form pages to 

accommodate changes in filled in form images. 

 Recognition 

Settings 

Allows you to view/modify the default recognition 

settings if no form templates are open. If a form 

template is open, allows you to view/modify the 
recognition settings used for the active form template. 

 

Scanner 
Properties 

(F8) 

Accesses the Scanner Properties window so that you 
can set up a scanner or make changes to the current 

scanner setup. 

 

Preferences 
(F9) 

Allows you to modify settings that control the way the 
Data Center looks, feels and performs. Use the Task 

Pane in the Preferences to perform software 
customization. Remark Office OMR saves any changes 

you make and applies them to future actions. 

3.5.5 Page and Region Menus 

The Page and Region menus are available in the Template Editor as you are creating or 

editing a form template. These menus give you options to add, delete, edit and view the 

properties of regions in the form template. The items change depending on whether you 

have selected a Page node or a Region node in the tree view. 

 

Tool Menu (Page 

or Region) 

Menu Pull-

Down 
Item 

Function 

 

 

 

 

 

Page & Region Insert Inserts a page or region before or after 

the selected node. 
 

Page: Yellow 

OMR: Green 
Image: Blue 

Barcode: Orange 
OCR: Purple 
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Tool Menu (Page 

or Region) 

Menu Pull-

Down 
Item 

Function 

 

Region Append 

Linked 
Region 

Adds a region to another region, linking 

them into one question. This feature is 
used for regions that have text or lines 

separating the answer choices and the 
OMR box cannot be drawn around all of 

the marks together.  

 

Region Link 
Regions 

Links multiple regions together so that 
they are considered one question.  

 

Region Break 

Region Link 

Separates a linked region into individual 

regions. 

 

Region Auto Align 

Page 

 

 

Allows you to auto align the selected page 

to a new image. This feature is useful 
when you need to rescan the form due to 

form changes, skew, etc. (e.g., when 
using the Reset Images feature).  

 

Page & Region Properties Shows the properties for the page or 

region. 

3.5.6 Help Menu 

When you have questions about the use of Remark Office OMR, or about a specific menu 

or command, look in the help file. 

Note: Help is context-sensitive. Press F1 while any Remark Office OMR 
window is active and help text appropriate to that window displays 
whenever possible. 

 

Tool Menu Pull-
Down Item 

Function 

 Contents Displays the contents of the Remark Office OMR help 

file. 

 Tutorials Displays a folder containing the Remark Office OMR 
tutorials in PDF format. 

 Documentation Displays a folder containing the Remark Office OMR 

user‟s guides in PDF format. 

 Edit 

Authentication 

Allows you to enter a new serial number or 

authentication code for the software. You should only 
use this option when directed by Gravic personnel. 

(Data Center only) 
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Tool Menu Pull-

Down Item 

Function 

 Transfer 
License 

Allows you to deactivate the software license on the 
current computer so that you can install and transfer 

the license to another computer. (Data Center only) 

 Register 

Software 

Launches your default web browser and loads the 

software registration page on the Gravic website. We 

strongly recommend that you register your software 
so that you receive important product notifications. 

(Data Center only) 

 Check for 

Updates 

Checks the Gravic website for a software update. If an 

update is available, you are given prompts to 
download and install it. If no update is available, you 

are notified that your software is up to date. 

 Copyrights Displays copyright information for Remark Office OMR. 
(Data Center only) 

 About Remark 

Office OMR 

Template 
Editor/Data 

Center 

Displays the About Remark Office OMR window, 

showing information about Gravic, Inc. as well as the 

serial number and current version of the software that 
is running. 

3.6 Accessing the Software Help File 

Remark Office OMR includes a help file to provide answers to your questions. Use the 

following procedures to access help when running Remark Office OMR: 

 

To access online help 

 To view context-sensitive help on the current window, press F1. 1

 To view the main help contents window for Remark Office OMR, select the Help 2

menu and then click Contents. 
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Setting Up Your Scanner 

 

Chapter 4 

4.1 Overview 

This chapter provides general information about scanners and how to configure your 

scanner in Remark Office OMR. You should already have your scanner connected to your 

computer and the drivers installed that allow the scanner to work before attempting to 

use your scanner with Remark Office OMR. 

4.2 Scanners- General Information  

A scanner is a peripheral device that is attached to a computer to scan paper-based 

documents, photographs, etc., in order to produce equivalent image file representations. 

Remark Office OMR works in conjunction with image scanners, which are the type of 

scanners that are also used for scanning pictures or pages of text and are readily 

available from your local computer dealer or via mail order and online companies. 

Scanners come in many different models and fall into many different price ranges 

depending on their performance and features. For Remark Office OMR purposes, it is 

recommended that you use a scanner with a sheetfeeder (ADF - Automatic Document 

Feeder), which allows you to scan multiple pages in batches, thus facilitating the data 

collection process. 

4.2.1 Scanner Connections 

Scanners are connected to a computer via a cable. Scanners are typically connected to 

the computer in one of three ways: 

 USB Port 

 SCSI Card (legacy scanners) 

 Network connection 

A video connection is not supported in Remark Office OMR. For USB port connections, 

you simply connect the scanner‟s cable to the appropriate port on the computer. For 

SCSI connections, you connect the scanner‟s cable to a SCSI card that is located inside 

the computer. Some scanners come with their own SCSI cards, or the computer may 

already have one installed. Otherwise, a SCSI card will need to be purchased. Please see 

your scanner‟s installation guide for the specifics on your particular model. Please note 

that SCSI cards are typically used with older scanners so you should check compatibility 
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with your operating system. Network scanners are not connected directly to a computer. 

They are attached to the network so that multiple computers can connect to them. 

Typically these systems are multi-function systems where you can print, copy, scan or 

fax. See section 4.4 for more information on multi-function peripherals.  

Note: Read the scanner manufacturer‟s directions BEFORE installing your 
scanner. You may need to install items in a specific order. 

4.2.2 Scanner Drivers 

Communication between software and a scanner occurs through a driver. There are 

several different scanner communications protocols. Remark Office OMR supports the 

most common protocol: TWAIN. TWAIN is a standard protocol for controlling scanning 

equipment. With TWAIN, each scanner manufacturer provides a TWAIN compliant driver 

for their scanners, and each software application includes TWAIN support as part of the 

software. Software applications supporting the TWAIN protocol can control many 

different scanners. When using the TWAIN option in Remark Office OMR, you have the 

option of using legacy support for older scanner drivers. 

Once you have connected your scanner to the computer, install the appropriate drivers 

and verify that the scanner is functioning properly. Then proceed to the next section: 

4.3 Selecting Your Scanner. 

4.3 Selecting Your Scanner 

To use your scanner with the Remark Office OMR software, you must first select your 

scanner from the list of supported scanners.  

4.3.1 TWAIN Source 

TWAIN is a standard for controlling scanning equipment. Most scanners ship with a 

TWAIN driver. If you are uncertain whether you have a TWAIN driver, check with your 

scanner manufacturer.  

Note: Individual scanner manufacturers write their own scanner drivers. 
The TWAIN standard leaves some areas unclear/open for interpretation, and 
as a result, the functionality of some TWAIN drivers is questionable. Remark 
Office OMR supports the TWAIN protocol, however, since scanners come 
onto the market so quickly and different companies have different software 
quality standards, Gravic, Inc. cannot guarantee that all TWAIN drivers work 
correctly. Scanner manufacturers typically revise TWAIN drivers frequently 
to correct for any problems; therefore it is a good idea to check for updated 
drivers for your scanner from time to time. Manufacturer websites often 
have updated drivers available for download. 

In order to select a TWAIN source in Remark Office OMR, the TWAIN driver must first be 

installed. Consult your scanner‟s documentation for installation instructions and 

information about obtaining a TWAIN driver for your scanner. Once the driver is 

installed, use the following procedures to select the scanner in Remark Office OMR. 
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To select and configure a scanner 

 From the Remark Office OMR Data Center, select the Tools menu and then click 1
Scanner Properties to display the Scanner Properties window. 

 Click the TWAIN Source drop-down arrow to display a list of TWAIN compliant 2
scanners that are available on your system. 

Note: Your scanner must be turned on and connected to the computer, and 
you must install your scanner‟s TWAIN driver in order for the scanner to 
display in this list. 

 Click the appropriate scanner to select it. 3

Note: Some versions of Windows come with Windows Image Acquisition 
(WIA) drivers. If you see two drivers for your scanner, we do not 
recommend selecting the one beginning with WIA. Whenever possible, it is 
better to use the driver that comes directly from the manufacturer. 

When you return to the Scanner Properties window, there are several options, which 

are summarized in the following table: 

 

Content 
Area 

Option Function 

TWAIN 

Source 

List of scanners Choose your scanner from the drop-down list. 

Note that your scanner may need to be 

connected and turned on in order to be visible in 
the list. If you have two options listed for your 

scanner and one begins with “WIA”, choose the 
one that does not begin with WIA. WIA is a built-

in Windows scanner driver. The second listing is 
most likely that offered directly from the 

manufacturer and is therefore recommended. 

TWAIN 

Source 

Use legacy driver Mark the Use legacy driver checkbox if you are 

using an older TWAIN driver. Legacy support 
allows you to use scanner drivers that support 

older versions of the TWAIN scanning protocol. It 
is not recommended that you use this option 

unless you find that your scanner driver is not 
working correctly. 

Parameters Resolution Use the Resolution setting to set the scanning 

resolution in Dots Per Inch (DPI). We 
recommend scanning at 200-300 DPI. This 

setting is not available if you have chosen to 
show the scanner‟s TWAIN interface (you select 

DPI when you scan a page). 
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Content 

Area 

Option Function 

 Color Depth Use the Color Depth setting to choose a 
scanning mode: Black/White, Grayscale or 

Color. For most cases, scanning in Black/White 
is fine and recommended. However, if your 

scanner supports grayscale or color scanning, 
you may select to use it here without having to 

do so in your scanner‟s TWAIN driver. Scanning 
in color or grayscale may be appropriate if you 

plan to use the images outside of Remark Office 

OMR or have dropout colors on your form. Note 
that scanning in color or grayscale slows down 

scanner and software performance. 

 Brightness Use the Brightness setting to set the scanner‟s 

brightness. We recommend scanning at your 

scanner‟s default brightness setting unless you 
encounter problems. The default setting in 

Remark Office OMR is 0. This setting is not 
available if you have chosen to show the 

scanner‟s TWAIN interface (you select brightness 
when you scan a page). Use a positive number 

to scan lighter and a negative number to scan 
darker. 

 Contrast Contrast is the difference between the color or 

shading of printed material on a document and 
the background on which it is printed. Most 

scanners can adjust contrast for a sharper 
image. Use the Contrast setting to set the 

scanner‟s contrast when scanning in grayscale or 
color. We recommend scanning at your scanner‟s 

default contrast setting unless you encounter 

problems. The default setting in Remark Office 
OMR is 0. This setting is not available if you have 

chosen to show the scanner‟s TWAIN interface 
(you select contrast when you scan a page). Use 

a positive number to lighten the contrast and a 
negative number to darken the contrast. 

Image 

Processing 
Options 

Despeckle Images Mark the Despeckle Images checkbox to 

remove speckling from the image. If you scan 
your forms and see black specks on the form, 

this is speckling. Note that sometimes scanning 
at a lighter brightness setting on your scanner 

can also remove speckling. We recommend only 
turning on this feature if you are having trouble 

with speckled forms. 
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Content 

Area 

Option Function 

 Maximum speckle 
size to remove 

Use the Maximum speckle size to remove 
option to select the pixel size to remove when 

using the Despeckle Images option. A pixel by 
definition is the smallest piece of information in 

an image. Pixels are represented using dots or 
squares. The default setting is 2 pixels. Use a 

higher number to remove larger speckles. Note 
that if you go too high, you run the risk of 

removing or damaging the marks (bubbles, 

checkboxes) on your form image. 

 Deskew image Use the Deskew image option to have Remark 
Office OMR automatically correct for skewing 

during the scanning process. Skewing can occur 
when pages are not fed neatly in the scanner‟s 

ADF or if your scanner pulls in the pages 
unevenly, in which case you may want to have 

your scanner serviced. In either case the result is 

a crooked image, which can make it hard for the 
software to read the marks on the image. We 

recommend only turning on this feature if you 
are having trouble with skewed forms. 

 Invert image Use the Invert image option to correct an 
image that scans in reverse: black background 

with white text. The default setting is No. You 

only need to adjust this setting if your image 
comes in reversed. 

 Rotate front side Use the Rotate front side option to rotate the 
front side of each page that is scanned. Select 

the rotation degrees in the box provided. Only 

use this option if the front side of your form does 
not rotate correctly on its own. 

 Rotate back side Use the Rotate back side option to rotate the 

back side of each page that is scanned when 
scanning duplex (two sides at one time). Select 

the rotation degrees in the box provided. Only 
use this option if the back side of your form does 

not rotate correctly on its own. 

Hardware 
Options 

Flatbed only Select the Flatbed only option if your scanner 
only contains a flatbed area for scanning. 

(Flatbed scanning is not recommended for 
Remark Office OMR.) 

 ADF only Select the ADF only option if your scanner only 

contains a sheetfeeder (ADF) for scanning. 

 Flatbed and ADF Select the Flatbed and ADF option if your 

scanner contains both a flatbed and a 
sheetfeeder (ADF). 
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Content 

Area 

Option Function 

 Duplex scanner  Select the Duplex scanner checkbox if the 
scanner you are using has duplex capabilities for 

double-sided form scanning (meaning the 
scanner can scan both sides of a piece of paper 

at one time). 

 Scan duplex Mark the Scan duplex checkbox if you have 
selected a duplex scanner and wish to scan both 

sides of a page at one time. This feature is used 
for scanning double-sided forms. 

 Show TWAIN 

interface 

Mark the Show TWAIN interface checkbox to 

show your scanner‟s TWAIN interface. By 
showing the scanner‟s interface, you can setup 

scanning parameters. We recommend turning 
this selection on initially to verify your scanner‟s 

settings (e.g., scanning mode, page size, 

resolution, brightness). Some scanners, but not 
all, support having the interface hidden. Once 

you verify all the settings within the scanner‟s 
interface, you can try turning off the TWAIN 

interface so that you do not have to see it every 
time you scan. 

 Show scanning 

progress 

Mark the Show scanning progress checkbox to 

show the scanner‟s progress indicator as pages 

are being scanned. Please note that not all 
scanners support this feature. Some scanner 

drivers always show scanning progress and some 
never show scanning progress. If the scanner‟s 

driver allows applications to control the scanning 
progress indicator, marking this checkbox 

enables the feature. 

 Center feed 
adjustment 

Mark the Center feed adjustment checkbox to 
have the page aligned with the center portion of 

the ADF, regardless of how the ADF is positioned. 
This feature is useful when scanning pages that 

are smaller than 8.5x11 inches. An adjustment is 
made so that the image does not start at the 

leftmost part of the scanner and cutoff a portion 
of the image (which can happen on some 

scanners even if the ADF is in the center 

position). Please note that some scanners have 
this property built in to their drivers, and some 

do not support this feature at all. 
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Content 

Area 

Option Function 

 Scan Ahead Mark the Scan Ahead checkbox if your scanner 
supports this feature. Scan Ahead allows the 

scanner to scan pages faster than processing 
occurs. It keeps the scanning moving so that 

there are not significant pauses while any 
processing takes place. 

 

Tip: We recommend that you initially show the scanner‟s TWAIN interface so 
that you can set the scanner settings. Once you have successfully scanned a 
page, many scanners support turning off the interface. If you disable this 
feature, you may use Remark Office OMR‟s resolution, contrast and 
brightness settings in the Parameters section of the Scanner Properties 
window.  

 In the Hardware Options section, choose the type of scanner you are using: 4
Flatbed, ADF or Flatbed and ADF. 

Note: The Hardware Options setting refers to the type of scanner you are 
using, not whether you will scan a page using the ADF or flatbed of the 
scanner.  

 If you have a duplex scanner (one that scans both sides of a sheet of paper in one 5

pass through the scanner), mark the checkbox 
for Duplex scanner. In addition, if you plan to 

scan duplex now, mark the checkbox for Scan 
duplex.  

 Enable or disable the checkbox for Show 6
TWAIN interface by clicking the checkbox. As 

stated earlier, we recommend turning on this 
option the first time you scan in order to check 

scanner settings. 

 Optionally set any other parameters as needed 7
based on the previous descriptions. Many 

settings do not need to be adjusted unless you 
encounter difficulties.  

 Click the OK button to save the scanner settings. 8

Important Note: It is important to make note of the settings you choose 
for your scanner. When you create a form template in Remark Office OMR, 
you will be using these settings. When you are ready to scan filled-in forms, 
you need to use the same settings that you used to create the form 
template. If you change scanner settings, you run the risk of creating 
images that do not match the form template, thus making it difficult for 
Remark Office OMR to accurately read the forms. 

4.3.2 Configuring a TWAIN Driver 

Most TWAIN drivers do not require any special adjustments, but some drivers may have 

special requirements. If you experience problems scanning in Remark Office OMR with 

your TWAIN driver, use the following sections for assistance. 
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When scanning in Remark Office OMR with a TWAIN driver, there are several basic 

settings that you want to use. Remark Office OMR supports color and grayscale 

scanning. However, it is not necessary. Most scanners achieve optimum scanning rates 

when used in black and white scanning mode (sometimes called line art). If you choose 

to scan in grayscale or color, you will likely experience slower scan rates. The resolution 

on the scanner, measured in dots per inch (DPI), should be set at 200-300 DPI. 200 DPI 

is usually sufficient, but you may wish to use 300 DPI if you are scanning barcodes or 

using OCR (optical character recognition). If your scanner allows you to adjust the 

scaling setting, you want it to be set at 100%. You should also verify that the page size 

your scanner is using matches the actual paper size you are scanning. You can also 

utilize the scanner‟s brightness (sometimes called threshold) and contrast settings to 

make scanned images lighter or darker. Under normal conditions, you want to use the 

scanner‟s default brightness and contrast settings. If, however, you need to make 

shading or a lightly colored paper background drop out (disappear), you could raise the 

brightness setting to accomplish these tasks. On the same token, you could set the 

brightness setting to a darker level to help compensate for light marks or lightly filled 

marks on forms.  

Tip: It is important to remember that the settings used to create the form 
template should also be used to scan the filled-in forms in order to maintain a 
level of consistency and achieve optimum recognition rates. 

4.3.2.a Controlling the TWAIN User Interface 

Not all TWAIN drivers support having their user interface hidden. We recommend that 

you turn on the option to Show TWAIN interface in the Scanner Properties window. 

When you scan, the scanner manufacturer‟s TWAIN interface appears. In this interface, 

you can specify TWAIN settings. The following table recaps the settings of which you 

should be aware: 

 

Option  Appropriate Setting 

Resolution 200 DPI recommended (300 DPI recommended if using barcodes or 
OCR) 

Scan Mode Black and White or Line Art (the software converts grayscale and color 

images to black and white, but scanning in black and white mode is 
faster) 

ADF Yes/On 

Page Size Letter (or your specific paper size) 

 

Once you have scanned a page successfully, it may be possible to hide the scanner‟s 

user interface in Remark Office OMR by turning off the Show TWAIN interface 

checkbox in the Scanner Properties window. If any problems occur, you need to show 

the scanner user interface again. 

Tip: If your scanner is used for scanning in programs other than Remark 
Office OMR, there is a good chance its settings will be altered. In this case, 
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we recommend that you make a note of what settings you are using in 
Remark Office OMR. Keep the Show TWAIN interface option on at all 
times so that you can see what settings are being used and maintain 
consistency with your forms. This practice may help you achieve a higher 
level of accuracy in the software. 

4.3.2.b Obtaining Updated TWAIN Drivers 

Most scanner manufacturers release new TWAIN drivers on a regular basis. Updated 

drivers are created to correct problems and maintain operating system compatibility. If 

you experience any problems scanning in Remark Office OMR while using a TWAIN 

driver, first try using the scanner in another application to see if the same problems 

exist. If so, contact your scanner manufacturer to ensure that you have the latest driver 

release and to troubleshoot the problems. You can find drivers on the websites of most 

scanner manufacturers. 

4.4 Multi-Functional Peripherals 

A multi-functional peripheral, or MFP, is a printing device that also scans, copies and 

sometimes faxes. These all-in-one units are becoming increasingly popular to automate 

workflows. Some MFPs are connected directly to a computer, while others are free 

standing and attached to your network. If you wish to utilize an MFP for scanning, you 

may do so with Remark Office OMR.  

When using an MFP that is connected directly to the computer running Remark Office 

OMR, you scan documents just as you would with any desktop scanner. See previous 

sections of this chapter for information about scanning with a TWAIN driver.  

When using an MFP on your network (not connected directly to a computer), you may 

scan the forms at the MFP and save them as image files, using the MFP‟s scanning 

software. Most MFPs can save images as TIF or PDF files. Remark Office OMR can then 

read those image files. Remark Office OMR users commonly scan the forms as TIF image 

files and save them on a network drive. Then they go to the computer where Remark 

Office OMR is installed and read the images from the network drive. If you are using a 

networked MFP, you can determine the workflow that works best for you and your 

organization. 

Tip: If you have the choice of TIF or PDF images, choose TIF. PDF files are 
not native image files and require more processing by Remark Office OMR. 
The result is that the scanning process is slower. TIF Group IV images are 
the most compressed for smaller file sizes and faster processing. 

Some network MFPs offer a network TWAIN driver that allows you to control the MFP 

from the computer running Remark Office OMR. Depending on the quality of the network 

TWAIN driver, you may be able to utilize it within Remark Office OMR. When using an 

MFP that has a network TWAIN driver, you scan documents just as you would with any 

desktop scanner. See previous sections of this chapter for information about scanning 

with a TWAIN driver.  
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Designing Scannable Forms  

Chapter 5 

5.1 Overview 

Remark Office OMR provides a flexible solution for scanning forms you create and 

producing data and reports. Because there is so much flexibility, a wide variety of forms 

can be created. Good form design is a key component to using Remark Office OMR 

successfully. Therefore, we have created a set of form design guidelines to help you 

create forms that will work well with the software. Remark Office OMR works with plain 

paper forms; no special inks or marks are needed. Respondents can use pen or pencil to 

complete the forms.  

Note: Remark Office OMR is not a form designer. Forms used with Remark 
Office OMR are created independently of the software in programs such as 
word processing and survey design packages. 

Designing scannable forms for Remark Office OMR can be broken down into the following 

elements: 

 Finding an application for designing forms (Section 5.2) 

 Mark selection for OMR (Section 5.3) 

 Character selection for OCR (Section 5.4) 

 Form spacing (Section 5.5) 

 Question grouping (Section 5.6) 

 Using shading (Section 5.7) 

 Margins (Section 5.8) 

 Barcodes (Section 5.9) 

 Paper selection (Section 5.10) 

 Duplicating forms (Section 5.11) 

 Testing forms (Section 5.12) 

 Form review service (Section 5.13) 

 

 

 



Remark Office OMR User’s Guide 

44 

5.2 Finding an Application for Designing Forms 

The first step in designing a scannable form is determining where you prefer to design 

the form. Some of your options include: 

 Word processing software 

 Survey design software 

 Form design software 

Word processing software (e.g., Microsoft® Word®) is commonly used for creating forms, 

as many people already have this software and are familiar with using it. If you are 

comfortable with word processing software, this may be the best choice for you.  

Software created specifically for survey design and analysis can offer the additional 

benefits of question banks (the ability to draw and save questions to and from a 

question library), layout assistance and analysis components. Form design software can 

give you advanced layout tools to create professional looking forms. 

Determining what software application to use is an individual decision. You should base 

your decision on what you are comfortable with using, your budget and your overall data 

collection needs. No matter what your choice, the design guidelines set forth in the next 

several sections apply. Please read through them thoroughly before undertaking your 

own form design. 

You may wish to consult the Gravic website for up to date partner information about 

survey and form design software. We provide links to manufacturer websites, many of 

which have demonstration software you can try. By seeing what tools are available, you 

can make an educated decision on what is the best solution for your needs. 

5.3 Mark Selection for OMR (Optical Mark Recognition) 

Forms need to be created so that Remark Office OMR can recognize the data on them. 

Remark Office OMR recognizes optical marks, which include bubbles (a circle or oval), 

checkboxes, etc., that respondents darken with a pen or pencil to indicate their 

response. Although Remark Office OMR works with almost any complete shape (e.g., 

circle, square, triangle), experience indicates that bubbles between 10 and 14 points in 

height work the best. Non-oval shapes are somewhat harder to fill completely. 

Respondents typically fill bubbles more completely and neatly, which leads to better 

recognition rates. 

When using word processing software, we recommend using a 

capital "O" in an Arial font. You may also use our OMR Bubbles 

fonts, which creates an encircled letter or number (). The 

OMR Bubbles fonts install with the Remark software. They can 

also be downloaded from the Gravic website. Once installed, 

you may access the fonts from Windows applications on your 

computer just as you would any other font. While it is 

possible to place numbers or letters inside of marks, the 

number/letter must be as small and light as possible. Dark, 

thick or bolded characters may cause Remark Office OMR to 

http://www.gravic.com/remark
http://www.gravic.com/remark
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interpret the mark as being filled. Therefore we recommend using our tested OMR 

Bubbles fonts if you require encircled numbers or letters.  

We do not recommend creating bubbles using the Times New Roman font, which may be 

the default font in some word processing programs. This font does not create an evenly 

defined bubble and can therefore break apart when scanned. Using the Arial font yields 

a well-defined bubble that scans consistently.  

Important Keyword:  
Mark: A mark is any type of complete shape used on a form. Respondents 
darken the marks to indicate their answer choice. Marks are typically 
bubbles or checkboxes on OMR forms. 

5.4 Character Selection for OCR (Optical Character 

Recognition) 

Remark Office OMR includes the capability to recognize machine printed text. This 

functionality is called OCR, or optical character recognition. 

Note: OCR does not include handwriting recognition (commonly called ICR 
or intelligent character recognition). In order to use the OCR feature, the 
text must be machine or computer generated. 

While the software‟s sensitivity level can be adjusted, certain fonts and font sizes 

recognize better than others. We recommend using a common font such as Arial or 

Times New Roman. You do not want to select a handwriting style font. The font size 

should be a minimum of 12 points (even larger is better), and you do not want to use 

bold, underline or italics formatting. If you notice areas where letters almost touch each 

other due to the shape of the letter, we suggest increasing the character spacing 

slightly, which is supported by most word processing applications. When scanning forms, 

a scanning resolution of 300 DPI (dots per inch) is recommended. Always test your 

forms with the Remark software to ensure that the characters are recognized properly 

before you print and distribute large quantities (see Section 5.12 for further details). 

5.5 Form Spacing  

Allowing enough white space on a form is an important part of good form design. Allow 

at least 3/8 inch of space between any text, lines or graphics on the form and all user-

markable areas (bubbles, checkboxes, barcodes, text you plan to read using OCR, etc.). 

The white space around your marks provides a buffer that can help Remark Office OMR 

accommodate scanner skew, form offset and not-so-perfect markings from your 

respondents. The more white space you have, the better Remark Office OMR is able to 

tolerate differences from form to form. In contrast, the more crowded a form (or the 

less white space there is), the harder it is for Remark Office OMR to compensate for 

form differences. 

Although groups of bubbles need to be 3/8 inch away from any visible lines or text, the 

individual bubbles within the group can be as close to one another as two character 

spaces.  
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We recommend staying away from the use of lines or boxes around or between the 

marks on a form. If you find it necessary to use lines or boxes, you may make them a 

light gray that drops out (completely disappear) during the scanning process. In 

addition, follow the spacing guidelines above.  

Note: You cannot photocopy forms that use gray lines as the gray becomes 
too dark. Only use clean printouts for forms utilizing gray lines. 

Example of good form spacing: 

 

 Excellent Good Fair Poor 
     

Question 1 O O O O 

Question 2 O O O O 

Question 3 O O O O 

5.6 Grouping Questions  

Positioning all of the marks for the same question type in a single region area minimizes 

your efforts when you create form templates within the software. Whenever possible, try 

to place similar types of questions together. For example, place all true/false questions 

in one area of the form and all multiple choice questions in another. All marks you want 

to define in a single OMR region must align horizontally and vertically.  

When possible, place the labels for a group of questions on the top of each column or at 

the beginning of each row (at least 3/8th inch away from the marks); this allows you to 

select the entire group of questions within one region when you create a form template 

in the software. If the labels are between marks, you may have to select questions 

individually and/or link marks together to form logical questions. 

Example: 

 

Original Layout:    Better Layout: 

What is your gender?   What is your gender? 

 

O     Female O     Male  O     Female 

      O     Male 

5.7 Shading  

Remark Office OMR works best with marks printed in black ink on white paper without 

shading. While we do not recommend the use of shading in areas containing marks, you 

can create shading that completely drops out when scanned (a 5-10% gray typically 

works well). A better alternative is to shade the questions but leave the area containing 

the marks white. 
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Note: You cannot photocopy forms that use shading as the shading 
becomes too dark. Use clean printouts for forms utilizing shading. 

Example: 

 Excellent Good Fair Poor 

     

Text for Question 1 O O O O 

Text for Question 2 O O O O 

Text for Question 3 O O O O 

Text for Question 4 O O O O 

Text for Question 5 O O O O 

 

Always test your form with your scanner before printing large quantities. Shading varies 

from printer to printer and scanner to scanner. If your scanner supports color drop-out, 

you can shade questions using a pale shade of one of the colors your scanner drops out. 

Note that this may slow down the scanning process and should be thoroughly tested 

before printing and distributing forms. 

5.8 Margins 

Margin space along the edges of a form is important. We recommend leaving a one inch 

margin around all sides of the page. At a minimum, do not go below ½ inch margins. 

The margin space allows some shifting in forms without having the marks fall off of the 

page when scanned. The smaller the margin, the less tolerance you have for 

inconsistencies from form to form.  

5.9 Barcodes 

Remark Office OMR can read many types of barcodes. Barcodes can be used to capture 

a variety of information, including, but not limited to, names, ID numbers, session/class 

numbers, other demographic information, etc. The software recognizes the following 

barcode types: 

 Code 3 of 9 (Code 39): Alphanumeric 

 Interleaved 2 of 5: Numeric  

 Codabar: Numeric  

 PDF 417: 2D, Alphanumeric 

 Data Matrix: 2D, Alphanumeric 

 QR Code: 2D, Alphanumeric 

 Code 11: Numeric 

 Code 128: Alphanumeric 

 Code 93: Alphanumeric 
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 EAN 13: Numeric 

 EAN 8: Numeric 

 UPCA: Numeric 

 UPCE: Numeric 

You may put one or more pieces of data within one barcode. If using multiple pieces of 

data in one barcode, you must separate the data with some character (called a 

delimiter), such as a space, comma or tab. Remark Office OMR outputs the individual 

pieces of data to separate cells in the data grid when the forms are processed.  

Use the following guidelines when placing barcodes on your forms: 

 Barcodes should be at least 26 points in terms of size (about 1/4 inch high). 

 Barcodes may be placed on forms horizontally or vertically. 

 If using barcode stickers, place a lightly colored placeholder on the form so that 

the person affixing the stickers to the form knows where to place the barcodes. 

The barcodes must be in the same place on each form in order for Remark Office 

OMR to recognize them. Ideally, the placeholder should be covered by the sticker 

or light enough to drop out (completely disappear) when scanned. You do not 

want the placeholder to interfere with recognition of the barcode. 

Example: 

 

 

 

 Do not put text, lines, etc., within ½ inch of the barcode (*with the exception of 

the tip below). 

Tip: If you would like to be able to read the barcode with the human eye, 
place the text of the barcode in small, light print directly beneath the 
barcode. Example: 

 
*12345* 
          12345 

5.9.1 The Code 3 of 9 Barcode 

The Code 3 of 9 barcode is created by installing the Code 3 of 9 barcode font. This font 

installs automatically with the Remark software or can be downloaded from the Gravic 

website. 

When using the Code 3 of 9 barcode font you need to begin and end the barcode with 

asterisks. These asterisks become bars in the barcode and are necessary for proper 

recognition of the barcode. Without these asterisks, Remark Office OMR cannot read 

your 3 of 9 barcode. Use caution as some word processing applications use the asterisks 

as an auto formatting feature to bold the text and drop the asterisks. Check your form 

design‟s program options for this auto formatting feature. In addition, do not use spaces 

 Place Barcode Here 

http://www.gravic.com/remark
http://www.gravic.com/remark
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in the barcode. If you need to represent a space, use the exclamation point (!) 

character. The Code 3 of 9 barcode always outputs letters in upper case. 

Example: To barcode the name Jane Doe, you would type: *Jane!Doe* and 
then convert the entire sequence to the Code 3 of 9 barcode font. 

5.10 Paper  

Remark Office OMR works best with plain white paper and black ink. Utilizing standard 

20# copier paper works well for single sided forms and 28# or higher paper works well 

for double-sided forms (heavier paper helps avoid bleed-through). While we recommend 

using white paper for the best recognition, you may use colored paper (pastel colors 

tend to work well), as long as the color completely drops out when scanned. Test your 

paper selection with your scanner before printing large quantities of your forms.  

Tip: You can test colored paper by scanning a form in the Remark Office 
OMR Template Editor. The resulting image should have a white background 
with black text. If you see speckles or other black marks in the background, 
your paper may be too dark. You can try raising the brightness setting on 
your scanner to see if the rest of the color from the paper drops out without 
compromising the marks on the form. 

 

Remark Office OMR supports any paper size or thickness supported by your scanner. 

Consult your scanner's user's guide for further information.  

5.11 Form Duplication 

When reproducing forms, quality and consistency can reduce form processing errors. 

You have the flexibility to duplicate forms in several ways: using a laser printer, a high 

quality photocopier or a professional printer. Consistency from form to form is 

important. Try to use the same source to duplicate all of the forms you will need for a 

single form type.  

When photocopying forms, the accuracy of page placement into the photocopier and 

your overall form design are the limiting factors as to how large your margins must be in 

order to minimize errors. Forms with inadequate spacing have a low tolerance for 

offset/skew. Carefully placing forms directly on the photocopy machine‟s glass tends to 

yield better copies than using the document feeder, which can skew the page as it is 

pulled into the copier. Test your form by creating a form template in the software and 

processing a batch of forms that are filled out as you expect to have them returned 

(e.g., not perfectly) before printing large quantities. Once you feel that your form design 

is adequate, try to photocopy all of the forms that you will need in one batch. This 

eliminates the need to make photocopies from photocopies at a later date, which can 

lead to form inconsistencies.  

Regardless of how you duplicate your forms, be sure to keep blank copies on hand. You 

always want to create your Remark Office OMR template using the same quality form 

that you distribute to your respondents. For example, if you photocopy your form, use a 

blank photocopy to make the form template in the software. 
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It is best to maintain as much control over form duplication as possible. However, if your 

workflow is such that multiple locations print and distribute their own forms, request 

that at least one blank copy of the form is returned to you with the filled in forms from 

each location. This allows you to realign your scanning template to the printout if you 

find that the forms have shifted significantly. 

Tip: Save forms to the Adobe PDF format to retain original form formatting. 
If you need to have someone else print your form, this format is preferable 
over other native word processing formats. Remember to embed the fonts 
you use in case the person printing the form does not have the same fonts. 
Do not use the PDF to create the form template; always use a blank scanned 
image. 

5.12 Form Testing 

The best way to know whether you have created a good, scannable form is to test it. 

Always test any forms you plan to use with Remark Office OMR before printing and 

distributing them. It is much easier to find and fix problems before the forms are printed 

and distributed.  

To test your form, create a form template in the Remark Office OMR Template Editor 

(see Chapter 6 for more information). Then fill out a sampling of forms as you expect to 

get them back from your respondents (not perfectly!). Scan the forms and check your 

results. If you do not get the accuracy you expect, check your form‟s design against the 

guidelines presented in this user‟s guide and make the appropriate modifications. 

Remember to use the same scanner settings for form template creation and when 

scanning the filled-in forms. 

5.13 Form Review Service 

We will review any form after it is created to ensure it is compatible with Remark Office 

OMR. You can email or fax forms to our technical support department and we will check 

them for known issues. We can often head off potential issues before they become 

problems. Be sure to use this service before you print and distribute your forms.  
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Using the Template Editor 

Chapter 6 

6.1 Overview 

The Remark Office OMR Template Editor is used to create form templates for the forms 

you process in Remark Office OMR. You must create one form template file for each 

form that you process with the Remark software. The form template file defines all of 

the information needed for the software to process your form correctly. Once a form 

template is created, the form can be used as often as desired without needing to create 

a new form template (as long as the form does not change). Example: If processing 

student exams, you can create form templates for various forms (e.g., 25 questions, 50 

questions and 75 questions) and then use those form templates as often as needed. 

The form template file holds information about where the marks, barcodes and text are 

located on the page, how many pages your form contains and what type of output you 

would like. A single template can hold up to 150 pages. 

Tip: The form template is the key to accurate recognition in Remark Office 
OMR. When creating form templates, be sure to use the same quality form 
as you will be distributing to respondents (e.g., if you are photocopying 
forms, use a blank photocopy for the form template). Also use the same 
scanner and scanner settings for both the form template and filled-in forms 
(e.g., resolution, brightness).  

The following topics are covered in this chapter: 

 Understanding the template editor interface (Section 6.2.1) 

 Creating form templates (Section 6.2) 

 Region types (Section 6.2.2) 

 Creating regions (Section 6.2.4) 

o OMR Regions (Section 6.2.5) 

o Image Regions (Section 6.2.9) 

o Barcode Regions (Section 6.2.10) 

o OCR Regions (Section 6.2.11) 

 Additional region properties (Section 6.3) 

 Additional template editor features (Section 6.4) 

 Saving form templates (Section 6.5) 

 Editing existing form templates (Section 6.6) 

 Editing regions (Section 6.6.1) 
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 Template Editor preferences (Section 6.7) 

Tip: It is strongly recommend that you perform the tutorials included with 
the software to get an understanding of the Template Editor. You can find 
the tutorials under the Help menu in the software or by clicking 
Start|Programs|Remark Office OMR 8|Documentation on your computer. 

6.2 Creating Form Templates 

6.2.1 Understanding the Template Editor Interface 

The Remark Office OMR Template Editor contains three basic components that you use 

to create and edit your form templates. The left portion of the template editor window 

contains a tree view (an item list) with nodes 

representing each region in your template.  

Important Keyword: 
Region: A region is an Image, Barcode, 
OCR or OMR area that you define. A single 
OMR region can contain one or more 
questions. 

Also in the left portion of the window, you can find 

the Task Pane. The Task Pane contains links to 

commonly used features and updates 

automatically based on your selections to help you 

navigate through the software. (Note that you 

may turn off the Task Pane by clicking View|Task 

Pane.) The right side of the window contains an 

image representation of your form. You provide 

this image via the scanner or a saved image file. 

You may use the tree view and the image representation area to work with your form 

template. Each region in the tree view contains the properties of that region, which are 

accessed by double clicking the region. You may think of a region as a question or item 

on your form. You may also double click within a region in the image representation area 

to view the region‟s properties. Continue with the following sections for specific 

instructions on using the Template Editor.  

6.2.2 Region Types 

Regions are explained in more detail later in this chapter, but it is worth providing an 

overview here. There are four basic region types that Remark Office OMR can process: 

 

 

 

 

 

Image Representation 
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Region Type What is on 

Your Form 

Description 

OMR (Optical 
Mark 

Recognition) 

Bubbles, 
checkboxes or 

any other 
complete 

shape, often 
used for 

answering 
multiple choice 

questions, 

filling in names 
and codes, etc. 

OMR regions are used to capture marks, such as 
bubbles and checkboxes, on your form. Marks 

can be used to collect many varying types of 
information, ranging from multiple choice 

questions to ID numbers to names.  

Barcode Horizontal or 
vertically 

positioned 

barcode 

Barcodes are used to encode just about any 
desired information, ranging from names to ID 

numbers to other demographic information.  

OCR (Optical 

Character 
Recognition) 

Machine 

printed text 

OCR regions are used to read text that is 

machine printed on your form (not handwritten). 
The software can read characters, such as ID 

numbers and names, as long as they are 
machine printed.  

Image An area for 

handwritten 
text, or other 

information 
that cannot be 

automatically 

converted to 
data 

Image regions capture handwriting from 

comment areas and other open ended questions. 
The software does not automatically interpret 

handwriting, but it does either take a picture of 
the handwriting, allow you to hand enter the 

written comments using image assisted data 

entry or type qualitative codes to apply themes 
to the handwritten comments. 

 

Now that you know how your form translates to a form template, we can begin the 

basics of form template creation. 

6.2.3 Beginning the Form Template 

Form templates are created in the Remark Office OMR Template Editor. There are two 

main ways to access the Template Editor to create a new form template: 

 From the Remark Office OMR Data Center, select the File menu and then click New 1

Form Template or click . Alternatively, with the Templates tab selected, click 

New form template in the Task Pane. 

 From your Windows Start menu, click Start|Programs|Remark Office OMR 2

8|Remark Office OMR Template Editor. 
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To create a new form template 

 From the Template Editor, select the File menu and then click New, or click , 1

to begin a new form template. Alternatively, select New form template from the 
Task Pane.  

The New Form Template Properties window appears. This window allows you to 

specify general information about the template, including a description, page size and 

page orientation.  

 If desired, enter a description for the form 2
template in the Form template description 

box.  

 Select the appropriate size of the form(s) you 3

are scanning in the Page Size drop-down box. 
All pages contained in a form template must be 

of the same size. 

 Select the orientation of the form in the 4

Orientation area. You may choose Portrait or 

Landscape. All pages contained in a form 
template must be of the same orientation. 

Tip: You may not change the Page Size and Orientation once the form 
template is created. Therefore, make your selections carefully in this 
window. 

 Click the Next>> button to continue. 5

The Create Page Elements window appears. From this window, select how you want to 

import the images of your form. You may scan pages directly into the Template Editor or 

you may import image files (that you previously scanned and saved) of the form. 

Regardless of how you import these images, remember to always base your form 

template on a blank copy of your form. 

Note: You must scan the blank form for template creation in order for 
accurate recognition. Do not import a PDF or similar file that did not 
originate from a scanner. Creating a PDF file directly from a document is not 
the same as scanning a form and producing an image file, and therefore 
your form template does not match the scanned images of your completed 
forms, leading to recognition errors. 

 

To create a form template image using the 

scanner 

 In the Select Method to Use for Image 1

Acquisition section, click the Read from 
scanner radio button. 

Note: If you need to configure your scanner, 
you may click Scanner Properties next to 
Read from scanner to view the Scanner 
Properties window. (See Chapter 4 for 
further details about using a scanner.) 
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 [OPTIONAL] If you are using drop-out colors on your form, choose the color you wish 2

to drop-out of the form: Red, Blue, Green. You may also select a Drop-out 
threshold. This threshold determines how close the color match must be in order for 

the color to drop-out. The higher the number, the closer the match must be. 

Note: Dropping out color is useful on forms where you have colored lines or 
shading near your marks. Dropping out the color means that the color 
disappears as the form is scanned. The marks (bubbles, checkboxes) must 
not be the same color you are dropping out or they will drop-out as well, 
making the form unreadable. Using drop-out colors via the software works 
with any scanner that can scan in color. If your scanner can also drop-out 
colors, we recommend using the scanner‟s color drop-out by turning on the 
scanner‟s TWAIN interface for optimum performance. Please note that 
dropping out color will likely slow down the scanning process.  

 Place the blank page(s) to be scanned in the scanner. You may scan pages one at a 3

time or all of the form‟s pages at once.  

 Click the Acquire Images from Scanner button to scan the page(s).  4

The page(s) are scanned and then a thumbnail image of the form appears in the Image 

window. If scanning multiple pages at once, use the arrows under the image to view all 

scanned images. You may also delete images by clicking the Delete icon. 

 If you are satisfied with the image(s), click the OK button. Otherwise, click Acquire 5
Images from Scanner again to rescan a page. (Make sure images do not look 

severely skewed; if they are, acquire the images from the scanner again.) 

Remark Office OMR opens a window with a tree view (item list) on the left and an image 

representation of your form on the right. In this window you outline the areas to be 

recognized. You may continue to Section 6.2.4 Creating Regions. 

 

To create a form template image using an existing image file 

 In the Select Method to Use for Image 1
Acquisition section, select the Read from 

image files radio button. 

 [OPTIONAL] If you are using drop-out colors on 2

your form, choose the color you wish to drop-

out of the form: Red, Blue, Green. You may 
also select a Drop-out threshold. This 

threshold determines how close the color match 
must be in order for the color to drop-out. The 

higher the number, the closer the match must 
be. 

Note: Dropping out color is useful on forms 
where you have colored lines or shading near your marks. Dropping out the 
color means that the color disappears as the form is scanned. The marks 
(bubbles, checkboxes) must not be the same color you are dropping out or 
they will drop-out as well, making the form unreadable. If your scanner can 
also drop-out colors, we recommend using the scanner‟s color drop-out 
feature when you scan the forms so that when the images are read in 
Remark Office OMR, the color is already gone.  

 Click the Acquire Images from File button to select an image from file.  3
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 In the Select Image File… window, use the Look in drop-down list to find the 4

image file you wish to use for the form template. You may only select one image at a 
time; however you can go back to this window to select more images in succession.  

A thumbnail image of the form appears in the Image window.  

 Repeat Steps 3-4 to add any other images to the form template, if desired.  5

 If you are satisfied with the image(s), click the OK button. Otherwise, click Acquire 6

Images from File again to reselect an image. 

Remark Office OMR opens a window with a tree view (item list) on the left and an image 

representation of your form on the right. In this window you outline the areas to be 

recognized. 

Tip: For multi-page forms, you can decide whether you want to start with a 
single template page or all pages at once. If you need to add pages later, 
simply click a page node in the tree view and use the Page|Insert menu to 
add new pages. 

6.2.4 Creating Regions 

Regions can be created several different ways: by using the tree view, menus, Task 

Pane or image representation area. The sections that follow detail these methods. 

You can create regions using the tree view by utilizing the appropriate menus and/or the 

mouse. The tree view contains nodes representing each page and region of your form. 

You can double click or right click each node in the tree view to perform specific actions. 

 

Using Menus to Insert Regions Using a Mouse to Insert Regions 

 Click the node above or below 1
where you would like the new 

region to be added so that it is 
highlighted. For the first question 

in a form template, click the 

Page 1 node. 

 Click the node above or below where you 1
would like the new region to be added so 

that it is highlighted. For the first question 
in a form template, click the Page 1 

node. 

 Click the Region menu if you 2

have selected a region. Click the 
Page menu if you have selected 

a page. 

 Right click the same node to display a 2

drop-down menu. 

 

 Click Insert. 3  Click Insert. 3
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Using Menus to Insert Regions Using a Mouse to Insert Regions 

 Make the appropriate selection 1
based on what you would like to 

insert and whether you want to 
insert it before or after the 

selected node: Page After, OMR 
Region After, Image Region 

After, Barcode Region After, 
OCR Region After, Page 

Before, OMR Region Before, 
Image Region Before, 

Barcode Region Before or OCR 

Region Before.  

 Make the appropriate selection based on 1
what you would like to insert and whether 

you want to insert it before or after the 
selected node: Page After, OMR Region 

After, Image Region After, Barcode 
Region After, OCR Region After, Page 

Before, OMR Region Before, Image 
Region Before, Barcode Region Before 

or OCR Region Before. 

 

Note: You may also use the toolbar buttons to insert each region type: (green 

for OMR (optical mark recognition) regions, orange for Barcode regions, blue 

for Image regions and purple for OCR (optical character 

recognition) regions).  

The mouse cursor turns to a crosshair, indicating you need to drag a box 

around the region in the image representation area of the screen. When 

you drag a box around an OMR region, do not include any surrounding 

text, lines or graphics. 

 Place the crosshair in the top left corner of the region, hold down the 2

left mouse button and drag a box to the lower right hand corner of the 
region.  

 Release the mouse button. 3

The Region Properties box appears. Region types and properties are 

explained in the following sections. 

 

Using the image representation area to create regions  

 Right click the mouse in the image representation area and then click Insert. 1

 Select the type of region you want to create. The Region Properties box appears. 2

Tip: Right clicking anywhere in the image representation inserts the new 
region after the last region that was defined on the page. To insert a region 
in a specific order, first select a region then right click and choose Insert. 
Next, make the selection that best indicates where you want the new item 
to be placed relative to the selected region (Page After, OMR Region After, 
etc.).  

Region types and properties are explained in the following sections. 
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Using the Task Pane to create regions 

 If the Task Pane is not visible, select the View menu 1
and then click Task Pane. The Task Pane updates 

automatically based on your last action. 

 Click the Define regions link. 2

 Select the link corresponding to the type of region you 3
would like to insert: Insert OMR region, Insert 

Image region, Insert Barcode region, Insert OCR 
Region. The new region is inserted after the currently 

selected node in the tree view. 

 Place the crosshair in the top left corner of the region, 4
hold down the left mouse button and drag a box to the 

lower right hand corner of the region.  

 Release the mouse button. 5

The Region Properties box appears. Region types and 

properties are explained in the following sections. 

6.2.5 OMR (Optical Mark Recognition) Regions  

An OMR region is an area on the form containing OMR bubbles, checkboxes, or some 

other complete shape. The respondent darkens the marks that correspond with his or 

her answer choice. Each OMR region contains a specific number of rows and columns. A 

single OMR region can contain one or more questions. When an OMR region is created, 

you must specify certain properties pertaining to the region, including the size of the 

region, the type of region and what output Remark Office OMR should generate. These 

topics are covered in the following sections. 

6.2.5.a OMR Region Types 

There are seven types of OMR regions. The following section describes each type in full 

detail, and includes examples of each style. The examples include the region as it looks 

on the printed form as well as how a selected response might appear in the data grid 

when you are processing forms. 

 

Multiple Region: A Multiple region designation is used for multiple-choice style 

questions. These questions can allow a single response or multiple responses. One 

Multiple region may contain more than one question. 
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Example 1: 

 

 Form:           Data Output: 

Gender  Gender 

    Female 

    Male 

 Female 

  

Example 2: 

  

       Form:           Data Output: 

     Question1 Question2 Question3 

Question 1    
A B C 

Question 2    

Question 3    

 

Grid Region: A Grid region designation is used for questions where the output from the 

rows and columns represents one piece of data. The respondent typically fills in several 

bubbles that make up one response (e.g., student ID numbers, names, social security 

numbers). 

Example: 

 

      Form: 

      Identification Number 

0 1 2 3 4 5 6 
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     Data Output:

Id Number 

0123456 

 

List Region: A List region designation is used for regions that contain multiple choice 

style questions, but the response bubbles are not contained in a single row or column. 

Each bubble has a unique output value. 

 

Example: 

 

Form: 

What is your middle initial? 

 







  

Data Output: 

Middle Initial 

L 

 

Add Region: An Add region designates a region where the values of all of the chosen 

OMR bubbles are added together to produce one value. You can assign individual values 

to each answer choice (or mark on the form). 

 

Example 1: 

For this example, you could add each of the scale values chosen to make up one total 

response: 

 

Form: 

Please answer the following questions honestly using the scale provided: 

      Unhappy     Happy 

      1 2 3 4 5 

 

How do you feel today?  O  O O O 

How did you feel yesterday?  O  O O O 

How did you feel last week?  O O  O O 
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Data Output (2+2+3): 

Feelings 

7 

  

Example 2: 

In this example, you could assign a 1 to each positive response and a –1 to each 

negative response and Remark Office OMR would output a total: 

Form: 

Mark the characteristics that you think apply to you: 

(+1) (-1) 

 

       happy most of the time O       unhappy most of the time 

O       laid back        tense 

O       fun        boring 

       intelligent O       unintelligent 

       exceptional O       average 

 

Data Output (1+1+1-1-1):  

Characteristics 

1 

 

Boolean Region: A Boolean region designation is used when you want a user-defined 

value (e.g., Yes) to be output if an answer choice is selected and another user-defined 

value (e.g., No) for answer choices that are not selected. Each response is output to a 

separate cell in the data grid during form processing. In comparison, when you use the 

Multiple or List region types for questions that allow multiple responses, Remark Office 

OMR places the data in a single cell, delimited by commas. The Boolean region type is 

useful for questions that allow multiple responses but for which you need the data in 

separate cells. For example, the Boolean region type can be used when you are 

exporting data to programs such as the legacy SPSS format that cannot handle multiple 

responses that are delimited by a comma. (The regular SPSS format does not require 

multiple responses to be output as Boolean fields.) 
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Example: 

 

Form: 

In which of the following activities do you participate (mark all that apply)? 

 

O Athletics (collegiate)   

 Athletics (intramural)  

O  Chess Team    

 Debate Team    

O Marching Band   

    

Data Output: 

Activity1 Activity2 Activity3 Activity4 Activity5 

No Yes No Yes No 

 

Binary Region: A Binary region designation is used when you want a pre-defined value 

(1) to be output if an answer choice is selected and another pre-defined value (0) for 

answer choices that are not selected. Binary regions output all responses to one cell. 

Using the previous example you would have the following: 

 

Example: 

 

Form: 

In which of the following activities do you participate (mark all that apply)? 

 

O Athletics (collegiate)   

 Athletics (intramural)  

O  Chess Team    

 Debate Team    

O Marching Band   

 

Data Output: 

Activities 

01010 
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Rank Region: A rank region designation is used for multiple-choice questions where 

each response or response set can only be used one time. For example, on a voting 

ballot you may be asked to put a list of candidates in order. Using the Rank question 

type allows you to limit how many times each answer choice can be selected. 

 

Example 1: 

Please rank the following ice cream flavors from most favorite (1) to least favorite (3): 

 

Form:    1 2 3 

 

Chocolate    O O 

Vanilla    O O  

Strawberry  O  O 

 

Data Output: 

1 2 3 

Chocolate Strawberry Vanilla 

 

Example 2: 

Please vote for President, Vice President and Secretary: 

 

Form:            Pres     VP      Sec 

 

John Doe    O O 

Joe Garcia   O O  

Ron Jackson  O O O 

Mary White  O O O 

Lisa Brown  O  O 

Jane Doe   O O O 

Marty Donovan  O O O 

 

Data Output: 

Pres VP Sec 

John Doe Lisa Brown Joe Garcia 
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6.2.5.b Region Orientation 

An OMR region can be oriented in columns or rows. The region orientation property in 

the form template determines how the region is positioned on the form: by column or by 

row. 

Column: Regions oriented by column contain question(s) that are positioned on the 

form in columns (it can be one column or several columns). 

Examples: 

 

 

 

 

 

Row: Regions oriented by row contain question(s) that are positioned on the form in 

rows (it can be one row or several rows). 

 

Examples: 

 Excellent Good Fair Poor 

Question 1 O O O O 

Question 2 O O O O 

Question 2 O O O O 

 

What is your age group? 

 

18-24  25-34  35-44  45-54  55-64  65+ 

 

   O        O     O     O     O   O  

6.2.6 Defining the OMR Region 

Once you have inserted an OMR region, the Properties - OMR Region window appears. 

The following table contains a brief summary of the OMR region properties.   

 

Property Function 

Region name A name assigned to an OMR region. Region names are used as 

grid column headers in the data grid window and are exported 
when saving data to common file formats. Region names are 

limited to 60 characters. 

What is your gender? 

O     Female 

O     Gender 

Select the best response: 

O A 

O B 

O C 

O D 
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Property Function 

OMR type The type of OMR region being described. Region types include: 

Multiple- indicates a region containing multiple-choice questions. 

Grid- indicates a grid or matrix of marks (bubble, checkbox) that 

equates to a single piece of data (e.g., student ID number). 

List- indicates a region where each mark is assigned a unique 

output value, but the marks are not contained in a single row or 
column (e.g., a list of answer choices). 

Add- indicates a region where the values for each of the answers 
that are filled by the respondent are added together to produce a 

single value for numeric data, or concatenated together for 

textual data. 

Boolean- indicates a region where a user-defined value (e.g., Yes) 

is output for filled responses and another value (e.g., No) is 
output for non-filled responses. Boolean regions output one piece 

of data for each mark (answer choice) in the region. 

Binary- indicates a region where a value of 1 is output for filled 

responses and a value 0 is output for non-filled responses. Binary 
regions output a string of responses (1s and 0s) to a single cell. 

Rank- indicates a region containing multiple-choice questions 

where each selection choice can only be selected one time. 

Data type Sets whether the data should be considered text or numeric when 

saved/exported. 

Region 
orientation 

Sets the orientation of the region in terms of columns and rows: 

Column- the region contains questions that are oriented in 

columns. 

Row- the region contains questions that are oriented in rows. 

Columns in the 

region 

Sets the number of columns of marks contained in the region. 

Rows in the 
region 

Sets the number of rows of marks contained in the region. 

Possible label 
scales 

Sets a range of pre-determined values as output Labels (e.g., A-E 
or 1-5). Use this setting to quickly enter Labels into the Labels 

grid as opposed to entering each Label individually. Each mark on 

your form is represented by a Label. The Label is the output when 
the form is processed (e.g., scanned). Note that only label scales 

corresponding to the number of answer choices you have selected 
appear in this list.  

Labels Sets the output data that appears in the data grid when reading 
forms. Each mark on your form is represented by a Label. The 

Label is the output when the form is processed (e.g., scanned). 

You cannot use the following reserved characters in the list of 
Labels: commas, quotation marks, semicolons or parentheses. 

Enter labels carefully because once you have processed data, you 
cannot change your labels without reprocessing your forms. 
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Property Function 

Values Use this setting to associate a numeric value with each textual 

answer choice (Label). Values are used for calculating statistics 
for responses that are set to the textual data type. Values are 

also used when saving to the SPSS file format. Note that values 
are not used as point values when grading tests. You cannot 

assign partial credit to individual answer choices when performing 
test grading. 

Possible value 

scales 

Sets a range of pre-determined numbers as Values. Use this 

setting to quickly enter Values for each of your textual output 
Labels into the Values grid as opposed to entering each Value 

individually. 

Save Current 

Scale 

Saves a scale of user-defined labels and values as output Labels 

that you can save and use over again (e.g., Excellent, Good, Fair, 

Poor). Click the Save Current Scale button after entering your 
labels in the Labels grid to save the scale for future use.  

NA Label If your question has a “Not Applicable” (NA) answer choice and 

you do not want the NA responses to be included in the Remark 
Quick Stats statistics (e.g., means), choose the appropriate label 

from the NA Label drop-down list. This list is automatically 
populated with the labels you defined in the Labels grid. Only one 

option can be selected as NA per question. In the Remark Quick 

Stats preferences you can choose whether to include or exclude 
the NA responses. 

Define Format The Define Format feature applies to Grid OMR regions only. 

Mark this checkbox to enter a pattern for the data that is output 
during form processing. The default setting (*) indicates that the 

characters are displayed one after the other with no separators. 
The * is a placeholder for your data. You may change this pattern 

to enter items such as slashes for a date, decimal points, etc. 
Enter the appropriate character in the proper position (e.g., for a 

date: **/**/****). 

Include region 
in read 

operation 

Mark this checkbox to include data from this region when 
processing forms. If this checkbox is not marked the region exists 

in the form template, but no data is captured during form 
processing. This checkbox is on by default. 

 

To create an OMR region 

 From the Page or Region menu choose Insert and then select OMR Region After 1
Selected Region|Page or OMR Region Before Selected Region|Page.   

Tip: There are several ways to create regions: menus, toolbar, right clicking 
in the image representation/tree view or the Task Pane. These options are 
covered in greater detail in Section 6.2.4 Creating Regions. Try creating 
regions using each method and then decide which way you prefer. 

 The mouse changes to a crosshair. Use the mouse to drag a box around the marks in 2

the region in the image representation area. Only select the marks; do not capture 
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any text near the marks. Place the box around the region so that it is not right 

against the bubbles, yet is also not too far from the bubbles, as shown in the 
following example. You want to create about 1/8 inch padding around the marks. 

Example: 

 

Rate the following on a scale of 5 (Strongly Agree) to 1 (Strongly Disagree). 

    

 

 

 

 

 In the Properties - OMR Region box, enter the 3
appropriate properties for the region on the 

OMR region properties screen, as described 
on the previous page. There are additional 

advanced features that may be defined. These 
features are discussed in detail beginning with 

Section 6.3.1. 

 Click the OK button to create the region. 4

After creating an OMR region, you can see the 

region in the image representation area and a new 

node is added to the tree view. Each OMR region in 

the image representation area is green to 

differentiate the regions. When you select a region, 

it has white image handles (tiny squares) around it 

to indicate it is the active region. 

Note: If the region appears with a solid red 
fill, it has not been drawn or set up properly. 
To correct this problem, please see Section 
6.2.8. 

6.2.7 Linking OMR Regions 

Marks that are separated by text, lines or graphics cannot be selected in one region 

definition. When creating an OMR region in an area that contains items such as text or 

lines, you can only select the marks. The Append Linked Region function allows you to 

link these types of marks into one OMR region. OMR region types that can be linked 

include Multiple, Grid, List, Rank, Binary and Add. The following is an example of a 

question layout that would require a linked OMR region: 

 

 

 

Question 1     

Question 2     

Question 3     

Question 4     
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What is your gender? 

 

O     Female O     Male 

 

The marks (bubbles) are separated by the response text in between them, but are still 

logically considered one question. However, you cannot select the word “Female” within 

your OMR region. Therefore, you create a region around just the mark for Female and 

then link the mark for Male to the original region. 

Tip: When designing your form try to avoid having to use linked regions by 
laying out questions without text, lines or anything else between the OMR 
bubbles whenever possible. 

 

To use the append linked region function 

 Create an OMR region around the first region to be linked as if it were its own region 1

(in the previous example, you would select the bubble for “Female”). Enter all of the 
region details as previously described. For the region size, only enter what pertains 

to what you have defined thus far (in the previous example, the region is only one 

row by one column at this point). 

 After defining the first part of the region, select the Region menu and then click 2

Append Linked Region, or click . 

The mouse turns into a crosshair. 

 Drag a box around the second area to be defined (in the previous example, you 3
would select the OMR bubble for “Male”). 

When you release the mouse button the Properties - OMR Region window appears. 

This window contains the same settings that were defined for the first part of the region 

that you selected. You need only define the Labels and Values (if desired) section of the 

window (unless the number of bubbles in each appended region varies).  

 Make any necessary changes to the region 4

definition and then click the OK button. 

Regions that are defined with the Append Linked 

Region feature are automatically linked to the 

previous region. These regions are a green color 

in the image representation window like OMR 

regions, but also have a dashed line around 

them and a plus sign in the tree view to 

represent their linked status: . If you click 

a linked region, its square image handles are 

gray instead of white (like an unlinked OMR 

region). 

Tip: Only regions of the same OMR type, data type and orientation can be 
linked. However, the columns/rows of marks do not have to have the same 
number of answer choices in order to be linked.   
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To make changes to a region that is already linked, first separate the regions by 

breaking the link, then make the changes and relink the regions. Many properties can 

only be accessed by first separating the linked regions. 

 

To break a linked region 

 Use the tree view or image representation area to select one of the OMR boxes 1

within the linked set you want to separate. 

 Select the Region menu and then click Break Region Link, or click . 2

The regions are separated into individual OMR regions. If you need to make changes to 

the regions, edit the regions and then relink them. 

 

To relink regions 

 While holding down the Shift key, select each OMR region to be linked by either 1

clicking its node or clicking it in the image representation area.  

 After all regions are highlighted, select the Region menu and then click Link 2

Regions, or click . 

6.2.8 OMR Region Colors/Region Positioning 

Each region in the form template has a different color so that you can tell one from the 

other easily. As indicated, OMR regions are green. If you create an OMR region and it 

turns a solid red, this is an indication that Remark Office OMR cannot properly recognize 

the region as it is set up. When a solid red region is encountered, you can place your 

mouse over the region and the Template Editor provides details of the problem. Flagged 

regions are also red and italicized in the tree view, indicating that you need to make a 

correction. Reasons for this issue include the following: 

 The number of columns or rows entered in the Properties – OMR Region 

window is not correct. 

 One of the region borders is touching something else on the image. It could be 

touching a mark, text, lines or graphics that are present on your form image. 

Borders cannot be touching anything on the image. You should have adequate 

white space on your form so that you can create regions without touching 

anything on the image. (See Chapter 5 for information about good form design.) 

 You have captured something other than marks (bubbles) within your OMR 

region (e.g., text or lines). Only capture the actual marks within a given OMR 

region. If there is something such as text prohibiting you from selecting all of the 

marks for a single question, you need to use the Append Linked Region function 

(see Section 6.2.7 for further details). 

 You are using a form that does not have optical marks. In order for Remark 

Office OMR to read your form, the form must contain complete shapes, such as 

bubbles or checkboxes. You cannot process forms that use circle the number 
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style questions or those that have a line that someone marks to indicate a 

response. 

 The image used for the form template is degraded. When scanning forms, the 

quality of the resulting image is sometimes not as clear as expected. The marks 

may break up, meaning that they have tiny gaps in them. You can use the zoom 

options on the toolbar to zoom in on your image to see if your marks are 

complete. When marks are not complete, Remark Office OMR cannot properly 

recognize them. If this problem occurs, reacquire your form template image by 

scanning it at a darker brightness setting (sometimes called threshold) on your 

scanner. 

Note that you may save templates that have solid red OMR regions but you should 

correct the problem before you begin processing forms to have the software recognize 

the forms properly. 

 

To reposition or redefine a region 

 If a region is solid red in color, place your mouse over the region to see the tooltip 1
describing the problem. Then review the previously listed potential reasons for the 

red color. If you need to move the entire region, place the mouse over the region 
and drag the entire region with the left mouse button to its new position and release 

the mouse. If you need to move a portion of 

the region, drag the box where you see the 
white image handle boxes. You can drag 

right, left, up, down or diagonally to adjust 
the region‟s borders. You know you have the 

image handle selected correctly when the 
mouse turns into a double arrow. 

 If the region appears to be positioned 2
properly but still appears as solid red, double 

click inside the red box to display the Region 

Properties window. 

 Ensure that the number of columns and rows 3

specified match what has been captured in 
the region. Make corrections if necessary and then click the OK button.  

If neither of these solutions addresses the red region, you may need to reacquire a 

cleaner image of your form or adjust your form design (see Chapter 5 – Designing 

Scannable Forms). 

6.2.9 Image Regions 

Image regions are used for areas on a form that contain handwritten text (e.g., a 

person‟s name, comments, etc.). Remark Office OMR cannot read this type of 

information automatically, but does provide you with three options for capturing this 

information as an Image region.  

 Data Entry Image regions reserve space in the data grid for the manual insertion 

of text. You can type the information contained in the Image region into the data 

grid using image-assisted data entry (typing while viewing the image on-screen). 
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You can also use default fill data, such as a date, to automatically populate the 

data set during form processing. 

 Image Clip Image regions save a snapshot image of the particular region to a 

user-specified location on your computer or network. The location is displayed in 

the data grid as the forms are being scanned. After collecting the Image region 

information, you may optionally run a report in Remark Quick Stats to view the 

results (see the Remark Quick Stats User‟s Guide PDF file under 

Start|Programs|Remark Office OMR 8|Documentation for further details). 

 Qualitative response coding allows you to set up codes for the responses you 

expect to get from your returned forms. Instead of typing long responses, you 

can code them into categories or themes. When entering the data during form 

processing, you can select a pre-defined code from a drop-down list as you read 

the response on-screen. An additional benefit of qualitative response coding is 

when you analyze the data in Remark Quick Stats, you can run item analysis 

reports to see a breakdown of the codes chosen for the particular question. As an 

example of qualitative response coding, suppose you have a comments question 

on your survey form. You probably want to read those comments. However, you 

also might want to be able to quickly see how many responses were positive, 

negative or mixed. In the Remark form template, you could enter pre-defined 

codes of Positive, Negative and Mixed. When you process the filled-in forms, you 

could read each comment on-screen and then choose whether it was a positive, 

negative or mixed response. When you analyze the data, you could quickly see 

the number of responses that fell into each category. You can also allow more 

than one coded response per comment. You can even combine image clipping 

and qualitative coding so that you can see a report of the handwritten comments 

and apply codes. 

An Image region has the following basic properties: 

 

Property Function 

Region name A name assigned to an Image region. Region names 

are used as grid column headers in the data grid 
window and are exported when saving data to 

common file formats. Region names are limited to 60 

characters. 

Region type Sets the type of Image region: Image Clip, Data 

Entry, or Data Entry and Image Clip. Use Image Clip 
to have Remark Office OMR capture an image of the 

region for later viewing and output the location of the 

image in the data grid (e.g., C:\Program 
Files\Gravic\Remark Office OMR 

8\Images\image1.pcx). Use Data Entry to hand enter 
the data that is captured in a region. Use Data Entry 

and Image Clip to both hand enter information (e.g., 
apply qualitative response codes or use a default fill) 

and store clipped images of the handwritten 
information. 
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Property Function 

Data type 

(Data Entry Image 
region only) 

Sets whether the data should be considered textual 

or numeric when saved/exported. 

Default fill  

(Data Entry Image 
region only) 

Sets a default entry to be used in the Image region. 

The information typed here is automatically output to 
the data grid when forms are processed. You may 

also select one of the following items from the drop-
down list to be used as a default fill option:  

Time Stamp 

Date Stamp 

Time and Date Stamp 

Record Number 

Page Number 

Record and Page Number 

When selecting an item from this list, you can also 

insert text before or after the selected item if desired.  

Auto increment fill 
value 

(Data Entry Image 
region only) 

When used in conjunction with Default Fill, Remark 
Office OMR assigns the next value in the range you 

define to the Image region in sequential order. For 
example, you can enter the number 1 as the default 

fill and then mark the Auto increment fill value 
checkbox. Remark Office OMR automatically places 

sequential numbers in the Image region during form 
processing. When using a default fill in this fashion, 

you can create the Image region anywhere on the 

form as a placeholder. 

Attempt to detect 

the presence of 
handwriting in the 

region 

Use this setting to have Remark Office OMR attempt 

to determine whether handwriting is in the region. 
For Data Entry Image regions, when text is detected 

during form processing, the Image region‟s cell in the 

data grid is colored blue. For Image Clip Image 
regions, the clip is captured when handwriting is 

detected and is not captured when handwriting is not 
detected. If you are not using this feature, image 

clips are captured for every Image region. 

Link Region to an 
Existing OMR Region 

(Data Entry Image 
region only) 

Use this setting to link a Data Entry Image region to 
one of the responses from another OMR region on the 

page (e.g., an “other” blank from a multiple choice 
question). The Image region is colored blue in the 

data grid if the linked mark is chosen so that you 

know which regions need attention for data entry. 
This feature is especially helpful when used in 

conjunction with Review Exceptions. 

OMR region 

(Data Entry Image 

region only) 

Use this drop-down list to select the region to which 

to link the Image region when using the Link Region 

to an Existing OMR Region option. 
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Property Function 

Question 

(Data Entry Image 
region only) 

Use this drop-down list to select the individual 

question within the OMR region to which to link the 
Image region. Note that if the linked OMR region only 

contains one question, you only see this question in 
the list. 

Answer 

(Data Entry Image 
region only) 

Use this drop-down list to choose an answer response 

(Label) from the linked question. Alternatively, you 
may type an answer choice in the box. When this 

answer choice is detected during form processing, the 
linked Image region‟s cell is colored blue in the data 

grid. 

Target directory Click the ellipsis (…) to select a location in which to 

store the Image Clips.  

Name builder Click the Name Builder… button to further 
customize the stored image clip names and locations.  

In the Image Base Name area, you may choose to 
add a region from the processed data to the image 

clip base name. Choose the region from the drop-

down list and then click the Add button. For 
example, if processing conference session 

evaluations, you could add a session name that is 
being collected from the form so that your processed 

image clips all have the session name them. 

In the Image Target Directory area, you may 

choose to add a region from the processed data to 
the folder structure that holds the processed image 

clips. Choose the region from the drop-down list and 

then click the Add button. For example, if processing 
conference session evaluations, you could add a 

session name that is being collected from the form so 
that each image clip is stored in a folder containing 

the conference session number. 

In the Name Builder box, click the OK button to 

return to the Image Properties. 

Begin names with 
(Image Clip Image 

region only) 

Use this box to enter a beginning (base) name to use 
when storing Image Clips. This name has numbers 

appended to it to allow for the greatest number of 
images to be stored. For example, if you are storing 

Image Clips of a comment question on a survey, you 
may wish to begin the clips with the name 

“Comments.” 

Include region in 

read operation 

Mark this checkbox to include data from this region 

when processing forms. If this checkbox is not 
marked the region exists in the form template, but no 

data is captured during form processing. 
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To create an Image region 

 From the Page or Region menu choose Insert and then select Image Region 1
After Selected Region|Page or Image Region Before Selected Region|Page.   

Tip: There are several ways to create regions: menus, toolbar, right clicking 
in the image representation/tree or the Task Pane. These options are 
covered in greater detail in Section 6.2.4 Creating Regions. Try creating 
regions using each method and then decide which way you prefer. 

 Use the mouse to drag a box around the image region in the image representation 2

area. Capture the entire area in which you expect respondents to write. 

 

Comments: 

 

 

 

 In the Properties - Image Region box, 3
enter the appropriate properties for the 

region on the Image region properties 
screen, as described on the previous page. 

There are additional more advanced features 

that may be defined. These features are 
discussed in detail beginning with Section 

6.3.1. 

 [Optional] If you would like to enter response 4

codes for qualitative analysis, click the 
Question text, names, and response 

codes link in the Task Pane on the left side of 
the Properties window.  

 [Optional] Enter the desired codes you wish to 5

use for qualitative analysis in the Codes 
column. Assign a numeric value to each code 

for statistical analysis in the Values column 
(e.g., for calculating means). Note that you 

may also use pre-defined codes in the 
Available scales drop-down list to quickly fill 

the Codes and Values columns.  

 [Optional] If you wish to allow multiple 6

response codes to be applied to each question, 

click the Region item properties link in the Task Pane. Under Multiple Exception 
Handling, select the number of multiple responses allowed (choose Allow all for no 

limit). 

 [Optional] If you want to be able to tabulate the question with the qualitative codes, 7

while on the Region item properties screen, mark the radio button for Tabulate 
this item. Image regions are not set to tabulate by default. 

 Click the OK button. 8

After creating an Image region, a new node is added to the tree view. Image regions are 

blue in the image representation area. 
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6.2.10 Barcode Regions 

Barcodes are a reliable way to capture information from a form while using a small 

amount of space. Barcodes can be placed directly on a form or on a sticker that is placed 

on a form. The barcode must be located in the same position on each form. You can 

create barcodes using special barcode generation software or by using a barcode font in 

a word processing program. Barcodes can be placed horizontally or vertically on the 

form. The barcode should be at least 26 points in terms of size (about ¼ inch high). A 

single barcode can contain one or more pieces of data. If using multiple pieces of data 

within one barcode, you must separate the data with a delimiter (e.g., comma, space, 

tab, etc.). When separating the data, make sure you choose a delimiter that is 

supported by your specific barcode type. 

Remark Office OMR recognizes several barcode types:  

 Code 3 of 9 (Code 39): Alphanumeric 

 Interleaved 2 of 5: Numeric  

 Codabar: Numeric  

 PDF 417: 2D, Alphanumeric 

 Data Matrix: 2D, Alphanumeric 

 QR Code: 2D, Alphanumeric 

 Code 11: Numeric 

 Code 128: Alphanumeric 

 Code 93: Alphanumeric 

 EAN 13: Numeric 

 EAN 8: Numeric 

 UPCA: Numeric 

 UPCE: Numeric 

Barcode regions have the following properties: 

 

Property Function 

Region name A name assigned to a Barcode region. Region names are used as 
grid column headers in the data grid window and are exported 

when saving data to common file formats. Region names are 
limited to 60 characters. 

Barcode type Use this setting to select the type of barcode to be recognized 

(types are listed earlier in this section). You may use the Auto 
Detect setting to have Remark Office OMR automatically determine 

what type of barcode is in the region. However, if you know the 
barcode type that you are using, we recommend that you choose it 

from the list. 

Barcode 
orientation 

Use this setting to select the orientation of the barcode:  horizontal 
(left to right) or vertical (top to bottom). 
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Property Function 

Data type 

 

Sets whether the data should be considered textual or numeric 

when saved/exported. 

Barcode 
Contains 

Multiple Items 

Barcodes can contain multiple pieces of data. When outputting 
more than one piece of data, the barcode must include a delimiter 

to separate the pieces of data. You can choose the delimiter that 
separates the pieces of data in the barcode using the box marked 

Item delimiter. Your choices are comma, tab, space, tilde (~), 
carriage return, line feed, carriage return/line feed. Make sure you 

set up the barcode with a delimiter that is supported by your 

specific barcode type. In the Number of items box, enter the 
number of pieces of data contained in the barcode. You may use 

the up/down arrows or type a number in this box. Delimited 
barcodes display in the tree view with an expandable plus (+) 

sign. You can expand the barcode node to see the separate pieces 
of data within that barcode. Opening the properties for one of the 

expanded nodes provides access to certain advanced features only 
for that piece of data (see Section 6.3 for full explanations of these 

features). 

Include region 
in read 

operation 

Mark this checkbox to include data from this region when 
processing forms. If this checkbox is not marked the region exists 

in the form template, but no data is captured during form 
processing. This checkbox is on by default. 

 

To create a barcode region 

 From the Page or Region menu choose Insert and then select Barcode Region 1

After Selected Region|Page or Barcode Region Before Selected Region|Page.   

Tip: There are several ways to create regions: menus, toolbar, right clicking 
in the image representation/tree or the Task Pane. These options are 
covered in greater detail in Section 6.3.3 Creating Regions. Try creating 
regions using each method and then decide which way you prefer. 

 In the image representation area, use the mouse to drag a box around the barcode 2

or the location where the barcode will be on the forms (e.g. if using stickers after the 
forms are returned, place the Barcode region in the area where the stickers will be 

affixed). Barcodes may vary in length 
depending on the data that you are capturing. 

Be sure to make the Barcode region large 

enough to capture the longest barcode you 
plan to recognize. 

 In the Properties - Barcode Region box, 3
enter the appropriate properties for the region 

on the Barcode region properties screen, as 
described previously. There are additional 

more advanced features that may be defined. 
These features are discussed in detail 

beginning with Section 6.3.1. 

 Click the OK button. 4
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After creating a Barcode region, you see the region in the image representation area and 

a new node is added to the tree view. Each Barcode region is orange to differentiate the 

regions. 

6.2.11 OCR (Optical Character Recognition) Regions 

OCR (Optical Character Recognition) regions are used to recognize machine printed text. 

Note: OCR does not include handwriting recognition (commonly called ICR 
or Intelligent Character Recognition). In order to use the OCR feature, the 
text must be machine or computer generated. 

You can pre-print information on your form and have the software recognize it. Please 

note that some fonts work better than others when it comes to recognizing text. Please 

see Section 5.4 for further details about fonts to use for optimal results. 

 

Property Function 

Region name A name assigned to an OCR region. Region names are used as 

grid column headers in the data grid window and are exported 

when saving data to common file formats. Region names are 
limited to 60 characters. 

OCR type Use this setting to select the type of OCR to use. Remark Office 
OMR includes two types: Standard and Microsoft Office Document 

Imaging (MODI). You only see the MODI option if you have 
Microsoft Office 2007 with the MODI option installed on the 

computer running Remark Office OMR. 

Language Use this setting to choose the language for the characters in the 

region. 
Standard OCR: English, French, Dutch, UK English 

MODI OCR: System Default, Chinese Simplified, Chinese 
Standard, Czech, Danish, Dutch, English, Finnish, French, 

German, Greek, Hungarian, Italian, Japanese, Korean, Norwegian, 
Polish, Portuguese, Russian, Spanish, Swedish, Turkish. 

Text 

orientation 

Use this setting to select orientation of the text:  Left to right, 

Right to left, Top to bottom, Bottom to top. (Applies to Standard 
OCR only.) 

Data type 

 

Sets whether the data should be considered textual or numeric 

when saved/exported. 

Define format Mark this checkbox to establish a pattern of characters to be 

recognized. Use the following syntax for your format: 

# = number 

A = letter 
X = any character 

? = optional character (for trailing purposes only) 

Other = character must match what you type exactly. 
For example, if you are reading a date field, type in 

##/##/#### and if you are reading an abbreviated US State 
field, type in AA. (Applies to Standard OCR only.) 
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Property Function 

Region 

contains more 
than one word 

Mark this checkbox if the OCR region contains more than one 

word. 

Region 
contains 

multiple lines 

of text 

Mark this checkbox if the OCR region extends past one line of 
text. (Applies to Standard OCR only.) 

Invert region 

image 

Mark this checkbox to invert the colors on the text and 

background of the OCR region during recognition. This feature can 
be used if the text on your form is white and the background is 

black and you want to invert them in order to read the text. 

Deskew region 

image 

Mark this checkbox to deskew the OCR region during recognition 

to assist in reading the text. 

Despeckle 

Image Region 

Mark this checkbox to despeckle the OCR region during 

recognition to assist with reading the text. Despeckling can help 
with thick, dark letters. Use the Maximum speckle size setting to 

adjust how much to despeckle. It is recommended that you start 
with a small number to see how the image looks. (Applies to 

Standard OCR only.) 

Auto rotate 
region image 

Mark this checkbox to automatically rotate the OCR region during 
recognition if the software is having difficulty reading the text. 

(Applies to MODI OCR only.) 

Limit OCR 
Character Set 

Mark this setting to choose the types of characters that are 
permitted: Numbers, Lower case text, Upper case text, Symbols 

or Custom character set. Limiting the character set can improve 
accuracy. If you do not wish to limit the character set, do not 

mark this option. (Applies to Standard OCR only.) 

Include region 
in read 

operation 

Mark this checkbox to include data from this region when 
processing forms. If this checkbox is not marked the region exists 

in the form template, but no data is captured during form 
processing. This option is on by default. 

 

To create an OCR region 

 From the Page or Region menu choose Insert and then select OCR Region After 1

Selected Region|Page or OCR Region Before Selected Region|Page.   

Tip: There are several ways to create regions: menus, toolbar, right clicking 
in the image representation/tree or the Task Pane. These options are 
covered in greater detail in Section 6.3.3 Creating Regions. Try creating 
regions using each method and then decide which way you prefer. 

 In the image representation area, use the mouse to drag a box around the text or 2
the location where the text will be on the forms. The text may vary in length 

depending on the data that you are capturing. Be sure to make the OCR region large 
enough to capture the longest text you plan to recognize. 
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 In the Properties - OCR Region box, enter 3

the appropriate properties for the region on 
the OCR region properties screen, as 

described previously. There are additional 
more advanced features that may be defined. 

These features are discussed in detail 
beginning with Section 6.3.1. 

 Click the OK button. 4

After creating an OCR region, you see the region 

in the image representation area and a new node 

is added to the tree view. Each OCR region is purple to differentiate the regions. 

6.3 Advanced Region Options 

Each region type (OMR, OCR, Image and Barcode) has a set of more advanced 

properties associated with it that are optional. When creating fields, you see only those 

options appropriate for the type of region you are creating. Use the navigation bar in the 

left section of the region properties window to access the additional features. 

Each advanced option is explained in detail in the following sections. 

6.3.1 Region Item Properties 

The Region item properties section of the Region Properties window allows you to 

define test and survey analysis options, recognition thresholds and exception handling. 

Each item is described below. 

6.3.1.a Test Settings 

Remark Office OMR provides useful test grading features that you can customize. You 

decide which regions to grade and set the test points to be used for grading. 

The following table lists the region types and their default grade settings: 

 

Region 
Type 

Grade Status Test Type 
(Objective or 

Subjective) 

Test Points 

OMR  Multiple, Rank, Boolean 
and List: Graded  

 

Grid, Add and Binary: 
Not Graded  

Objective 

 

 

N/A 

Correct: 1 

Incorrect: 0 

No Response: 0 

Image Not Graded  N/A N/A 

Barcode Not Graded  N/A N/A 

OCR Not Graded N/A N/A 
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Questions can be designated as Objective or Subjective questions. An objective question 

is one where respondents choose one or more pre-defined answers on a form by 

darkening in a mark (e.g., bubble). These questions are typically multiple choice or 

true/false questions. A subjective question is one that is open ended and must be 

graded by a human, such as an essay or short answer question. Remark Office OMR 

cannot automatically read this type of question; however, you can include points from a 

subjective question when grading. First, place a region on the form where the instructor 

can enter the appropriate amount of points earned on the subjective portion of the test. 

This is typically an OMR region where the instructor bubbles in the points earned. Then 

designate the region as a subjective item in the form template. This region must be set 

to the numeric data type in order to use the region as a subjective region. When setting 

up your answer key, enter the maximum number of subjective points that can be earned 

(see the Remark Quick Stats User‟s Guide PDF file under Start|Programs|Remark Office 

OMR 8|Documentation for further details about setting up answer keys). When grading, 

Remark Office OMR displays the overall, objective and subjective scores. 

Extra credit is available in the Region item properties using the All points awarded 

should be treated as extra credit checkbox. This feature allows you to use Easy 

Grade to grade the tests and still designate a question as extra credit. When this 

checkbox is selected, any points awarded for the question are added to the total score 

(therefore it may be possible to score greater than 100%). 

Using the Test Settings section sets the options on an individual region basis. You can 

change the default setting for whether to grade each region type globally in the program 

Preferences under the Tools menu. 

 

To set grade options 

 Create a region as defined in Section 6.2.4. 1

 From the Properties window, click the Region item properties link in the left Task 2
Pane. 

 In the Test Settings section, mark the radio button for Grade this item.  3

Note: If grading tests and using multiple answer keys, there is a third 
option for Designate as key identifier. Use this option when creating a 
region that contains the test answer key version information. For example, if 
you distribute three versions of the test – A, B, C- you can use the 
Designate as key identifier property on the region that contains the 
particular test‟s test version (A, B or C). Remark Quick Stats can then use 
the region to sort the tests into their 
respective groups so that they are properly 
graded. 

 In the Test Point System section, select the 4

type of question: Objective item or 
Subjective item.  

 If using an Objective item, enter the values 5

for Correct points, Incorrect points and 
No Response points that are appropriate for 

the region. You may use a negative number 
to subtract points for incorrect or unanswered 
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questions if desired. You may also use decimal places. 

Note: A single question can have multiple correct responses, which you can 
designate when scanning the answer key or using the Grade Wizard. 
However, you cannot utilize partial credit on a per response basis (e.g., a=1 
point, b=2 points, c=3 points, etc.). 

 If desired, mark the All points awarded should be treated as extra credit 6

checkbox to mark the question as extra credit. (Note: you can also mark regions as 
extra credit in the Grade Wizard when grading.) 

 Click the OK button to save the changes and return to the tree view. 7

6.3.1.b Survey Settings 

Remark Office OMR provides useful survey tabulation features that you can customize. 

You decide which regions to tabulate.  

The following table lists the region types and their default survey settings: 

 

Region Type Survey Status 

OMR  Multiple, Rank, Boolean and List: Tabulated  

Grid, Add and Binary: Not Tabulated  

Image Not Tabulated  

Barcode Not Tabulated  

OCR Not Tabulated 

 

 

To set survey options 

 Create a region as defined in Section 6.2.4. 1

 From the Properties window, click the Region 2

item properties link in the left Task Pane. 

 In the Survey Settings section, mark the radio 3

button for Tabulate this item. 

 Click the OK button to save the changes and 4

return to the tree view. 

6.3.1.c Special Note for Image Regions 

By default, Image Regions are not set to grade or 

tabulate. However, if you are using the Qualitative 

Response Codes feature, you want to turn on the 

option to grade or tabulate the region. If using the 

Image Clip and Data Entry region type, you see two 

nodes in the tree view. Click the plus sign (+) to 

expand the nodes. You can select the node 

individually where you want to tabulate or grade 
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and then turn on the appropriate option under Region item properties. 

6.3.1.d Analysis Respondent ID 

You may also set a particular region as an Analysis Respondent ID region so that it can 

be used as an identifier on reports. This feature is useful when you are capturing items 

such as ID numbers or names. When set as an Analysis Respondent ID region, the 

resulting reports show the information captured in the region alongside of the results. 

For example, if you administer a test where the students enter their ID number, the 

grade report shows the ID number and then that student‟s grade. When exporting data 

to some gradebook packages, you may also be required to set an Analysis Respondent 

ID.  

Note: Analysis Respondent IDs are included as identifiers in the analysis, 
but they are not tabulated or graded. In order to set a region as an Analysis 
Respondent ID, make sure it is set to Do not grade this item and Do not 
tabulate this item.  

 

To set an Analysis Respondent ID 

 Create a region as defined in Section 6.2.4.  1

 From the Properties window, click the Region 2

item properties link in the left Task Pane.  

 In the Analysis Respondent ID section, mark 3
the checkbox for Designate as a respondent 

ID. 

 Click the OK button to save the changes and 4

return to the tree view. 

6.3.1.e Recognition Threshold 

The Recognition Threshold setting allows you to compensate for degraded images and 

poorly marked forms, assists with the recognition of text in OCR regions and assists with 

the recognition of handwriting in Image regions. Use the Recognition Threshold setting 

to increase or decrease standards for mark and text recognition.  

You can set the Recognition Threshold on a region-by-region basis. For OMR and Image 

regions, the Recognition Threshold setting ranges from 1 to 6, with 3 being the default 

setting. It is recommended that you use the default values unless you encounter 

problems. Use a lower Recognition Threshold to compensate for errors when reading 

light pages, degraded images or pages where the respondent has not filled the marks 

completely. Use a higher Recognition Threshold to compensate for errors when reading 

dark pages or pages with many erasures. 

Note: The Recognition Threshold can only be set on a region basis. If you 
have a region containing multiple OMR questions, the Recognition Threshold 
setting applies to all questions in the region. 

For OCR regions, the Recognition Threshold setting ranges from 1-100% (default setting 

is 70%). The threshold applies to each individual character. The software returns a 

confidence value for each character recognized (e.g., 62% certain it is a “G”). If any 
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character returns a confidence value lower than the specified threshold, the OCR field is 

flagged as an exception for your review. 

Recognition Threshold settings can also be adjusted on a global scale. Please see section 

7.14.a for more information. 

 

To set the Recognition Threshold 

 Create a region as defined in Section 6.2.4.  1

 From the Properties window, click the 2
Region item properties link in the left Task 

Pane. 

 In the Recognition Threshold (applies to 3
region) section, set the Threshold value to 

the desired number. For OMR and Image 
regions, choose a higher value to have the 

software be less sensitive and choose a lower 
value to have the software be more sensitive 

when processing forms.  

Tip: Use caution when setting extreme 
OMR Recognition Threshold values. Decreasing to 1 causes the software to 
be quite sensitive and it may pick up unintended marks, such as erasures 
and stray marks. Increasing to 6 may cause the software to be quite 
discriminate and it may choose the most filled mark for you when two marks 
are selected (and are not permitted). 

For OCR regions, choose a higher value to have the software be more stringent and flag 

when uncertain, and choose a lower value to make the software less likely to flag the 

region even if it is unsure. 

 Click the OK button to save the changes and return to the tree view. 4

Tip: If you are having trouble recognizing an entire form, you can override 
the form template Recognition Threshold settings for all regions by going to 
Tools|Recognition Settings in the Data Center. 

6.3.1.f Blank, Multiple and Duplicate Exception Handling 

You can specify how Remark Office OMR should handle blank, multiple and duplicate 

responses in OMR regions when processing forms and exporting data. The default 

settings are: 

 Blank responses: The word BLANK is inserted for items that are not answered. 

 Multiple responses: All responses are shown but flagged with green when more 

than one response is chosen and not permitted.  

 Duplicate responses: The word DUP is inserted for Rank questions when more 

than one response is chosen.  

Color coding is also applied to the data grid, making the exceptions easier to locate: 

yellow for blanks, green for mults and peach for duplicates. Also by default, only one 

answer response is allowed. You can replace these values on a region-by-region basis. 

You may choose one of the default options listed or type in a custom value. 
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Note: In previous versions of Remark Office OMR, the word MULT was 
output when multiple responses were found and not permitted. If you were 
using a previous version of Remark Office OMR, any form templates that you 
convert still have the previous default replacement of MULT. If you would 
like to change old form templates to use the new ALL functionality, open the 
form template in the Template Editor and change the Replace with setting 
under Region item properties. Note that any new form templates you 
create use the ALL option by default. 

  

To set blank response settings 

 Create a region as defined in Section 6.2.4. 1

 From the Properties window, click the Region item properties link in the left Task 2

Pane. 

 In the Blank Exception Handling section, choose a value from the Replace with 3
drop-down list or enter a unique replacement of your own. Pre-set choices include 

BLANK, Asterisk (*), Nothing, Space Character, Tilde (~), and VOID. 

 You may optionally use the Flag Blanks setting to further refine how blank 4

responses are handled. Using this setting 
allows you to further customize how Remark 

Office OMR interprets blank responses. Grid 
regions are often used to capture data that 

vary in length, which can lead to unintended 

blank responses. For example, you may have 
respondents fill in bubbles corresponding to 

their name and allow for ten characters. If a 
name only contains five characters, the region 

may come up as blank simply because the 
respondent did not utilize all ten characters. 

Or you may have questions that are often left 
blank due to the nature of the question (e.g., it will not apply to many respondents). 

In such a case, you can replace blank characters with Nothing and use the Flag 

Blanks parameters to further define the output. The options are as follows: 

 

Option Description 

Always If any character in the region is left blank, or the entire 

question is left blank, regardless of the replacement characters 
being used, the region is considered blank. Replacement 

characters, if used, are still utilized, but the region contains the 
yellow BLANK exception color. 

Ignore 

leading/trailing 

If a leading or trailing character in the region is left blank, it is 

ignored. This allows you to capture data smaller than the 
allotted region without it being considered blank. You will see 

whatever data is captured and the region will not contain a 
yellow BLANK exception color. This setting applies to Grid 

regions only. 
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Option Description 

Never  If any character within the region is blank, or the entire 

question is left blank, Remark Office OMR ignores it. The region 
never appears with a yellow BLANK exception color in the data 

grid. 

 

 Click the OK button to save the changes and return to the tree view. 5

 

To set multiple response settings 

 Create a region as defined in Section 6.2.4. 1

 From the Properties window, click the Region item properties link in the left Task 2

Pane. 

 In the Multiple Exception Handling section, select the number of responses 3
allowed in the Multiple responses drop-

down list. Select Not Allowed to only allow a 
single response. Select Allow All to allow an 

unlimited number of responses. Alternatively, 
select a specific number from the list to only 

allow that number of responses. (If the 
respondent chooses more than you allow, 

their responses are colored green as an 

exception (ALL setting) or replaced by the 
value you designate in the Replace with box.) 

The final option is Select most filled. 
Selecting this option forces Remark Office 

OMR to select the mark it thinks is the most filled when more than one mark is 
detected. 

Tip: Use extreme caution when using the Select most filled option. Using 
this option means that Remark Office OMR never returns a MULT for you to 
review. The software always chooses what it thinks is the most filled mark. 

 In the Replace with box, choose a value from the drop-down list or enter a unique 4
replacement of your own. Pre-set choices include ALL, MULT, Asterisk (*), 

Nothing, Space Character, and Tilde (~). If you choose the ALL option (this is 

the default setting), all chosen responses are displayed in the data grid, but it is still 
flagged green for review. Having all the responses expedites the cleanup process and 

allows you to easily change your mind about allowing multiple responses after 
processing forms. 

Note: If you were using a previous version of Remark Office OMR, any form 
templates that you convert still have the previous default replacement of 
MULT. If you would like to change old form templates to use the new ALL 
functionality, open the form template in the Template Editor and change the 
Replace with setting under Region item properties. Note that any new 
form templates you create use the ALL option by default. 

 Click the OK button to save the changes and return to the tree view. 5
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To set duplicate response settings 

The word DUP is inserted for Rank questions when more than one response is chosen. 

You may choose to customize the output for duplicate rankings. 

 

 Create a region as defined in Section 6.2.4. Set it to the Rank OMR type. Ranking 1

questions only allow one response per 

answer item. 

 From the Properties window, click the 2

Region item properties link in the left 
Task Pane. 

 In the Duplicate Response Handling 3
section, choose a value from the Replace 

with drop-down list or enter a unique 
replacement of your own. Pre-set choices 

include DUP, Asterisk (*), Nothing, 

Space Character, and Tilde (~). 

 Click the OK button to save the changes 4

and return to the tree view. 

6.3.1.g Mark Discrimination 

Remark Office OMR allows you to disable mark discrimination on an OMR region. Mark 

discrimination sets the value that determines the difference between two (or more) 

marks that are filled/partially filled. This allows the Remark software to determine which 

mark is actually filled. If you turn off mark discrimination, Remark Office OMR does not 

try to determine which mark is more filled when more than one mark is filled (whether 

or not they are allowed). The result is a multiple exception in the data grid that you can 

review and correct if multiple responses are not found. If multiple responses are 

allowed, all marks considered filled are reported. Disabling mark discrimination is 

considered an advanced option and not recommended for most applications. 

 

To set disable mark discrimination 

 Create a region as defined in Section 6.2.4. 1

 From the Properties window, click the 2

Region item properties link in the left Task 
Pane. 

 Mark the checkbox for Disable mark 3
discrimination. 

 Click the OK button to save the changes and 4
return to the tree view. 

6.3.1.h Required Items 

Remark Office OMR allows you to make items required to be filled during processing. 

This feature is used in conjunction with Review Exceptions (see Section 7.6). If an item 

is marked as required in the form template and you are using the Review Exceptions 
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feature, Remark Office OMR flags any items that are left blank. If you are using Review 

Exceptions during form processing, the processing stops so that you may review the 

unrecognized item. If you are using Review Exceptions after form processing, Remark 

Office OMR includes the unrecognized item during the review operation. 

 

To set an item as required 

 Create a region as defined in Section 6.2.4. 1

 From the Properties window, click the Region 2
item properties link in the left Task Pane.  

 Mark the checkbox for Required item. 3

 Click the OK button to save the changes and 4
return to the tree view. 

6.3.2 Question Text and Names 

The Question text and names section of the Question Properties window allows you to 

enter custom question text and question names. Question text is displayed on reports 

and exported to certain formats, such as SPSS. Question names are used as column 

headers in the template grid and are exported along with your data. Question names are 

limited to 60 characters. 

Important Note: The Question text and names section differs slightly 
when adding fields as opposed to editing them. This section covers adding 
fields. When editing fields, Question text and names becomes Question 
text, names and responses; this screen is covered in Section 6.6 Editing 
an Existing Form Template. 

6.3.2.a Question Text 

Question text may optionally be added to make reports more meaningful. When 

question text is present, it is used on the reports to identify the question. If no question 

text is entered, the region names are used on the reports.  

You may manually type question text into the question text grid or paste text from the 

Windows clipboard by using the keyboard shortcuts (Ctrl + V) or by double clicking a 

cell, then right clicking and choosing Paste from the menu. In order to paste 

information, you must first copy it from another location (e.g., a Word document). You 

may select multiple rows in the grid to paste multiple lines of question text. 

 

To set question text for a new region 

 Create a region as defined in Section 6.2.4.  1

 From the Properties window, click the 2

Question text and names link in the left 

Task Pane. 

 Click in the first grid cell under Question 3

Text.  
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 Type the desired question text in the first grid cell. Alternatively, double click in a 4

cell, then right click and select Paste from the menu or press Ctrl + V on the 
keyboard to paste the contents of your Windows clipboard into the cell. 

 Press the Enter key on the keyboard or click in the next cell going down to continue 5
adding question text (only applies to regions with more than one question). 

 Once you have entered all of the desired question text, click the OK button to save 6
the changes and return to the tree view. 

6.3.2.b Question Names 

When defining an OMR region with multiple questions in the same region, you can 

specify individual question names for each question in the region. By using individual 

question names, it is easier to save data to existing databases and other file types that 

may already be set up with specific fields.  

By default, Remark Office OMR uses sequential region names for each question in the 

same region. Sequential region names consist of adding numbers sequentially onto the 

region name you provide in the Properties - OMR Region window. For example, if you 

enter a region name of Question, Remark Office OMR calls the individual question names 

within the region Question1, Question2, Question3, etc. 

In contrast, if you use the Question Names section of the Question text and names 

window to enter individual question names, you are able to customize the question 

name for each question within the region. Question names are limited to 60 characters 

each. 

Tip: The following characters are not allowed in region/question names due 
to the problems they could cause when exporting data to certain formats: 
. - Period 
! - Exclamation 
' - Singe quote 
[ - Left bracket 
] - Right bracket 
, - Comma 
" - Double quote    
( - Left paren 
) - Right paren 

  

To insert individual question names 

 Create a region as defined in Section 6.2.4. 1

 From the Properties window, click the 2
Question text and names link in the left 

Task Pane. 

 Click in the first grid cell under Question 3

Names. 

 Type the desired question name in the first 4
grid cell. Alternatively, double click in a cell, 

then right click and select Paste from the 
menu or press Ctrl + V on the keyboard to 
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paste the contents of your Windows clipboard into the cell. 

 Press the Enter key on the keyboard or click in the next cell going down to continue 5
adding question names (only applies to regions with more than one question). 

 Once you have entered all of the desired question names, click the OK button to 6
save the changes and return to the tree view. 

6.3.3 Tracking 

Remark Office OMR offers three types of tracking to assist with the automation of forms 

processing: 

 Auto Form ID: Provides automatic identification of a form when processing 

multiple form types at the same time. 

 Auto Page ID: Provides automatic identification of pages within a form template. 

 Respondent Tracker: Provides automatic identification of respondent data. 

With Auto Form ID, Remark Office OMR can 

automatically recognize a form and match it to its 

template, allowing you to process various form types 

at once without pre-sorting the forms. With Auto 

Page ID, Remark Office OMR takes it a step further 

and identifies specific page order within a form 

template if the pages are processed out of order. 

With Respondent Tracker, Remark Office OMR 

recognizes a specific respondent‟s page and place it 

in the correct grid row with the rest of that 

respondent‟s data even if the pages are processed 

out of order. When you design your paper form, you 

add the tracking identification to each form (e.g., 

bubbles or barcodes indicating form or page 

numbers). These features can be used with OMR, OCR or Barcode regions. (If using OMR 

bubbles, do not pre-fill the bubbles on the form being used to set up the form template; 

they should be blank like the rest of the form used to create the form template.) When 

combined, the three types of tracking allow you to process forms without pre-sorting 

and Remark Office OMR is able to match each page to the correct form (template), page 

number and respondent within the appropriate template grid. 

Tip: You can use delimited barcodes as identifiers. Delimited barcodes 
contain multiple items within a single barcode. When set up in the Template 
Editor, you can tell the software which part of the barcode to use as the 
Form, Page or Respondent Identifier. 

6.3.3.a Setting up an Auto Form ID Region 

You must have a form identifier on each page of your form to use the Auto Form ID 

feature. When you create a paper form, place optical marks (e.g., bubbles), computer 

generated text (OCR) or barcodes on it that identify the form. If you already have an 

existing form you wish to process, add the bubbles, text or barcodes to the form so that 

they identify the form. These markings must be the same on each page of the same 

form. However, they should be unique from any other types of identifiers you are using, 
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such as Page IDs or Respondent IDs on this form or other forms. An example could be 

the words “Form A” in barcode format. Alternatively, you could place bubbles on the 

form and mark them as A, B, C, etc. (depending on how many forms you want to 

automatically recognize) to identify each particular form. 

Note: If using barcodes as identifiers and the barcodes contain multiple 
pieces of data within a single barcode (called Barcode Contains Multiple 
Items in the Barcode Properties window), you can set up tracking after 
creating the barcode region. Set up the barcode as usual. You then see it 
listed in the tree view with a plus sign (+). Click the plus sign to expand the 
barcode, showing its separate pieces of output. Then select the individual 
item from the tree view to which you want to apply the tracking. 

 

To set up an Auto Form ID region 

 Create a region as defined in Section 6.2.4. 1

 From the Properties window, click the Tracking link in the left Task Pane. 2

 Mark the checkbox for Use Region as 3

Unique Identifier.  

 Select the radio button for Form ID (region‟s 4

value identifies this form during the read 
operation – Auto Form ID). 

 If using an OMR region, type in the ID 5
value. Note that the ID value for an OMR 

region must be one of the labels you defined 

for the region. If using a barcode or OCR, 
click the Recognize button to have Remark 

Office OMR automatically recognize the 
region‟s value. This value acts as the 

identifier for this particular form. All forms that you wish to process with this form 
template (using Auto Form ID) must have this value present. 

 If desired, mark the checkbox for Insert ID data into the grid during the read 6
process. Viewing the ID data captured along with the rest of the data can be useful 

for verification of processed data. 

 Click the OK button to save the changes and return to the tree view. 7

When you are ready to process forms, open any form templates containing Auto Form 

ID regions in the Remark Office OMR Data Center. In the Read Wizard, turn on the Auto 

Form ID feature. Remark Office OMR begins processing the forms, searching for the 

Auto Form ID regions first. When it matches a region on the form to the region in the 

form template, it automatically places that data in the corresponding data grid. Any 

regions that are not recognized are flagged for your review or placed in the 

Unrecognized Images queue. See Section 7.9 for further details about processing forms 

using Auto Form ID regions. 

6.3.3.b Setting up a Page ID Region 

You must have a page identifier on each page of your form to use the Auto Page ID 

feature. When you create a paper form, place optical marks (e.g., bubbles), computer 

generated text (OCR) or barcodes on the form pages that identify each individual page. 
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If you already have an existing form you wish to process, add the bubbles, text or 

barcodes to the form to identify the individual form pages. These markings must be 

unique for each page on the form. They should also be unique from any other types of 

identifiers you are using, such as Form IDs or Respondent Tracking identifiers. An 

example could be the words “Page 1” in barcode format. Alternatively, you could place 

bubbles on the form and mark them as 1, 2, 3, etc. (depending on how many pages you 

have in a particular form) to identify each particular page. 

Note: If using barcodes as identifiers and the barcodes contain multiple 
pieces of data within a single barcode (called Barcode Contains Multiple 
Items in the Barcode Properties window), you can set up tracking after 
creating the barcode region. Set up the barcode as usual. You then see it 
listed in the tree view with a plus sign (+). Click the plus sign to expand the 
barcode, showing its separate pieces of output. Then select the individual 
item from the tree view to which you want to apply the tracking. 

 

To set up a Page ID region 

 Create a region as defined in Section 6.2.4. 1

 From the Properties window, click the Tracking link in the left Task Pane. 2

 Mark the checkbox for Use Region as Unique Identifier. 3

 Select the radio button for Page ID (region‟s value identifies the specific page during 4

the read operation). 

 If using an OMR region, type in the ID 5
value. Note that the ID value for an OMR 

region must be one of the labels you defined 
for the region. If using a barcode or OCR, 

click the Recognize button to have Remark 
Office OMR automatically recognize the 

region‟s value. This value acts as the 
identifier for this particular page. All form 

pages that correspond to this form template 

page must have this value present in order 
for the software to automatically recognize 

the page. Each page within a single form 
template must have a different page value. 

 If desired, mark the checkbox for Insert ID data into the grid during the read 6
process. Viewing the ID data captured along with the rest of the data can be useful 

for verification of processed data. 

 Click the OK button to save the changes and return to the tree view. 7

When you are ready to process forms, open the form template containing Page ID 

regions in the Remark Office OMR Data Center. Use the Read Wizard to process your 

forms. Remark Office OMR begins processing the forms, searching for the Page ID 

regions first. When it matches a region on the form to the region in the form template, it 

automatically places that data in the correct page order. Any regions that are not 

recognized are flagged for your review or placed in the Unrecognized Images queue. 

Note that if you are not using the Respondent Tracker feature, you must process all of 

the pages belonging to one respondent‟s form before beginning those of a different 
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respondent. See Section 7.9 for further details about processing forms using Auto Page 

ID regions. 

Tip: Page IDs can be used alone if you only want to recognize various pages 
within the same form. If you want to be able to recognize various pages 
within different forms at the same time, you need to use Form IDs as well. 

6.3.3.c Setting up a Respondent Tracker Region 

Respondent Tracker regions can be setup to identify each respondent‟s form. To use 

Respondent Tracker, you must also have a page identifier on each page of your form 

(see previous section). When you create a paper form, place optical marks (e.g., 

bubbles), computer generate text or barcodes on every form page to identify the 

individual respondents. For example, if the respondent fills in an identifier such as name 

or ID number on each page, or you have such information captured in a barcode, these 

regions could be used as Respondent Trackers. These markings must be unique from 

any other types of identifiers you are using, such as Form IDs or Page IDs. Each 

respondent identifier must also be unique among all respondents. However, the 

Respondent Tracker output must be the same for each page within a particular 

respondent's form. 

Note: If using barcodes as identifiers and the barcodes contain multiple 
pieces of data within a single barcode (called Barcode Contains Multiple 
Items in the Barcode Properties window), you can set up tracking after 
creating the barcode region. Set up the barcode as usual. You then see it 
listed in the tree view with a plus sign (+). Click the plus sign to expand the 
barcode, showing its separate pieces of output. Then select the individual 
item from the tree view to which you want to apply the tracking. 

 

To set up a Respondent Tracker region 

 Create a region as defined in Section 6.2.4. 1

 From the Properties window, click the Tracking link in the left Task Pane. 2

 Mark the checkbox for Use Region as Unique Identifier.  3

 Select the radio button for Respondent 4

tracker (region‟s value identifies this 
respondent during the read operation).  

 If desired, mark the checkbox for Insert ID 5

data into the grid during the read 
process. Viewing the ID data captured along 

with the rest of the data can be useful for 
verification of processed data. 

 Click the OK button to save the changes and 6
return to the tree view. 

When you are ready to process forms, open the 

form template containing Respondent Tracker regions in the Remark Office OMR Data 

Center. Use the Read Wizard to process your forms. Remark Office OMR begins 

processing the forms, searching for the Page ID regions first. When it matches a region 

on the form to the region in the form template, it automatically places that data in the 
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correct page order. It then searches for the Respondent Tracker and matches that 

respondent‟s data to an existing record or begins a new record. Any tracking regions 

that are not recognized are flagged for your review or placed in the Unrecognized 

Images queue. See Section 7.9 for further details about processing forms using 

Respondent Tracker. 

Tip: If you want to be able to recognize various pages and respondents 
within different forms at the same time, you may want to use the Auto Form 
ID and Page ID features as well as Respondent Tracker. Use of all three 
features allows you to scan various form types without pre-sorting and still 
keep pages and respondents together. 

6.3.4 Database Lookup 

Remark Office OMR has a Database Lookup feature that can: 1) verify that recognized 

data from a region appear in an external database, and 2) lookup and replace 

recognized data with additional fields from an external database. To use this feature, 

you link a region in the form template to an external database. As each form is 

processed, Remark Office OMR verifies that the recognized data appear in the selected 

database field. If the data are not present, Remark Office OMR flags the question as a 

Database Lookup error for correction. Database Lookup can be used with OMR, OCR, 

Image and Barcode regions. 

This feature is useful for validating names, identification numbers, zip codes, etc. It is 

also useful for pulling information you have already collected out of a database and 

inserting it into your processed form data. When you set up a Database Lookup region, 

you tell the software what field to validate, and whether to replace the output with a 

field from the external database and/or append additional fields from the external 

database. 

For example, suppose you are grading tests and you have the students fill in their ID 

numbers on the forms being processed. You could verify the ID numbers in a database 

to ensure the right forms are being scanned, and then specify another value that 

corresponds to the ID number (e.g., a name). If the ID number is found in the database, 

Remark Office OMR automatically displays the corresponding value (student name in this 

case) for that ID number in the data. When you run your grade reports, they are 

produced with each student‟s name, yet you did not have to type in that information (or 

have students bubble it in on the form).  

 

To use database lookup 

 Create a region as defined in Section 6.2.4. 1

 From the Properties window, click the Database lookup link in the left Task Pane.  2

 Mark the checkbox for Use Database Lookup. 3

 In the Database Selection area, use the Type drop-down list to select the type of 4
database to which you want to connect this region (e.g., Access, Excel, etc.). 

 Click the Browse… button to locate and select the database file. 5

 Select a file and then click the Open button (or double click the file name). 6



Remark Office OMR User’s Guide 

94 

If using an ODBC connection, perform the Steps 7-9 (you need to obtain specific 

information from your database administrator to complete these steps). Otherwise, skip 

to Step 10. 

 

 OPTIONAL: Select your database type from the DSN drop-down list. 7

 OPTIONAL: Select the appropriate checkbox to indicate whether your database is 8

Directory or DSN based: Directory based or DSN based. 

 OPTIONAL: If your database utilizes password protection, use the Username and 9

Password boxes to enter your login information. If the database is not password 

protected, you may skip this step. 

 

 In the Lookup & Return section, click the Connect to Database button to link the 10

database to the region. 

 Use the Table drop-down list to select the table in the database containing the fields 11

to which you are linking the region. 

 Use the Lookup drop-down list to select a field in the connected database to which 12

you want to link this region. When the forms are processed, the respondents‟ 
answers are verified against the values in this database field. If the answer is found 

in the database field, Remark Office OMR outputs the Replace value. If the answer 
is not found in the database field, Remark Office OMR flags it for review. 

 Use the Replace drop-down list to select a 13

field in the connected database to return 
when the Lookup field is verified. If you 

only want to verify data and not replace it 
with anything else, use the same field in 

both the Lookup and Replace lists. If you 
want to look up the value and then replace 

it with a different database field‟s 
information, select the appropriate field in 

the Replace list. 

 If desired, select database fields from the 14
Additional Return Fields list to insert 

additional information from the database 
into the data grid during form processing. You may look up a field once but return 

several database fields‟ worth of information. This is a quick and easy way to get 
information out of the existing database and into your processed data. Fields are 

listed in the data grid in the order in which they appear in the Additional Return 
Fields list. 

 If desired, use the Return Names column to specify region names for the Return 15

fields. By default, the name is taken from the external database to which the region 
is connected. You may type a new name in the Return Names cell if desired. 

 Use the drop-down arrow to select Yes in the Respondent ID box to include the 16
Return field in the reports as a respondent identifier. If this setting is set to Yes, the 

data collected from this region is used on the appropriate reports to identify the 
respondent. 

 Click the OK button to save the changes and return to the tree view. 17

When you process your filled in forms, Remark Office OMR looks up the captured data in 

the database and if found, returns your Replace and Additional Return Field data. 
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6.4 Additional Template Editor Features 

The Remark Office OMR Template Editor provides several other features and functions to 

help make it user friendly. The following features and/or functions are available: 

 Copy/paste 

 Copy special/paste special 

 Drag/drop (reordering) 

 Delete 

 Undo/redo 

 Adjusting region borders 

 Moving regions 

 Reset images 

 Auto align 

 Spell check 

 Scales 

 Zoom  

 File properties 

All of these features can be accessed from the menus. Many also have toolbar buttons or 

can be accessed by right clicking the mouse on a node in the tree view or in the image 

representation area. 

6.4.1 Copy/Paste 

When creating regions with similar attributes, using the Copy and Paste options can 

facilitate the form template creation process. You can copy regions on the same page or 

on different pages within the same form template. 

 

To copy and paste a region 

 Activate the region(s) you want to copy by clicking within the region boundaries in 1

the image representation area or clicking its node in the tree view. 

 Select the Edit menu and then click Copy, click , right click the mouse and 2

select Copy or press Ctrl+C on the keyboard. 

 Highlight the node before or after where you would like the region copied. 3

 Select the Edit menu and then click Paste Before (Ctrl+B) or Paste After 4

(Ctrl+V) to place the copied node either before or after the selected node. 

Note: You may also use the toolbar button for Paste,        , or right click 
and choose Paste to paste the region after the highlighted node. 

After pasting a region, the region appears in the image representation area of the 

Template Editor window. You then need to position the region correctly in the image 

representation area by dragging it with the mouse. 
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6.4.2 Copy Special/Paste Special  

If you would like to copy regions from one form template to another, you may use the 

Copy Special and Paste Special features.  

 

To use copy special and paste special 

 Open the Remark Office OMR Template Editor twice. 1

 Open one form template in the first instance of the Template Editor and another form 2

template in the second instance of the Template Editor. 

 Select the region or regions in the first instance of the Template Editor that you want 3

to copy by clicking them in the tree view. 

Tip: You can select multiple regions by holding down Ctrl on the keyboard 
and clicking each region or by clicking a region, holding down Shift on the 
keyboard and then clicking another region; all regions in between the 
selections are highlighted. 

 Select the Edit menu and then click Copy Special. 4

 In the second instance of the Template Editor, select the node in the tree view after 5
which you want to paste the new region(s). 

 Select the Edit menu and then click Paste Special. The new node(s) (region(s)) are 6
pasted after the highlighted node. You then need to position the region(s) correctly 

in the image representation area by dragging it with the mouse.  

6.4.3 Drag/Drop 

The drag/drop feature allows you to click a region in the tree view and drag it to another 

position within the tree. The order of the regions in the tree view determines the order 

of the fields in your data set. You may set the order of the regions on a page without 

regard to where the region is located on the image. When using drag/drop you can 

either move a node or copy a node. 

 

To move a node using drag/drop 

 Select the node representing the region you would like to move. 1

 While holding down the left mouse button, drag the region to its new desired 2

location. 

 When you have reached the new location, release the mouse button. A dialog box 3

appears, confirming whether you want to move the region to the new location. 

 Click the OK button to move the node. 4

Tip: You can press the Shift key on the keyboard as you drag a node to 
toggle between Move Before and Move After options. By pressing Shift, you 
can move a region before the selected region (otherwise, the region is 
placed after the selected region automatically). 

 

To copy a region using drag/drop 

 Select the node representing the region you would like to copy. 1
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 While holding down the left mouse button, drag the region to its new desired location 2

and then press the Ctrl key while still holding down the left mouse button. 

 When you have reached the new location, release the mouse button. A dialog box 3

appears, confirming whether you want to copy the region to the new location. 

 Click the OK button. 4

After copying a region, the region appears in the image representation area of the 

Template Editor window. You then need to position the region correctly by dragging it 

with the mouse. 

6.4.4 Deleting Regions 

Use the Delete option to remove unwanted region definitions.  

 

To delete a region 

 Activate the region you want to delete by clicking within the region boundaries or 1
clicking its node in the tree view. 

 Select the Edit menu and then click Delete, click , right click the mouse and 2

choose Delete or press Delete on the keyboard. You may also right click the region 

and choose Delete from the menu. 

6.4.5 Undo/Redo 

Remark Office OMR employs Undo and Redo in the Template Editor. Using Undo negates 

the last action that was performed. Using Redo repeats the last action for which undo 

was used. 

 

To use undo  

 Select the Edit menu and then click Undo, click , or press Ctrl+Z on the 1

keyboard to negate the previous action. 

 

To use redo 

 Select the Edit menu and then click Redo, click , or press Ctrl+Y on the 1
keyboard to repeat the previous action. 

6.4.6 Adjusting Region Borders 

If you need to adjust a region border (e.g., make the region larger or smaller), you can 

do so with the mouse. 
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To adjust region borders 

 Select the region you want to adjust by clicking it in the image representation area.  1

 Place the mouse over one of the squares in the field border until you see a double 2

arrow. 

 Drag the border to the desired location. 3

 When finished, release the mouse button. 4

6.4.7 Resetting Form Template Images 

There may be times when your form template images no longer match your actual form. 

For example, suppose that you create a form and then decide to remove one of the 

questions from the form. Or, perhaps you create the form template from a printed 

version of the form and then decide to make photocopies for distribution, which causes 

the entire form to be shifted. In either case, if you have already created your form 

template, you can use the Reset Images feature to bring in new images with your 

existing form template without having to recreate the entire form template. 

Tip: If using the Reset Images feature you need to acquire images for all 
pages in the form template. If you want to acquire individual form template 
pages, double click the page node and then acquire the new image for that 
page. 

 

To use Reset Images with a scanner 

 Select the Tools menu and then click Reset Images, or click . 1

 In the Select Method to Use for Image Acquisition section, click the Read from 2
scanner link option. 

Note: If you need to configure your 
scanner, you may click the Scanner 
Properties link just after Read from 
scanner to view the Scanner Properties 
window. 

 Place the page(s) to be scanned in the 3

scanner.  

 Click the Acquire Images from Scanner 4

button to scan the page(s).  

The page(s) are scanned and then a thumbnail 

image of the form appears in the Image 

window. If scanning multiple pages at once, use 

the Previous Page and Next Page icons under the image to view all scanned images. 

You may delete any images you do not wish to keep by clicking the Delete icons. 

 If you are satisfied with the image(s), click the OK button. Otherwise, click Acquire 5
Images from Scanner again to rescan a page. You may be prompted to have the 

software attempt to move your existing regions to the appropriate place on the new 

image. Review changes carefully after repositioning. 
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To use Reset Images with an image file 

 Select the Tools menu and then click Reset 1

Images, or click . 

 In the Select Method to Use for Image 2

Acquisition section, click the Read from 
image files link option. 

 Click the Acquire Images from File button 3
to select an image from file.  

 In the Select Image File… window, use the 4
Look in drop-down list to find the file(s) you 

wish to use for the form template. You may 

only select one image at a time; however you 
can go back to this window to select more 

images in succession. 

A thumbnail image of the form appears in the Image window. If acquiring multiple 

images, use the Previous Page and Next Page icons under the image to view all 

images. You may delete any images you do not wish to keep by clicking the Delete 

icons. 

 Repeat Step 2 to add any other form images to the form template. 5

 If you are satisfied with the image(s), click the OK button. Otherwise, click Acquire 6
Images from File again to reselect an image. You may be prompted to have the 

software attempt to move your existing regions to the appropriate place on the new 
image. Review changes carefully after repositioning. 

 

To reset a single page 

You may optionally reset the image for a single page instead of using the Reset Images 

function. 

 Double click the page node in the tree view 1

representing the page you want to reset. 

 In the Page Properties window, reacquire 2

the image via the scanner or an image file. 
See the previous sections for information 

about acquiring images. 

 Click the OK button to save the updated 3
image. Once the new image is acquired, the 

existing image is automatically overwritten. 

Once you have reset your images you will see all 

of your existing regions with the new image(s). 

You may find that you need to adjust the 

existing regions so that they are in the right position on the new image(s). You may 

move or delete regions as needed to line them up with the new image(s). You may also 

use the Auto Align feature to have the software automatically try to readjust the regions 

(see the next section for further details). 
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6.4.8 Auto Align 

The Auto Align feature attempts to adjust all regions on a page so that they are situated 

properly around the marks. This feature is useful if you need to scan a new image for 

the form due to form changes or a badly skewed image. It is also useful if you plan to 

share form templates with another user. Form templates created with one scanner 

should be realigned to new images when a different scanner is used. You can align one 

page or an entire form template. 

 

To use auto align for one page 

 Select the page node you wish to align. 1

 Right click the page node, select the Region menu or right click in a blank section of 2
the image representation area.  

 Choose Auto Align Page from the menu. 3

Note: You can also select the page node and click the toolbar button for Auto Align 

Page: . 

 

To use Auto Align for the entire form template 

 Select the Tools menu and then click Auto Align Form Template. 1

Once you have aligned pages or the entire form template, you should review the 

changes to make sure the regions are in the right position. You may need to do some 

additional moving of regions. 

6.4.9 Spell Check 

Remark Office OMR has a spell check feature that can be used to check spelling on 

region names, question text and labels in the template regions. You can specify the 

dictionary to use by clicking Tools|Preferences|General. 

 

To use spell check 

 With a form template open, select the Tools menu and then click Perform Spell 1

Check, or click .  

 Mark the options you wish to use while 2
checking the form template. 

 Click the Start button to begin searching the 3
form template. 

 When a spelling error is detected, you are 4
prompted with the word in question and 

suggestions, if they are available. The item 
containing the word is in the title bar. 
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 You may choose to ignore the word once 5

(Ignore) or all times (Ignore All) in the 
form template, add the word to your 

dictionary (Add), change this (Change) or all 
(Change All) occurrences of the word in the 

form template or Cancel the spell check 
operation. 

 When the entire form template has been 6
searched, click the Finish button to close the 

Spell Checker window. 

6.4.10 Response Scales 

Remark Office OMR allows you to save the response scales that you use as labels in your 

OMR regions or codes in your Image regions that use qualitative response coding. When 

you enter custom labels in the Region Properties window, you can save them for later 

use or to edit existing scales. From within the Properties window, you only have access 

to the response scales that fit the region you are defining. For example, if you have 

defined an OMR region that has five possible answer choices, you only have access to 

response scales that offer five answer choices. Therefore, the software allows you to 

access all of the saved response scales under the Tools menu. 

 

To view or modify response scales 

 Select the Tools menu and then click Response Scales, or click .  1

 Select a scale to view or modify from the Saved scales drop-down list. 2

 To delete the scale, click the Delete button. 3

 To edit the scale, click the Edit button and then type the new information.  4

 To create a new response scale, click the New 5

button, provide a Scale name and then enter 
the possible responses in the Labels grid and 

their corresponding numeric values in the 
Values grid, one per line. You may also click 

the down arrow on the New button and choose 
From Copy. This copies the selected scale and 

allows you to make modifications to the copy 

instead of starting over when you want to 
create similar scales. Click the Save button 

when you have finished creating your new 
scale. 

 When you are finished, click the OK button to 6
save the changes. 

Tip: You may right click the mouse within the Labels or Values grid to 
access cut, copy and paste functions. 
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6.4.11 Zoom 

You may use the software‟s zoom features to zoom in and out of the image for better 

viewing. It is recommended that you find a zoom range that allows you to see an entire 

region as you are creating it. 

 

To use the zoom features 

 With a form template open, select the View menu and then click Zoom. 1

 Select In to zoom in and Out to zoom out. Alternatively, select Fit Width to have 2

the image fit in the viewer based on width or Fit Height to have the image fit in the 
viewer based on height. You may also use the toolbar buttons for each of these 

functions: . 

6.4.12 File Properties 

You may view the properties of a form template at any time by selecting the File menu 

and then clicking Properties, or click . From this window you can review the form 

template description, size, orientation, number of pages, number of regions and number 

of items. You may also reset the form template images from this window. 

6.5 Saving a Form Template 

You may save a form template at any time. It is recommended that you save your form 

templates as you go in case you are interrupted. 

 

To save a form template 

 Select the File menu and then click Save, or 1

click , to save the region definitions.  

You may also use the Save As function to save 

the form template under a new name. 

 In the Save As dialog box, enter a file name 2

in the box titled File name.  

 Choose a directory location in the box titled 3

Save in. 

 Click the Save button. 4

Form templates can only be saved with a .omr file extension. The form template images 

are stored automatically as part of the overall form template file. 
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6.6 Editing an Existing Form Template 

You can edit previously created form templates to add or delete pages or to make 

changes to the region definitions or page layout.  

Note: Changing the structure of a form template after processing a batch of 
forms can cause compatibility conflicts between the form template and 
previously saved data files. Changes to the number of questions, the 
question order or the output labels will likely invalidate existing data files 
and Grade Wizard/Survey Wizard definition files. 

Form templates from previous versions of the software can be opened in the Remark 

Office OMR 8 Template Editor. The software automatically converts older form templates 

to the new version. Form template files are not backward compatible. Once a form 

template has been converted to the new version, it cannot be opened in a previous 

version of the software. Always make copies of form templates before converting them. 

Tip: If you accidentally convert a form template without backing it up first 
and then want to use it in the previous software version, you will find a file 
with a .old extension in your form templates folder (the folder from which 
you originally opened the form template). You may rename this file with a 
.omr extension and then open it in the previous version of Remark Office 
OMR. 

 

To edit a form template 

 If not already running, start the Remark Office OMR Template Editor program. 1

 Select the File menu and then click Open, or click . You may also use the 2

Recent Files option under the File menu or the Task Pane to open files. 

 Select the form template you would like to edit. 3

 Click the Open button. 4

The form template is displayed in the tree view, with the image representation area on 

the right. 

 Double click within the boundaries of any region you want to edit, or double click the 5
node representing the region in the tree view to display the Region Properties 

window. If you would like to rescan the pages of the form template, select the Tools 
menu and then click Reset Images. 

 Make the desired changes to the region‟s properties and then click the OK button. 6

Note: For more information about region types see the Creating Form 
Templates section of this chapter. 

 Save the form template when finished editing.  7

6.6.1 Editing OMR Regions 

OMR Regions can be modified after they have been created in order to change properties 

such as region names, data types, orientation, labels, etc. If you select the entire OMR 

region, you have access to all of the properties that are valid for that region. If you are 

editing an OMR region that contains multiple questions, you may only edit certain 
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properties when selecting individual questions. The ability to edit individual questions 

allows you to change items such as test points, the ability to accept multiple responses 

and blank and multiple exception handling on an individual question basis, yet still only 

create one OMR region.  

Note: Changing regions in a form template does not change data that have 
already been processed. To update data that have been read you need to 
process the forms again, or use the Find/Replace option to change the 
existing data to match the revised form template. Changing a form template 
can also invalidate Grade Wizard/Survey Wizard definition files. If you have 
already created these files, it is recommended that you recreate them based 
on the current form template settings. 

 

To edit a region with multiple questions 

 Double click within the boundaries of any 1

region you want to edit, or double click a 
region node in the tree view to display the 

Properties window. You have access to the 
OMR region properties, Region item 

properties and Question text and names 
sections. 

 Make the desired changes and click the OK 2
button. Remember that changes made at this 

level apply to the entire region. 

 Save the form template when finished 3
editing.  

 

To edit individual questions within an OMR region 

 Expand the region containing multiple questions by clicking the plus sign next to the 1
region node in the tree view. 

 Double click the question node representing the question you wish to change. You 2
can also select multiple nodes by holding down Ctrl on the keyboard and clicking 

each region or by clicking a region, holding down Shift on the keyboard and then 

clicking another region; all nodes in between the selections are highlighted. 

Note: If multiple questions are selected, you are not able to edit Question 
Text or Question Names. You are able to adjust the Labels for all selected 
questions, however. 

 The Properties window appears. You are 3

able to adjust Region item properties and 
Question text, names, and responses. 

Note: When viewing properties for 
individual questions within an OMR region, 
the Question text and names window 
changes to Question text, names, and 
responses. You can find the question‟s 
labels on this screen. Question text and 
names are only displayed for the selected 
question(s). 
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 Make the desired changes. 4

 Click the OK button to save your changes and return to the tree view. 5

6.7 Template Editor Preferences 

The Remark Office OMR Template Editor comes with a set of preferences to help you use 

the software optimally. Use these preferences to customize the software to the way you 

use it. By setting defaults, the software works in a way that you use most often. Keep in 

mind that these are only default settings; you can change individual form templates at 

any time. There are five preference areas you can customize: General, OMR regions, 

Image regions, Barcode regions and OCR regions. 

Using the Template Editor preferences 

 Select the Tools menu and then click Preferences, or click , to access the 1

preferences. 

 Select the link in the Task Pane corresponding to the preference you wish to edit. 2

 Make the appropriate changes. 3

 Click the OK button to save the changes. 4

Preferences are global changes and take effect the next time you use the applicable 

feature. Changing the preferences does not affect existing form templates and regions. 

6.7.1 General Preferences 

The General screen allows you to customize general features of the Template Editor. The 

following options are available:  
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Section Option Description 

General 

Preferences 

Default region 

name 

Enter a default region name to be used for 

every new region created. For example, 
entering “Q” causes every region name to be 

called Q. Remark Office OMR automatically 
appends numbers to the end of the region 

name so that your regions are called Q1, Q2, 
Q3, etc. 

 Format delimiter 

(Grid) 

Specify the character to use for the Define 

Format feature for Grid regions. Define Format 
allows you to format the output of a Grid 

region (e.g., put slashes in between numbers 
to produce a date: **/**/****). The Format 

Delimiter is the character displayed in the 
region properties window when you use this 

feature. The asterisk (*) is the default 

delimiter. Each asterisk represents a character 
in the region. 

 Perform logging Mark this checkbox to have Remark Office 
OMR store log files that can be recovered if 

the software terminates unexpectedly. The log 
file contains the work you were doing so that 

it can be restored when you restart the 

software. You are prompted to load the log file 
in the event of an unexpected termination. 

Use of this feature is strongly recommended. 

Dictionary 

Settings 

Dictionary 

location 

Use this setting to specify where the spell 

checker dictionary is located. The default 

location is the Windows\System32 folder. 

 Active dictionary Use this setting to choose the dictionary you 
want to use for the spell checker. Any 

dictionaries installed on your system are 
displayed in the list. 

 

6.7.2 OMR Region Preferences 

The OMR Regions screen allows you to setup default settings to be used when creating 

new OMR regions. When creating new OMR regions, the selected settings are used 

automatically. However, you can always change individual OMR region properties as you 

go. The following options are available: 
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Section Option Description 

Default Region 

Definition 

OMR type Sets the default OMR region type to be used 

when creating new OMR regions: Multiple, 
Grid, Boolean, List, Add, Binary, Rank.  

 Data type Sets the default OMR region data type to be 

used when creating new OMR regions: Textual 
or Numeric. The data type is used when 

exporting data. 

 Orientation Sets the default OMR region orientation to be 
used when creating new OMR regions: Row or 

Column.  

 Threshold Sets the default recognition threshold for OMR 
regions. Lower thresholds force the software 

to be more sensitive when reading light or less 
filled marks. Higher thresholds force the 

software to be stricter and therefore more 

discriminate when reading regions with 
multiple filled marks. Use the default setting 

of 3 unless you encounter problems when 
processing forms. Use caution when using 

extremely low or high thresholds. Low 
thresholds cause the software to be very 

sensitive, possibly picking up items such as 
erasures. High thresholds may cause the 

software to choose the most filled mark when 

two marks are encountered instead of 
outputting a multiple response for your 

review. 

Default Region 

Grade Settings  

Regions to Grade Use the checkboxes to select the OMR region 

types that you want to be graded by default 
when performing a grade operation. 

Default Region 

Survey Settings 

Regions to 

Tabulate 

Use the checkboxes to select the OMR region 

types that you want to be tabulated by default 
when performing a survey operation. 
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Section Option Description 

Default Multiple 

Exception 
Handling 

Replace with 

(Multiple, Rank 
and List) 

Select the replacement option to be used by 

default when a multiple response occurs for a 
Multiple, Rank or List region during form 

processing. The text entered in this box 
appears as output in the data grid and is 

exported in any saved data files. The default 
replacement is ALL, meaning that all 

responses are output and the data cell is 
flagged green. Other pre-defined options 

include MULT, Asterisk (*), Nothing, Space 

Character, and Tilde (~). You may also type 
characters into the Replace with box.  

 Replace with 
(Grid) 

Select the replacement option to be used by 
default when a multiple response occurs for a 

Grid region during form processing. The text 

entered in this box appears as output in the 
data grid and is exported in any saved data 

files. The default replacement is Asterisk (*). 
Other pre-defined options include MULT, 

Nothing, Space Character, and Tilde (~). You 
may also type characters into the Replace 

with box.  

Default Blank 
Exception 

Handling 

Replace with 
(Multiple, Rank 

and List) 

Select the replacement option to be used by 
default when a blank response occurs for a 

Multiple, Rank or List region during form 
processing. The text entered in this box 

appears as output in the data grid and is 
exported in any saved data files. The default 

replacement is BLANK. Other pre-defined 
options include Asterisk (*), Nothing, Space 

Character, Tilde (~) and VOID. You may also 

type characters into the Replace with box. 

 Replace with 
(Grid) 

Select the replacement option to be used by 
default when a blank response occurs for a 

Grid region during form processing. The text 
entered in this box appears as output in the 

data grid and is exported in any saved data 
files. The default replacement is BLANK. Other 

pre-defined options include Asterisk (*), 

Nothing, Space Character, Tilde (~) and VOID. 
You may also type characters into the 

Replace with box. 
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Section Option Description 

 Flag Blanks 

(Grid) 

Use this setting to further customize how 

Remark Office OMR interprets blank 
responses: 

Always- If any character in the Grid region is 
left blank, regardless of the replacement 

characters being used, the region contain a 
yellow BLANK flag.  

Ignore leading/trailing- If leading or trailing 
characters in the region are left 

blank, they are ignored. This allows you to 

capture data smaller than the allotted region 
without the data being flagged with a yellow 

BLANK flag. 
Never- If any character within the region is 

blank, Remark Office OMR ignores it. The 
region never appears with a yellow BLANK flag 

in the data grid. 

Default 

Duplicate 
Exception 

Handling 

Replace with 

(Rank) 

Select the replacement option to be used by 

default when a duplicate response occurs for a 
Rank region during form processing. The text 

entered in this box appears as output in the 
data grid and is exported in any saved data 

files. The default replacement is DUP. Other 
pre-defined options include Asterisk (*), 

Nothing, Space Character and Tilde (~). You 
may also type characters into the Replace 

with box. 

6.7.3 Image Region Preferences 

The Image Region screen allows you to setup default settings to be used when creating 

new Image regions. When creating new Image regions, the selected settings are used 

automatically. However, you can always change individual Image region properties as 

you go. The following options are available: 
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Section Option Description 

Default Region 

Definition 

Image type Sets the default Image region type: Data 

Entry, Image Clip or Data Entry and Image 
Clip. Data Entry regions allow you to hand 

enter data from the region into your data grid 
with the assistance of image files. Image Clip 

regions capture a snapshot image of the 
information in the region and store it on your 

computer. Data Entry and Image Clip regions 
allow you to capture image clips but still use 

other Image region properties, such as 

default fills and qualitative coding. The 
information captured from all types of Image 

regions can be viewed in reports in Remark 
Quick Stats. 

 Data type Sets the default Image region data type to be 

used when creating new Image regions: 
Textual or Numeric. The data type is used 

when exporting data. 

 Threshold Sets the default recognition threshold for 

Image regions. Lower thresholds force the 
software to be more lenient when reading 

light text or image regions with smaller 

amounts of text. Higher thresholds force the 
software to be stricter and therefore less 

likely to pick up stray or light markings within 
the region. Use the default setting of 3 unless 

you encounter problems when processing 
forms. Use caution when using extremely low 

or high thresholds. Low thresholds cause the 
software to be very sensitive, possibly picking 

up items such as erasures. High thresholds 

may cause the software to not detect 
handwriting within light or less filled Image 

regions. 

Default Image 

Clip Options 

Target directory Sets the default storage location for the 

images that are captured when using Image 

Clips. 

 Clip file type Sets the default image file format to use 
when capturing image clips. You may choose 

TIF, PCX, PDF or JPG. If using the TIF or PDF 
formats, you may also select the compression 

level. 

Default Grading 
& Survey 

Analysis 

Grade region Mark this checkbox to grade Image regions 
by default when performing a grade 

operation. 
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Section Option Description 

 Tabulate region Mark this checkbox to tabulate Image regions 

by default when performing a survey 
operation. 

6.7.4 Barcode Region Preferences 

The Barcode Region screen allows you to setup default settings to be used when 

creating new Barcode regions. When creating new Barcode regions, the selected settings 

are used automatically. However, you can always change individual Barcode region 

properties as you go. The following options are available: 

 

 

 

 

 

 

 

 

 

 

 

 

 

Section Option Description 

Default Region 
Definition 

Barcode 
orientation 

Sets the default orientation to be used when 
creating new Barcode regions: Horizontal or 

Vertical. 

 Data type Sets the default Barcode region data type to 

be used when creating new Barcode regions: 

Textual or Numeric. The data type is used 
when exporting data. 

Default Grading 
& Survey 

Analysis 

Grade region Mark this checkbox to grade Barcode regions 
by default when performing a grade 

operation. 

 Tabulate region Mark this checkbox to tabulate Barcode 
regions by default when performing a survey 

operation. 
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6.7.5 OCR Region Preferences 

The OCR Region screen allows you to setup default settings to be used when creating 

new OCR (optical character recognition) regions. When creating new OCR regions, the 

selected settings are used automatically. However, you can always change individual 

OCR region properties as you go. The following options are available: 

 

 

 

 

 

 

  

 

 

 

 

 

Section Option Description 

Default Region 

Definition 

OCR type Sets the type of OCR to use. There are two 

options: 
Standard: Standard OCR is Remark Office 

OMR‟s built-in OCR engine. It tends be faster 
but may be less accurate. 

Microsoft Office Document Imaging (MODI): 

MODI OCR comes with Microsoft Office 2007 
and is only available if you have this software 

installed with the MODI option. Using MODI 
tends to be slower but yields high accuracy 

rates. 

 Language Sets the default language to use when 
performing OCR functions. Note that the 

available languages change based upon the 
type of OCR you are using. 

 Data type Sets the default OCR region data type to be 
used when creating new OCR regions: 

Textual or Numeric. The data type is used 

when exporting data. 

 Orientation Choose the orientation in which to read the 

region: Left to Right, Right to Left, Top to 
Bottom or Bottom to Top. (Applies to 

Standard OCR only.) 
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Section Option Description 

 Auto rotate 

region image 

Mark this checkbox to have Remark Office 

OMR automatically rotate the image in order 
to read the text captured in the OCR region. 

If the software cannot read the text in one 
direction, it rotates the image to try again. 

(Applies to MODI OCR regions only.) 

 Threshold Select a threshold to use for the software to 
determine whether it recognizes the printed 

text. The threshold applies to each individual 

character. The software returns a confidence 
value for each character recognized (e.g., 

62% certain it is a “G”). If any character 
returns a confidence value lower than the 

specified threshold, the OCR field is flagged 
as an exception for your review. 

Default Grading 

& Survey 
Analysis 

Grade region Mark this checkbox to grade OCR regions by 

default when performing a grade operation. 

 Tabulate region Mark this checkbox to tabulate OCR regions 
by default when performing a survey 

operation. 
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Processing Forms 

Chapter 7 

7.1 Overview 

This chapter explains how to process forms in the Remark Office OMR Data Center. You 

should refer to your scanner‟s documentation for instructions on installing and using the 

scanner. You can read forms directly from a scanner connected to the computer running 

Remark Office OMR or from pre-scanned images you created outside of the Remark 

software. 

The following topics are covered: 

 Opening a form template (Section 7.2) 

 Using the Read Wizard (Section 7.3) 

 The Image Viewer (Section 7.4) 

 The Graph Viewer (Section 7.5) 

 Reviewing exceptions (Section 7.6) 

 Collating forms (Section 7.7) 

 Overwriting data (Section 7.8) 

 Form, page and respondent IDs (Section 7.9) 

 Batch processing (Section 7.10) 

 Server Mode (Section 7.11) 

 Respondent detection (Section 7.12) 

 Reviewing duplicates (Section 7.13) 

 Software recognition options (Section 7.14) 

 Recognition tools (Section 7.15) 

7.2 Opening a Form Template 

The Remark Office OMR software requires a form template file for each unique form that 

you want to process. This file defines all of the information needed for the software to 

read the form. Form templates are created in the Remark Office OMR Template Editor, 

which is covered in Chapter 6 of this user‟s guide. Once you have a form template for 

your form, it can be reused as often as needed (as long as the form does not change). 

To begin the reading process, open the form template file corresponding to your form in 

the Data Center. The Remark Office OMR template grid window uses a spreadsheet style 

interface to display processed data. Each grid column corresponds to an item or question 
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on the form, as it was defined in the form template. If your form template contains 

multiple pages, each page is separated by a blue line. 

Important Note: Form templates from previous versions of the software 
can be opened in the Remark Office OMR 8 software. Once they are opened 
in the new version, form templates are automatically converted. Form 
template files are upward compatible only. Once a form template has been 
converted to the new version, it cannot be opened in a previous version of 
the software. Always make copies of form templates from previous versions 
before converting them. 

 

To access the Data Center 

 From the Windows Start menu, click Programs|Remark Office OMR 8|Remark 1

Office OMR Data Center. 

You can see a Task Pane on the left and an empty grid on the right. This grid is where 

your form template is opened and data is processed. 

 

To select a form template 

 Select the File menu and then click Open Form Template, or click , to display 1
the Open form template window. Alternatively, select Open form template from 

the Task Pane. 

Note: Form template file names have 
an OMR file extension.  

Tip: You can access recently used form 
templates from the File menu or the 
Task Pane. 

 Use the Look in drop-down list to locate 2
files on your computer or network. Select 

the correct form template file by clicking 
its name. 

 Click the Open button to open the form 3
template and display the corresponding 

data grid window. 

Once the form template is open, you may 

begin processing forms. By default, when you open a form template, you see the data 

grid across the top of the screen and 

the Image Viewer and Graph Viewer 

at the bottom of the data grid. The 

data grid is where you see the data as 

forms are processed. The Image 

Viewer displays an image of the form 

as it is processed. If you click within a 

data grid cell, the Image Viewer 

moves to that place on the 



 Processing Forms   

 117 

corresponding image. (Note: If you have the Zoom to Region on Selection toolbar 

button enabled, , the Image Viewer also zooms in on the selected region.) The 

Graph Viewer graphs the tabulation of a single question, as selected in a cell of the data 

grid. 

7.3 The Remark Office OMR Read Wizard 

Form processing is handled through the Remark Office OMR Read Wizard. When reading 

forms in the Remark Office OMR Data Center, you can have the software read pages 

directly from a scanner connected to the computer or from image files that you have 

previously created by scanning forms outside of the Remark software. Before attempting 

to read any pages from the scanner, turn on your scanner, ensure it is set up in Remark 

Office OMR and open the form template that corresponds to your forms. (See Section 

7.2 Opening a Form Template.)  

Note: The forms you wish to process must correspond to the selected form 
template.  

The Data Center places the recognized data in the open data grid. All data obtained from 

reading one form appear in a single grid row. Each column of the data grid corresponds 

to each variable (question) defined in the form template. 

Every time you open a form template file and launch the Read Wizard, the settings used 

with the same form template during the previous Read Wizard session are automatically 

loaded. As you move through the Read Wizard steps, your settings are automatically 

saved for the form template file. For example, if you are scanning and store the images 

to a specific network folder, the next time you open the same form template, that file 

storage folder is automatically used. Or, suppose you make a change to one of the 

recognition settings, such as Recognition Threshold Override. The next time you use the 

same form template, the Recognition Threshold Override is still turned on. The storing of 

Read Wizard settings applies to both reading from scanner and reading from images 

operations. 

Note: The settings you apply to a form template are stored in each user‟s 
preferences file. Therefore, if you share form templates or have different 
users accessing the same form template on the same machine, the Read 
Wizard settings could vary. Be sure to coordinate any changes you make to 
the Read Wizard settings with any other Remark users. 

 

Tip: You may wish to read section 7.14 Recognition Settings to understand 
the possible recognition settings that can be stored with your form template. 

7.3.1 Scanning Forms with the Read Wizard 

Forms can be scanned with most TWAIN compliant scanners. See Chapter 4 for more 

information about scanners and how to set them up in Remark Office OMR. As the forms 

are scanned, images of each form are stored on your computer. These images are used 

to review the data for easy clean up. 
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To read pages from the scanner 

 Open the correct form template. (See Section 7.2 Opening a Form Template.) 1

 Select the Tools menu and then click Read 2

Wizard, or click . Alternatively, 

you may select the Read Wizard link from 
the Task Pane. 

 In the Read Method window, select the 3
radio button for Read from scanner. 

Note: If you need to configure your 
scanner, click the Scanner Properties 
link to view its setup (see Chapter 4 for 
detailed information about setting up a 
scanner). 

 If desired, modify the recognition settings being used by the software by clicking the 4

Recognition Settings link. This link opens 
the recognition settings that apply to this 

form template. Please see Section 7.14 for 
a detailed description of each option. The 

link is provided in the Read Wizard for your 

convenience. Note that you should not 
modify the recognition settings unless you 

experience recognition problems with your 
form. The default settings are optimized for 

general use of the software. If you do 
modify the recognition settings from the 

Read Wizard, the settings are stored with 
the form template and therefore still 

remain in effect the next time you use the 

same form template. 

 If desired, mark the appropriate checkboxes under Advanced Collection Options. 5

The following options are available when scanning (these options are covered in 
more depth in later sections of this chapter): 

 

Option  Description 

Server Mode Automates form processing by having Remark Office 
OMR run in the background using specific options. 

See Section 7.11 Server Mode for further details. 

Auto Form ID Mode Allows the software to automatically recognize form 
templates, form pages and respondents through 

identifiers you place on the forms. See Section 7.9 
Form, Page and Respondent IDs for further details. 

Start reading from form 

template page 

Allows you to process forms starting with a specific 

form template page instead of at the beginning. This 
feature is useful for overwriting data. 
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Option  Description 

Collate Mode Allows you to scan forms that are double sided 

without the use of a duplex scanner. See Section 7.7 
Using Collate Mode for further details. 

Resume last Collate Mode 
session 

Resumes scanning from the point in which you left off 
in your last Collate Mode scan session.  

 

 If you would like to configure image naming conventions for your scanned forms, 6
click the Next>> button to continue. 

Otherwise skip to step 14. 

 The Image Naming Conventions 7
window allows you to specify options 

about the images that are 
automatically stored each time you 

scan forms. In the Begin image 
names with box, enter a file base 

name that the software can use to 
name the images stored for this form. 

The default base name is the form 

template name; however, you may 
use any name you like. We suggest 

using something that identifies to you 
that the images belong to a certain form. The images that are stored all begin with 

this base name and then have the page number (if scanning a multi-page form), 
date and time appended to them to keep track of the various images. You may 

optionally choose a region from the form template to use as the base name. The 
value that is collected from the form for the specified region is used as the base 

name for the corresponding stored image. For example, if scanning student tests you 

could use a Student ID region to name the resulting image files by student. If you 
leave the Begin image names with option blank, your images only have the page 

number (if applicable), date and time as the name of each image.  

 In the Image target directory box, click the ellipsis (…) button to select a location 8

in which to store the images for this form. You may use the default directory for 
images or select a different directory on your computer, external drive or network. 

Note: Choose the image location carefully. The images should remain in this 
location once the data is saved using the RMK format if you want to retain 
the link between the processed data and each image file. This link allows 
you to view the forms on screen as you click through the data grid, making 
it easy to correct exceptions in your data. Therefore, you should plan ahead 
on how you will store these images when the forms are processed. 

Tip: If you are sharing files with other Remark Office OMR users, you may 
wish to save the image files on a shared network drive that all users have 
access to in the same manner (e.g., through a mapped network drive). 

 Mark the checkbox for Save images in a subfolder based on the form 9
template’s name to have the Data Center automatically create a folder in which to 

store these images. The folder name is the name of the form template and the folder 

is created in the directory you have selected in the Image target directory box. 
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Tip: We recommend using the Save images in a subfolder based on the 
form template’s name feature for easier organization of image files. Use 
of this feature keeps all images associated with each form template in one 
folder for easy access. The unique date and time portion of the image names 
prevents images from being overwritten. 

 [OPTIONAL] If desired, click the Name Builder… button to further customize the 10

stored image names and locations.  

 In the Image Base Name area, you may choose to add a region from the 

processed data to the image 

base name. Choose the region 
from the drop-down list and 

then click the Add button. If 
you already added a region in 

Step 7, the Name Builder 
allows you to add additional 

regions. For example, if 
processing tests, you could add 

a Student ID that is being 

collected from the form so that 
your processed images all have 

the Student ID number in them. 

 In the Image Target Directory area, you may choose to add a region from the 

processed data to the folder structure that holds the processed images. Choose 
the region from the drop-down list and then click the Add button. For example, if 

processing tests, you could add a Test ID that is being collected from the form so 
that each student‟s form images are stored in a folder containing the Test ID. 

 In the Name Builder box, click the OK button to return to the Read Wizard. 

 In the Saved image type box, select an image type to use for storing images. The 11
choices are: PCX/DCX, PDF, TIF or JPG.  

 When saving to the PDF or TIF formats, you can choose the compression level under 12
Image compression level: Uncompressed, Group 3, Group 3 2d, Group 4 and 

LZW. Group 4 creates the most compressed image (smallest file size that take up 
less space on your computer). 

 Mark the checkbox for Save multiple page form templates as multiple page 13
image files if you are scanning a multi-page form and would like all of the images 

for one complete form to be saved as one image file. Using this option creates fewer 

image files and is recommended. 

 If you would like to configure Review Exceptions options, click the Next>> button 14

to continue. Otherwise click the Read button to begin scanning pages. 

Review Exceptions is a way to correct exception cases found on forms, such as blank 

and multiple responses (see Section 7.6 Review Exceptions for further details about 

using this feature). 

 In the Review Exceptions window, specify whether to review exception cases 15

during the scanning process by marking the Activate Review Exceptions 
checkbox.  

 In the Review Exceptions Options area, mark the checkboxes for those cases that 16
you wish to review during scanning. The following options are available: Multiple 

responses, Blank responses, Recognition errors, Image regions, Database 
lookup regions, Barcode regions, OCR regions, Repeated rank responses or 
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Required items. Reviewing Exceptions 

during scanning causes the software to 
stop scanning when it encounters any 

exception cases you select. You can then 
make the appropriate adjustments and 

the scanning resumes. 

Note: Review Exceptions can also be 
run after all the forms are processed if 
you prefer not to stop processing when 
problems occur. 

 Place the completed forms in the scanner. 17

 Click the Read button to begin processing pages. 18

Note: If desired you can click the drop-down arrow on the Read button and 
choose Save or Save and Read. If you choose one of the save options, 
your Read Wizard settings are saved as an Automation Wizard file (.rez). 
The Automation Wizard is used to automate form processing. Please see the 
Remark Office OMR Automation Wizard User‟s Guide.pdf file 
(Start|Programs|Remark Office OMR 8|Documentation) included with your 
software for more information about the Automation Wizard. 

Remark Office OMR continues scanning pages until the scanner‟s sheetfeeder is empty.  

 After processing all of the pages, you are prompted to continue scanning. Click Yes 19
to scan more pages or No to end the scanning process.  

7.3.1.a Scanning Using Default Settings (Easy Scan) 

Once you have run the Read Wizard, you may optionally scan using default settings 

without running the Read Wizard each time. This method is called Easy Scan and 

scanning occurs using the last settings specified in the Read Wizard. If you are using a 

form template you have used previously, the last settings used for that specific form 

template are applied. 

Caution: Easy Scan is useful if you are using the same settings each time 
you scan. If you are uncertain about what settings exist, it is recommended 
that you run the Read Wizard to initiate scanning. 

 

To use Easy Scan 

 Open the correct form template. (See Section 7.2 Opening a Form Template.) 1

 Select the Tools menu and then click Easy Scan, or click the Easy Scan toolbar 2

button . 

All pages in the scanner are scanned based on the last settings used with this form 

template. If the form template has never been used, the last used settings in the Read 

Wizard are applied. You then see a spreadsheet of data. Each row represents one 

complete form and each column represents each item (question) you defined in the form 

template. 
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7.3.2 Processing Image Files with the Read Wizard 

Remark Office OMR can process image files that have already been scanned. For 

example, if you have a network scanner or a scanner that is not compatible with Remark 

Office OMR, you can scan your forms in another application and then save the resulting 

image files. If you use a multi-function peripheral (MFP) that has scanning capabilities, 

you can scan forms on the MFP, save them as image files and then have Remark Office 

OMR read the images with the corresponding form template. The end result looks just as 

if you had scanned the forms directly in the Remark Office OMR Data Center. 

Remark Office OMR can read the following image file formats: 

PCX (*.pcx) Multipage PCX (*.dcx) 

TIFF (*.tif, *.tiff) JPEG (*.jpg, *.jpeg) 

Portable Document Format (*.pdf) PNG (*.png) 

Windows Bitmap (*.bmp)  

Tip: It is strongly recommended that you use the TIF/TIFF format for pre-
scanned image files, particularly if you have a choice between TIFF and PDF 
(very common on multi-function devices). PDF files are not native image 
files and require more processing time, making the reading process slower. 
TIFF Group 4 compression gives you the most compressed file for fastest 
processing.  

 

To read image files with the Read Wizard 

 Open the correct form template. (See Section 7.2 Opening a Form Template.) 1

 Select the Tools menu and then click Read Wizard, or click . 2

Alternatively, you may select the Read Wizard link from the Task Pane. 

 In the Read Method window, select the radio button for Read from image files. 3

 If desired, modify the recognition 4
settings being used by the software by 

clicking the Recognition Settings 
link. This link opens the recognition 

settings that apply to this form 
template. Please see Section 7.14 for 

a detailed description of each option. 

The link is provided in the Read 
Wizard for your convenience. Note 

that you should not modify the 
recognition settings unless you 

experience recognition problems with 
your form. The default settings are 

optimized for general use of the software. If you do modify the recognition settings 
from the Read Wizard, the settings are stored with the form template and therefore 

still remain in effect the next time you use the same form template. 

 If desired, click the link for Advanced Image Recognition Properties. This link 5
allows you to set the following options: Invert image, Auto deskew images 

during recognition, Auto despeckle images during recognition. 
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Caution: We do not suggest making changes to the Advanced Image 
Recognition Properties unless you encounter difficulties related to these 
settings. 

 If desired, mark the appropriate checkboxes under Advanced Collection Options. 6

The following options are available: 

 

Option  Description 

Server Mode Automates form processing by having Remark Office 

OMR run in the background using specific options. 
See Section 7.11 Server Mode for further details. 

Auto Form ID Mode Allows the software to automatically recognize form 
templates, form pages and respondents using 

identifiers you place on the forms. See Section 7.9 
Form, Page and Respondent IDs for further details. 

Start reading from form 

template page 

Allows you to start processing forms starting with a 

specific form template page instead of at the 
beginning. This feature is useful for overwriting data. 

Package and rename images Allows you to repackage the processed image files in 
a new location, new format or with new parameters 

from your data set. Applies when processing image 
files only. This feature is useful for archiving images 

or for placing images in specified locations for later 
distribution. See the next few pages for more details. 

Delete images after 

packaging 

Allows you to delete the originally processed (pre-

scanned) images once they have been repackaged 
into your desired format. This feature allows you to 

maintain only one copy of the images. Use caution 

when using this feature: the original images are 
permanently deleted. 

 

 Click the Next>> button to continue. 7

 In the Select Images to Read area, use the drop-down list to locate the folder on 8

your computer or network that contains the images you wish to process. 

 Once you have located the correct folder, select the images you wish to process. You 9

may make multiple selections by holding down the Ctrl key and clicking images or 
holding down the Shift key and selecting a range of images (click the first and last 

image and all images in between are 

selected). 

 Click the Add Selected Images button to 10

move the images into the bottom window. 
Alternatively, you can select an entire 

folder‟s set of images by clicking the 
bottom Add All Images button. The 

images are moved to the Images in 
Read Order box. The selected images are 
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processed in the order in which they appear in this box. 

 If an image appears in the Images in Read Order box and you wish to remove it, 11
select the image and then click Remove. You may make multiple selections by 

holding down the Ctrl key and clicking images or holding down the Shift key and 
selecting a range of images (click the first and last image and all images in between 

are selected). You can also remove all images by clicking the Remove All button.  

 Click the Next>> button to continue. If you are using the Package and rename 12

images option, proceed to step 13. If you are not using this feature, proceed to Step 
14. 

 [OPTIONAL] If you chose the Package and rename images option on the first step 13

of the Read Wizard, the Image Naming Conventions window appears. The Image 
Naming Conventions window allows you to specify options for repackaging the 

processed images.  

 In the Begin image names with box, enter a file base name that the software 

can use to name the images of each form. The default base name is the form 
template name; however, you may use any name you like. We suggest using 

something that identifies to you that 
the images belong to a certain form. 

The images that are stored all begin 

with this base name and then have the 
page number (if processing a multi-

page template), date and time 
appended to them to keep track of the 

various images. You may optionally 
choose a region from the form 

template to use as the base name. The 
value that is collected from the form 

for the specified region is used as the 

base name for the corresponding stored image. If you leave the Begin image 
names with option blank, your images only have the page number (if 

applicable), date and time as the name of each image. NOTE: If you are 
processing images for multiple form templates using the Auto Form ID feature, as 

long as all open form templates have a region name in common, you may use 
that region as your Begin image names with choice. Remark Office OMR 

names the images appropriately by pulling the data from the corresponding form 
template file. 

 In the Image target directory box, click the ellipsis (…) button to select a 

location in which to store the repackaged images for this form. You may use the 
default directory for images or select a different directory on your computer, 

external drive or network. 

Note: Choose the image location carefully. The images should remain in this 
location once the data is saved using the RMK format if you want to retain 
the link between the processed data and each image file. This link allows 
you to view the forms on screen as you click through the data grid, making 
it easy to correct exceptions in your data. Therefore, you should plan ahead 
on how you will store these images when the forms are processed. 

Tip: If you are sharing files with other Remark Office OMR users, you may 
wish to save the repackaged image files on a shared network drive that all 
users have access to in the same manner (e.g., through a mapped network 
drive). 
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 Mark the checkbox for Save images in a subfolder based on the form 

template’s name to have the Data Center automatically create a folder in which 
to store these images. The folder name is the name of the form template and the 

folder is created in the directory you have selected in the Image target directory 
box. 

Tip: We recommend using the Save images in a subfolder based on the 
form template’s name feature for easier organization of image files. Use 
of this feature keeps all images associated with each form template in one 
folder for easy access. The unique date and time portion of the image names 
prevents images from being overwritten. 

 [Optional] If desired, click the Name Builder… button to further customize the 

stored image names and locations.  

o In the Image Base Name area, you may choose to add a region from the 

processed data to the image base name. Choose the region from the 
drop-down list and then click the Add button. If you already added a 

region on the previous 
screen, the Name Builder 

allows you to add additional 

regions. For example, if 
processing tests, you could 

add a Student Name field 
that is being collected from 

the form so that your 
repackaged images all begin 

with the students‟ names. 

o In the Image Target 

Directory area, you may 

choose to add a region from the processed data to the folder structure 
that holds the repackaged images. Choose the region from the drop-down 

list and then click the Add button. For example, if processing tests, you 
could add teacher name and student ID fields that are being collected 

from the form so that each student‟s form images are stored in a folder 
containing the teacher‟s name and then a subfolder named by the student 

ID number. 

o In the Name Builder box, click the OK button to return to the Read 

Wizard. 

 In the Saved image type box, select an image type to use for storing the 
repackaged images. The choices are: PCX/DCX, PDF, TIF or JPG. For example, 

you may be processing TIF images, but want to repackage them as PDF files for 
others to view. 

 When saving to the PDF or TIF formats, you can choose the compression level 
under Image compression level: Uncompressed, Group 3, Group 3 2d, 

Group 4 and LZW. Group 4 creates the most compressed image (smallest file 
size that takes up less space on your computer). 

 Mark the checkbox for Save multiple page form templates as multiple page 

image files if you are processing a multi-page form and would like all of the 
images for one complete form to be saved as one image file. Using this option 

creates fewer image files and is recommended. 

 If you would like to configure Review Exceptions options, click the Next>> button 14

to continue. Otherwise click the Read button to begin processing image files. 
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Review Exceptions is a way to correct exception cases found on forms, such as blank 

and multiple responses (see Section 7.6 for further details about using Review 

Exceptions). 

 In the Review Exceptions window, specify whether to review exception cases 15
during the reading process by marking the Activate Review Exceptions checkbox.  

 In the Review Exceptions Options 16
area, mark the checkboxes for those 

cases that you wish to review during 

reading. The following options are 
available: Multiple responses, Blank 

responses, Recognition errors, Image 
regions, Database Lookup regions, 

Barcode regions, OCR regions, 
Repeated rank responses or Required 

items. Reviewing exceptions during 
image processing causes the software to 

stop reading image files when it 

encounters any exception cases you 
select. You can then make the appropriate adjustments and then resume image 

processing. 

Note: Review Exceptions can also be run after all the forms are processed if 
you prefer not to stop processing when problems occur. 

 Click the Read button to begin processing image files. 17

Note: If desired you can click the drop-down arrow on the Read button and 
choose Save or Save and Read. If you choose one of the save options, 
your Read Wizard settings are saved as an Automation Wizard file (.rez). 
The Automation Wizard is used to automate form processing. Please see the 
Remark Office OMR Automation Wizard User‟s Guide.pdf file 
(Start|Programs|Remark Office OMR 8|Documentation) included with your 
software for more information about the Automation Wizard. 

The Data Center continues processing images until all of the specified images are read. 

You then see a spreadsheet of data. Each row represents one complete form and each 

column represents each question you defined in the form template. 

7.4 Image Viewer 

Remark Office OMR includes an Image Viewer at the bottom of the screen that displays 

an image of each processed form. It is used to view handwritten comments for data 

entry and qualitative coding, as well as for reviewing exceptions and making corrections. 

The Image Viewer eliminates the 

need to refer back to the original 

paper form. To show and hide the 

Image Viewer, select the View 

menu and choose Image Viewer. 

The following options are available 

on the Image Viewer: 
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Icon Option Description 

 Print Click the Print button to print the current image. A printer 

window appears where you can choose and configure a 
printer. 

 Rotate 
Image  

Click the Rotate Image icon to rotate the active image 0, 
270, 180 or 90 degrees. 

 Toggle 

Image 
Color 

Click the Toggle Image Color button to show the image 

in its native color (if it was originally scanned in color or 
grayscale) or show it in black and white format (what 

Remark Office OMR uses to read the image). 

 Zoom to 
Region 

on 
Selection 

Click the Zoom to Region on Selection button to have 
the colored area on the Image Viewer zoom to the selected 

region in the grid. This feature is useful when correcting 
exceptions so that you can see the exact cell contents 

where the error occurred. 

 Zoom 

In/Zoom 

Out 

Click the Zoom In button to zoom in on the image (make 

it larger) and click the Zoom Out button to zoom out on 

the image (make it smaller). Note that Remark Office OMR 
only holds your zoom settings as you click cells in the data 

grid if you do not have Zoom to Region on Selection 
selected. 

 Close 

Image 
Viewer 

Click the X to close the Image Viewer. You can always 

reopen it using the Tools menu. 

7.5 Graph Viewer 

Remark Office OMR includes a Graph Viewer at the bottom of the screen to view quick 

results of processed data. The graph viewer displays a graph of the data being 

processed, indicating the frequency of each 

response chosen (an item analysis). Click in any 

cell containing data to view a graph of the 

responses. Please note that the graph viewer is 

not grading data and that it may slow down the 

processing speed. To show and hide the Graph 

Viewer, select the View menu and choose 

Graph Viewer. The Graph Viewer has many 

options, which are summarized in the following 

table:  
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Icon Option Description 

 Copy Click the Copy button to copy the graph to the Windows 

clipboard. The graph can then be pasted into another 
application. 

 

Print Click the Print button to print the current graph. If you 
drop down the arrow on the Print icon, you can choose 

whether to print in monochrome or color (if your printer 
supports it). 

 

Graph 

Title 

Toggle the Graph Title icon to turn the title over the 

graph on and off. Click the down arrow on the Graph Title 
icon to choose what to display: None (no title), Question 

Name, or Question Text. Please note that the font size 
used for the Graph Title updates automatically based on 

the amount of text being displayed. 

 

Graph 
Type 

Click the Graph Type icon to cycle through the various 
graph types. Alternatively, use the drop-down arrow on 

the Graph Type icon to choose a graph type: 3D Bar, 2D 
Bar, 3D Pie, 2D Pie, 3D Area, 2D Area and Line. 

 

Graph 

Data 

Click the Graph Data icon to cycle through the various 

graph options. Alternatively, use the drop-down arrow on 
the Graph Data icon to choose what to graph: Frequency 

(base the Y axis on the data set using frequencies), 
Percent Auto Scale (allow Remark Office OMR to choose 

the best Y axis percentage scale for your data) or Percent 
Standard Scale (use a standard percentage scale for the 

Y axis, such as 0-100%). 

 Close 
Graph 

Pane 

Click the X to close the Graph Viewer. You can always 
reopen it using the Tools menu. 

7.6 Reviewing Exceptions 

As forms are processed, exception cases can 

occur. You should edit cells containing exception 

cases to validate your data before performing 

any analysis operations or exporting the data to 

another application. Each exception case is 

assigned a specific color so that you can easily 

distinguish different types of exceptions. There is 

a legend depicting the types of exceptions and 

their accompanying color in the Task Pane of the 

Data Center (if you cannot see the Exceptions 

Legend, click View|Legend). The following table 

summarizes the types of exception cases and 

their possible causes. 
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Error Type Text Color Possible Causes 

Multiple 

Responses 
(Too Many 

Responses) 

All multiple 

responses 
or MULT  

Green More than one answer selected when 

multiple responses are not permitted. 

Partially erased forms. 

Carelessly marked forms. 

Blank 

Responses  

(No 
Response) 

BLANK Yellow Unanswered questions. 

Response not completely filled. 

Recognition 

Errors (Form 
Error 

ERROR… 

(various 
code 

numbers 
may 

appear) 

Red Forms that have been enlarged, reduced, 

offset or skewed by more than 3/8 inch; 
could result from photocopying or 

reprinting. 

Improperly or carelessly placed forms in 

the automatic document feeder of the 
scanner, where they are pulled in 

crookedly and skewed images result. 

Could also be a result of a mechanical 
issue with the scanner, in which case you 

should have your scanner cleaned and 
serviced. 

Forms that have text or lines placed too 
close to markable areas, causing the text 

or lines to be interfere with the marks 
(bubbles, checkboxes). 

Images scanned with brightness setting 

too high or low. 

Carelessly marked forms. 

Forms processed with wrong form 
template file. 

Forms that do not follow the design 
guidelines outlined in Chapter 5. 

Image 

Regions 

None Light Blue Signifies a data entry image region where 

handwriting was found. You need to type 
the information found in the region, or 

apply a code if using qualitative coding. 

Database 
Lookup Errors 

Selected 
Responses 

Purple Response not found within the selected 
database to which the region is linked. 
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Error Type Text Color Possible Causes 

Barcode 

Errors 

??? Dark 

Orange 

Used a barcode type that Remark Office 

OMR cannot recognize. 

Used the Code 3 of 9 barcode type 

without using beginning and ending 
asterisks (*). 

Barcode does not fit within region 
definition area. 

Barcode is printed too small on the form. 

Extraneous marks are located within the 

Barcode region. 

Scanning resolution is too low (should be 
at least 200 DPI, 300 DPI recommended). 

OCR Region 
(Optical 

Character 

Recognition) 

Miscellan-
eous 

characters 

Dark Blue The font used for the text does not create 
readable text (e.g., a handwriting style 

font). 

Text is too small to be read. 

Region border created in the form 

template does not properly encapsulate 
the text. 

OCR region threshold setting in the form 
template or program preferences is too 

high or too low. 

Printed text on form is in an unsupported 

language. 

Trying to recognize handwriting (ICR) 
instead of machine printed text. 

Scanning resolution is too low (should be 
at least 300 DPI). 

Repeated 

Rank 
Responses 

DUP Pale 

Orange 

A duplicate rank was given to a Ranking 

style question. For Ranking questions, 
each response can only have one rank 

assigned, and each rank can only be used 
once. 
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Error Type Text Color Possible Causes 

Required 

item 

None Exception 

Color 

Signifies that a required region was not 

properly answered. Typically, this means 
that another exception occurred, such as 

a Blank, Mult or Error. The data grid cell 
takes on the color of this exception (e.g., 

yellow for a blank response), but there is 
no text, indicating that the question was 

required. Flagging required questions is 
particularly useful when you use the 

Review Exceptions function during form 

processing (meaning the processing stops 
so that you can review the problem). Note 

that you should use caution when making 
questions required and using the “Flag 

Blanks” setting. If Flag Blanks is set to 
Never, anything left blank does not 

display as a required item exception. 

Multiple 
exceptions 

None Gray Signifies that multiple exceptions were 
found in the region. For example, an OCR 

region that is also being used as a 
Database Lookup region might not be 

recognized properly. In this case, it is 
both an OCR recognition exception and a 

Database Lookup exception. The gray 

color lets you know that more than one 
issue was found. 

 

Remark Office OMR offers image-assisted exception reviewing using the Image Viewer, 

which eliminates searching through paper forms to make corrections to the data. You 

can resolve exception cases in one of two ways: editing individual cells or using the 

Review Exceptions feature during or after form processing. 

Note: The exception colors in the grid are only retained if you save data to 
the Remark or Remark Office Archive data formats. Once you export your 
data to another format, if you reopen that format, the grid colors are not 
present. Please see Section 8.6 for detailed information about saving data. 

7.6.1 Reviewing Exceptions by Modifying Individual Cells 

One way of correcting exceptions is by individually clicking the cell you wish to change. 

You can use the drop-down arrow to select correct responses or type the desired text 

into the cell. As you click in a cell, the Image Viewer at the bottom of the screen updates 

automatically (select View|Image Viewer if you are not seeing the Image Viewer). 

You may also zoom to the selected region by enabling the toolbar button for Zoom to 

Region on Selection on the Image Viewer toolbar, . 

Note: Editing a cell removes any error colors. 
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To reconcile cells individually 

 Click the cell that you wish to change. 1

 If the cell contains a drop-down arrow, click the arrow and choose the correct 2

response from the list. 

 If the cell does not contain a drop-down arrow, type the appropriate response in the 3

cell and press Enter or click another cell. 

Note: Each cell contains either a text box or a drop-down list box depending 
on its region type. Grid, Binary and Add OMR regions, Barcode regions, OCR 
regions and Image regions that are not using the Database Lookup or 
qualitative response coding features are considered text regions. You do not 
have a drop-down list box for these region types. All other types of OMR 
regions and Image regions using qualitative response codes are considered 
list regions and have a drop-down list from which you can choose responses. 

7.6.2 Using Review Exceptions 

Remark Office OMR provides the Review Exceptions feature as a method to validate 

data. You may use the Review Exceptions feature to review the following exception 

cases: blank responses, multiple responses, form errors, barcode errors, database 

lookup errors, required items, OCR regions, repeated rank responses, multiple 

exceptions or data entry Image regions.  

The Review Exceptions feature can be used in one of two ways: 

During Form Processing: If used during the reading process, whether scanning forms 

or processing saved image files, Review Exceptions provides an option to have the Data 

Center pause after encountering selected exception types. You can then select or enter 

the correct response.  

After Form Processing: Review Exceptions can also be used after the forms have been 

processed; therefore, you are not required to have the software stop processing forms 

when exceptions are encountered. When reviewing after processing, the software cycles 

through the data file to find exception cases and then allows you to make the 

appropriate changes. 

Regardless of how you use Review Exceptions, the Data Center displays a Review 

Exceptions window in the Task Pane. The software also shows you the question/region 

containing the exception case in the Image Viewer at the bottom of your screen. You 

may use the image to guide you in making the appropriate updates in the Review 

Exceptions pane. The following table details the available Review Exceptions options: 

 

Review Option Function 

Blank Responses Review when a respondent fails to answer a question. 

Multiple Responses Review when a respondent chooses more responses than were 

permitted. 

Image Regions Review when a flagged Image region is encountered. Allows the 
hand entry of information into the data grid or the ability to 

choose a qualitative response code. 
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Review Option Function 

Region Errors Review when a recognition error occurs and Remark Office OMR 

cannot properly recognize the region (e.g., image is skewed, 
form is poorly marked, spacing is too tight on the form). 

Database Lookup 

Errors 

Review when a database lookup error is encountered, meaning 

that the response is not located in the database that was 
specified during the form template creation process. Once you 

correct the Database Lookup exception, if you are returning 
other fields from the database, they are updated automatically. 

Barcode Errors Review when Remark Office OMR cannot read the barcode 

properly. 

OCR Errors Review when the text in an OCR region cannot be properly 

recognized. 

Repeated Rank 
Responses 

Review when a respondent chooses the same rank for different 
questions in the same region. 

Required Items Review when a required item has not been answered. 

Multiple exceptions Review when multiple exceptions occur. For example, an OCR 
region utilizing Database Lookup could be unrecognized, which 

would generate both an OCR exception and a Database Lookup 
exception. 

 

To use Review Exceptions during form processing 

 Open the correct form template. (See Section 7.2 Opening a Form Template.) 1

 Begin processing forms by either selecting the Tools menu and then clicking Read 2

Wizard, clicking  or clicking the Read Wizard link in the Task Pane. 

 Make the necessary selections on the Read Method screen and the Scanned 3
Image Naming Conventions (if scanning) or Image Selection window (if reading 

image files) screen. See Section 7.3 The Remark Office OMR Read Wizard for 
detailed information about these screens.  

 Click the Next>> button to go to the Review Exceptions screen. 4

 Mark the checkbox for Activate Review 5

Exceptions to turn on the Review 
Exceptions feature.  

 In the Review Exceptions Options 6

area, select the exception cases you 
would like to review during form 

processing: Multiple responses, Blank 
responses, Recognition errors, 

Image regions, Database lookup 
regions, Barcode regions, OCR 

regions, Repeated rank responses or 
Required items. 

 Click the Read button to begin the 7

reading process. 
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The Data Center begins processing forms normally. When the software encounters one 

of the specified exception cases, processing stops and the Review Exceptions window 

appears in the left Task Pane. You use this window to make changes. Please proceed to 

Section 7.6.2.a for detailed information about the Review Exceptions window. 

 

To use Review Exceptions after form processing 

 After processing forms, select the Tools menu and then 1

click Review Exceptions, or click . Alternatively, 

you may select the Review exceptions link from the 
Data tab of the Task Pane. 

 In the Review Exceptions Options area, select the 2

exception cases you would like to review: Blank 
responses, Multiple responses, Recognition errors, 

Image regions, Database lookup regions, Barcode 
regions, OCR regions, Repeated rank responses or 

Required items. 

 Click the Begin Review button to begin reviewing the 3

data.  

Tip: You may process forms and clean sections of the data as you go. 
Simply begin Review Exceptions normally. Then, if you wish to process more 
forms, leave the Review Exceptions window open and process additional 
forms. When you are ready to review the newly processed forms, in the 
Review Exceptions window, click the down arrow on the Begin Review 
button and choose Begin from Last Read Operation. The Data Center 
begins reviewing data grid rows from the point where you most recently 
began processing forms. 

The Data Center searches the data for the specified exception cases. When a selected 

exception case is found, it appears in the Review Exceptions window in the left Task 

Pane. You use this window to make changes. Please proceed to the next section for 

detailed information about the Review Exceptions window. 

Tip: When using Review Exceptions after form processing, you can review 
the entire data set or sections of the data set. To review sections of the data 
set, select the column or row header(s) of the area you wish to review, or 
highlight a group of cells. For example, if you only want to review a specific 
comment region (Image region) so that you can hand enter data, select the 
column header of the comment region so that the entire column is 
highlighted. Then click Review Exceptions; only the selected column is 
reviewed. 

There may be times when you are reviewing exceptions and the exceptions are 

legitimate, e.g., a question is left blank. By default, if you leave the exception as is, it 

always retains the color coding and exception text. If you prefer to remove the color 

coding once an item has been reviewed, go to Tools|Preferences and mark the 

checkbox for Clear exceptions after they have been reviewed in the section called 

Review Exceptions. After a cell is reviewed using Review Exceptions, the color 

disappears even if you did not make a change to the cell. If Review Exceptions is run 

again, the cell is not flagged as an exception. 
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7.6.2.a Using the Review Exceptions Window 

Whether you use Review Exceptions during or after form processing, any exceptions 

found while reading display in the Review Exceptions window. The Review Exceptions 

window displays the following information: 

 

Property Function 

Search by: Row/Respondent: Use this option to search across the 

data grid in rows (by respondent). 

Column/Item: Use this option to search across the data 
grid in columns (by form template item/question). 

Response Displays the current response. Use this box to enter the 

correct response by typing the response or clicking the 
drop-down arrow and choosing a response. You can view 

the item in question in the Image Viewer for assistance in 
verifying the response. 

Search Forward Moves to the next exception case on the form.  

Search Backward Moves backwards until it encounters an exception case. 

Next Row/Column Moves to the next exception case on the next form or 
column (it searches by row or column, depending on your 

selection in the Search by box). 

Previous Row/Column Moves backward one row or column until it encounters an 

exception case (it searches by row or column depending 
on your selection in the Search by box). 

Finished Ends Review Exceptions. 

Cancel  Cancels reviewing of the current page. Upon canceling 
you have three options: 

1. Restore Original Data: Cancels any changes made to 

this page during Review Exceptions and restores the 

original data. 

2. Discard Page Data: Discards the current page‟s data all 

together. You may rescan or re-import an image file after 

discarding the data. 

3. Cancel: Returns to Review Exceptions. 

 

To replace an exception 

 Click the Response box down arrow (if 1

available) to view a list of possible 
responses and then click the correct 

answer(s), or type the desired text into 
the Response box. The down arrow is 

available for Multiple, Boolean, Rank and 
List OMR regions, as well as Image regions 

that use Database Lookup or qualitative 
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response codes. You may type the first few letters of a response and Remark Office 

OMR tries to auto-fill the response for you. For Grid, Add and Binary OMR regions, as 
well as Barcode, OCR and any other data entry Image regions, you may type the 

appropriate response. 

Note: The displayed exception text (e.g., BLANK) and color remain in the 
output data unless you replace it. If you prefer to remove the color coding 
once an item has been reviewed but left unchanged, go to 
Tools|Preferences and mark the checkbox for Clear exceptions after 
they have been reviewed in the section called Review Exceptions. Then 
run Review Exceptions. 

 To move to the next exception case on the 2

current form, click the Search Forward button 
at the bottom of the window. You may also press 

the Enter key on your keyboard to advance to 
the next exception. 

 To skip any remaining exception cases on the current form and move to the next 3

form containing exception cases, click the Next Row/Next Column button at the 
bottom of the window. 

 When you have completed reviewing exceptions, click the Finished button. 4

Tip: If you need to return to the processed data at a later point to complete 
reviewing exceptions, save the data to the Remark or Remark Archive 
format. These formats save the exception case colors and links to the stored 
images so that you may continue reviewing the data. If the data is exported 
to other formats, these colors and image links are not included in the 
exported data file. See Section 8.6 Saving Data for complete details on 
saving data. 

7.7 Using Collate Mode (Scanning Double Sided Forms with 

a Single Side Only Scanner) 

The Remark Office OMR Data Center provides Collate Mode to read duplex (double-

sided) forms when you have a simplex (single side only) scanner. Therefore, if you do 

not have a duplex scanner (one that reads both sides of a form in a single pass) you can 

still process double-sided forms in the software. 

Note: If your scanner can scan in duplex mode, meaning it scans both sides 
of a page in one pass through the scanner, you do not need to use Collate 
Mode. Instead, turn on the duplex capability in the scanner‟s TWAIN 
interface or the Remark Office OMR Scanner Properties window 
(Tools|Scanner Properties). 

To use Collate Mode you perform three basic steps: place a stack of forms in the 

scanner‟s automatic document feeder and scan the odd numbered pages, flip the stack 

over and then scan the even pages. The forms are placed in the scanner in regular page 

order. The Data Center reads all odd numbered pages first, regardless of how many sets 

of forms you place in the scanner. The software then reads the even numbered pages in 

reverse order so that the data are written to the correct position. For example, suppose 

you have a six page, double-sided form. You would first scan pages one, three and five, 

then flip the stack over and scan pages six, four and two. When scanning in Collate 
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Mode, make sure the forms are in regular page order, with all pages belonging to one 

complete form together. 

Note: If your form does not have an even number of pages (e.g., the last 
page has a blank backside), Remark Office OMR automatically compensates 
for the blank backside. You do not need to create a blank form template 
page. 

 

To process pages using Collate Mode 

 Open the correct form template. (See Section 7.2 Opening a Form Template) 1

 Select the Tools menu and then click Read Wizard, or click . 2

Alternatively, you may select the Read 
Wizard link from the Task Pane. 

 In the Read Method window, select the 3
radio button for Read from scanner. 

Note: If you need to configure your 
scanner, click the Scanner Properties 
link to view its setup. (See Chapter 4 for 
detailed information about setting up a 
scanner.) 

 In the Advanced Collection Options 4

area, mark the checkbox for Collate 
Mode.  

Note: Collate Mode is only enabled if you open a multi-page template and 
you do not have the Scan Duplex option marked in the Scanner 
Properties window. 

 Click the Next>> button to continue by modifying Scanned Image Naming 5
Conventions and Review Exceptions options (see Sections 7.3 and 7.6 for further 

details), or click the Read button to begin processing forms. 

 Place all double-sided forms you want to read in the automatic document feeder of 6
your scanner in normal page order and then click the OK button. 

The Data Center begins reading the odd numbered pages (the front sides of the forms). 

When finished processing the odd numbered pages, you are prompted to read in the 

other direction.  

 When prompted, turn the stack of forms over and place it back in the automatic 7

document feeder of the scanner. Do not rearrange the forms. The Data Center 

collates the forms properly. 

 Click the checkbox for Begin Reading in Other Direction.  8

 Click the Continue button. 9

 When finished reading the even pages (the backsides), you are prompted to start a 10

new batch or finish processing. Continue reading forms in this manner until all forms 
have been processed. 

Caution: When using Collate Mode, scan complete form sets in batches. 
Complete an entire set of odd and even pages before scanning more forms 
in a single direction. This way if the scanning process is interrupted 
unexpectedly, you are less likely to lose any data and it is easier to recover. 
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If the scanning process is interrupted, Remark Office OMR has a Resume option. Follow 

the directions above, but mark the checkbox for Resume last Collate Mode session in 

the Read Wizard. This option picks up the scanning from where you last left off. 

7.8 Overwriting Data Records 

The Remark Office OMR Data Center allows you to process forms in their original order 

beginning on a selected form template page. This method is useful if your reading 

session was interrupted unexpectedly and you need to resume form processing midway 

into your data. To use this method, you must first select a grid row. You can then use 

the Read Wizard to process new forms either at the beginning of the selected data grid 

row or beginning with a certain form template page. The latter option is the same as 

reading from the scanner or image files normally except that you can choose the page 

on which to begin. 

 

To overwrite data 

 Highlight the data grid row(s) containing the data you wish to overwrite by clicking in 1

the row header(s). 

 Select the Tools menu and then click Read Wizard, or click . 2

Alternatively, you may select the Read Wizard link from the Task Pane. 

 In the Read Method window, select the radio button for the option you wish to use: 3
Read from scanner or Read from image 

files. 

 [Optional] If using a multi-page template and 4

you only want to overwrite a portion of the 
data record, in the Advanced Collection 

Options area, mark the checkbox for Start 

reading from form template page. Enter 
the page number at which to start 

processing. You may use the up and down 
arrow keys or type a number. If you are 

using a single page form template, or 
overwriting the entire data grid row, you do 

not need to use this setting. 

 Configure the remaining Read Wizard options by clicking the Next>> button (see 5

Section 7.3 The Remark Office OMR Read Wizard for detailed information about using 

the Read Wizard). If processing image files, click the Next>> button to choose the 
image files. 

 If scanning forms, place all pages to be read in the scanner, starting with the page 6
corresponding to the form template page entered in step 4, and then click the Read 

button.  

Note: If you place more than one page in the scanner, the Data Center 
continues reading pages and placing data across the selected grid row 
sequentially. However, the Data Center does not read past the last 
highlighted grid row(s). 
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 When prompted to overwrite the data, click the Overwrite button. If you do not 7

wish to overwrite the data for any reason, click the Cancel button. 

The Data Center continues processing forms beginning on the selected form template 

page until all selected pages in the data grid row have been replaced.  

7.9 Using Form, Page and Respondent Detection 

Remark Office OMR allows for three types of automatic tracking and detection to assist 

with form processing: Auto Form ID, Auto Page ID and Respondent Tracker. With Auto 

Form ID, Remark Office OMR can automatically recognize a form and match it to its form 

template, allowing you to process various form types at once without pre-sorting the 

forms. With Auto Page ID, Remark Office OMR takes it a step further and identifies 

specific page order within a form template if the pages are scanned out of order. With 

Respondent Tracker, Remark Office OMR recognizes a specific respondent‟s page and 

places it in the correct data grid row with the rest of that respondent‟s data if the pages 

are processed out of order. Form, Page or Respondent IDs can be OMR, OCR or Barcode 

regions. 

Tip: You can use delimited barcodes as identifiers. Delimited barcodes 
contain multiple items within a single barcode. When set up in the Template 
Editor, you can tell the software which part of the barcode to use as the 
Form, Page or Respondent Identifier. 

Note: It is strongly recommended that you read Section 6.3.3 Tracking for 
detailed information on setting up Form ID, Page ID and Respondent Tracker 
regions in a form template before you begin processing forms using Tracker 
regions. 

7.9.1 Auto Form ID 

Remark Office OMR provides an Auto Form ID option for automatically matching a form 

with its corresponding form template. This type of form recognition allows you to 

process many different form types without pre-sorting the forms. 

Note: You cannot use the Collate Mode option with Auto Form ID. If you 
wish to process double-sided forms using Auto Form ID, you need to use a 
duplex scanner. 

Each form type you want to use with Auto Form ID must contain an ID region on every 

form template page. The ID region can be an OMR, OCR or Barcode region. 

Note: For backwards compatibility, forms with an ID region on the first page 
only still work in Auto Form ID mode, when using Auto Form ID by itself. If 
you wish to use Auto Page ID or Respondent Tracker in conjunction with 
Auto Form ID, you must have identifying regions on every page of the form. 

 

To use Auto Form ID 

 Outside of Remark Office OMR, create a form that contains a unique identifier on 1
each page that can be captured as an OMR, OCR or Barcode region in the Remark 

Office OMR form template. 
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Tip: The Auto Form ID region could be a series of bubbles that represent 
form numbers, such as 1-4. Or it could be a barcode or OCR area that 
identifies a specific form, such as “Form A.” 

 Create a form template for each form you 2

wish to process in Auto Form ID mode. When 
creating the form template, set the region to 

be used as the Form ID region in the 
Tracking section of the region‟s properties. 

Mark the checkbox for Use Region as a 
Unique Identifier. Then select the radio 

button marked Form ID. See Section 6.3.3.a 
Auto Form ID for further information about 

setting up ID regions in the form template. 

 When you are ready to start processing 3
forms, open the form templates you wish to 

use in Auto Form ID mode in the Data 
Center (see Section 7.2 Opening Form 

Templates). Only open form templates 
that contain Auto Form ID regions. 

 Read forms from either scanner or image 4
file by selecting the Tools menu and then 

clicking Read Wizard, or click 

.  

 In the Read Wizard, go to the section 5
titled Advanced Collection Options and 

mark the checkbox for Auto Form ID 
Mode.  

 Click the Next>> button to configure remaining Read Wizard options. (See Section 6
7.3 The Remark Office OMR Read Wizard for further details about processing forms.) 

Make your selections and then click the Read button. 

Caution: When using Auto Form ID alone, the Data Center processes 
multiple page forms sequentially. After recognizing the first page of a 
multiple page form, Remark Office OMR assumes the following pages belong 
to the same form template. You may optionally use the Auto Page ID and/or 
Respondent Tracking features (described in the next two sections) to 
process pages out of sequential order. 

After recognizing the form type, the Data Center places the data into the appropriate 

data grid window. Any images that the Data Center cannot recognize enter a queue of 

unrecognized images. You can review these images during or after form processing. See 

Section 7.9.4 Reviewing Unrecognized Images for further information about reviewing 

unrecognized images. 

7.9.2 Auto Page ID 

The Auto Page ID feature allows you to process form pages out of normal page order. 

The Data Center searches for the page identifier region on each page first, and places 

the data in the proper order. Auto Page ID can be used alone or in conjunction with Auto 

Form ID and/or Respondent Tracker. When used alone, you must process only those 

forms associated with one specific form template and be certain that all pages belonging 
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to each respondent are grouped together for processing. Without the use of Respondent 

Tracker, if pages from differing respondents are mixed together, you are prompted and 

form processing stops. You need to re-sort your forms so that each respondent‟s pages 

are processed together; an individual respondent‟s pages can be out of order within the 

same form, but a single respondent‟s pages cannot be interspersed with another 

respondent‟s pages. Auto Page ID regions can be OMR, OCR or Barcode regions. 

 

To use Auto Page ID 

 Outside of Remark Office OMR, create a form that contains a unique identifier on 1

each page that can be captured as an OMR, OCR or Barcode region in the Remark 
Office OMR template. Remember that if you are also using Auto Form ID, you need a 

second unique identifier to be used as the Page ID. Each Page ID must be unique 
from page to page. 

Tip: The Page ID region could be a series of bubbles that represent page 
numbers, such as 1-4. Or it could be an OCR area or barcode that identifies 
a specific page. 

 Create a form template for each form you 2

wish to process using automatic page 
detection. When creating the form template, 

set the region to be used as the Page ID 
region in the Tracking section of the 

region‟s properties. Mark the checkbox for 
Use Region as a Unique Identifier. Then 

select the radio button marked Page ID. 
See Section 6.3.3.b Page IDs for further 

information about setting up ID regions in 

the form template. 

 When you are ready to start processing forms, open the form template(s) you wish 3

to use with Auto Page ID in the Data Center (see Section 7.2 Opening a Form 
Template).  

 Read forms from either scanner or image file by selecting the Tools menu and then 4

clicking Read Wizard, or by clicking . (See Section 7.3 The Remark 

Office OMR Read Wizard for more details about processing forms.) Make your 

selections and then click the Read button. 

After recognizing the page, the Data Center places the data into the appropriate 

template grid section. Any images that the Data Center cannot recognize enter a queue 

of unrecognized images. You can review these images during or after form processing. 

See Section 7.9.4 Reviewing Unrecognized Images for further information about 

reviewing unrecognized images. 

7.9.3 Respondent Tracker 

The Respondent Tracker feature allows you to scan respondents‟ form pages in any 

order. Remark Office OMR uses the respondent identifier region of the form template to 

determine the appropriate record for each respondent. This feature is only useful for 

multi-page forms. Therefore, you need to also use the Auto Page ID feature along with 

Respondent Tracker. Remark Office OMR first identifies the page being processed, and 



Remark Office OMR User’s Guide 

142 

then the respondent. Optionally, you may use Auto Form ID as well. Using all three 

features allows you to process various forms, form pages and individual respondent 

pages in any order and still have Remark Office OMR record the data properly. 

Respondent Tracker ID regions can be OMR, OCR or Barcode regions. 

Note: If you are only processing one multi-page form, use of Auto Form ID 
is not necessary. If you would like to process more than one form type at 
once and use the Respondent Tracker feature, you need to also use Auto 
Form ID. 

 

To use Respondent Tracker 

 Outside of Remark Office OMR, create a form that contains a unique identifier on 1

each page that can be captured as an OMR, OCR or Barcode region in the Remark 
Office OMR form template. Remember that if you are using Auto Form ID and Auto 

Page ID, you need a third unique identifier to be used as the Respondent Tracker. 

Tip: The Respondent Tracker region can be a bubble region where the 
respondent marks identifying information, such as name, ID number, etc. It 
can also be a Barcode or OCR region that contains similar information and is 
pre-printed. The information must appear on every page of the form. 

 Create a form template for each form you 2
wish to process using the Respondent Tracker 

feature. When creating the form template, set 

the region to be used as the Respondent 
Tracker region in the Tracking section of the 

region‟s properties. Mark the checkbox for 
Use Region as a Unique Identifier. Then 

select the radio button marked Respondent 
tracker. See Section 6.3.3.c Respondent 

Tracker for further information about setting 
up Respondent Tracker regions in the form 

template. 

 When you are ready to start processing 3
forms, open the form template(s) you wish to use with Respondent Tracker mode in 

the Data Center (see Section 7.2 Opening a Form Template).  

 Read forms from either scanner or image file by selecting the Tools menu and then 4

clicking Read Wizard, or by clicking . (See Section 7.3 The Remark 

Office OMR Read Wizard for more details about processing forms.) Make your 
selections and then click the Read button. 

After recognizing the page and respondent, Remark Office OMR places the data into the 

appropriate data grid section. Each unique respondent tracker produces a new row of 

data in the data grid. 

There may be times when you are 

presented with overwrite options if a 

respondent tracker data value is already 

present in the data grid. The message tells 

you that the region‟s value has already 

been read. You may Overwrite what has 
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been read, Ignore it (skip the page) or choose End Read to stop the read process 

(e.g., in the case where you think incorrect forms might be being processed). 

7.9.4 Reviewing Unrecognized Images 

Forms that are not recognized while processing in Auto Form ID, Auto Page ID or 

Respondent Tracker mode are stored for review. You can choose whether to review the 

unrecognized images during or after form processing. You must match the unrecognized 

image with the appropriate form template, page or respondent. 

The Unrecognized Image Utility is used to match unrecognized form templates, form 

pages or respondents and can be used in one of two ways: 

During Form Processing: If used during the reading process, whether scanning forms 

or processing saved image files, the Unrecognized Image Utility provides an option to 

have the Data Center software pause after encountering an unrecognized identifier 

region. You can then match the region to the appropriate form template, page or 

respondent.  

After Form Processing: The Unrecognized Image Utility can also be used after the 

forms have been processed; therefore, you are not required to have the software stop 

when a form, page or respondent is not recognized. Any images that are not recognized 

are stored in a queue. You can then access this queue after the forms have been 

processed and make the appropriate identifications. 

Note: When using automatic page identification without the Respondent 
Tracker feature, you must process all pages of one complete respondent‟s 
form before moving on to the next form. If a page is not recognized, 
processing stops even if you are not using the option to review during the 
read operation. Please sort your pages so that an entire respondent‟s form is 
read at one time. 

Regardless of how you use the Unrecognized Image Utility, the Data Center displays the 

Unrecognized Image utility window when an unrecognized form or page is encountered. 

This window is described in detail in Section 7.9.5 Using the Unrecognized Image Utility. 

 

To use the Unrecognized Image Utility during form processing 

 Open the correct form template. (See Section 7.2 Opening a Form Template.) 1

 Begin processing forms by selecting the Tools menu and then clicking Read 2

Wizard, clicking  or by clicking the Read Wizard link in the Task Pane. 

 Make the necessary selections on the Read Method screen. If using Auto Form ID, 3

mark the Auto Form ID Mode checkbox. (If automatically recognizing page or 
respondent IDs, you do not need to make any extra indications in the Read Wizard.) 

 Click the Next>> button to continue. 4

 Make the necessary selections on the Scanned Image Naming Conventions (if 5

scanning) or Image Selection window (if reading image files) screen. See Section 

7.3 The Remark Office OMR Read Wizard for detailed information about these 
screens.  

 Click the Next>> button to go to the Review Exceptions screen.  6
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 Mark the checkbox for Review unrecognized images when using region 7

tracking and/or page error detection to turn on the Review Unrecognized 
Images feature. 

 Click the Read button to begin the reading 8
process. 

Remark Office OMR begins processing forms 

normally. When an image is not recognized, 

the Unrecognized Image Utility window 

appears. You use this window to make 

changes. Please proceed to Section 7.9.5 for 

detailed information about the Unrecognized 

Image Utility window. 

 

To use the Unrecognized Image Utility after form processing 

 After processing forms, select the Tools menu and then click Review 1
Unrecognized Images. 

The Unrecognized Image Utility window appears, displaying any images that were 

not recognized during the read operation. You use this window to make changes. Please 

proceed to Section 7.9.5 for detailed information about the Unrecognized Image Utility 

window. 

7.9.5 Using the Unrecognized Image Utility 

When an image is not recognized automatically, the Unrecognized Image Utility appears. 

You use this window to see which specific ID region was not recognized, and then match 

the image to the appropriate form template, form template page or respondent. The 

following table details the available Unrecognized Image Utility options: 

 

Option Description 

Form Templates Provides a list of open form templates to which you can match 

the form that is not being automatically recognized. Use the 
drop-down list to select the correct form template for the 

image that is displayed in the image area and then click the 

Read button. 

Pages Provides a list of pages corresponding to the form template 

that the unrecognized image matches. Use the drop-down list 
to select the correct form template page for the image that is 

displayed in the image area and then click the Read button. 

Respondent ID Allows you to enter the correct respondent ID for the form. An 
exception color is present to show you why the region was not 

automatically recognized (e.g., BLANK or MULT colors). Once 
you enter the correct respondent ID, the software either 

matches it to an existing record (if one exists) or begins a new 
record. After entering the correct response, click the Read 

button. 
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Option Description 

Details Lists the details pertinent to the page being read, including 

the Form ID, Number of Pages, and the Page ID (if 
applicable). When a region has not been automatically 

recognized, its details are not listed until a form 
template/form page is selected. 

Image Provides an image representation of the form to assist in 

matching forms and pages to the appropriate form template. 

Cancel Use this button to cancel processing of the current page. The 
Cancel button offers three options: 

Cancel: Cancels the current image and stops the reading 
process. If you are reviewing images after form processing, 

the review process ends. 

Skip Image: Skips the current image but continues with the 

unrecognized image review. This option is only available when 
using the Review Unrecognized Images utility after form 

processing. 

Discard Image: Skips the current image and: 
1) if reviewing images created while scanning forms, deletes 

the corresponding image, or 
2) if reviewing images created by processing saved image 

files, does not place the image into the Unrecognized Image 
queue for later review (the actual image file is not deleted). 

Read After matching a form, page or respondent to its form 

template, click the Read button to continue processing forms. 

 

When using multiple tracking regions, you match one region at a time. For example, if a 

form template, page and respondent are all not recognized, you first match the form 

template, then the utility appears again so that you can match the form template page, 

and finally the utility appears again so that you can match the respondent ID.  

Continue to the next sections to understand how to use the Unrecognized Image Utility 

when both forms and pages are not recognized automatically. 

7.9.5.a Reviewing Unrecognized Auto Form ID Images 

If the Data Center cannot automatically match a form to its form template, the 

Unrecognized Image Utility appears. If you have chosen to review unrecognized images 

during form processing, the window appears for each unrecognized form ID region. If 

you have chosen not to review during form processing, the images are stored in a queue 

so that you can process them all at once later. 

To use the Unrecognized Image Utility for Auto Form ID regions 

 Follow the directions in Section 7.9 Form, Page and Respondent Detection to begin 1

form processing using Auto Form ID. 

 When the Unrecognized Image Utility appears for an unrecognized image, the 2

Form Templates list is empty. Click the drop-down list to choose the correct form 
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template for this image. Use the Image Viewer in the right portion of the screen to 

assist with understanding which form has been processed. 

 [Optional] If desired, click the Cancel button to skip recognizing this image. This 3

might be appropriate if the wrong form was scanned (or the wrong image was 
processed). If desired, use the Skip Image 

or Discard Image options. 

 Once you have matched a form to its form 4

template, click the Read button to continue 
processing. 

 If using the Unrecognized Image Utility 5

during form processing, forms continue to be 
read until you end the read process. If 

reviewing unrecognized images after form 
processing, once all forms have been 

identified, the Unrecognized Image Utility 
closes automatically. If you are also using 

Page IDs, please see the next section. 

7.9.5.b Reviewing Unrecognized Page ID 

images 

If the Data Center cannot automatically match a page to its form template, the 

Unrecognized Image Utility appears. There are three possible scenarios when using Page 

IDs: 

1. Page IDs alone: If using only Page IDs, you need to process each respondent‟s form 

completely before processing another respondent‟s form. If the pages are out of 

order for a particular respondent, the Page IDs are used to put the data in the 

correct place. If multiple respondents‟ pages are processed together, the processing 

stops and you need to sort the pages by respondent before continuing. 

2. Page IDs with Form IDs: If using Page IDs with Form IDs, the software attempts to 

first recognize the form template for the overall form and then each page of the 

form. If both the form and page are not recognized, the Unrecognized Image Utility 

first appears for the form and then again for the page. You need to process each 

respondent‟s form completely before processing another respondent‟s form. If the 

pages are out of order for a particular respondent, the Page IDs are used to put the 

data in the correct place. If multiple respondents‟ pages are processed together, the 

processing stops and you need to sort the pages by respondent before continuing. 

3. Page IDs with Form IDs and Respondent Tracker (Respondent IDs): If using Page 

IDs with Form IDs and Respondent Tracker regions, forms can be processed in 

virtually any order and still be recognized. The software attempts to first recognize 

the form, then the page and then the Respondent Tracker. The Unrecognized Image 

Utility assists you when any ID region cannot be automatically matched. When using 

Respondent Tracker with your Page IDs, you do not have to process each 

respondent‟s form in its entirety before processing another form.  

If you have chosen to review unrecognized images during form processing, the window 

appears for each unrecognized page ID region. If you have chosen not to review during 
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form processing, the images are stored in a queue so that you can process them all at 

once. 

Note: When using automatic page identification without the Respondent 
Tracker feature, you must process all pages of one complete form before 
moving on to the next form. If a page is not recognized, processing stops 
regardless of whether you are using the option to review during the read 
operation. Please sort your pages so that an entire respondent‟s form is read 
at one time. 

 

To use the Unrecognized Image Utility for Page ID regions 

 Follow the directions in Section 7.9.2 Auto Page ID to begin processing forms. If you 1

are using the Auto Form ID feature, remember to mark the Auto Form ID Mode 

checkbox in the Read Wizard. 

 If you are using the Auto Form ID feature, when the Unrecognized Image Utility 2

appears, the Form Templates list may be empty if the form was not recognized. If 
necessary, click the drop-down list to choose the correct form template for this 

image. Use the Image Viewer in the right portion of the screen to assist with 
understanding which form has been processed.  

 Once the correct form is identified (or if you are 3
not using Auto Form ID), you may select the 

page being processed. Click the Pages drop-

down list and then select the correct page for 
the form being processed. Use the Image 

Viewer in the right portion of the screen to 
assist with understanding which form page has 

been processed. 

 [Optional] If desired, click the Cancel button to 4

skip recognizing this image. This might be 
appropriate if the wrong form was scanned (or 

the wrong image was processed). If desired, 

use the Skip Image or Discard Image 
options. 

 Once you have matched a page to its form template page, click the Read button to 5
continue processing. 

 If using the Unrecognized Image Utility during form processing, forms are 6
continued to be read until you end the read process. If reviewing unrecognized 

images after form processing, once all forms have been identified, the 
Unrecognized Image Utility closes automatically. If you are also using Respondent 

Tracker regions, please see the next section. 

7.9.5.c Reviewing Unrecognized Respondent Tracker Images 

If the Data Center cannot automatically read a Respondent Tracker region the image is 

added to the Unrecognized Images queue. If you have chosen to review unrecognized 

images during form processing, the Unrecognized Image window appears for each 

unrecognized Respondent Tracker region. If you have chosen not to review unrecognized 

images during form processing, the images are stored in a queue so that you can 

process them all at once. 
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Note: If you are using the Review Exceptions feature to correct exception 
cases (either during form processing or before reviewing unrecognized 
images), it is possible to provide a valid respondent tracker value before the 
image is added to the Unrecognized Images queue. Depending on the types 
of exceptions you are reviewing, Review Exceptions may show you 
exceptions in your Respondent Tracker regions (e.g., BLANK, MULT, etc.). 
Once corrected, the software matches data records based on the 
Respondent Tracker region. Exceptions that have not been corrected in 
Review Exceptions cause the image to be added to the Unrecognized Images 
queue. 

 

To use the Unrecognized Image Utility for Respondent Tracker regions 

 Follow the directions in Section 7.9.3 Respondent Tracker to begin form processing. 1

 [Optional] If you are using the Auto Form ID feature, when the Unrecognized 2

Image Utility appears, the Form Templates list may be empty if the form was not 

recognized. If necessary, click the drop-down list to choose the correct form 
template for this image. Use the Image Viewer in the right portion of the screen to 

assist with understanding which form has been processed. NOTE: If the form is 
automatically recognized, you do not see this step. 

 [Optional] Once the correct form is identified (or if you are not using Auto Form ID), 3
you may select the page being processed, if it is not recognized. Click the Pages 

drop-down list and then select the correct page for the form being processed. Use 
the Image Viewer in the right portion of the screen to assist with understanding 

which form has been processed. NOTE: If 

the page is automatically recognized, you 
do not see this step. 

 When the Unrecognized Image Utility 4
appears for an unrecognized Respondent 

Tracker region, the Respondent Tracker 
box shows an exception color indicating 

why the software could not recognize the 
region (e.g., BLANK, MULT, etc.). Enter the 

correct response for this image in the 

Respondent ID box. Use the Image Viewer 
in the right portion of the screen to assist 

with understanding which form has been 
processed. Once the response is entered, 

the software either matches the record to 
an existing data record or begins a new 

record if the Respondent Tracker is unique to the existing data. 

 [Optional] If desired, click the Cancel button to skip recognizing this image. This 5

might be appropriate if the wrong form was scanned (or the wrong image was 

processed). If desired, use the Skip Image or Discard Image options. 

 Once you have entered the correct Respondent Tracker, click the Read button to 6

continue processing. 

 If using the Unrecognized Image Utility during form processing, forms continue to 7

be read until you end the read process. If reviewing unrecognized images after form 
processing, once all forms have been identified, the Unrecognized Image Utility 

closes automatically. 



 Processing Forms   

 149 

7.10 Batch Processing 

The Remark Office OMR Data Center includes a batch processing feature that allows you 

to process batch header forms along with your forms. Batch header forms can provide 

further information about the group of forms being processed that make your data more 

meaningful. For example, if you are processing student tests or course evaluations, you 

can process a batch header form containing information such as instructor name, class 

name, class section, and so forth. The batch header form is processed once, at the 

beginning of each batch. Then the forms that correspond to that batch header form are 

processed subsequently. The data from the header form is pre-pended to (added to the 

beginning of) each data record. You can start processing a new batch and its 

corresponding forms at any time. The header data is also available when it comes time 

to report on the data in Remark Quick Stats. 

To create a batch, you create form templates for the batch header form(s) and the form 

you wish to process with that batch header form (called a primary form template). You 

can use multiple batch header forms but only a single primary form template. You then 

combine these form templates into a batch file. Both forms must have unique Page IDs 

on them. Remark Office OMR uses the page IDs to understand when a batch header 

form is being read versus a regular form. 

 

To use batch header forms 

 Create a form template for the form you wish to process as a batch header form. 1
Ensure the form has a Page ID. (See Chapter 6 for further information about creating 

form templates.) 

 Create a form template for the form you wish to process along with the batch header 2

form. Ensure the form has a unique Page ID. (See Chapter 6 for further information 
about creating form templates.) 

 In the Remark Office OMR Data Center, 3

select the File menu and then click Batch 
Wizard. Alternatively, select the Batch 

Wizard link from the Task Pane. 

 In the Batch Wizard (Step 1) window, 4

select the form template that is being used 
as the primary form template (not the 

header form). This is the form template 
that corresponds to the form you wish to 

process after each batch header form. Click 

the Add File(s) button to add the form 
template to the Primary Form Template 

box.  

 Click the Next>> button to continue. 5
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 In the Batch Wizard (Step 2) window, 6

select the form template corresponding to 
your batch header form. Click the Add 

File(s) button to add it to the Batch 
Header Form Templates box. You may 

select multiple batch header form 
templates if desired. 

 Click the Next>> button to continue. 7

 In the Batch Wizard (Step 3) window, 8

enter a file name for the new combined 

batch file. The Data Center combines the 
form template and batch header form 

template(s) into one batch file. The new 
combined file has a .obf file extension. 

 Click the Create Batch button to combine 9
the templates and exit the Batch Wizard. 

When the batch file opens in the data grid, an 

orange line defines the end of the batch 

header form template regions from the 

beginning of the primary form regions.  

 Process the first batch header form (or forms) by starting the Read Wizard and 10
either scanning forms or reading image files. (See Section 7.3 The Remark Office 

OMR Read Wizard for detailed information about using the Read Wizard.) 

 Follow the batch header form with the forms that correspond with the group 11

identified on the batch header form. 

 When the first group of forms has been processed, insert a new batch header form 12

and follow it with the corresponding forms. 

 Continue processing forms in this fashion until you have processed all of your 13
batches. In the end, you see an entire data set with all of the batch header 

information pre-pended to the records. 

Tip: If you have already created a batch file and want to open it without 
using the Batch Wizard, select the File menu and then select Open Form 
Template. Change the Files of type drop-down list to Remark Office 
Batch Files to view available batch files.  

7.11 Server Mode 

Server Mode is a mode of operation in which Remark Office OMR runs in the 

background, processing pages or image files according to your instructions. Server Mode 

allows you to simultaneously use your computer for other projects while using Remark 

Office OMR to process forms. Server Mode can also be used to process completed forms 

that are received as image files over a network or by fax. You can use Server Mode in 

conjunction with Auto Form ID to process a variety of form types. 

Server Mode works in two ways: continuously polling the scanner for pages and/or 

checking a user-specified directory on your computer or network for image files. The 

following table summarizes how each event works. 
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Action Event Description 

Read from 

scanner 

If you have a scanner set up in Remark Office OMR, you may use 

this option. Your scanner must have an Automatic Document 
Feeder (ADF), and this feeder must be capable of telling Remark 

Office OMR when a page is placed in it (some scanners do not 
have this capability). The Data Center polls your scanner for 

pages at a user-specified interval. If pages are found, they are 
scanned automatically with the open template(s). The Data 

Center stores images of these scanned forms for later correction. 
Note that some computer performance degradation should be 

expected while a page is being scanned. 

Read from 

image files  

You may have the Data Center process image files from a folder 

that you specify on your computer or network. Supported image 
files are processed in the order of file creation date. This feature 

allows you to use scanning software that came with just about 
any input device to scan your pages. Then save these scanned 

images to a folder and the Data Center automatically processes 
them. 

 

Important Note About Using Server Mode and Page IDs: If you are 
using Page IDs with Server Mode, form processing stops if a Page ID cannot 
be recognized. You need to sort your forms/images so that each 
respondent‟s form is scanned in its entirety before another form is 
processed. See Section 7.9.2 Auto Page IDs for further information about 
using Page IDs. 

 

To scan forms using Server Mode  

 Open the correct form template. (See Section 7.2 Opening a Form Template.) 1

Tip: If you want to process multiple form types simultaneously, use Form 
IDs and each form. You can then use Server Mode with multiple form 
templates by using the Auto Form ID feature. See Sections 6.3.3 and 7.9 for 
further information about Auto Form ID. 

 Select the Tools menu and then click Read Wizard, or click . 2

Alternatively, you may select the Read 
Wizard link from the Task Pane.  

 In the Read Method window, select the 3
radio button for Read from scanner. 

 In the Advanced Collection Options 4
area, mark the checkbox for Server 

Mode. 

 Click the Next>> button to continue. 5

 If you would like to configure image 6

naming conventions, click the Next>> 
button to continue. Otherwise click the 

Read button to begin scanning pages. 
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 The Scanned Image Naming Conventions window allows you to specify options 7

about the images that are automatically stored each time you scan forms.  

 In the Begin image names with box, 8

enter a file base name that the software 
can use to name the images stored for this 

form. The default base name is the form 
template name. However, you may use any 

name you like. We suggest using something 
that identifies to you that the images 

belong to a certain form. The images that 

are stored all begin with this base name 
and then have the page number (if 

scanning a multi-page template), date and 
time appended to them to keep track of the 

various images. You may optionally choose a region from the template to use as the 
base name. The value that is collected from the form for the specified region is used 

as the base name for the corresponding stored. If you leave the Begin image 
names with option blank, your images only have the page number (if applicable), 

date and time as the name of each image.  

 In the Image target directory box, click the ellipsis (…) button to select a location 9
in which to store the images for this form. You may use the default directory for 

images or select a different directory. 

 Mark the checkbox for Save images in a subfolder based on the form 10

template’s name to have the Data Center automatically create a folder in which to 
store these images. The folder name is the name of the form template and the folder 

is created in the directory you have selected in the Image target directory box. 

Tip: We recommend using the Save images in a subfolder based on the 
form template’s name feature for easier organization of image files. Use 
of this feature keeps all images associated with this form template in one 
folder for easy access. The unique date and time portion of the image names 
prevents images from being overwritten. 

 [OPTIONAL] If desired, click the Name Builder… button to further customize the 11
stored image names and locations.  

 In the Image Base Name area, you may choose to add a region from the 
processed data to the image base name. Choose the region from the drop-down 

list and then click the Add button. 

For example, if processing tests, you 
could add a Student ID that is being 

collected from the form so that your 
processed images all have the 

Student ID number in them. 

 In the Image Target Directory 

area, you may choose to add a region 
from the processed data to the folder 

structure that holds the processed 

images. Choose the region from the 
drop-down list and then click the Add 

button. For example, if processing tests, you could add a Teacher ID that is being 
collected from the form so that each student‟s form images are stored in a folder 

containing the Teacher‟s ID number. 

 In the Name Builder box, click the OK button to return to the Read Wizard. 
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 In the Saved image type box, select an image type to use for storing images. The 12

choices are: PCX/DCX, PDF, TIF or JPG.  

 When saving to the PDF or TIF formats, you can choose the compression level under 13

Image compression level: Uncompressed, Group 3, Group 3 2d, Group 4 and 
LZW. Group 4 creates the most compressed image (smallest file size that takes up 

less space on your computer). 

 Mark the checkbox for Save multiple page form templates as multiple page 14

image files if you are scanning with a multi-page template and would like all of the 
images for one complete form to be saved as one image file. 

 If you would like to configure Review Exceptions options, click the Next>> button 15

to continue. Otherwise click the Read button to begin scanning pages. 

Note: If using Review Exceptions during Server Mode, scanning stops 
each time an exception is found until the exception is reviewed. If you turn 
on Review Exceptions in the Read Wizard, all scanning stops when an 
exception occurs and does not start again until the exception is addressed. 
You may wish to run Review Exceptions after form processing so that Server 
Mode can run uninterrupted (see Section 7.6 Reviewing Exceptions for more 
information about Review Exceptions 
after form processing). 

 In the Review Exceptions window, specify 16

whether to review exception cases during 

the reading process by marking the 
Activate Review Exceptions checkbox.  

 In the Review Exceptions Options area, 17
mark the checkboxes for those cases that 

you wish to review during reading. The 
following options are available: Multiple 

responses, Blank responses, 
Recognition errors, Image regions, 

Database Lookup regions, Barcode regions, OCR regions, Repeated rank 

responses or Required items. 

Note: Review Exceptions can also be run after all the forms are processed if 
you prefer not to stop processing when problems occur.  

 Place the completed forms in the scanner. 18

 Click the Read button to begin processing pages. 19

When you click the Read button in the Read Wizard window, Server Mode begins and 

you may continue working in other Windows applications. By default, Remark Office 

OMR polls the scanner every five seconds for pages. If you want to change the number 

of seconds between polls, select the Tools Menu and then click Preferences. You will 

see the System poll interval during Server Mode setting under the General section. 

 

To read image files using Server Mode  

 Open the correct form template. (See Section 7.2 Opening a Form Template.) 1

 Select the Tools menu and then click Read Wizard, or click . 2

Alternatively, you may select the Read Wizard link from the Task Pane. 

 In the Read Method window, select the radio button for Read from image files. 3
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 If desired, click the link for Advanced Image Recognition Properties. This link 4

allows you to set the following options: Invert image, Auto deskew images 
during recognition, Auto despeckle images during recognition. 

Caution: We do not suggest making changes to the Advanced Image 
Recognition Properties unless you encounter difficulties related to these 
settings. 

 In the Advanced Collection Options 5
area, mark the checkbox for Server Mode. 

The Auto Form ID and Package and 
rename images options are also available 

in Server Mode. 

 Click the Next>> button to continue. 6

 In the Image Source Directories area, 7

use the Add Directories button to locate 
the folder(s) on your computer or network 

that contains the images you wish to 
process. Any images found in the folders 

listed here are processed, based on the filters you select in the next step. 

 In the Image Filters area, mark the checkboxes corresponding to the types of 8

images in the Image source directory that you wish to process. Only images 
corresponding to these file types are read; all others are ignored. 

Tip: The last item in the Image Filters list is *.*, meaning all image types. 
Mark this checkbox if you want all images in the source directory to be read. 
Note that only images of the software‟s supported file types are processed. 

 If desired, you may use the Custom Filters box to further refine your file list. You 9

can specify specific cases here by using wildcards. For example, if you wanted to 
process all images that start with 

“English 101” you could enter “English 
101*.*” as a custom filter. Only images 

that start with this text are processed. 
Type the custom filter into the Custom 

Filter box and then click the Add 
button. The filter is added to the Image 

Filters list and automatically selected. 

Unused custom filters are removed from 
the list automatically the next time you 

run the Read Wizard. 

 If desired, mark the checkbox for 10

Delete images after they have been processed to remove the images from the 
specified directories after the Data Center has processed them. 

Note: Marking this checkbox permanently deletes the images! However, if 
you do not delete the images and stop and start Server Mode, the same 
images are processed again if they still reside in the specified folder(s). You 
may wish to consider creating a batch file on your own to move the 
processed images to a different location once they have been read. 

 Click the Next>> button to continue. 11

 [OPTIONAL] If you chose the Package and rename images option on the first step 12
of the Read Wizard, the Image Naming Conventions window appears. The Image 
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Naming Conventions window allows you to specify options for repackaging the 

processed images. 

 In the Begin image names with box, enter a file base name that the software 

can use to name the images of each form. The default base name is the form 
template name; however, you may use any name you like. We suggest using 

something that identifies to you that the images belong to a certain form. The 
images that are stored all begin with this base name and then have the page 

number (if processing a multi-page template), date and time appended to them 
to keep track of the various images. You may optionally choose a region from the 

form template to use as the base name. The value that is collected from the form 

for the specified region is used as the base name for the corresponding stored 
image. If you leave the Begin image names with option blank, your images 

only have the page number (if applicable), date and time as the name of each 
image.  

 In the Image target directory box, click the ellipsis (…) button to select a 
location in which to store the images for this form. You may use the default 

directory for images or select a different directory on your computer, external 
drive or network. 

Note: Choose the image location carefully. The images should remain in this 
location once the data is saved using the RMK format if you want to retain 
the link between the processed data and each image file. This link allows 
you to view the forms on screen as you click through the data grid, making 
it easy to correct exceptions in your data. Therefore, you should plan ahead 
on how you will store these images when the forms are processed. 

Tip: If you are sharing files with other Remark Office OMR users, you may 
wish to save the image files on a shared network drive that all users have 
access to in the same manner (e.g., through a mapped network drive). 

 Mark the checkbox for Save images in a subfolder based on the form 

template’s name to have the Data Center automatically create a folder in which 
to store these images. The folder name is the name of the form template and the 

folder is created in the directory you have selected in the Image target directory 
box. 

Tip: We recommend using the Save images in a subfolder based on the 
form template’s name feature for easier organization of image files. Use 
of this feature keeps all images associated with each form template in one 
folder for easy access. The unique date and time portion of the image names 
prevents images from being overwritten. 

 [Optional] If desired, click the Name Builder… button to further customize the 

stored image names and locations.  

o In the Image Base Name 

area, you may choose to add 
a region from the processed 

data to the image base name. 
Choose the region from the 

drop-down list and then click 

the Add button. For example, 
if processing tests, you could 

add a Student Name field that 
is being collected from the 

form so that your repackaged 
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images all begin with the students‟ names. 

o In the Image Target Directory area, you may choose to add a region 
from the processed data to the folder structure that holds the repackaged 

images. Choose the region from the drop-down list and then click the Add 
button. For example, if processing tests, you could add teacher name and 

student ID fields that are being collected from the form so that each 
student‟s form images are stored in a folder containing the teacher‟s name 

and then a subfolder named by the student ID number. 

o In the Name Builder box, click the OK button to return to the Read 

Wizard. 

 In the Saved image type box, select an image type to use for storing the 
repackaged images. The choices are: PCX/DCX, PDF, TIF or JPG. For example, 

you may be processing TIF images, but want to repackage them as PDF files for 
others to view. 

 When saving to the PDF or TIF formats, you can choose the compression level 
under Image compression level: Uncompressed, Group 3, Group 3 2d, 

Group 4 and LZW. Group 4 creates the most compressed image (smallest file 
size that takes up less space on your computer). 

 Mark the checkbox for Save multiple page form templates as multiple page 

image files if you are processing a multi-page form and would like all of the 
images for one complete form to be saved as one image file. Using this option 

creates fewer image files and is recommended. 

 If you would like to configure Review Exceptions options, click the Next>> button 13

to continue. Otherwise click the Read button to begin processing image files. 

Note: If using Review Exceptions during Server Mode, processing stops 
each time an exception is found until the exception is reviewed. If you turn 
on Review Exceptions in the Read Wizard, all processing stops when an 
exception occurs and does not start again until the exception is addressed. 
You may wish to run Review Exceptions after form processing so that Server 
Mode can run uninterrupted (see Section 7.6 Reviewing Exceptions for more 
information about Review Exceptions after form processing). 

 In the Review Exceptions window, 14

specify whether to review exception cases 
during the reading process by marking 

the Activate Review Exceptions 
checkbox.  

 In the Review Exceptions Options 15
area, mark the checkboxes for those 

cases that you wish to review during 
reading. The following options are 

available: Multiple responses, Blank 

responses, Recognition errors, Image 
regions, Database Lookup regions, 

Barcode regions, OCR regions, Repeated 
rank responses or Required items. 

 Click the Read button to begin processing image files. 16

When you click the Read button in the Read Wizard window, Server Mode begins and 

you may continue working in other Windows applications. By default, the Data Center 

polls the specified image directory every five seconds for images. If you want to change 
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the number of seconds between polls, select the Tools Menu and then click 

Preferences. You will see the System poll interval during Server Mode setting 

under the General section. 

 

To end Server Mode 

 Select the Tools menu and then click Stop Server Mode, or click , to stop 1

Server Mode and allow access to the full Remark Office OMR feature set. 

7.12 Respondent Detection 

Remark Office OMR includes the ability to determine which respondents‟ forms have 

been processed, as well as locating duplicate respondents. This feature, called 

Respondent Detection, is used in conjunction with Database Lookup. If a region is linked 

to an external database using Database Lookup, the software provides a report of which 

respondents listed in the external database have been processed, not been processed or 

have been processed more than one time. For example, suppose you have a region on 

your form where the respondent fills in an ID number. You can link this ID number 

region to an external database that has all of the ID numbers of your expected group of 

respondents. You can then use Respondent Detection to compare IDs collected in the 

data set to IDs in the external database. Any time you use the Respondent Detection 

feature, you also have the option to return additional data from the external database if 

desired (this is not required to use Respondent Detection). When you process your 

forms, Remark Office OMR confirms which ID numbers from the external database exist 

in the processed data. The software then provides a report showing found ID numbers, 

missing ID numbers and duplicate ID numbers. If you are returning additional fields, this 

information is also available in the report. You can save this report as a text file to use 

outside of Remark Office OMR. 

 

To use Respondent Detection 

 Setup a form template that uses the Database Lookup feature. See Section 6.3.4 1

Database Lookup for complete details on using Database Lookup. 

 Process forms using the scanner or by reading from image file. See Section 7.3 The 2

Remark Office OMR Read Wizard for information 
about using the Read Wizard to process forms. 

 Once the forms have been processed and the 3
data cleaned, select the Tools menu and then 

click Respondent Detection, or click 

. The Respondent Detection 

wizard appears. 

 From the Regions available for detection 4

drop-down list, select the form template region 
you wish to use for detection. 
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 If the region is linked to a database containing additional fields, you may optionally 5

select those fields from the Database Field List. Use the green arrow to move the 
desired fields into the Additional Fields box. Any fields moved to the Additional 

Fields box are also used for detecting 
respondents. 

 Click the Next>> button to continue. The 6
Detection Results window appears.  

 Use the Detection Results window to view 7
your results. The main region on which you are 

basing the detection is listed first. You then see 

a Detected column that marks the values that 
were detected. The Duplicates column is next, 

which marks any duplicate values that are 
found. After the Duplicates column, you see 

any additional return fields from the external 
database that you selected in Step 5 (if you 

selected any). 

 If desired, use the Export button to save the 8

results to an external file. You may click the Export button to export the entire set 

of results, or use the arrow on the Export button to select which portions of the 
results to export. The export options are as follows: 

 

Option Function 

Export Exports all results (region, detected, missing, duplicates 

and additional fields). 

Export 
Missing 

Exports only the missing respondents, those that exist in 
the external database but were not processed as part of 

the data file. 

Export 

Detected 

Exports only the detected respondents, those that both 

exist in the external database and were processed as part 
of the data file. 

Export 

Duplicates 

Exports only the duplicate respondents, those that appear 

more than once in the data file. The software only detects 
duplicate entries that have also been verified as existing in 

the linked database. 

Print Results Prints all results to the default printer on your computer. 

 

 Click the Close button to return to the Remark Office OMR Data Center. 9

7.13 Reviewing Duplicate Responses 

Remark Office OMR includes a feature to detect duplicate responses even when not 

using the Database Lookup feature with Respondent Detection, as described in the 

previous section. The Review Duplicates feature allows you to choose any region in the 

data grid in which to search for duplicates. When a duplicate entry is found, you are 

prompted to take one of four possible actions: review the duplicates, keep only the first 
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duplicate record, keep only the last duplicate record or delete all duplicate records. 

During the review process, the data grid is automatically sorted on your duplicate 

identifier region so that you can easily review the data. This feature is useful if you 

accidentally process a form multiple times, or someone fills out a form multiple times 

when this is not permitted. 

 

To use Review Duplicates 

 Open a form template and process forms by either scanning or reading pre-scanned 1

images. See Section 7.3 The Remark Office OMR Read Wizard for information about 
using the Read Wizard to process forms. 

 Once the data is collected and cleaned, select the Tools menu and then click 2

Review Duplicates, or click , to launch the Review Duplicates Task 

Pane. Alternatively, select Review 

Duplicates from the Task Pane. 

 In the Review Duplicates Task Pane 3
on the left side of the window, use 

the Unique respondent identifier 
drop-down list to choose a region or 

image files from your data that you 
want to check for duplicate entries. 

Using the image files option is useful 
if an entire set of forms was 

accidentally processed twice. If the 

same set of images exists more than 
one time (based on the image file 

names), the images are flagged as duplicates. 

 Click the Search button to begin the search for duplicate entries. The gold bar 4

underneath The Unique respondent identifier box tells you whether duplicates 
were found. The data is sorted based on the duplicates that are found.  

 Determine the action you wish to take. If you want to review the duplicates before 5
taking action, choose Review duplicate records in the Action drop-down list and 

then click the Execute button. Remark Office OMR highlights any sets of duplicate 

records it finds. You may use the green arrows in the Navigate area to move 
between records. The Next Record arrow takes you to the next duplicate record 

within the same group. The Next Group arrow takes you to the next group of 
duplicates (you may have more than one set of duplicates within the same region). 

Similarly, the Previous Record arrow takes you back to the previous duplicate 
record within the same group, and the Previous Group record takes you back to the 

previous group of duplicate records. 

 If you have chosen to review the duplicate records, you have two options. You can 6

choose a specific record and delete it manually by clicking the Delete button. Or, 

you may click the Finish button and then review the region again. Then to perform a 
mass function, in the Action drop-down list, choose the appropriate action: Keep 

only first duplicate records, Keep only last duplicate record or Delete all 
duplicate records. Any one of these three choices applies to all sets of duplicate 

records within the region. 

 If you choose any action that causes records to be deleted, you receive a warning 7

message to ensure that you want to delete the records. Note that once the records 
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are deleted, they cannot be recovered (unless you process the forms again). If you 

are sure you want to proceed, click the Yes button. The requested action is taken. 

 If you wish to search for more duplicates in other regions, repeat steps 3 through 7. 8

 When you are finished reviewing duplicates, click the Finish button. 9

Click the Back arrow underneath Review Duplicates to return to the full Task 

Pane. 

7.14 Software Recognition Settings 

Out of the box, Remark Office OMR comes with the recognition settings that are optimal 

for a well designed and tested scannable form. However, circumstances can introduce 

recognition problems. Here are few things that can potentially interfere with proper 

recognition of your forms: 

 Respondents who do not fill bubbles completely or use light marks, cross out 

responses, erase responses or use white out to change responses 

 Forms that are scanned upside down 

 Forms that are accidentally scanned with the wrong batch, including blank forms 

 Form images that are compressed or expanded as compared to the original form 

template image 

 Forms that are much lighter or darker than the original 

Remark Office OMR has several recognition settings that can help you compensate for 

these issues. Please note that you may have to try a few adjustments to get the right 

settings for your particular form. Recognition Settings can be either software based or 

form template based.  

You can access the Recognition Settings in three ways: 

1. Select Tools|Recognition Settings|Default Settings or Tools|Recognition 

Settings|Template Settings. 

2. From the Data tab in the left Task Pane click View|Recognition Settings. 

3. From the Read Wizard, Step 1, click the Recognition Settings link. 

The Recognition Settings are broken into two parts: Recognition and Image Pre-

processing. The Recognition settings apply throughout the software whether you are 

reading forms directly from a scanner or reading pre-processed image files. The Image 

Pre-processing settings only apply when reading pre-scanned image files from a 

directory folder. 

Recognition settings are stored in two places: as global software defaults and with the 

form template to which they were applied. Choose the link that best meets your needs. 

If a specific form template is causing problems, open it in the Data Center first, then 

adjust only its recognition settings using either the Tools|Recognition 

Settings|Template Settings option or the Recognition Settings link within the Read 

Wizard. If you wish to change recognition settings across the board for all new form 

templates, use the Tools|Recognition Settings|Default Settings option. When 

recognition settings are adjusted for a particular form template, those settings override 

any global settings. Global settings apply to any form templates that have never been 
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used. The first time you use the form template, the global settings are in effect and 

remain in effect until you make changes while the form template is active. 

Note: The settings you apply to a form template are stored in each user‟s 
preferences file. Therefore, if you share form templates or have different 
users accessing the same form template on the same machine, the settings 
could vary. Be sure to coordinate any changes you make to the recognition 
settings on the form template level with any other Remark users. 

The Recognition Settings window has a Defaults button. If you are in the global software 

defaults, clicking the Defaults button returns the software to the original installation 

defaults. If you have a form template open and are viewing the recognition settings for 

that form template, clicking the Defaults button resets the settings to the global default 

settings.  

Note: The recognition settings are not a substitute for good form design and 
proper procedures for processing forms. It is very important that you follow 
the form design guidelines in Chapter 5 when creating scannable forms, as 
well as the best practices laid out in this user‟s guide (e.g., creating a form 
template image from the same quality form you are distributing to 
respondents and maintaining scanner settings from the form template to the 
filled in forms). These recognition settings are intended to supplement good 
form design and best practices. 

7.14.a Threshold Overrides 

There are three types of threshold overrides: OMR Region, Image Region and OCR 

Region. Thresholds are used behind the scenes to define tolerance levels when 

determining if a mark is filled (OMR regions, text is recognizable (OCR regions) or if 

handwriting is present (Image regions). When setting thresholds in the Recognition 

Settings, you are setting them globally, meaning they override the form template 

settings for the same feature. Threshold Overrides are off by default. You should only 

change the threshold from the default setting if you encounter recognition problems, as 

described in the next three paragraphs. 

OMR Threshold: The OMR Threshold is a value from 1 to 6, with 3 being the default. 

Using a lower value makes the software more sensitive. Lower values can be used to 

help pick up lighter markings (e.g., pencil), or when respondents do not fill a large 

portion of the mark. Use caution as you go lower; a value of 1 may cause erroneous 

marks, such as erasures, to be seen as filled marks. 

Higher values for the Recognition Threshold can be used to make the software more 

discriminating when multiple marks are filled. For example, if two marks are filled and 

one is erased, leaving some marking behind, or one is partially filled, a higher 

Recognition Threshold can help Remark Office OMR figure out which mark is filled. Very 

high Recognition Thresholds cause the software to be quite discriminating, meaning that 

it may choose a mark that is X‟d out as the most filled when that was not the intention 

of the respondent. (Note: See Section 7.14.d for using large marks to correct marks that 

are accidentally selected.) 

Image Threshold: The Image Threshold is a value from 1 to 6, with 3 being the 

default. Using a lower value makes the software more sensitive. Lower values can be 

used to help pick up lighter markings (e.g., pencil), or when respondents do not fill a 
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large portion of the area in which they can hand write responses. Use caution as you go 

lower; a value of 1 may cause false positives during form processing. 

Higher values for the Recognition Threshold can be used to make the software more 

discriminating when looking for handwriting in an Image region. Very high Recognition 

Thresholds may cause the software to not pick up some handwriting (e.g., if only a few 

words are written in a large space or light writing is used, such as pencil). However, it 

reduces the likelihood that unintended marks are picked up (e.g., stray marks and 

erasures). 

OCR Threshold: The OCR Threshold setting ranges from 1-100% with a default setting 

of 70%. The threshold applies to each individual character in the text you are trying to 

recognize. The software returns a confidence value for each character recognized (e.g., 

62% certain it is a “G”). If any character returns a confidence value lower than the 

specified threshold, the OCR field is flagged as an exception for your review. If you find 

that regions are being flagged as blue during processing, indicating an OCR exception, 

but the text is read correctly, you can lower the Recognition Threshold. If you find that 

text is not being flagged but is being incorrectly interpreted, you can raise the OCR 

Threshold. 

 

To change thresholds 

 Determine the threshold you wish to 1
override.  

 Mark the appropriate checkbox for OMR 2
Threshold, Image Threshold and/or OCR 

Threshold. 

 Choose the desired value (1-6 for OMR and 3

Image Regions, a percentage for OCR 
regions, as previously described). 

 Click the OK button. 4

The adjusted settings apply to your next Read 

operation and stay in place until you change 

them again. 

7.14.b Auto Rotate  

The Auto Rotate feature causes the software to try to rotate form images if it cannot 

properly read the form during the first pass. If a form is accidentally scanned upside 

down, the Auto Rotate feature will flip the scanned image right side up and try the 

recognition again. This feature is on by default, and it is recommended that you keep it 

on. The default threshold is 25%, meaning that if the percentage of questions on the 

page contains 25% or more errors, Remark Office OMR will try to rotate the image and 

re-recognize the page. If the error rate is not better than the original pass, no new 

results are recorded and the image will not be rotated. 25% is generally a good number 

to use. Use a lower percentage if you want the software to find fewer errors before it 

tries to rotate the page (less error tolerance). Use a higher percentage if you want the 

software to find more errors before it tries to rotate the page (more error tolerance).  
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To use Auto Rotate 

 Mark the checkbox for Automatically 1
Rotate Images. 

 Choose the desired percentage of questions 2
in which errors are found that should trigger 

the rotation (25% is recommended). 

 Click the OK button. 3

The adjusted settings apply to your next Read 

operation and stay in place until you change 

them again. 

7.14.c Advanced Settings 

The Advanced Settings features include some behind the scenes advanced processing 

techniques and the ability to compensate for degraded marks. Enhanced Reading Mode 

is on by default, and we recommend keeping it on. Compensate for Missing and 

Damaged Marks is not on by default. You should turn it on when you encounter forms 

that have degraded images, such as optical marks (bubbles) that have been “whited” 

out or erased. 

Enhanced Reading Mode: Enhanced Reading Mode allows the software to do more in 

depth recognition of uncertain regions. 

Compensate for Missing and Damaged Marks: The Compensate for Missing and 

Damaged Marks setting allows Remark Office OMR to still recognize responses when 

marks (bubbles) are missing or partially missing. For example, respondents may have 

tried to erase an incorrect response, taking some of the mark with them. Or they may 

have used white out to remove a mark altogether. Without this feature, these cases 

would result in recognition errors. 

You can set a tolerance for missing and damaged marks on a region basis and on a 

question basis. The default setting for regions is 30%. This setting means that if 30% or 

more of a single region‟s marks are missing or damaged, a recognition error is output. 

The default setting for questions is 50%. This setting means that if 50% or more of a 

single question‟s marks are missing or damaged, a recognition error is output. Once the 

number of errors exceeds the specified threshold, the errors are reported (e.g., as 

recognition errors in the data grid). If the number of errors does not exceed the 

threshold, then the missing or damaged marks are considered unfilled. 

Note: The software must be able to 
recognize at least one complete OMR 
region consisting of four or more bubbles 
in order for the Compensate for Missing 
and Damaged Marks feature to be active. 

 

To use Enhanced Reading Mode 

 Mark the checkbox for Use Enhanced 1

Reading Mode. 
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 Click the OK button.  2

The adjusted settings apply to your next Read operation and stay in place until you 

change them again. 

 

To use Compensate for Missing and Damaged Marks 

 Mark the checkbox for Compensate for 1

Missing and Damaged Marks. 

 Region damage threshold: Choose the 2

desired percentage of each region‟s marks 
above which recognition errors should be 

reported (30% is recommended as a starting 
point). 

 Question damage threshold: Choose the 3
desired percentage of each question‟s marks 

above which recognition errors should be 

reported (50% is recommended as a starting 
point). 

 Click the OK button. 4

The adjusted settings apply to your next Read operation and stay in place until you 

change them again. 

7.14.d Ignore Large Marks 

The Ignore Large Marks option lets you allow respondents to put large marks, such as 

an X, through a response that was marked by mistake (as opposed to erasing it or 

trying to use white out to remove it). If the software finds a large X or slash through a 

bubble, it tries to ignore it. If you want to use this feature, you should tell respondents 

how to mark bubbles they did not mean to fill, and include a graphic representation with 

the X or slash through the mismarked bubble. The Ignore Large Marks feature is off by 

default. 

Use the Large mark threshold to tell the software how to interpret the large marks. 

The default value is 2. Use a lower value to have the software be more likely to 

recognize a large X or slash and ignore the mark. Use a higher value to have the 

software be less likely to recognize a large X or slash and therefore include the mark in 

the recognition process.  

Use the Only ignore large marks if the question contains multiple responses 

option to only turn on this feature when Remark Office OMR detects multiple responses 

and one or more (but not all) of the responses is a large mark. Questions that contain 

only large marks report all of the responses selected. Therefore if a respondent uses all 

X‟s or slashes on the form, they are not accidentally misinterpreted as large marks. This 

option is on by default when the Ignore Large Marks feature is turned on. 

Note: If you are using this feature and respondents‟ large X or slash go into 
or very close to an adjacent bubble you risk that Remark Office OMR also 
ignores the adjacent bubble. When designing your form, be sure to allow 
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enough space in between bubbles, both vertically and horizontally to allow 
respondents to make a large mark. 

 

To use Ignore Large Marks 

 Mark the checkbox for Ignore Large 1
Marks. 

 Choose the desired Large mark 2

threshold (2 is the default) as previously 
described. 

 If desired, mark the checkbox for Only 3
ignore large marks if the question 

contains multiple responses, as 
previously described (recommended). 

 Click the OK button. 4

The adjusted settings apply to your next Read operation and stay in place until you 

change them again. 

7.14.e Dynamic Brightness Compensation 

The Dynamic Brightness Compensation feature automatically compensates for processed 

form images where the brightness of the image differs from that of the form template 

image. It is always recommended that you a) use the same quality form that you 

distribute for your form template image, and b) use the same scanner settings, such as 

brightness, for the form template image and the scanned forms. However, due to real 

world circumstances that may be beyond your control, the filled in forms returned for 

processing may have some differentiation in brightness. For example, they may have 

been photocopied or printed at a lighter density setting. Or they may have been scanned 

on a different scanner or with different scanner settings than those that were used for 

the form template. While Dynamic Brightness Compensation cannot compensate for 

every instance of form differences, it can help you in these situations. If the filled in 

form image is darker or lighter than the template image, the software tries to still 

recognize the regions on the form. The Brightness Compensation Threshold determines 

when to compensate. If the brightness of the filled in form image is more than the 

specified percentage lighter or darker, Remark Office OMR attempts to compensate for it 

when producing data. The default percentage is 5%. Use a lower percentage to make 

the software more sensitive to lightness/darkness changes (compensating more 

frequently). Use a higher percentage to make the software less sensitive to 

lightness/darkness changes (allowing larger differences in image brightness before 

compensating). 
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To use Dynamic Brightness Compensation 

 Mark the checkbox for Dynamic 1
Brightness Compensation. 

 Choose the desired Brightness 2
compensation threshold (5% is the 

default) as previously described. 

 Click the OK button. 3

The adjusted settings apply to your next Read 

operation and stay in place until you change 

them again. 

7.14.f Blank Page Detection 

The Blank Page Detection option allows you to automatically detect when a blank page is 

scanned and remove it from the recognition process. For example, suppose you have the 

duplex option turned on for your scanner but are scanning a single sided form. Using 

Blank Page Detection, the backsides that the duplex scanner picks up are ignored. Or, if 

a blank page is accidentally scanned with valid pages, it is ignored. This feature is also 

useful if your form has an odd number of pages (e.g., three double sided pages). You 

don‟t have to create a blank backside in the form template; you can simply ignore the 

blank pages. 

The Blank Page Fill Threshold determines how much of the page must be filled in order 

for it to be ignored. The default setting is 10%, meaning that if the page‟s fill percentage 

is less than 10% of the template‟s lowest fill percentage the page is ignored. Use a lower 

percentage to require less fill on the page in order for the page to be considered blank 

(less sensitive). Use a higher percentage to require more fill on the page in order for the 

page to be considered blank (more sensitive). 

To use Blank Page Detection 

 Mark the checkbox for Ignore Blank 1

Pages. 

 Choose the desired Blank page fill 2

threshold (10% is the default) as 

previously described. 

 Click the OK button. 3

The adjusted settings apply to your next Read 

operation and stay in place until you change 

them again. 

7.14.g Page Error Detection 

The Page Error Detection option allows you to queue pages that contain many errors for 

later review. If a page contains more OMR or barcode errors than the threshold you 

have set, the page‟s image is placed in the Unrecognized Images Queue. You can then 

review all of the images in the queue and decide whether to keep or discard them. It is 
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strongly recommended that before you use this feature, you read Section 7.9.5 on using 

the Unrecognized Images Queue. 

Note: Multiple response (green cells) and blank response (yellow BLANK 
cells) errors are not part of the error percentage used for detecting page 
errors. Page errors are recognition errors where the OMR region or barcode 
simply could not be read. 

Use the Page Error Threshold to set how much of the page must contain errors before it 

is put in the unrecognized images queue. The default setting is 40%. Use a lower 

percentage to require fewer errors on the page before the image is sent to the 

unrecognized images queue. Use a higher percentage to require more errors on the 

page before the image is sent to the unrecognized images queue. 

 

To use Page Error Detection 

 Mark the checkbox for Page Error 1
Detection. 

 Choose the desired Page error threshold 2
(40% is the default) as previously 

described. 

 Click the OK button. 3

The adjusted settings apply to your next Read 

operation and stay in place until you change 

them again. 

7.14.h Bit Depth Reduction 

When using color or grayscale images with Remark Office OMR, they must first be 

converted to black and white before they can be properly recognized. The software has 

to figure out which pixels are black and which are white. 

Tip: A pixel is the smallest single component of a digital image. Therefore a 
single image is made up of many pixels. 

Remember that if you use black and white native images, this conversion does not need 

to happen; this is why we recommend using black and white images to reduce the 

processing load whenever possible. 

Generally the software can do this conversion automatically. However, if the standard 

conversion produces images that are too light or too dark, you can use the Bit Depth 

Reduction settings to fine tune the conversion process. There are individual settings for 

black and white conversions. 

Use the Black Bit Depth Conversion Threshold to adjust the thresholds for converting 

pixels to black. The default setting is 175. Use a lower number to make the image 

lighter. Use a higher number to make the image darker. For example, using a higher 

number could help light pencil marks appear darker and aid with recognition of those 

lighter marks. 

Use the White Bit Depth Conversion Threshold to adjust the thresholds for converting 

pixels to white. The default setting is 225. Use a lower number to make the image 
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lighter. Use a higher number to make the image darker. For example, using a lower 

number could help erasures become less visible during processing. 

 

To use Bit Depth Reduction 

 Mark the Enable Black Bit Depth Conversion Threshold checkbox to adjust the 1

black threshold. 

 Choose the desired threshold, as described previously (175 is the default). You may 2
need to try a few different thresholds before 

you get it just right for your form. 

 Mark the Enable White Bit Depth 3

Conversion Threshold checkbox to adjust 
the white threshold. 

 Choose the desired threshold, as described 4
previously (225 is the default). You may 

need to try a few different thresholds before 

you get it just right for your form. 

 Click the OK button. 5

The adjusted settings apply to your next Read 

operation and stay in place until you change them again. 

 

Sections 7.14.i – 7.14.k apply to pre-processed image files only and are accessed via 

Tools|Recognition Settings|Default Settings/Template Settings|Image Pre-

processing. 

7.14.i Invert Image 

The Invert Image option applies to pre-processed images only. Use the Invert image 

option to correct an image that appears in reverse: black background with white text. 

The default setting is No. You only need to adjust this setting if your image comes in 

reversed. 

 

To use Invert Image 

 Under Tools|Recognition Settings|Image 1

Pre-Processing, use the drop-down list for 
Invert image to select Yes if you want to turn 

on the invert image feature. 

 Click the OK button. 2

The adjusted settings apply to your next Read 

operation and stay in place until you change them 

again. 
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7.14.j Deskew Images During Recognition 

The Deskew Images During Recognition option applies to pre-processed images only. 

Use the Deskew Images During Recognition option to correct an image that is 

crooked. The default setting is off. You only need to adjust this setting if your image 

comes in crooked. 

 

To use Deskew Images During Recognition 

 Under Tools|Recognition Settings|Image 1

Pre-Processing mark the checkbox for 
Deskew Images During Recognition to turn 

on the deskew image feature. 

 Click the OK button. 2

The adjusted settings apply to your next Read 

operation and stay in place until you change them 

again. 

7.14.k Despeckle Images During Recognition 

The Despeckle Images During Recognition option applies to pre-processed images only. 

Use the Despeckle Images During Recognition option to correct an image that has 

specks on it. Specks are typically caused by colored paper, shading on the form, using a 

dark brightness setting on your scanner or a dirty scanner. The default setting is off. You 

only need to adjust this setting if your image comes in with speckles. 

 

To use Despeckle Images During Recognition 

 Under Tools|Recognition Settings|Image 1
Pre-Processing mark the checkbox for 

Despeckle Images During Recognition to 

turn on the deskew image feature. 

 Choose the Maximum speckle size to 2

remove in pixels. 2 is the default setting. If 
the specks are larger, you can use a higher 

number. 

 Click the OK button. 3

The adjusted settings apply to your next Read 

operation and stay in place until you change them 

again. 
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7.15 Recognition Tools 

When form recognition errors occur, Remark Office OMR offers tools to help you 

diagnose and troubleshoot why the errors are occurring. The Recognition Tools feature 

allows you to view form template region offset, giving you an opportunity to reset your 

form template to the processed image on the fly and re-recognize the form. You can also 

save revised form templates as new form template files. This feature is useful, for 

example, if you receive forms from various sources and they are all offset from the 

original used to create the form template. Instead of resetting the form template for 

every batch, you can reset it to the batch in the Data Center. Another example where 

this feature is useful is if you photocopy forms. Suppose you run out of forms and 

photocopy more forms from a photocopy. It is very likely that the new batch will be 

offset compared to the old batch. Using the Recognition Tools, you can reset the form 

template to the new batch on the fly. 

The Image Viewer is required to use the Recognition Tools feature. If the Image Viewer 

is not visible, click View|Image Viewer to turn it on. You may also find it helpful to 

close the Graph Viewer when using the Recognition Tools so that you have more room 

for the Image Viewer. 

The Recognition Tools feature can only be used on data where the links to the images 

are intact. You can use the feature with data you just scanned or read from image files 

as well as with data saved to the RMK or ROA formats. If the data is saved to a different 

format, where the link to the processed images is no longer present, the Recognition 

Tools feature has no effect on the data. 

Tip: It is useful to review the previous section on Recognition Settings 
before attempting to use the Recognition Tools. Combining Recognition 
Settings with the Recognition Tools can provide the most assistance with 
processing forms that are generating recognition errors. 

The Recognition Tools draw feature allows for three basic activities, all of which are 

visible in the Image Viewer: 

1. Draw Active Question: Highlights the active question so that you can see where 

Remark is attempting to find data on the image. Active questions display in a dark 

yellow color. 

2. Draw All Regions: Highlights all regions on the image so that you can see where 

Remark is attempting to find data on the image. These regions display in a light 

yellow color. 

3. Draw Template Regions: Highlights all of the form template regions as they were 

defined when you created the form template. By viewing the defined form template 

regions and the current form template regions on the selected image, you can easily 

see any offset. Form template regions display in a gray color. 

When viewing regions, if you notice that the image is significantly offset compared to the 

form template image, you can move regions, optionally save your changes and then re-

recognize the data. Original form template regions cannot be moved, but you can move 

the yellow regions that display when you select Draw All Regions. Once you have the 
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regions moved to the correct place on the specific image, you have three options for re-

reading forms: 

1. Re-read Region: The Re-read Region option reads only the active region for the 

selected image. This option is best when you are having problems with only a 

specific region on a specific image. 

2. Re-read Page: The Re-read Page option reads all of the regions on the active page. 

The entire page is re-read regardless of the Draw options chosen. This option is best 

when an entire image within a batch is shifted. 

3. Re-read Batch: The Re-read Batch option reads all of the images corresponding to 

the data in the data grid. The entire batch is re-read regardless of the Draw options 

chosen. If you would only like to select a portion of the records to re-read, choose 

the grid rows and then select the Re-Read Batch option. This option is best when you 

know an entire batch of forms is offset in the same way (e.g., all from the same 

photocopied form that is shifted to the left/right/top/bottom).  

When you make changes to the positioning of the regions, you may optionally save the 

form template as a new form template. This feature is helpful if you want to re-read an 

entire batch of forms using the adjusted positions. Suppose you discover that the new 

batch of forms was created off of a different printer or photocopied from a new 

photocopier. You may wish to save the adjusted form template so that you can continue 

using it with the newly offset forms or to re-read the current batch with the modified 

form template. If you attempt to re-read a batch without saving your modifications, the 

changes are lost and not applied while reading.                

Note: The newly saved templates have the new region locations saved with 
the original form template images. Therefore, if the newly modified template 
is opened in the template editor, the regions may or may not line-up 
correctly. Ideally, you should replace the image with a more appropriate one 
if you want to edit the template in the template editor (See Resetting 
Template Images in Section 6.4.7). 

 

To use Recognition Tools 

 After processing data or opening an RMK/ROA data file, click the Data tab in the 1

Task Pane (if it is not already active). 

 Select the link called Recognition Tools. The Task Pane changes to reflect the 2

available options. If the Image Viewer is not showing, click View|Image Viewer. 

 Determine what you want to view, based on the descriptions above: Draw Active 3

Region, Draw All Regions and/or Draw 

Template Regions. 

 Once you have viewed the desired 4

regions, make adjustments to the regions 
by clicking them with the mouse and 

dragging them to the desired place on the 
image. Remember that only the Draw All 

Regions option allows you to move 
regions in order to re-recognize them. 

 If you wish to save the changes to a new 5

form template, click the Save Template 
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Changes link in the Task Pane. Select a template name and location for the new file. 

We do not recommend overwriting the original template file. If you do not save the 
form template, all changes are lost. 

Tip: If you are working from a saved data file and save the new form 
template, when you open the new form template with the old data file 
together, you receive an error stating that the files do not match. As long as 
you did not change the structure of the form template file (in the Template 
Editor), you should be able to click OK to attempt to open the data file 
anyway. Remark Office OMR is only displaying an error because the data 
was not originally saved with the new form template. 

 If you want to re-read the images, choose one of the available options based on the 6

previous descriptions: Re-read Region, Re-read Page or Re-read batch.  

 You receive a warning message allowing you to choose whether to continue and 7

overwrite the existing data in the grid. Click Yes to continue or No to stop the re-

reading process. 

Note: If you choose to re-read the batch, a preliminary warning asks if you 
want to save the changes to a new form template file. Click Yes to save a 
new form template and 
then re-read the batch, 
click No to revert to the 
original form template 
settings (thus canceling 
any changes you made) 
and click Cancel to stop 
the re-reading process 
(the changes you made using Recognition Settings are still intact). Then you 
can click Yes or No to the data overwrite warning if you choose to continue 
with the re-reading process. 

 Once the re-reading process completes, a message appears telling you if it was 8
successful. 

 You may continue to make adjustments as needed.  9

 To return to the regular Task Pane, click the Back link within the Task Pane or the 10

Data tab at the top of the Task Pane. 

7.15.a Using the Recognition Tools in Conjunction with 

Recognition Settings 

When using the Recognition Tools you may find it helpful to use the Recognition Settings 

to improve general recognition. The Recognition Settings are described in full in Section 

7.14. When you click the Recognition Tools link in the Task Pane, the Recognition 

Settings portion of the Task Pane also appears below. The settings shown are specific to 

the active form template. You can click the link for any Recognition Setting and make 

adjustments. You can then choose re-read options from the Recognition Tools portion of 

the Task Pane. If you make changes to the Recognition Settings, they are stored with 

the active template. The general Recognition Settings, however, are not updated. 
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Working with Your Data  

Chapter 8 

8.1 Overview 

This chapter explains the basics of data manipulation and using the data grid in the 

Remark Office OMR Data Center, and includes the following: 

 Understanding the data grid (Section 8.2) 

 Editing the data grid (Section 8.3) 

 Sorting data (Section 8.4) 

 Spell checking data (Section 8.5) 

 Saving data (Section 8.6) 

 Printing data (Section 8.7) 

 Emailing data (Section 8.8) 

 Send wizard (Section 8.9) 

 Opening grid data (Section 8.10) 

 Logging changes (Section 8.11) 

The Remark Office OMR software requires a form template file for each type of form that 

you want to process. For each form template created, there is a corresponding data grid. 

The Remark Office OMR Data Center uses a data grid to store data recognized from 

forms. A form may contain up to 150 pages. The data read from one form are 

considered a single record and display in one grid row. Each column in the grid 

represents one variable or question on the form, as defined in the form template. 

8.2 Understanding the Data Grid 

The Remark Office OMR data grid window 

employs a spreadsheet style view of the 

form template to display recognized data. 

When a form template is open, each grid 

column corresponds to an item or question 

on the form, as it was defined in the form 

template. Hover your mouse over any 

column header to see information 

pertaining to the specific item (question). 

The grid employs two cell types to store 



Remark Office OMR User’s Guide 

174 

data: text and list. The cell type depends on the kind of region being used. Barcode 

regions, Image regions that do not contain Database Lookup or qualitative response 

code information, OCR regions and OMR regions set to the Grid, Add or Binary Data 

Type use text cells. Text cells are used to type information manually. All other OMR 

regions and data entry Image regions that utilize qualitative response codes use list 

cells. List cells contain a drop-down list of possible answer items (labels) as they are 

defined in the form template. See Section 8.3.2 Changing Cell Contents later in this 

chapter for information on how to edit individual cells.  

If an individual region contains more than one question, by default the corresponding 

column headers also contain question numbers. For example, Eval2 would correspond to 

the second item of a region titled Eval. If you entered individual Question Names in the 

OMR region properties of the form template, these Question Names appear instead (See 

Section 6.3.2.b Question Names for more detailed information about Question Names). 

8.3 Editing the Data Grid 

The data grid window behaves like a spreadsheet. You can cut, copy and paste 

selections to and from the grid. Additionally, you can change the contents of individual 

grid cells by clicking in a cell. This section explains the basics of manipulating data within 

the grid and includes the following: 

 Making selections 

 Changing cell contents 

 Cutting, copying, pasting and deleting 

 Resizing, inserting and deleting rows 

 Using find and replace 

8.3.1 Making Grid Selections 

The following table lists the different methods for making selections in the grid: 

 

Selection Area Method 

Single Cell Click in it. Use the mouse, tab or arrow keys to move from cell 
to cell. Double clicking within a cell puts you in edit mode. 

Multiple Cells Click the upper, left-hand corner of the desired selection, drag 
the mouse to the lower, right-hand corner and release. 

Single Column Click the column header. 

Multiple Columns Click and drag a range of column headers or click a beginning 

column header, press and hold the Shift key, and then click an 
ending column header. 

Single Row Click the row header. 

Multiple Rows Click and drag a range of row headers or click a beginning row 
header, press and hold the Shift key, and then click an ending 

row header. 
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Selection Area Method 

Entire Grid Select the Edit menu and then click Select All, or click the 

upper, left-most grid header cell. 

8.3.2 Changing Cell Contents 

The data grid allows in-cell editing by clicking within a particular cell. The grid employs 

two cell types to store data: text and list. The cell type depends on the kind of region 

being used. Each cell changes to either a text box or list box depending on its region 

type. Grid, Add and Binary OMR regions, barcode regions, OCR regions and Image 

regions without the use of Database Lookup or qualitative response coding are 

considered text regions. You do not have a drop-down box for these region types. All 

other types of OMR regions and Image regions using qualitative response coding are 

considered list regions and do have a drop-down box from which you can choose 

responses, as they were defined in the form template (labels). 

 

To change the contents of a text cell 

 Select the cell by clicking within its borders. 1

 Type the desired cell contents into the cell and press Enter. 2

 

To change the contents of a list cell 

 Select the cell by clicking within its borders. 1

 Click the down arrow on the cell‟s list box.  2

 Click the correct response. 3

Note: An asterisk appears next to selected responses. 

 If more than one response is permitted, repeat steps 2 and 3 to select more than 4

one response. 

Editing a cell removes any exception case colors that may have been present (e.g., 

yellow for a BLANK response).  

8.3.3 Cutting, Copying, Pasting and Deleting 

The Remark Office OMR template grid supports normal Windows clipboard functions: 

cut, copy and paste. In addition, it supports the Paste Special command, which allows 

you to copy the contents of one cell and then paste it into multiple cells. 

Tip: This section assumes an understanding of how to make grid selections 
in order to select grid cells. See Section 8.3.1 Making Grid Selections for 
detailed information about this topic. 

 

 

 



Remark Office OMR User’s Guide 

176 

To cut data from the grid 

 Select an area to cut. Select the Edit menu and then click Cut, click or press 1
Ctrl+X. 

The selected data are cut from the grid and placed on the Windows clipboard. 

 

To copy grid data 

 Select an area to copy.  1

 Select the Edit menu and then click Copy, click or press Ctrl+C. 2

The selected data are copied to the Windows clipboard. 

 

To paste data from the clipboard to the grid 

 Select the area to which you want to paste.  1

 Select the Edit menu and then click Paste, click or press Ctrl+V. 2

The data on the Windows clipboard are pasted into the selected grid cell(s). 

Note: You do not need to select the same amount of space in the grid as 
the amount of space you copied to the clipboard. 

 

To use Paste Special 

 Select a cell containing the data you wish to copy.  1

 Select the Edit menu and then click Copy, or click . 2

 Select the cells in which you want to paste the data. 3

 Select the Edit menu and then click Paste Special. 4

The data on the Windows clipboard are pasted into the selected grid cells. 

 

To delete grid data 

 Select the area that you want to delete.  1

 Select the Edit menu and then click Delete, right click in a cell and select Delete, 2

click the toolbar button for Delete , or press the Delete key. You may also 

delete an entire grid row by clicking the row header or clicking in a cell in the row 

and then right clicking and selecting Delete Row or by selecting the Edit menu and 
then clicking Delete Row. 
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8.3.4 Resizing, Inserting and Deleting Rows 

You can change the number of rows contained in each data grid by adding rows to the 

end of the grid, inserting rows into the grid or deleting rows from the grid. Note that 

during form processing, the grid expands as needed to hold your data; you do not need 

to manually add rows to the grid. 

Tip: This section assumes an understanding of how to make grid selections 
in order to select grid cells. See Section 8.3.1 Making Grid Selections for 
detailed information about this topic. 

 

To insert row(s) into the grid 

 Select the desired insertion point by clicking a grid cell.  1

 Select the Edit menu and then click Insert Row to insert a row, or click . 2

Alternatively, select Shift+Insert on the keyboard, or right click within the cell and 
choose Insert Row. The row is inserted above your current selection point. 

Note: You may also select multiple rows to insert the same number of rows 
above the selection (e.g., select two complete rows to insert two rows above 
the highlighted rows). 

 

To delete rows from the grid 

 Select the rows to delete.  1

 Select the Edit menu and then click Delete Row, or click . Alternatively, 2
select Shift+Delete on the keyboard, or right click the mouse and then select 

Delete Row. 

Tip: You may delete multiple rows by selecting more than one grid row. Use 
the row headers to select the rows. 

8.3.5 Freezing Columns and Rows 

You can freeze specific columns and rows in the data grid so that as you scroll, the 

frozen columns and rows are still visible. For example, if grading exams, you might want 

to freeze the Student Name column so you can see the students as you scroll. You can 

freeze a maximum of 10 columns and rows. 

 

To freeze columns and rows 

 With your data set open, select the View 1
menu. 

 To freeze rows, select Freeze Rows. Then 2

choose the number of rows to freeze. 

 To freeze columns, select the Freeze 3

Columns. Then choose the number of 
columns to freeze. 
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Your selected rows/columns are frozen and delineated with an orange line. If you wish to 

return to normal viewing, select the View menu and choose Unfreeze Rows or 

Unfreeze Columns. 

8.3.6 Using Find and Replace 

The Remark Office OMR Data Center provides find and replace commands for locating 

and replacing text. You can search for each occurrence of characters, including 

uppercase and lowercase letters, whole words and parts of words. 

By default the Data Center searches the entire data grid when performing a find and 

replace operation. However, you can search a specific region by highlighting the area 

you would like to search prior to using Find and Replace. (See Section 8.3.1 See Making 

Grid Selections.) 

 

To find text  

 Select the Edit menu and then click 1

Find, or click . 

 If searching for text, enter the search 2
text in the box titled Find what.   

 Select the other options you want to use 3

to control the search. 

 

Search Option Result 

Case sensitive Mark this checkbox to make the search case sensitive. 

Include partial 
matches 

Mark this checkbox to search for part of the text (does not 
require the entire contents of the cell to match what you have 

entered in the Find what box). 

Search for values 
greater than or 

equal to specified 
value 

If searching for numeric data, mark this checkbox to search for 
numeric values that are greater than or equal to the value you 

have typed in the Find what box. 

Search selected 

block only 

Mark this checkbox to search in the selected cell(s) only. 

 

 Click the Find Next button. 4

If Remark Office OMR locates a match, the grid scrolls to display the cell where the 

match is found. 

 Make any necessary changes to the grid. 5

 Click Find Next to continue searching. 6

 When you have completed searching the data, click the Close button. 7
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To find and replace text  

 Select the Edit menu and then click 1

Replace, or click . 

 Enter the search text in the box titled 2
Find what.  

 Select the other options you want to use 3
to control the search. 

 

Search Option Result 

Case sensitive Mark this checkbox to make the search case sensitive. 

Include partial 
matches 

Mark this checkbox to search for part of the text (does not 
require the entire contents of the cell to match what you have 

entered in the Find what box). 

Search for values 

greater than or 

equal to specified 
value 

If searching for numeric data, mark this checkbox to search for 

numeric values that are greater than or equal to the value you 

have typed in the Find what box. 

Search selected 
block only 

Mark this checkbox to search in the selected cell(s) only. 

 

 To replace items located in the search, enter the replacement text in the box titled 4
Replace with. 

 Choose one of the following search commands by clicking the appropriate button: 5

 

Search Command Result 

Find Next Locate the next item meeting search criteria. 

Replace Locate and automatically replace the next item meeting 

search criteria. 

Replace All Locate and automatically replace all items meeting search 
criteria. 

 

 When you have completed searching the data, click the Close button. 6

8.4 Sorting Grid Columns 

Columns in the data grid can be sorted according to the values in a specific region. Data 

can be sorted in ascending or descending order. For example, you can sort your data by 

ID number or respondent name. There are two ways to sort data: right clicking a column 

header or using the menus. 
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To sort data by right clicking the mouse 

 Select the header of the column by which you want to sort the data (the entire 1
column is highlighted). (See Section 8.3.1 Making Grid Selections.)  

 Right click the column header, click Sort and then click Ascending or Descending.  2

The entire data set is sorted according to your selection. 

 

To sort data using the menus 

 Select the Edit menu and then click Sort, or click .  1

 In the Primary sort key box, use the drop-down list to choose a region on which to 2

base the sort operation. 

 Mark the checkbox for Descending if you 3

want the data to be sorted in descending 
order. Leave this checkbox blank to sort the 

data in ascending order. 

 If you want to sort the data by more than 4
one criterion, select the appropriate regions 

on which to sort in the Secondary sort 
key and Third sort key boxes.    

 When finished selecting regions, click the 5
Sort button. 

The entire data set is sorted according to your selection(s). 

8.5 Spell Checker 

Remark Office OMR includes a Spell Checker that checks Data Entry Image regions, 

Barcode regions, OCR regions and OMR regions for misspellings. The spell checker works 

from the dictionary in the Remark Office OMR Preferences. To choose a dictionary, select 

Tools|Preferences|File Storage Locations, or click . 

 

To use the Spell Checker 

 Select the Tools menu and then click Perform spell check, or click . 1

 In the Spell Checker window, choose the desired options: 2

 

Option Description 

Search data entry 
regions 

Mark this checkbox to perform spell checking on Image regions 
set to the Data Entry type. 

Search barcode 

regions 

Mark this checkbox to perform spell checking on Barcode 

regions. 
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Option Description 

Search OCR 

regions 

Mark this checkbox to perform spell checking on OCR regions. 

Search OMR 

regions 

Mark this checkbox to perform spell checking on OMR regions. 

Ignore words with 
numbers 

Mark this checkbox to skip spell checking any numeric text. 

Ignore words in  
upper case 

Mark this checkbox to skip spell checking on words that begin in 
upper case. 

Ignore words in 

mixed case 

Mark this checkbox to skip spell checking on any words that use 

mixed case capitalization. 

 

 Click the Start button to begin the search. When an item matches your specified 3

criteria, the Spell Checker shows you the flagged word and offers suggestions if 
possible. You may choose a suggestion or 

modify the flagged word and then choose 
Change or Change All to make the 

modification. You may also choose Add to add 

the word to your dictionary so that it is not 
flagged again. Alternatively, you may choose 

Ignore or Ignore All to keep the word as is, 
and if choosing Ignore All, not have it flagged 

again during this search. Choose Cancel to 
stop the Spell Checker. 

 When the Spell Checker is finished searching 4
the grid, it alerts you that it is complete. Click 

the OK button to return to the main Spell Checker window. 

 Click the Finished button to complete the Spell Checker process. 5

8.6 Saving Data 

You can save the data in the data grid to dozens of different file formats. The Remark 

file format was specifically designed to optimize the data storage process in the Remark 

Office OMR software.  

Tip: When working with data in Remark Office OMR, use the Remark file 
format (RMK). This is the only format that preserves the link between the 
data and the corresponding images, as well as exception colors. Export data 
to other formats after you have collected and cleaned all of your data. 

When saving data, you have the option of using Save Data or Save Data As. The Save 

Data option can be used to save a data set for the first time or to overwrite the current 

data set. The Save Data As option allows you to save the current data set with new 

parameters (e.g., new file name, different directory, different file type, etc.)  

The following table lists the different save file formats, their extensions and a brief 

description: 
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File Format Extension Description 

Remark RMK Remark Office OMR format; saves grid exception 

colors and image links 

Remark Office 

Archive 

ROA Remark Office OMR Archive format; combines 

template, data and stored image files into one file; 
saves grid exception colors and image links; 

existing files may only be overwritten (there are 

no append options); optionally includes support 
information for troubleshooting 

SQL Server 2000-
2005 

MDF Microsoft SQL Server format 

Oracle 7.4 and 

later 

*.* Oracle format 

Access 2007-2010 ACCDB Microsoft Access 2007 and 2010 format (only 

available if the Access 2007 or 2010 database 
engine is installed) 

Access 2000-2003 MDB Microsoft Access 2000-2003 format 

Access 95-97 MDB Microsoft Access 95-97 format  

Access 2.0 MDB Microsoft Access 2.0 format 

Access 1.0 MDB Microsoft Access 1.0 format  

Excel 2007-2010 XLSX Microsoft Excel 2007 and 2010 format (only 

available if the Access 2007 or 2010 database 
engine is installed); existing files can only be 

appended, not overwritten 

Excel 97-2003 XLS Microsoft Excel 97-2003 format 

Excel 95 XLS Microsoft Excel 95 format  

Excel 4.0 XLS Microsoft Excel 4.0 format 

Excel 3.0 XLS Microsoft Excel 3.0 format  

Questionmark QSF Perception Questionmark format (save only) 

SPSS SAV SPSS 16 format 

SPSS Legacy SAV SPSS 6 format 

Survey Pro SRV Survey Pro standard format (Apian Software) 

Survey Pro STL STL Survey Pro STL format (Apian Software) 

ASCII [commas] ASC Comma delimited ASCII 

ASCII [tabs] ASC Tab delimited ASCII 

Spreadsheet 
[commas] 

TXT Comma delimited ASCII with quotes around non-
numeric data 

Spreadsheet 

[tabs] 

TXT Tab delimited ASCII with quotes around non-

numeric data 
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File Format Extension Description 

Survey System DAT The Survey System format (Creative Research 

Systems) 

dBase V DBF dBase V format 

dBase IV DBF dBase IV format 

dBase III DBF dBase III format 

Paradox 5.X DB Paradox 5.X format; existing files may only be 

overwritten (there are no append options) 

Paradox 4.X DB Paradox 4.X format; existing files may only be 
overwritten (there are no append options) 

Paradox 3.X DB Paradox 3.X format; existing files may only be 

overwritten (there are no append options) 

Lotus WK3 WK3 Lotus Works 3 format; existing files may only be 

overwritten (there are no append options) 

Lotus WK1 WK1 Lotus Works 1 format 

Lotus 1-2-3 WKS Lotus 1-2-3 format 

LXR Test MRG LXR Test format 

Report RPT Fixed format ASCII, cell text padded or truncated 
to specified record length 

Data Interchange 

Format 

DIF Standard format using file header and data section 

CCI Assessment DAT CCI Assessment format; existing files may only be 
overwritten (there are no append options) 

XML XML Extensible Markup Language format 

HTML HTM Hypertext Markup Language  

ODBC *.* Open Database Connectivity  

Custom  ASC, TXT Custom Text format 

Database Update XLS, XLSX, 
MDB, 

ACCDB 

Updates an existing database with new data (e.g., 
adds missing information, overwrites existing 

information). 

ODBC Database 
Update 

*.* Updates an existing ODBC database with new data 
(e.g., adds missing information, overwrites 

existing information). 

 

To save grid data 

Before saving data to another data format, we suggest saving a copy of the data to the 

Remark (RMK) format to preserve exception colors and links to stored images. Once 

your project is complete, you may delete or archive the RMK file, or save all of your files 

to the Remark Office Archive (ROA) format. 
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When exporting to a specific format (e.g., Access, Excel, etc.) make certain your data 

meets the format's specific requirements (see Start|Programs|Remark Office OMR 

8|Documentation|Remark Office OMR 8 Supported File Formats for more information). 

 After processing forms, select the File menu and then click Save Data, or click 1

, if saving the data set for the first time or to overwrite the data. Click Save 

Data As to save the data with new parameters. 

Note: Clicking the toolbar button for Save Data overwrites the current data 
set. 

If saving for the first time or using Save Data As, 

the Save Data window opens, allowing you to 

choose a file name, a file type, the directory in which 

you would like the file saved and Advanced saving 

options. 

 Select the desired directory location using the 2

Look in drop down box. 

 Enter a name in the box titled File name. 3

 Select the desired output format in the box titled 4

Save as type. 

 If saving to a database type that supports 5

internal table names, enter a table name in the 
box titled Table name. 

Note: Each database format has different table name limitations. Refer to 
your database documentation for information on table name limitations. 
When saving to a database where one or more fields are too small to hold 
the data being saved, Remark Office OMR attempts to resize the database 
column so that it can hold the data being saved. 

 When exporting, you can save the column headers for certain formats by selecting 6

the Save headers checkbox. The Save headers checkbox only displays when 
appropriate. 

 Click the OK button to save the file. 7

8.6.1 Advanced Saving Options 

When saving data to certain formats, you have the option of setting advanced 

parameters. The Advanced Save window shows you each question and pertinent 

information about the question (region). You can then choose options about the region 

that you want included in your database. This feature can be useful if you are saving to 

a database format that has specific requirements. You can temporarily override the form 

template settings by using the advanced parameters. The Advanced Save window also 

allows you to save either the scanned form image or path to the scanned form images to 

your data file. 

Note: Setting parameters in the Advanced Save window does not make any 
changes to the form template. 

The following advanced features are available (note that what is available depends on 

the file format selected): 
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Option Description 

Include Mark this checkbox to include the region (question) in the data file. 

Note that you may include the paths to the stored images of each 
processed form. The last item(s) in the Name list is the form image(s) 

listed by page (e.g., Page 1 Image). 

Name Use this column to enter a new field name to be used in the exported 

data file, if desired. Changing the field name in this window does not 

affect the region‟s name in the form template. 

Data Type Use this column to change the data type for this question. 

Size Use this column to specify a field size for the data for this question. 

Do not specify a size that is smaller than what is in your data. 

 

To use advanced saving options 

 Select the File menu and then click Save Data As.  1

The Save Data window opens, allowing you to choose a file name, a file type, the 

directory in which you would like the file saved and advanced saving options. 

 Select the desired directory location using the Look in drop down box.  2

 Enter a name in the box titled File name. 3

 Select the desired output format in the box titled Save as type. 4

 If saving to a database type that supports internal table names, enter a table name 5
in the box titled Table name. 

 Click the Advanced button. 6

 [OPTIONAL] If you have previously saved a 7

definition file for this data set, click the Load… 

button to locate the appropriate INI file 
containing your settings. Otherwise, continue to 

Step 8 to build a new data file. 

 Make any desired changes in the Include, 8

Name, Data Type or Size columns. 

Note: You can save the path of the form 
images or the actual form images to the file 
by using the Advanced options. Scroll to the 
bottom of the Names list to mark the form 
images. If you want the actual image to be stored, change the data type to 
binary. If the data type is not binary, the path to the images is stored. 

 [Optional] If desired, click the Save… button to save the settings to a configuration 9

file (.ini file). You can then open this configuration file for future save operations with 
this same form template. This feature can save time when saving future data sets. 

 Click the OK button to save the changes. 10

 In the Save Data window, click the OK button to save the data. 11
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8.6.2 Remark Office Archive Format 

The Remark Office Archive format saves the form template, data file and stored images 

in one zipped file. By having all items stored together, the information becomes 

portable. For example, this feature is useful if you own and use multiple copies of the 

software. One person can scan forms on one system and then save the data to the 

Remark Office Archive Format. Another person can then open that Remark Office 

Archive file, which provides the form template, data file and stored images, and run 

Review Exceptions to clean the data. This process makes sharing the workload easier. 

Caution! Please read the Remark license agreement carefully before 
installing Remark Office OMR on multiple computers. Licensing is computer-
based, meaning that one copy of the software may only be installed on one 
computer. 

 

To save data to the Remark Office Archive format 

 Select the File menu and then click Save Data As.  1

The Save Data window opens, allowing you to choose a file name, a file type and the 

directory in which you would like the file saved. 

 Select the desired directory location using the Look in drop down box. 2

 Enter a name in the box titled File name.  3

 Select the Remark Office Archive (*.ROA) 4
format in the box titled Save as type. 

 [OPTIONAL] If desired, mark the checkbox for 5
Delete original images after archiving to 

delete the original images that are stored 
during form scanning. These images are 

included in the archive format in case you need 
to access them at a later point. 

 [OPTIONAL] If Remark Support has requested 6

an ROA file for troubleshooting, mark the 
Include support files checkbox. This action 

includes additional information for support 
personnel to correctly troubleshoot your issue. 

 Click the OK button to save the file. 7

 

To open a saved Remark Office Archive file 

 In the Data Center, select the File menu and 1
then select Open Form Template.  

 Set the Files of type to Supported Files or 2

Remark Office Archive Files. 

 Highlight the ROA file you wish to open and then 3

click the OK button. 

 A Select the archive extract location… 4

window appears. Use this window to select a 
location in which to unzip the files associated 
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with this form template (form template, data and stored images). We suggest 

putting them in a folder based on the form template name so that you can easily 
associate the files with the right form.  

 Click the OK button once you have selected a folder. 5

The files are automatically be unzipped to the location specified. The form template and 

data load normally into the data grid. All associated image files are available so that you 

can click in a cell and view the corresponding image or use Review Exceptions to clean 

the data. 

8.6.3 Custom Format 

The Custom format allows you to create a customized text file. This format is useful for 

exporting data into a database that has very specific requirements. The format can also 

be used to break apart rows of data into multiple rows. For example, if you are 

processing an attendance sheet containing records for multiple students in a single row, 

you can use the Custom format to separate the data into one record for each student. 

Note: When saving to an existing custom data file, regions are not matched 
by region name; instead they are matched by position in the data file. 
Ensure that the data you are saving matches the existing custom wizard 
data file before appending new records. 

The following table summarizes the screens and options that are found in the Custom 

Wizard and the corresponding descriptions of each option: 

 

Custom 

Wizard 
Screen 

Option Description 

Step 1: 

Configuration 
File 

Configuration File Use the Browse… button to locate a 

previously saved configuration file that 
you created when using the Custom 

Wizard (optional). 

Step 2: File 
Type and 

Start Row 

File Type Delimited: Fields are separated by a 
delimiter, such as a comma or tab. 

Fixed Width: Fields are aligned at fixed 
character spaces. 

 Automatically format 

questions that allow 
multiple responses 

Mark the Automatically format 

questions that allow multiple 
responses checkbox to automatically set 

formatting for questions that allow more 
than one answer choice (e.g., (1,5,12) 

becomes 1 5 12). 

 Start export at row Enter the row number that you want to 
use as the first record in the exported 

data file. All rows from this point forward 
are included in the data file. Enter 0 to 

include field names as the first record. 
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Custom 

Wizard 
Screen 

Option Description 

Note: Step 3 changes based on whether you select Fixed Width or Delimited for the 

File Type in Step 2. Items that correspond with each type are noted. 

Step 3: 
Column 

Delimiter and 
Text Qualifier 

(Delimited 

Fields Only) 

Column Delimiter Select the character to use to separate 
the columns in the data file: Comma, Tab, 

Semi-colon, Space, Other.  

 Text Qualifier Select the character to use to qualify text. 

Textual responses are encapsulated 
within these characters. Options include: 

None, double quote (“), single quote („). 

Step 3: Field 
Width and 

Padding (Fixed 
Width Fields 

Only) 

Field Size The maximum number of characters 
allowed in the field.  

 Start Position The position, in characters, where the 
field begins. For example, if your field 

sizes are 25, the first field starts at 
position 1 and the second field starts at 

position 26 (25 characters later). 

 Pad With Enter the character to use to pad the field 
(typically a space character). 

 Pad On Select whether to pad the field on the left 

or right of the text that resides in the 
field.  

Step 4: 

Record 
Delimiter 

Record Delimiter Sets the delimiter to be used to separate 

records: Carriage Return/Line Feed, 
Carriage Return, Line Feed, Other. 

Step 5: Field 
Exclusion and 

Record Breaks 

Exclude Mark the Exclude checkbox to exclude 
the field listed from the data file. 

 Break After Mark the Break After checkbox to start a 

new record in the data file after this field.  

 Every Record Mark the Every Record checkbox to 
include the field in every record of the 

data file (e.g., repeat the field for each 
record). 
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To use the Custom format 

 Select the File menu and then click Save Data As.  1

The Save Data window opens, allowing you to choose a file name, a file type, the 

directory in which you would like the file saved and advanced saving options. 

 Select the desired directory location using the Look in drop down box. 2

 Enter a name in the box titled File name. 3

 Select the Custom (*.ASC, *.TXT) format in the box titled Save as type. 4

 Click the OK button. 5

 If you have used the Custom Wizard format 6

previously and have a saved configuration file that 
applies to this data set, click the Browse… button 

to locate the configuration file. Otherwise, click the 
Next>> button to begin creating a new 

configuration file. 

 Select the options you wish to use to customize 7
your data set. Each option is described in the 

previous table. Use the Next>> button to navigate 
from screen to screen. 

 When finished, click the Finish button. 8

 When the Save Text Export Configuration 9

window appears, click the Yes button to save your 
settings to a file that you can use later when saving data. If you do not wish to save 

this configuration file, click the No button. If you are not saving the configuration 

file, the data file is saved when you click the No button. Continue with the next steps 
if you are saving the configuration file. 

 [Optional] If saving the configuration file, in the Save Text Export Configuration 10
As box, select a location in which to save the configuration file in the Save in box. 

 Enter a name for the file in the File name box. 

 Leave the Save as type box set to Text Export Configuration Files (*.tec). 

 Click the Save button to save the file and create the data file. 

8.6.4 Database Update Format 

The database update format allows you to update an existing database based on the 

data in the Remark Office OMR data grid (Access or Excel). The data are matched to the 

existing database by the region names and a mapping process. When saving to this 

format, you map the regions in the Remark Office OMR data to the fields in the existing 

database. You also choose a question to be the record identifier. If data corresponding 

to the unique record identifier exists in the database it is updated with what is in Remark 

Office OMR when the identifiers are matched. For example, if you are conducting a 

survey that collects demographic information, and include for a respondent identifier on 

your form, you could use the identifier as the record ID to update an external database 

using the Database Update format. During the save process, Remark Office OMR 

attempts to find the Student ID in the database and then updates the data fields 

associated with that student. If the student ID is not found, you have the option of 

adding the record to the external database. 
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To use the Database Update format 

 Select the File menu and then click Save Data As.  1

The Save Data window opens, allowing you to choose a file name, a file type, the 

directory in which you would like the file saved and advanced saving options. 

 Select the desired directory location using the Look in drop down box. 2

 Select a file to update, which fills the File name box. 3

 Select the Database Update (*.ACCDB, *.MDB, *. XLSX, *.XLS) format in the 4

box titled Save as type. 

 Click the OK button. A wizard opens to walk you through the next few steps. 5

 If you have used the Database Update format previously and have a saved 6
configuration file that applies to this data set, click the Load… button to locate the 

configuration file. Otherwise, go on to step 7. 

Note: You are prompted to save a configuration file with your settings after 
saving the data. 

 In the Update Options area, select the number of records contained in each row of 7
the data set (e.g., if multiple respondents‟ answers are on a single form, you would 

have more than one record per data row). If each record in the data set corresponds 
to one respondent‟s submission, use 1 for the value. 

 In the Update Options area, mark the Add database records for missing record 8

identifiers checkbox if you would like to create new records in the database when 
an identifier is not found. 

 In the Field Mapping area, map the regions from Remark Office OMR to the fields in 9
the external database. The target database fields are listed in the first column, called 

Database Field, and the Remark Office OMR regions (questions) are listed in the 
second column, called Grid Column. Use the down arrow in the Grid Column 

section to choose the appropriate field to map to the corresponding database field. 

Note: Remark Office OMR attempts to automatically map the fields based 
on the field/region names. Review the field 
mapping first and then make changes if 
necessary.  

 Choose a field or fields to use as an identifier by 10

marking the appropriate checkbox next to the 
field name. The identifier fields are used to 

match data from Remark Office OMR to the 
external database. If a match is not found, the 

data is not added to the database (unless you 
selected this feature in step 8) and you receive a 

message. You may select more than one field to 

use as the identifier, in which case the data from 
all identifier fields must be a match for the 

record to be updated in the external database. 

 Click the OK button to save the data.  11

 If any problems are encountered when updating the selected file, a message appears 12
detailing the problems. If the database is updated successfully you receive a 

message telling you how many records were updated and asking you if you want to 
save the configuration file for later use. If you do wish to save the file, click the Yes 
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button. Enter a file name and choose a location for the .ini file in the Save window 

that appears. 

Note: The ODBC Database Update format works just as described 
previously, but you can save to a database using an ODBC connection. 

8.6.5 Save All Data 

The Save All Data feature allows you to save multiple open data sets to one combined 

file. This feature is useful if you need to store and analyze data both on an aggregate 

and individual level. By maintaining separate files you can easily report on an individual 

data set. However, by combining the individual data files into one, you can also report 

on the data as a whole without having to open each data set individually any time you 

want to analyze all the data. 

 

To use Save All Data 

 Select the File menu and then click Save All Data.  1

The Possible Data Sets window opens, allowing you to choose the open files you wish 

to include in the save operation. 

 Mark the checkboxes of all data sets you wish to include in the save operation. You 2
may use Select All to select all data sets in the list. Please note that the data set 

must correspond to the active form 

template in order for it to be included in 
the save operation.  

 If needed, use the Up and Down arrow 3
buttons to move data sets. The order in 

which the files appear on the Possible 
Data Sets window is the order in which 

they are saved. 

 If any of the open data sets had changes 4

made to them prior to the save 

operation and were not saved, you receive a warning. The warning lets you know 
that during the save operation, all of the data sets being combined are closed. Click 

Yes to continue or No to cancel the operation, allowing you to go back and save the 
individual files first. 

 

 

 

 

 

 

Note: If you made changes to your original data files and want those 
changes to be saved, save the individual files before using Save All Data. If 
you choose to ignore the warning, the changes to the individual data sets 
are not saved.

 Click the OK button. 5

 Select the desired directory location using the Look in drop down box. 6
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 Enter a name in the box titled File name.  7

 Select the desired file format in the box titled Save as type. 8

 Click the OK button to save the file. 9

All selected data sets are saved to the file specified and closed in the data grid. The 

combined data set is opened. 

8.6.6 Save Data Builder 

The Save Data Builder option allows you to fine tune the data saving process by building 

dynamic file, folder and table names. Using the Data Builder options, you can use 

information directly from your data set to name the data file, storage folder or table 

within the file. This functionality is similar to the Name Builder in the Read Wizard that is 

used to name scanned and repackaged image files (see Section 7.3 for further 

information).  

 

To use Save Data Builder 

 Select the File menu and then click Save Data Builder.  1

The Save Data Builder window opens, allowing you to choose a file name, a file type, 

the folder in which you would like the file saved and table name saving options. The first 

step is to choose a file type and location for the data. 

 Under Base Save File and Type, click the 2

Browse… button to select a file name and 
format for your data. 

 Select the desired folder location using the 3
Look in drop down box. 

 Enter a file name in the File name box. If 4
choosing a database format, also enter a 

Table Name. 

 Choose the file format in the Save as type 5

box. 

 Click the OK button. 6

 Next, go to the File Name area of the window. 7

The name you set in the previous screen is 
listed as the file name. You may modify it by typing in the box. You may also use the 

drop-down list to add a region from the processed data to the file base name. 
Choose the region from the drop-down list and 

then click the Add button. For example, if 
processing student test forms, you could add a 

student name region that is being collected 
from the form so that your data file name 

includes the name of each student (each time 

the student name changes, a new data file is 
created). 

 In the Folder Name area, you may choose to 8
add a region from the processed data to the 

folder structure that holds the data file. Choose 
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the region from the drop-down list and then click the Add button. Continuing with 

our example, if processing student test forms, you could add a teacher name or ID 
region that is being collected from the form so that your folder names include 

teacher identifiers. Each student‟s data from the data set would be stored in a 
separate folder based on teacher name or ID number. 

 If using a database format that requires a 9
table name, go to the Table Name area of 

the window. The name you chose for Table 
Name when initially setting up the file in 

Step 4 is listed as the Table Name. You may 

modify it by typing in the box. You may also 
use the drop-down list to add a region from 

the processed data to the file base name. 
Choose the region from the drop-down list 

and then click the Add button. Continuing 
with our example, if processing student test 

forms, you could add a student name region 
that is being collected from the form so that 

your data file table name includes the name 

of the students. 

 Click the OK button to save the data. 10

The data file(s) is saved based on your specifications. If you named files or folders based 

on data from your data set, you may see separate folders and files. For folders, there is 

a separate folder for each unique entry in your data set. Within each folder you find the 

appropriate data file. For data files, the data file names begin with the region data you 

chose during the set up process. 

8.7 Printing Data 

The Remark Office OMR Data Center allows you to print grid data on any Windows-

supported printer. 

 

To print the grid data 

 From the Remark Office OMR Data Center, select the File menu and then click 1

Print, or click  to display the Print 

Options window. 

 Click the Properties… button to choose and 2

configure a specific printer. Otherwise, the 

default printer is used. 

 In the Print Display section, mark the 3

checkboxes corresponding to the items you 
wish to print: Column headers, Row 

headers, Grid lines, Border. 

 In the Margins section, choose the print 4

margins in inches. The default settings are 1 
inch margins on the top and bottom, and ½ 
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inch margins on the left and right.  

 In the Header and Footer area, optionally enter text to be displayed in the header 5
and footer of the page. 

 In the Print Range area, select a page range to print: Active sheet (currently 6
selected form template) or All sheets (all open form templates). 

 In the Print Color area, select whether to print the page in Color or Black & white 7
(the color setting only applies if the selected printer is color-enabled).  

 Click the Print button to print the grid. 8

8.8 Emailing Data 

8.8.1 Email Overview and Set Up 

You can email data files in their native formats or in ZIP format from the Remark Office 

OMR Data Center. You have a choice of using Microsoft Outlook 2007 or 2010 or your 

own SMTP server to send the emails. We cover both methods here.  

Note: When emailing data, a local copy of the data is not saved. If you need 
to save a data file, make sure you take that step in addition to using the 
email function. Saving data is covered in Section 8.6. 

 

Your SMTP Server:  

If you use your own SMTP server, you must have a valid SMTP server set up 

independently of Remark Office OMR. SMTP stands for Simple Mail Transfer Protocol and 

is the Internet standard for transmitting email across networks. It is likely your 

organization has a running SMTP server already set up. You just need to find out general 

information about the server. You will likely need to consult with your network/email 

administrator to obtain information about your SMTP server. Please use the following 

table as a guide to have your administrator provide the proper settings: 

 

Option Description 

SMTP Server This is the name, address or IP address of the mail server. 

SMTP port The SMTP port is usually 25 but may vary with your email server. 

Enable a 

secured 

(SSL) 
connection 

If desired, use a secure connection by marking the checkbox for 

Enable a secured (SSL) connection. SSL encrypts data as it is 

transmitted. Your SMTP server must be configured to use SSL in order 
for this feature to work. 

Use the 
default 

credentials of 

the currently 
logged in 

user 

If you need to use authentication for your SMTP server, you can enter 
credentials or use those of the user logged in to the computer. Mark 

the Use the default credentials of the currently logged in user 

checkbox to utilize the user‟s credentials (e.g., the person logged in 
when sending the emails from Remark Office OMR). Otherwise, 

continue to the next step to enter specific credentials. 
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Option Description 

Username 

and 
Password 

If authentication is required, and you are not using the credentials of 

the currently logged in user, enter the Username and Password, as 
supplied by your network/email administrator. 

Throttle rate The throttle rate adds a delay while sending emails. The default 
setting is 500ms, meaning that one email is sent every 500 ms (in 

other words, two emails are sent per second). Throttling emails keeps 

the SMTP server from being overloaded when sending large numbers 
of emails. Unless you plan on sending hundreds of emails at one time, 

the default setting of 500 is likely fine. 

 

Microsoft Outlook: 

If you plan to use Microsoft Outlook 2007 or 2010, you do not need to set up anything 

outside of telling the software to use Outlook.  

 

To choose Microsoft Outlook or your own SMTP server in Remark Office OMR: 

 From the Remark Office OMR Data Center, 1
select the Tools menu and then click 

Preferences. 

 Click the Email link in the left Task Pane. 2

 Under Email client, choose Default to use your 3
own SMTP server. Choose Outlook to use 

Microsoft Outlook 2007 or 2010. If you are using 
Outlook, simply click OK. If you are using the 

Default email client, continue to the next step. 

 If you have chosen the Default client, click the 4
SMTP Server button. 

 Fill in the settings as described in the previous 5
table. You will need your network/email 

administrator to provide this information to you. 

 Click the OK button. 6

8.8.2 Using Email to Send Data Files 

Once you have set up your email preferences in Tools|Preferences (see previous 

section), you are ready to start emailing data files. 

 

To email data files using Microsoft Outlook 

 After processing forms, saving data or opening a data file, select the File menu and 1

click Email. Note: If you choose the toolbar option or Task Pane option to send 
email, the file is always in zipped format. 

 Choose Data as Attachment to attach the native file to an outgoing email message. 2
Choose Data as ZIP Attachment to first zip the native data file (compress it into a 

.zip file) and then attach it to an outgoing email. 
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Note: Your organization, or the recipient‟s organization, may have 
restrictions on the types of files that can be sent via email. If the file is 
restricted and you do not zip it, the email may never reach the intended 
recipient. If you are unsure whether the selected file type is restricted, use 
the ZIP option. The recipient must have a Zip program to unzip the file and 
view it. 

The Email Data window appears. 

 Choose the File name, file format using 3
Save as type and if using a database 

format, the Table or Sheet name. You do 

not need to specify a location for the file, as 
it is automatically attached to an email 

message. 

 Click the OK button. 4

Outlook automatically opens a new email 

message with your file attached. You may now 

enter recipients and a message and send your 

file. Note if you chose to zip the file, it appears 

with a .zip extension. 

 

To email data files using your SMTP server 

 After processing forms, saving data or opening a data file, select the File menu and 1

click Email. Note: If you choose the toolbar option or Task Pane option to send 
email, the file is always in zipped format. 

 Choose Data as Attachment to attach the native file to an outgoing email message. 2
Choose Data as ZIP Attachment to first zip the native data file (compress it into a 

.zip file) and then attach it to an outgoing email. 

Note: Your organization, or the recipient‟s organization, may have 
restrictions on the types of files that can be sent via email. If the file is 
restricted and you do not zip it, the email may never reach the intended 
recipient. If you are unsure whether the selected file type is restricted, use 
the ZIP option. The recipient must have a Zip program to unzip the file and 
view it. 

The Email Data window appears. 

 Choose the File name, file format using Save as 3

type and if using a database format, the Table 
or Sheet name. You do not need to specify a 

location for the file, as it is automatically 

attached to an email message. 

 Click the OK button. 4

 The Email Message window appears. 5

 Enter the recipient(s)‟ email address in the To 6

box. Separate multiple recipients with a semi 
colon (;). 

 Enter your return email address in the From box.  7
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 Accept the default subject, which is the file 8

name, or enter a new one in the Subject box. 

 In the rich text box, type your message to the 9

recipient(s). You may use the toolbar to format 
your message as desired.  

 If you have already configured your SMTP 10
settings in Remark Office OMR, as described in 

section 8.8.1, you do not need to click the 
SMTP Settings tab. However, if you have not 

entered your SMTP settings or need to modify 

them, click the SMTP Settings tab to enter the 
SMTP server information. You will need to obtain 

this information from your network/email 
administrator. 

 Click Send when you are ready to send your 11
message. 

Your email message is automatically sent. If delivery problems occur, they are routed to 

the address listed in the From box of the email message (this may depend on how your 

SMTP server is configured to handle message failures). 

8.9 Send Wizard 

The Remark Office OMR Send Wizard allows you to send files via FTP (file transfer 

protocol) or email. As opposed to the Email option in Remark Office OMR, the Send 

Wizard provides more advanced tools for creating profiles so that data and reports can 

be automatically sent to other destinations. Send Wizard configurations can be utilized 

from the Automation Wizard when automating Remark Office OMR functions. Send 

Wizard configuration files can be set up ahead of time to look for files in directories and 

then either send them to an FTP site or email them. For example, you could set up an 

Automation Wizard file that does the following: Opens a form template, scans forms, 

saves the data to a file, grades the data and then launches a Send Wizard file to move 

the grades to an FTP server or send a report via email. If you wish to use email with the 

Send Wizard you must have an SMTP (simple mail transfer protocol) server set up 

independently of Remark Office OMR. You will need to obtain the settings from your 

network/email administrator for that SMTP server and enter them into the Remark 

software. When setting up the Send Wizard profile, you can send files via FTP and/or 

email. For the purposes of this documentation, we will break out the steps for each, but 

please note you can do both operations at the same time. 

Tip: If you are not familiar with the Automation Wizard, which is used to 
automate basic Remark Office OMR functions, please read the Remark Office 
OMR 8 Automation Wizard User‟s Guide.pdf file, located on your Windows 
Start menu (Start|Programs|Remark Office OMR 8|Documentation). 
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To use the Send Wizard to send files via FTP 

 Select the Tools menu and click Send Wizard. 1

 If you have already saved a Send Wizard configuration file, click the Load… button 2

to retrieve it. Otherwise, continue to step 3 to begin a new Send Wizard 
configuration.  

 Under File Name Pattern Matching, using the Browse… button, chose a location 3
on your computer or network for the software to search when looking for files to 

send.  

 Under Custom Filter, choose the extension of the file to send. For example, if you 4

are sending Excel 2010 files to an FTP site, you 

would enter “.xlsx.” If you want all files found in 
the specified directory to be included in the 

send operation, enter “*.*”. 

 Click the first Add button to move your 5

selections into the configuration window. 

 [Optional] If you have additional files not 6

generated by Remark Office OMR or very 
specific files that you want to include, click the 

Add button next to the File list window. 

 [Optional] In the Open window, select the files 7
you wish to include. 

 Once you have all the files you wish to include 8
visible in the File list window, click the Next 

button. 

 Under Send type, choose FTP to send the files to an FTP site.  9

 [Optional] If you would like to compress the files first, mark the checkbox for 10
Compress Files into a Zip Archive. 

 [Optional] If using compression, choose 11

whether you want each file in its own zip file 
(Create a separate zip archive for each file) 

or to combine all files into one zip file (Create a 
single zip archive for all files). 

 [Optional] If creating a single zip file, enter a 12
name for the file in the Zip file name box. 

(Note: when archiving each file individually, the 
zip file is automatically named with the file 

name.) 

 [Optional] If you would like the contents of the 13
zip file to be encrypted and password protected, 

mark the checkbox for Encrypt and Password 
Protect the Zip Archive(s). 

 [Optional] Enter the password required to open the zip file in the Zip password box. 14

 [Optional] If you would like to delete the original files stored locally once the files are 15

sent via the Send Wizard, mark the checkbox for Delete local files after 
successful send. If a problem is encountered sending the files, the original files are 

not deleted. 

 Click the Next button to continue. 16
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 On the FTP Server settings window, tell Remark Office OMR about your FTP server. 17

If you have run the Send Wizard previously and set up an FTP site, you can select it 
from the FTP sites drop-down list. If you do not have any sites listed, set one up by 

continuing with the following steps. The following options are available when setting 
up an FTP server. 

 

Basic Tab: 

 

Option Description 

Server Address This is the internet address of the FTP server. If you enter a 
DNS name for the server (e.g. ftp://myftpsite.com ), then 

the prefix ftp:// is required. If you enter an IP address 
(e.g., ftp://12.34.56.78), then the prefix ftp:// is optional 

(e.g., just enter 12.34.56.78). 

Target Directory You can, optionally, specify a target directory on the FTP 
server. The target directory holds the file once it is 

transferred to the server. 

Note: No verification is performed to check that the 
directory path you enter is valid on the server. To verify 

connectivity to the server, use Test Connectivity on the 
FTP - Basic screen. 

Username This is the username that is required for FTP login on the 

FTP server. The person responsible for your FTP server 
should be able to provide this information to you. 

Password This is the password that is required for FTP login on the FTP 

server. The person responsible for your FTP server should be 

able to provide this information to you. 

Transfer Type Select either Binary or ASCII. As a guideline, use ASCII 
only for plain-text files and Binary for all other types. The 

default value is Binary. 

File Exists Action Select an action to perform if the uploaded file already exists 
on the FTP server. You can choose to overwrite the existing 

file or choose not to upload the file at all. 

 

Advanced Tab 

 

Option Description 

Restrict upload file 

size 

You can choose to restrict the size of files are uploaded by 

the FTP service. Any files that are placed in the Source 

Directory (defined under the Basic tab) that exceed this 
value in size is not uploaded to the FTP server. 

ftp://myftpsite.com
ftp://is
ftp://12.34.56.78
ftp://is
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Option Description 

File Lock Timeout When a file is copied (or moved) to the Source Directory 

(defined under the Basic tab), the actual copy (or move) 
operation takes time to perform on any operating system. 

For very large files, this time period can be several seconds, 
or even minutes. While this takes place, the file cannot be 

uploaded with FTP, since the file is “incomplete” (in this 
folder) until the copy (or move) operation has finished. The 

FTP Service attempts to gain exclusive use (“locked” use) of 
the file before uploading it. In this way, the software can 

determine that a copy (or move) operation has finished, and 

therefore, that the file is complete and ready for upload. 

Use this File Lock Timeout setting to control the time period 

for which the FTP Service attempts to lock the file before 
giving up and recording an upload failure. 

 

 Enter the details for your FTP server as 18

described in the previous table. 

 Use the Test Connectivity button to ensure 19

you can connect to the FTP server using the 
supplied information. 

 [Optional] If you would like to save your FTP 20

server information, click the Save button. The 
FTP Server name is automatically used to name 

your settings. 

 Click the Finish button to complete the setup. 21

Optionally, you may click the arrow on the 
Finish button and choose to Save your 

configuration without executing it, Execute the configuration without saving it (e.g., 
to test it) or Save and Execute to both save and execute the configuration in one 

step. 

 When clicking Finish, you are prompted to 22
save your Send Wizard Configuration file. It is 

recommended that you save the file so you 
may use it again in the future or call it up 

from the Automation Wizard. The file can be 
saved anywhere on your computer or network 

and has an XML file extension.  

 To save the Send Wizard Configuration File, 23

click the Yes button, choose a location and 

provide a file name. Ensure that you 
remember where the files are stored so that 

you can locate them later. 

 If you do not wish to save the Send Wizard 24

Configuration File, click the No button. The configuration executes. 

Once the wizard closes, the action is active. Remark Office OMR looks in the 

directory(ies) specified for files to send to your FTP site. If any problems occur, you are 
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notified. Otherwise, the requested action is executed and a notice appears letting you 

know the operation was successful. 

 

To use the Send Wizard to send files via email 

 Select the Tools menu and click Send Wizard. 1

 Under File Name Pattern Matching, chose a 2

location on your computer or network for the 
software to search when looking for files to 

send. 

 Under Custom Filter, choose the extension of 3

the file to send. For example, if you are 
sending Excel 2010 files to an FTP site, you 

would enter “.xlsx.” If you want all files found 
in the specified directory to be included in the 

send operation, enter “*.*.” 

 Click the first Add button to move your 4
selections into the configuration window. 

 [Optional] If you have additional files not generated by Remark Office OMR or very 5
specific files that you want to include, click the Add button next to the File list 

window. 

 [Optional] In the Open window, select the files you wish to include. 6

 Once you have all the files you wish to include visible in the File list window, click 7
the Next button. 

 Under Send type, choose Email to send the files via email.  8

 [Optional] If you would like to compress the files first, mark the checkbox for 9
Compress Files into a Zip Archive. 

Note: Your organization, or the recipient‟s organization, may have 
restrictions on the types of files that can be sent via email. If the file is 
restricted and you do not zip it, the email may never reach the intended 
recipient. If you are unsure whether the selected file type is restricted, use 
the ZIP option. The recipient must have a Zip program to unzip the file and 
view it. 

 [Optional] If using compression, choose 10
whether you want each file in its own zip file 

(Create a separate zip archive for each 
file) or to combine all files into one zip file 

(Create a single zip archive for all files). 

 [Optional] If creating a single zip file, enter a 11

name for the file in the Zip file name box. 

(Note: when archiving each file individually, 
the zip file is automatically named with the file 

name.) 

 [Optional] If you would like the contents of the 12

zip file to be encrypted and password 
protected, mark the checkbox for Encrypt and 

Password Protect the Zip Archive(s). 

 [Optional] Enter the password required to open the zip file in the Zip password box. 13
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 [Optional] If you would like to delete the original files stored locally once the files are 14

sent via the Send Wizard, mark the checkbox for Delete local files after 
successful send. If a problem is encountered sending the files, the original files are 

not deleted. 

In the Email Message window, format your email.  

 Enter a recipient(s) address in the To box (separate 15

multiple recipients with a semi colon (;). 

 Enter the sender‟s email address in the From box.  16

 Enter a subject of your choice in the Subject box. 17

 Compose your message. You may use the toolbar 18

buttons to add formatting to your message. 

 Click the SMTP Settings tab to enter information 19

about your SMTP Server. You must have a valid 

SMTP server set up independently of Remark Office 
OMR. SMTP stands for Simple Mail Transfer Protocol 

and is the Internet standard for transmitting email 
across networks. It is likely your organization has a 

running SMTP server already set up. You just need 
to find out general information about the server. 

You will likely need to consult with your 
network/email administrator to obtain information 

about your SMTP server. Please use the following 

table as a guide to have your administrator provide 
the proper settings: 

 

Option Description 

SMTP 

Server 

This is the name, address or IP address of the mail server. 

SMTP port The SMTP port is usually 25 but may vary with your email server. 

Enable a 

secured 
(SSL) 

connection 

If desired, use a secure connection by marking the checkbox for 

Enable a secured (SSL) connection. SSL encrypts data as it is 
transmitted. Your SMTP server must be configured to use SSL in order 

for this feature to work. 

Use the 
default 

credentials 
of the 

currently 
logged in 

user 

If you need to use authentication for your SMTP server, you can enter 
credentials or use those of the user logged into the computer. Mark 

the Use the default credentials of the currently logged in user 
checkbox to utilize the user‟s credentials (e.g., the person logged in 

when sending the emails from Remark Office OMR). Otherwise, 
continue to the next step to enter specific credentials. 

Username 
and 

Password 

If authentication is required, and you are not using the credentials of 
the currently logged in user, enter the Username and Password, as 

supplied by your network/email administrator. 
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Option Description 

Throttle 

rate 

The throttle rate adds a delay while sending emails. The default 

setting is 500ms, meaning that one email is sent every 500 ms (in 
other words, two emails are sent per second). Throttling emails keeps 

the SMTP server from being overloaded when sending large numbers 
of emails. Unless you plan on sending hundreds of emails at one time, 

the default setting of 500 is likely fine. 

 

 Enter the settings as described in the previous table. 20

 Click the Finish button to complete the setup. Optionally, you may click the arrow 21
on the Finish button and choose to Save your configuration without executing it, 

Execute the configuration without saving it (e.g., to test it) or Save and Execute to 

both save and execute the configuration in one step. 

 When clicking Finish, you are prompted to save your Send Wizard Configuration file. 22

It is recommended that you save the file so you 
may use it again in the future or call it up from 

the Automation Wizard. The file can be saved 
anywhere on your computer or network and has 

an XML file extension.  

 To save the Send Wizard Configuration File, 23

click the Yes button, choose a location and 

provide a file name. Ensure that you remember 
where the files are stored so that you can 

locate them later. 

 If you do not wish to save the Send Wizard 24

Configuration File, click the No Once the wizard 
closes, the action is active.  

Remark Office OMR looks in the directory(ies) specified for files and sends them to your 

designated recipients. If any problems occur, you are notified. Otherwise, the requested 

action is executed. 

8.10 Opening Data 

The Remark Office OMR Data Center can open data saved in dozens of different file 

formats. We specifically designed the Remark file format to optimize the data storage 

process in the Remark Office OMR software. The software is designed to work with data 

that is collected using a form template in Remark Office OMR. Therefore, you must first 

open a form template and then open the corresponding data file. Once the data file is 

opened, you can save it to another format or location, or use Remark Quick Stats to 

analyze it. 

Tip: When working with data in Remark Office OMR, use the Remark file 
format (RMK). This format saves the link to the image files and exception 
case colors. Only save data to other formats when exporting. 

The following table lists the different file formats the Data Center can open, their 

extensions and a brief description: 
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File Format Extension Description 

Remark RMK Remark Office OMR format; saves grid exception 

colors and image links 

Remark Office 

Archive 

ROA Remark Office OMR Archive format; combines 

template, data and stored image files into one file, 
Saves grid exception colors and image links 

Web Survey RWD Remark Web Survey format 

SQL Server 2000-
2005 

MDF Microsoft SQL Server format 

Oracle 7.4 & later *.* Oracle format 

Access 2007-2010 ACCDB Microsoft Access 2007/2010 format (only available 
if the Access 2007 or 2010 database engine is 

installed) 

Access 2000-2003 MDB Microsoft Access 2000-2003 format 

Access 95-97 MDB Microsoft Access 95-97 format  

Access 2.0 MDB Microsoft Access 2.0 format 

Access 1.0 MDB Microsoft Access 1.0 format  

Excel 2007-2010 XLSX Microsoft Excel 2007/2010 format (only available if 
the Access 2007 or 2010 database engine is 

installed) 

Excel 97-2003 XLS Microsoft Excel 97-2003 format 

Excel 95 XLS Microsoft Excel 95 format  

Excel 4.0 XLS Microsoft Excel 4.0 format 

Excel 3.0 XLS Microsoft Excel 3.0 format  

SPSS SAV SPSS 16 format 

SPSS Legacy SAV SPSS 6 format 

Survey Pro SRV Survey Pro standard format (Apian Software) 

ASCII [commas] ASC Comma delimited ASCII 

ASCII [tabs] ASC Tab delimited ASCII 

Spreadsheet 
[commas] 

TXT Comma delimited ASCII with quotes around non-
numeric data 

Spreadsheet 
[tabs] 

TXT Tab delimited ASCII with quotes around non-
numeric data 

dBase 5.0 DBF dBase 5.0 format 

dBase IV DBF dBase IV format 

dBase III DBF dBase III format 

Paradox 5.X DB Paradox 5.X format  

Paradox 4.X DB Paradox 4.X format 
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File Format Extension Description 

Paradox 3.X DB Paradox 3.X format 

Lotus WK4 WK4 Lotus Works 4 format (open only) 

Lotus WK3 WK3 Lotus Works 3 format 

Lotus WK1 WK1 Lotus Works 1 format 

Lotus 1-2-3 WKS Lotus 1-2-3 format 

LXR Test MRG LXR Test format 

Report RPT Fixed format ASCII, cell text padded or truncated 

to specified record length 

Data Interchange 
Format 

DIF Standard format using file header and data section 

CCI Assessment DAT CCI Assessment format 

XML XML Extensible Markup Language format 

HTML HTM Hypertext Markup Language  

ODBC *.* Open Database Connectivity  

Custom  ASC, TXT Custom Text format 

 

To open grid data 

 Open the correct form template. (See Section 7.2 Opening a Form Template.) 1

 Select the File menu and then click Open 2

Data, or click , to display the Open 

Data window. Alternatively, use the Open 
data file link from the Task Pane. 

 Select a file from the list. Use the Look in box 3
to locate saved data files. You may need to 

adjust the Files of type list to find the 
desired file. 

Note: The data contained in the file must 
correspond to the currently active form 
template or an error may occur. 

 If opening a database file, select the 4
appropriate table from the Table name drop-

down list. 

 Click the OK button to open the data file. 5

Caution: When opening a database file type, the Data Center attempts to 
match grid column headers (region names) to the database's field names. If 
any column headers cannot be matched, an error occurs. Grid column 
headers do not need to appear in the same order as the database fields. 
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8.11 Data Center Logging 

As changes are made in the Remark Office OMR Data Center, they can optionally be 

logged, allowing you to see what changes were made and who made them. Logging is 

turned on and off in the Remark Office OMR Preferences. It can only be turned off if you 

know the password used when turning on the feature. Changes made to the data grid 

(edits, review exceptions, review duplicates, clipboard, open, save, etc.) are logged in a 

password protected Access database in the following location: 

Windows XP: C:\Documents and Settings\All Users\Application Data\Gravic\Remark 

Office OMR\8\Change Logs (where C is the drive on which Remark Office OMR is 

installed). 

Windows Vista/Windows 7: C:\ProgramData\Gravic\Remark Office OMR\8\change log 

(Note you must have the option to show hidden folders and files on to see this location). 

When the database is initially created, it uses the date of creation as the filename. From 

that point forward, all changes to all templates/data files are stored in that Access file as 

long as the feature is turned on. Data file types, exception flags and actions are all listed 

with a numeric equivalent in the database. The additional tables in the database explain 

each of the numeric values. When a database reaches 10MB in size, a new database is 

created the next time Remark Office OMR is opened. 

Four tables are created in the Access file: 

 

History Table: 

 ID: Numeric index for each action. 

 Template File: The name of the form template that corresponds to the data file 

that was changed. 

 Log Action: The action taken such as opening data, reviewing exceptions, etc. 

 Data File: The name of the data file that was changed. 

 Table Name: The name of the table, if applicable, that was changed 

 File Type: The file type of the file that was changed. Note that this is a numeric 

value that corresponds to the items in the Save as type drop-down list in the 

Save Data window. For example, the Remark (RMK) format is the second item in 

the list, so it is listed as 2. (See File Types Table below for a complete listing.) 

 Column Number: The column in the data that was changed. 

 Row Number: The row in the data that was changed. 

 Respondent ID: The respondent ID, if applicable, that was changed. 

 Question Name: The question name (region name) of the applicable question that 

was changed. 

 Question Text: The question text, if applicable, of the corresponding question 

that was changed. 

 Original Value: The original value stored prior to making any changes. 

 Original Flag: If an exception flag existed originally (e.g., BLANK) it is listed. Note 

that this is a numeric value that corresponds to the items in the Exceptions 
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Legend in the Data Center. For example, a MULT is the first item in the list, so it 

is listed as 1. (See Flag Types Table below for a complete listing.) 

 New Value: The text that was entered during the change process. 

 New Flag: If a new exception flag was applied, it is listed. (See Flag Types Table 

below for a complete listing.) 

 System Name: The name of the system where Remark Office OMR was running 

during the change process. 

 Windows User: The Windows name of the logged in user who made the changes. 

 Change Date: The date and time the changes were made. 

 

Actions Table: The Actions Table displays the list of possible actions that are 

logged. 

 

0- Modify 4- Sort 

1- Insert 5- Open 

2- Delete 6- Save 

3- Clear 7- Read 

  

File Types Table: The File Types Table displays the list of data file types that are 

displayed in the Actions table when data is saved or opened. 

 

2- Remark (*.RMK) 34- ODBC (*.*) 

3- ASCII [Commas] (*.ASC) 35- Custom (*.ASC,*.TXT) 

4- ASCII [Tabs] (*.ASC) 36- Survey Pro STL 

(*.STL,*.ST3) 

5- CCI Assessment (*.DAT) 37- HTML (*.HTM, *.HTML) 

6- DIF Files (*.DIF) 38- Lotus WK4 (*.WK4, *.WKS) 

8- LXR Test (*.MRG) 36- Survey Pro STL 

(*.STL,*.ST3) 

9- Report (*.RPT) 39- Lotus WK3 (*.WK3) 

10- Spreadsheet [Commas] 

(*.TXT) 

40- Lotus WK1 (*.WK1) 

11- Spreadsheet [Tabs] (*.TXT) 41- XML (*.XML) 

12- SPSS Legacy (*.SAV) 43- Remark Office Archive 

(*.ROA) 

13- Survey Pro SRV (*.SRV) 44- Questionmark (*.QSF) 



Remark Office OMR User’s Guide 

208 

14- Survey System (*.DAT) 45- Database Update 

(*.ACCDB,*.MDB, 

*.XLSX,*.XLS) 

15- Access 2000 - 2003 

(*.MDB) 

46- ODBC Database Update (*.*) 

16- Access 95, 97 (*.MDB) 47- Access 2007 - 2010 

(*.ACCDB) 

20- dBase V (*.DBF) 48- Excel 2007 - 2010 (*.XLSX) 

21- dBase IV (*.DBF) 49- Paradox 7 - 8 (*.DB) 

23- Excel 97 - 2003 (*.XLS) 52- SQL Server 

24- Excel 95 (*.XLS) 53- Oracle 

31- Paradox 5 (*.DB) 54- SPSS (*.SAV) 

 

Flags Table: The Actions Table displays the list of possible exception flags that are 

logged. 

 

0- None 16- Data Entry 

1- Blank Response 32- OCR Error 

2- Multiple Response 64- Database Verification  

4- Recognition Error 128- Duplicate Response 

8- Barcode Error 256- Required 

 

To turn on logging 

 From the Remark Office OMR Data Center, 1

select the Tools menu, then click 
Preferences, then Change Log. 

 Mark the checkbox for Enable Change 2
Logging. 

 Enter a password in the Password box. 3

Passwords have a maximum of 255 
characters. 

 Click the Enable button. 4

 Click the OK button to close the Preferences.  5

From this point forward, all changes to the data 

grid are logged. 
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To turn off logging 

 From the Remark Office OMR Data 1
Center, select the Tools menu, then click 

Preferences, then Change Log. 

 Enter the password that was set when 2

turning on logging in the Password box. 

 Click the Disable button. 3

 Click the OK button to close the 4
Preferences.  

From this point forward, all changes to the data 

grid are not logged. If changes have been logged previously, the Access database still 

exists. 

 

To access the change log database 

 Using Windows Explorer or My Computer, go to  1

Windows XP: C:\Documents and Settings\All Users\Application Data\Gravic\Remark 

Office OMR\8\Change Logs (where C is the drive on which Remark Office OMR is 

installed). 

Windows Vista/Windows 7: C:\ProgramData\Gravic\Remark Office OMR\8\change log 

(Note you must have the option to show hidden folders and files on to see this 

location). 

 Double click the Access file (when the database was initially created, it used the date 2
of creation as the filename). 

 Enter the password that was used when logging was enabled in the Remark Office 3
OMR Preferences.  

The database opens in Access for your review. It is a fully functioning Access database 

that you may modify. For example, you could write an Access report to provide change 

information by user, by form template, etc.  

Note: If you change the structure of the Access tables from what was 
originally designed, the database may stop functioning with Remark Office 
OMR. Remark Support cannot troubleshoot Access features or issues. 
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Remark Quick Stats – Data Analysis 

Chapter 9 

9.1. Overview 

Remark Quick Stats is an analysis package that ships with the Remark Office OMR 

software. Remark Quick Stats allows you to tabulate surveys and grade tests right in the 

software. An overview of Remark Quick Stats is provided here; a complete user‟s guide 

is installed in PDF format with the software and can be found by clicking 

Start|Programs|Remark Office OMR 8|Documentation|Remark Quick Stats 

User’s Guide.  

Depending on the report selected, Remark Quick Stats can include the following 

statistics: 

Survey statistics and reports include: 

 For each item Remark Quick Stats calculates: Mean, Variance, Standard 

Deviation, Standard Error, Min, Max, Range, Median, Skewness, Kurtosis, T-

Value, Percentiles, Confidence Intervals  

 For each answer choice Remark Quick Stats calculates: Frequencies, Percentages, 

Valid Percent  

 A Response Report displays the responses for any particular question on one 

easy-to-read report (primarily used for open-ended questions) 

 Crosstabs  

 A Group Report displaying means for question groupings  

Test statistics and reports include: 

 A Grade Wizard steps you through the process of setting up an answer key, 

grade scale, questions points, learning objectives, benchmark scores and other 

grading information for your test  

 For each item Remark Quick Stats calculates: Mean, Variance, Standard 

Deviation, Standard Error, Min, Max, Range, Median, Skewness, Kurtosis, T-

Value, Percentiles, Confidence Intervals, P-values, Point Biserial Correlation  

 For each answer choice Remark Quick Stats calculates: Frequencies, Percentages, 

Point Biserial  

 For each student Remark Quick Stats calculates: Total score, Raw score, Grade, 

Dev. IQ, Number correct/incorrect/unanswered  
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 For the test Remark Quick Stats calculates: Number of graded tests and items, 

Max, Min, Median, Range, Percentile scores, Mean, Variance, Standard Deviation, 

Confidence Intervals (1,5,95,99%), KR 20, KR21, Coefficient (Cronbach) Alpha  

 A Grade Report displays each student‟s results on the test and optionally an 

image of the scanned test  

 A Group Report displays grades for specific subsets of your data  

A variety of graph types are also included (all of which can be copied and printed):  

 Pie   

 Bar   

 Horizontal Bar  

 Line  

 Area  

 Point  

 Polar  

 Fast Line  

9.2 Tabulating Surveys with Remark Quick Stats 

Surveys can be tabulated in two ways: Easy Survey and the Survey Wizard. Easy Survey 

uses the parameters specified in the form template‟s region properties, such as which 

questions to tabulate, and then launches Remark Quick Stats. The Survey Wizard allows 

you to customize the tabulation process by choosing which regions to include, assigning 

numeric values to answer items, assigning benchmarks, adding question text, specifying 

question groups and more.  

 

To access survey tabulation features 

 From the Remark Office OMR Data Center, open a form template and either open 1

an existing data file or process forms.  

 Select the Tools menu, then select Analysis and then click Easy Survey  or 2

Survey Wizard. Alternatively, select the Analysis tab in the Task Pane and then 

choose an analysis option. In addition, the analysis options are available on the 

toolbar:  . 

Remark Quick Stats opens, allowing you to configure and display reports. Please consult 

the Remark Quick Stats user‟s guide PDF for further details about using Remark Quick 

Stats. 

Tip: The Survey Wizard and Easy Survey screens and functions are 
described in complete detail in the Remark Quick Stats User‟s Guide PDF file. 
Access the file by clicking Start|Programs|Remark Office OMR 
8|Documentation.  
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9.3 Grading Tests with Remark Quick Stats 

Tests can be graded in two ways: Easy Grade and the Grade Wizard. Easy Grade uses 

the parameters specified in the form template, such as which questions to grade and 

their point values. In addition, Easy Grade uses the first row of data in the data grid as 

the answer key; therefore, you should insert your answer key before your test data if 

you plan to use Easy Grade (e.g., scan the answer key first). The Grade Wizard allows 

you to customize the grading process by choosing which questions to include, assigning 

point values, setting benchmarks, adding question text, specifying learning objectives. 

adding scaled scores and more.  

 

To access test grading features 

 From the Remark Office OMR Data Center, open a form template and either open 1

an existing data file or process forms.  

 Select the Tools menu, then select Analysis and then click Easy Grade or Grade 2

Wizard. Alternatively, select the Analysis tab in the Task Pane and then choose an 
analysis option. In addition, the analysis options are available on the toolbar: 

. 

Remark Quick Stats opens, allowing you to configure and display reports. Please consult 

the Remark Quick Stats user‟s guide PDF for further details about using Remark Quick 

Stats. 

Tip: The Grade Wizard and Easy Grade screens and functions are described 
in complete detail in the Remark Quick Stats User‟s Guide PDF file. Access 
the file by clicking Start|Programs|Remark Office OMR 
8|Documentation.  
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Remark Office OMR Data Center 

Preferences  

Chapter 10 

10.1 Overview 

This chapter details how to customize the Remark Office OMR software by setting up 

preferences. Preferences allow you to set the way the software functions by default, 

which can facilitate your use of the software. 

Important Note: The Preferences are global software settings. When you 
make a change to the Preferences, it affects all actions from that point 
forward. It does not affect anything you have already completed. 

 

To access the Preferences 

 In the Remark Office OMR Data Center, select the Tools menu and then click 1

Preferences. 

Use the links in the left Task Pane to access all of the available preferences. 

Note: Each component of the software has its own set of preferences. The 
Remark Office OMR Template Editor preferences are covered in Section 6.7 
Template Editor Preferences. The Remark Quick Stats preferences are 
covered in the Remark Quick Stats User‟s Guide PDF file, which can be 
accessed by clicking Start|Programs|Remark Office OMR 
8|Documentation.  

The available Data Center preferences are described in the sections that follow. 

Recognition Preferences are covered in Section 7.14. 

10.2 General Preferences 

General preferences allow you to setup defaults for basic software functions. The 

following options are available:  
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Preference Option Description 

Shade alternate rows to look like Mark this checkbox to shade every other template 

grid row. Click the paint bucket to choose a 

shading color.  

Update the Image Viewer During 

Read Operations 

Mark this checkbox to have the Image Viewer 

update with a new form image each time a form 
is processed. The Image Viewer is located 

beneath the data grid window. Using this option 
could alert you to issues such as skewed forms. 

Update the Graph Viewer During 

Read Operations 

Mark this checkbox to have the Graph Viewer 

update with a new graph per question each time a 
form is processed. The Graph Viewer is located 

beneath the data grid window. It provides a quick 
glimpse into your data by graphing the active 

question. 

Review Exceptions: Auto search 
the response combo box when 

typing 

Mark this checkbox so that you can type the first 
letter(s) of a response into the Response box of 

Review Exceptions and the software automatically 
selects the response that begins with those 

characters. This option applies to questions that 
employ list box style cells only (Multiple, List, 

Rank and Boolean OMR regions and Image 

regions that utilize Database Lookup or qualitative 
response coding).  

Review Exceptions: Play sound on 
review exceptions startup 

Mark this checkbox to play a sound when Review 
Exceptions first starts. This feature is useful as an 

alert if you are processing forms in an unattended 

manner.  

Review Exceptions: Play sound 

when an exception case is located 

Mark this checkbox to play a sound every time an 

exception case is located in Review Exceptions. 
Click the … button to select a .wav sound file. You 

may also click the button  to preview the 

sound. 
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Preference Option Description 

Review Exceptions: Clear 

exceptions after they have been 
reviewed 

Mark this checkbox to remove the color coding for 

an exception after it has been reviewed. This 
setting applies when you review grid cells but do 

not make changes that would automatically 
remove the exception color (e.g., if a question is 

legitimately blank, you might leave it as BLANK 
with the yellow colored cell). By clearing the 

exceptions, Review Exceptions does not stop on 
them the next time it is run. 

Maximum length for a value in a 

data grid cell 

Enter the maximum number of characters allowed 

in a data grid cell. You are not able to enter more 
characters than allowed (e.g., when entering text 

using a Data Entry Image region). Note that 
performance may be affected by data grid cells 

that contain very large amounts of text. 

Replace missing data values with Enter the value to be used when missing data are 
encountered during a data file export. Missing 

data means that the piece of data captured does 
not match what was defined as Labels in the form 

template. A MULT, BLANK and ERROR left in the 
data set would all be considered missing. If you 

typed a response in a list cell in the grid but it did 

not match the labels defined, this data would also 
be considered missing (e.g., “A” is defined in the 

form template, but you type “a”). The Missing 
Value is also used when running reports in 

Remark Quick Stats. The default value is -1. 

System poll interval during Server 
Mode (secs.) 

Enter the number of seconds in between polls for 
Server Mode. The software searches for image 

files in a directory or pages in the scanner‟s 
sheetfeeder based on this time interval. 

10.3 File Storage Location Preferences 

File Storage Location preferences allow you to setup the default directories that are used 

to store various file types. If you prefer to store files on a network drive, you can enter 

that location here (ensure that you have permission to fully access that drive). The 

following options are available: 
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Preference Option Description 

Form templates Sets the default location in which to store form template 

files. Highlight this selection and then click the Modify 

Directory… button to set a directory. The default 
directory is C:\Program Files\Gravic\Remark Office OMR 

8\Templates. 

Data Sets the default location in which to store data files. 

Highlight this selection and then click the Modify 
Directory… button to set a directory. The default 

directory is C:\Program Files\Gravic\Remark Office OMR 

8\Data. 

Dictionaries Sets the default location in which to store spell check 

dictionary files. Highlight this selection and then click 
the Modify Directory… button to set a directory. The 

default directory is C:\Windows\System32. 

Image Directory Search List Sets the locations(s) in which images are stored for 

processed forms and Image region Image Clips. When a 
cell in the data grid is clicked, the stored image file is 

displayed in the Image Viewer. The Image Viewer can 
be used for image-assisted data entry, Review 

Exceptions and in-cell editing. Use the Add Directory… 
button to add any directories in which you plan to store 

image files for processed forms. Remark Office OMR 
searches for these images in the order in which the 

directories are specified. Use the Move Up or Move 

Down buttons to change the order, and the Remove 
Directory button to remove a directory from the search 

list. Note that you can store images in any directory 
using the Read Wizard. However, providing frequently 

used directories in the Image Directory Search List aids 
the Remark software in finding images to display 

whenever a data set is opened. 
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Preference Option Description 

Active Dictionary Sets the active dictionary to be used for Spell Checker. 

Click the down arrow to view any dictionaries that are 
currently installed in your default Dictionaries 

directory. 

10.4 Custom Font Preferences  

Custom Font preferences allow you to setup the default fonts to use throughout the 

application. Mark the Use Custom Font Settings checkbox to choose a font to use 

throughout the application, allowing you to customize the software‟s look. You may 

choose a character set, font and font size. You should choose a font that is supported by 

your operating system. Please note that not all fonts look optimal in the software. You 

should restart the application after making any font changes. 

 

 

 

 

 

 

 

 

 

 

 

10.5 Email Preferences 

Email preferences allow you to set your internal SMTP server or Outlook as your default 

email client. This setting directly applies to the email option available from the File menu 

(Section 8.8), which can use either your SMTP server or Microsoft Outlook. When using 

Outlook, Outlook opens with your file(s) as an attachment. When using Default (SMTP), 

an internal email client opens that utilizes your SMTP server.  

The Send Wizard (Section 8.9) uses the SMTP server only. If you set up your SMTP 

server settings in the Preferences, they are available by default when using email with 

the Send Wizard. 

SMTP stands for Simple Mail Transfer Protocol and is the Internet standard for 

transmitting email across networks. It is likely your organization has a running SMTP 

server already set up. You just need to find out general information about the server. 

You will likely need to consult with your network/email administrator to obtain 

information about your SMTP server. Please use the following table as a guide to have 

your administrator provide the proper settings: 
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Option Description 

SMTP Server This is the name, address or IP address of the mail server. 

SMTP port The SMTP port is usually 25 but may vary with your email server. 

Enable a 
secured 

(SSL) 
connection 

If desired, use a secure connection by marking the checkbox for 
Enable a secured (SSL) connection. SSL encrypts data as it is 

transmitted. Your SMTP server must be configured to use SSL in order 
for this feature to work. 

Use the 

default 
credentials of 

the currently 
logged in 

user 

If you need to use authentication for your SMTP server, you can enter 

credentials or use those of the user logged in to the computer. Mark 
the Use the default credentials of the currently logged in user 

checkbox to utilize the user‟s credentials (e.g., the person logged in 
when sending the emails from Remark Office OMR). Otherwise, 

continue to the next step to enter specific credentials. 

Username 
and 

Password 

If authentication is required, and you are not using the credentials of 
the currently logged in user, enter the Username and Password, as 

supplied by your network/email administrator. 

Throttle rate The throttle rate adds a delay while sending emails. The default 

setting is 500ms, meaning that one email is sent every 500 ms (in 
other words, two emails are sent per second). Throttling emails keeps 

the SMTP server from being overloaded when sending large numbers 

of emails. Unless you plan on sending hundreds of emails at one time, 
the default setting of 500 is likely fine. 

 

To choose your default email client, in the Email client drop-down list, choose Default 

to use your SMTP server or Outlook to use Microsoft Outlook 2007/2010. If using your 

SMTP server, click the SMTP Server button and put in the settings as described in the 

previous table for your SMTP server. These settings apply to both the email option from 

the File menu and the Send Wizard. 
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10.6 Change Log 

As changes are made in the Remark Office OMR Data Center, they can optionally be 

logged, allowing you to see what changes were made and who made them. Logging is 

turned on and off in the Remark Office OMR Preferences. It can only be turned off if you 

know the password used when turning on the feature. Changes made to the data grid 

(edits, review exceptions, review duplicates, clipboard, open, save, etc.) are logged in a 

password protected Access database in the following location: 

Windows XP: C:\Documents and Settings\All Users\Application Data\Gravic\Remark 

Office OMR\8\Change Logs (where C is the drive on which Remark Office OMR is 

installed). 

Windows Vista/Windows 7: C:\ProgramData\Gravic\Remark Office OMR\8\change log 

(note you must have the option to show hidden folders and files on to see this location). 

When the database is initially created, it uses the date of creation as the filename. From 

that point forward, all changes to all templates/data files are stored in that Access file as 

long as the feature is turned on. Data file types, exception flags and actions are all listed 

with a numeric equivalent in the database. The additional tables in the database explain 

each of the numeric values. Once a database reaches 10MB in size, a new database is 

created the next time Remark Office OMR is opened. 

Logging changes is covered in greater detail in Section 8.11. 

 

To turn on logging 

 From the Remark Office OMR Data Center, 1
select the Tools menu, then click 

Preferences, then Change Log. 

 Mark the checkbox for Enable Change 2

Logging. 

 Enter a password in the Password box.  3

 Click the Enable button. 4

 Click the OK button to close the 5

Preferences.  

From this point forward, all changes to the data grid are logged. 

 

To turn off logging 

 From the Remark Office OMR Data Center, 1

select the Tools menu, then click 
Preferences, then Change Log. 

 Enter the password that was set when turning 2
on logging in the Password box. 

 Click the Disable button. 3

 Click the OK button to close the 4

Preferences.  
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From this point forward, all changes to the data grid are not logged. If changes have 

been logged previously, the Access database still exists. 

10.7 Check for Updates 

Remark Office OMR has the ability to check automatically for software updates. You can 

check at any time by clicking the Help menu and then choosing Check for Updates. You 

can also have the software check for an update every time it starts up. When this option 

is turned on, every time you start the software, it sends information about your current 

version to the update website and lets you know if there is a newer version of the 

software available. If an update is available, you are prompted to install it. The Check 

for Updates window also has the ability to do an immediate check for updates. 

 

To automatically check for updates 

 Select the Tools menu, then click 1

Preferences, then Check for Updates. 

 Mark the checkbox for Check for 2

updates when starting to turn on the 
automatic check for updates. 

 [Optional] If you would like to see if an 3
update is available immediately, click the 

Check for Updates Now link. 

 Click the OK button to close the 4
Preferences.  

The next time the software is started, it automatically checks for an update. If an update 

is found, and you would like to install it, follow the on-screen prompts. You must have 

an Internet connection to download the update. If no updates are available, you receive 

a message indicating that your software is up to date. 

The Remark Office OMR Automatic Update collects some system configuration data in 

order to provide you with updates that apply to your installation. This information 

includes: 

 

 Product Name  Remark Authentication Code 

 License Key  Software Version and Build Number 

 Remark Serial Number  System Finger Print (same as activation) 

Gravic, Inc. is committed to helping protect your privacy. Using the automatic update 

feature does not collect your name, address, email address, or any other form of 

personally identifiable information. Your Internet Protocol (IP) address is logged when 

you connect to the Gravic website, but this address is only used to generate aggregate 

statistics.  
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Tips and Helpful Hints 

Appendix A 

A.1 Overview 

The following appendix provides some useful tips for getting the most out of your 

Remark Office OMR software. There are several key areas of the software that you use 

often. Look through the following sections to learn more about how to best utilize the 

software. For complete details about a feature, consult the proper section in this user‟s 

guide. 

A.2 Scanners 

Remark Office OMR works with image scanners. There are a wide variety of scanners 

that fall into this category. Use the following guidelines when selecting and using a 

scanner with Remark Office OMR: 

 There are four basic categories of scanners: low-end, mid-range, high-end and 
multi-function peripherals (MFP). Generally speaking, a low-end scanner is capable of 
scanning up to 10 pages per minute (ppm). Low-end scanners are often geared 
toward graphics scanning rather than document scanning, and therefore are not 
typically recommended for use with Remark Office OMR. A mid-range scanner is 
capable of scanning about 11 to 40 pages per minute. A high-end scanner is capable 
of scanning over 40 pages per minute. Speed has a direct effect on price. MFPs are 
typically larger peripherals that can perform several functions, such as printing, 
faxing, copying and scanning. Some MFPs connect directly to a computer through a 
USB cable and others are connected through your network. If connected directly to a 
PC running Remark Office OMR, you can scan right into the software. If the MFP is on 
the network, you scan forms and save them as image files (independently of Remark 
Office OMR) and then Remark Office OMR processes those image files (unless the 
MFP has a network TWAIN driver). If you plan to scan double-sided forms, invest in a 
scanner with duplex capabilities (can scan both sides of a sheet of paper in one pass 
through the scanner). 

 There are three major points to consider when purchasing a scanner: your budget, 
the volume of forms you are processing and whether the scanner will be used for 
purposes other than scanning forms in Remark Office OMR. If you have low volume 
(e.g., a few forms processing applications a year, a few hundred forms each time), a 
low-end scanner may be fine. For moderate volume (e.g., several forms processing 
applications a year, a few thousand forms each time) look into a mid-range scanner. 
For high volume (e.g., a many forms processing applications a year, several 
thousands of forms total) look into a high-end scanner. Note that price goes up 
considerably with speed. If the scanner will be used for other purposes as well, look 
into its color and resolution capabilities. Remember that you get what you pay for 
when it comes to scanners. Know what you need before you begin shopping. 
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 Purchase a scanner with an automatic document feeder (ADF). You do not want to 
have to scan forms one at a time. The ADF allows you to place a batch of forms in 
the scanner at one time. 

 If you experience a problem using your scanner in Remark Office OMR, verify that 
the scanner is working properly outside of Remark Office OMR before contacting 
technical support. You can verify that the scanner is functioning by scanning pages in 
another scanning application. Many scanners bundle an application for scanning with 
the scanner driver. Or use another default Windows application that permits 
scanning if it is available on your computer. If the scanner does not work in another 
program you may be experiencing a hardware problem and should contact your 
scanner manufacturer for assistance. You should also clean and follow the 
maintenance guidelines for your scanner to keep it working optimally. 

 If your scanned image is unclear, check the settings being used by your scanner. Go 
to the Scanner Properties window in Remark Office OMR and mark the checkbox to 
Show TWAIN interface. When you scan, verify that you are scanning in a black and 
white (line art) mode for the best results. You can also check page size, resolution 
and brightness settings in the scanner‟s user interface. A resolution of 200 dots per 
inch (DPI) is recommended (300 DPI if processing OCR (optical character 
recognition) regions). 

A.3 Forms 

Creating forms correctly is the most important step to a successful experience with 

Remark Office OMR. When a form is created well, many potential problems are averted. 

Note the following points when creating your forms: 

 Create your forms where you are most comfortable- a word processing program, 
survey design program, etc. 

 Review Chapter 5 Designing Scannable Forms before creating your own forms. These 
guidelines help you understand how to consistently create forms that scan well and 
produce more accurate results. 

 Consider using barcodes to capture information such as ID numbers, names, etc. You 
can easily create barcodes yourself with the Code 3 of 9 barcode font (installs with 
the software and is available on our website for download). Make the barcode about 
26 points in size (do not make it smaller than 24 points). If using the Code 3 of 9 
font, you must begin and end the barcode with asterisks and use the exclamation 
point for a space. For example, to barcode John Doe, you would type *John!Doe*. 
Barcodes must be in the same position on each form of the same type. You can use 
barcode stickers as well to attach the barcode after the forms have been duplicated. 
If using Microsoft Word to create barcodes, turn off the Auto Format/Correct feature 
to Replace *Bold* with Real Formatting. This feature turns anything between two 
asterisks to bold and ignores the last asterisk, which leads to recognition problems if 
left activated.  

 An alternative to barcodes is OCR – Optical Character Recognition. OCR recognizes 
machine printed text (not handwriting, which is called ICR). You can pre-print text 
on a form and have Remark Office OMR recognized it. Be sure to follow the form 
design guidelines in Chapter 5 for OCR areas on a form. 

 Take advantage of our free form review service. Fax or email forms to Gravic 
Support before you duplicate them. The support department provides feedback on 
your form‟s compatibility with Remark Office OMR and suggestions if necessary. 

 Test your form with the software before duplicating and distributing it. Create a form 
template and fill in a few forms as you expect to have them returned (not perfectly!) 
to get an idea of how well the form works. 
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 Understand the process that is used once you have a form defined. Sometimes a 
poor process can cause a well-designed form not to work. Distribution of the form is 
key. Ideally you want to scan forms all from the same method of distribution (e.g., 
printed on the same printer, photocopied once on the same copier, etc.) If you 
cannot control distribution, ensure that for each batch of forms you receive, you 
have at least one blank copy. This copy can be used to reset the form template 
image if the batch does not match that which was originally used for the form 
template (e.g., form shift due to variances in printers or photocopiers). 

A.4 Form Templates 

The form template is another key to accurate form processing. Every form that is 

scanned is compared to the form template in order for Remark Office OMR to locate the 

marks on the page and output the correct information. Therefore, the form template 

must be the same as the filled-in forms that are scanned. The form template determines 

the order of fields in your data as well as the labels your data contains. If you plan to 

export your data to another file format (e.g., Access, Excel, SPSS, etc.) adhere to the 

limitations imposed by that specific file format (see your file format's documentation for 

these limitations). Make sure you know where your data will eventually end up before 

you create your form template so that the form template can be set up to meet your 

database‟s needs. Note the following points when creating your form templates: 

 Always use a form that has not been filled in to create the form template. 

 Use the same quality form to create the form template that you are distributing to 
your respondents. This means that if you photocopied the forms, use a blank 
photocopy to create the form template. If you had the forms professionally printed, 
use a blank printer‟s copy to create the form template. If you printed them on a laser 
printer, use a blank copy from the same laser printer to create the form template. 
When forms are duplicated, offset may occur. By using the same quality form, you 
compensate for this offset. If you allow various locations to print their own version of 
the form, ensure you get at least one blank copy of the form from their printer back. 
You can then reset the form template image with their version of the form if it is 
significantly shifted from the original. 

 The image in the form template should always come from a scanned version of the 
blank form. Do not import a PDF document into the Template Editor. A PDF created 
from applications such as Microsoft Word is not the same as what your scanner 
produces. In order to get a true comparison between the filled-in forms and the form 
template image, the quality must be the same. 

 If your scanner has an automatic document feeder, feed the form through the 
document feeder when scanning it for the form template. Do not place the form 
directly on the flatbed glass, as the positioning is different. 

 Scan the form for the form template at a resolution of 200 DPI (dots per inch). Use 
the same setting when you scan the filled in forms that was used when you created 
the form template. Resolution affects the size of the image, which in turn affects the 
location of the marks on the page. Changing the resolution midway may lead to 
recognition errors. Note: 300 DPI resolution is recommend if you plan on using OCR 
(optical character recognition). 

 Use the default brightness setting (sometimes referred to as threshold or contrast) 
on your scanner when you scan the form for the form template. You should only 
change the brightness setting when you encounter a problem (e.g., the image for 
the form template looks too light and the marks are not complete). If you change the 
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brightness setting for the form template, use the same brightness setting when you 
scan the filled-in forms. 

 Before you create the form template, know what you will be doing with the data after 
the forms are scanned. The format in which you want to save your data should 
determine how you set up the form template. For example, if you want to export the 
data to Excel, your form template Region Names must be limited to 64 characters. If 
you plan to export the data to a survey design and analysis package, find out the 
data requirements of the particular survey design and analysis package before 
creating the form template. 

 When you create an OMR region, you may only capture the marks on the form (no 
text, lines, etc.). If text or lines separate the marks, you must use the Append 
Linked Region feature. Take advantage of the Append Linked Region feature as you 
go to link the regions as you define them. This is a great time saver. 

 The Remark Office OMR Template Editor utilizes basic Windows commands such as 
cut, copy, paste, drag/drop and undo. These shortcuts can be tremendous time 
savers when you are creating regions. You may also copy regions from one page to 
the next, or from one form template to another (use Copy/Paste Special for the 
latter case). 

 The order in which the regions are defined in the tree view of the Template Editor is 
the order in which they are processed (e.g., the order in which the data appear in 
your data set). You can move regions in the tree view using drag and drop or cut and 
paste to reorder them. 

 If you need to make a change to the form template, remember that major changes 
do not change data that have already been processed, thus invalidating your 
processed data. These types of changes include changing Labels, rearranging the 
order of regions and changing the size of a region. If you make such changes you 
need to process your forms again because the existing data no longer matches the 
form template. You can either scan the forms again or read the stored image files 
from the original scans to recreate your data file.  

 If you change your form slightly but have already created a form template, you do 
not have to create a new form template. You can scan the new page with the 
existing form template by using the Reset Images feature in the Template Editor, or 
by editing the page properties and acquiring a new image. Once you have scanned or 
imported a new image, use the Auto Align feature to move the existing regions to 
their proper location on the new image (double check positioning after using the 
Auto Align feature and adjust as needed). 

 Test your form and form template with the software before duplicating and 
distributing forms. Create a form template and fill in a few forms to get an idea of 
how well the form works and whether you have set up the form template properly for 
your data analysis needs. 

A.5 Reading Forms 

When the form and form template guidelines in the previous sections are followed, 

reading forms is a smooth process. Here are some tips to keep things running 

efficiently: 

 Scan filled in forms at the same resolution and brightness settings that were used for 
the form template. If you are unsure of theses settings, open your form template in 
the Template Editor. Double click any page node and then hover your mouse over 
the information button in the image viewer to view details about the stored image:  
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 Whenever possible, scan in black and white mode (as opposed to grayscale or color). 
Black and white is the fast scanning mode. 

 If you are going to scan forms outside of Remark Office OMR and then have the 
Remark software read the resulting images, save the scanned forms as TIF, black 
and white images. Do not save them as PDF files, as these are not native image files 
and require a great deal more processing from the software (meaning your 
processing time is slower). 

 You have two options when it comes to cleaning your data: 1) Use Review 
Exceptions during form processing to stop processing when selected exception cases 
are encountered and make a correction immediately, or 2) Use Review Exceptions 
after processing the forms to have the software cycle through the data and allow you 
to make corrections based upon an image of the problem area. If you want to review 
the data after scanning, you must save your data to the Remark (RMK) or Remark 
Office Archive (ROA) formats. These formats preserve the links between the data 
and stored images as well as the exception case colors. 

 If you receive a recognition error, consider the following when trying to resolve it: 1) 
Did you use the same quality forms for the form template and filled in forms? 2) Did 
you set up the region properly in the form template? 3) Have you changed any 
settings on the scanner since you scanned the form for the form template? 4) Did 
you use the ADF for both the form template and the filled-in forms? 5) Does your 
form follow our form design guidelines? 

 If you want to scan your forms in batches over a period of time, use the Remark 
(RMK) format to save the data. This format allows you to save the stored images 
with the data so that you can make corrections at a later time. Once you have 
scanned all of your forms, you can resave the data in another format for exporting, if 
desired. 

 If you are scanning double-sided forms with a duplex scanner, you do not need to 
use the Collate Options when reading. Instead, turn on the duplex capabilities of 
your scanner in the Scanner Properties window or your scanner‟s TWAIN interface. 

 If you are experiencing recognition errors, read Section 7.14 to learn how the 
software‟s recognition settings may be able to assist with your form. 

A.6 Working with the Data 

Once you have scanned your forms, you will likely need to clean the data. After the data 

is cleaned, you have two options for the data: 1) Use Remark Quick Stats to grade or 

tabulate the data, or 2) export the data to another program for analysis. Note the 

following points when working with your data: 

 To clean your data, make use of in-cell editing and Review Exceptions to make 
changes to the data. In-cell editing is convenient when making just a few 
corrections. Review Exceptions allows you to automate the review process and allows 
you to refer to images to make large-scale corrections. 

 When exporting data to another program, know the limits and specifications of the 
file format. You may need to set up your form template in a specific manner to 
accommodate your file format. File format specifications are outlined in 
Start|Program Files|Remark Office OMR 8|Documentation|Remark Office OMR 8 
Supported File Formats. 
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A.7 Analysis 

The Remark Quick Stats program provides detailed analysis of your data. Information 

about Remark Quick Stats is included in a separate user‟s guide in PDF format, which is 

installed with the software. Go to Start|Programs|Remark Office OMR 8|Documentation 

to locate this file. 

Keep the following in mind when using Remark Quick Stats: 

 To facilitate the grading process, set up an answer key file that you can use over 
again. You can specify an answer key, ID and subjective regions, learning objectives, 
benchmarks, multiple test versions, custom report headers and a grade scale in the 
answer key file. 

 Use the program‟s Preferences to set global options so that you can take advantage 
of Easy Survey and Easy Grade for fast and simple reporting. These reports utilize 
the settings in your Remark Office OMR preferences and the associated form 
template file. 

 Save reports as internal report files from within Remark Quick Stats if you feel that 
you will need to recall them. Saving a modified report can save a great deal of time if 
you need to reuse it. 

 When grading tests, remember that you can select an answer key in one of several 
ways: 1) scan the answer key as the first grid row of the data, 2) scan the answer 
key when you perform the grade operation, 3) import an image of your form with the 
correct responses, 4) enter a grid row containing the answer key when you perform 
the grade operation 5) reopen an answer key file that contains the answer key when 
you perform the grade operation or 6) utilize a generic answer key file setup ahead 
of time in the Grade Wizard/Grade Wizard Utility. 

 Take advantage of the Report Batch Wizard to display, print and/or export multiple 
reports at one time. This wizard also allows you to auto filter data based on the 
values in up to three template regions, saving you time as compared to using the 
regular filter options. 
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Understanding Error Messages 

Appendix B 

B.1 Error Message Details 

This appendix details the different error messages in Remark Office OMR. Use this 

appendix to gain a better understanding of any problems that may arise while using the 

software. The following table lists error class, error category, error number and the error 

text along with some enhanced instructions where applicable. 

 

Class # Category Error # Error Text 

0100 Memory 

Errors 

100-106 Not enough memory to perform specified operation. 

Close other applications to free up more memory or 
restart Windows. Ensure that your computer meets 

the minimum system requirements. 

0200 Windows 
Errors 

200-206 Windows function errors (internal to Remark Office 
OMR). Could signify that the Windows environment 

is functioning improperly. Close other software 
applications and restart Windows. 

1000 File Open 

Errors 

1001-

1012 

Remark Office OMR could not open the specified 

file. The file no longer exists or could not be opened 
for an unknown reason. Possible causes could be: a 

full hard drive, an inaccessible network drive, or the 
file is being used by another application. 

1100 File Read 

Errors 

1101-

1103 

Error reading the specified file. Possibly indicates a 

corrupt file. Possible causes could be: a full hard 

drive, an inaccessible network drive, or the file is 
being used by another application. 

1200 File Write 
Errors 

1201-
1214 

Error occurred while writing file to disk. Possible 
causes could be: a full hard drive, an inaccessible 

network drive, or the file is being used by another 
application. 

1300 File Access 

Errors 

1301-

1310 

Error occurred while attempting to access a file. 

The file may be damaged. Possible causes could be: 
a full hard drive, an inaccessible network drive, or 

the file is being used by another application. 
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Class # Category Error # Error Text 

1400 File Close 
Errors 

1401-
1403 

An error occurred while trying to close a file. Check 
the amount of free disk space. Possible causes 

could be: a full hard drive, an inaccessible network 
drive, or the file is being used by another 

application. 

1500 File 
Creation 

Errors 

1501-
1502 

An error occurred while trying to create a file. 
Check the amount of free disk space. Possible 

causes could be: a full hard drive, an inaccessible 
network drive, or the file is being used by another 

application. 

1600 View 
Image 

Errors 

1600-
1610 

Not enough memory or disk space available to 
perform the view image operation. Free up more 

memory by closing other applications or restarting 
Windows. Ensure that your computer meets the 

minimum system requirements. 

1700 Miscellan-

eous File 
Errors 

1700-

1703 

A file cannot be accessed due to a bad name or 

path. Check that the file name is valid and that the 
target directory can be accessed from your system. 

  1704 A file has already been opened by Remark Office 
OMR or by some other application and cannot be 

opened again. Close other applications using this 
file. 

  1705 The disk is full. Delete some files or try saving to 

another location. 

  1706 Too many files are currently open on your system. 

Close some applications and try the operation 

again. 

  1707-

1708 

Permission was denied or the disk was not ready 

when trying to write the file. Also, check the region 
names you are using in the form template for 

invalid characters, such as commas, parentheses, 

etc. 

2000 Graphics 

File Errors 

2001-

2005 

The graphics file selected is not of a type 

recognized by Remark Office OMR. Check to see 
that it is a supported file type. You may email the 

file to Gravic technical support for verification. 

  2006-
2015 

Error encountered while processing the graphics 
file. File may not be a type recognized by Remark 

Office OMR or may be corrupted. You may email the 
file to Gravic technical support for verification. 

  2016-

2031 

Error encountered while processing the .TIF 

graphics file. File may not be a type recognized by 
Remark Office OMR or may be corrupted. You may 

email the file to Gravic technical support for 
verification. 
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Class # Category Error # Error Text 

3000 Form 
Template 

Training 
Errors 

3000 The number of rows specified does not match the 
number of labels specified. Check to ensure that 

your marks (bubbles, checkboxes) are not 
degraded. 

  3001 The number of columns specified does not match 

the number of labels specified. Check to ensure 
that your marks (bubbles, checkboxes) are not 

degraded. 

  3004-
3005 

The number of rows and columns found does not 
agree with the number found in the region. The 

specified region orientation could be incorrect. 
Check to ensure that your marks (bubbles, 

checkboxes) are not degraded. 

  3006 The software could not locate a region that matches 
the description specified in the OMR Region 

Properties window. Could indicate that the page 
was not scanned correctly (skewed, upside 

down...). 

  3008 No marks were found in the region. Reselect the 

region. 

  3009 Incorrect region definition. The number of columns 
and rows are reversed or the label location 

selection is incorrect. Also check to ensure that 
your marks (bubbles, checkboxes) are not 

degraded. 

  3010-
3013 

A border of your region definition is touching your 
marks. Hover your mouse over the region for error 

details. Then adjust the border as indicated. 

  3018 An invalid number was specified for the number of 
rows contained in the region. Check to ensure that 

your marks (bubbles, checkboxes) are not 
degraded. 

  3019 An invalid number was specified for the number of 

columns contained in the region. Check to ensure 
that your marks (bubbles, checkboxes) are not 

degraded. 

3100 Recogni- 
tion Errors 

3100 Cannot locate the region on the page. Possible 
causes may be a skewed or offset page, form 

design or a degraded image. 

  3101 The image is degraded. Cannot locate marks. 

Possibly scanned incorrectly. 

  3102 
MULT 

Multiple answers were entered for a region in which 
multiple responses were not permitted. 

  3103 

BLANK 

No response was given. 
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  3104 Unable to locate the region on the page. Possible 
causes: scanning a page that is smaller than the 

form template or scanning pages with the wrong 
template. 

3200 Barcode 

Errors 

3200 Unable to recognize barcode. Check to ensure it is a 

supported barcode type and printed at a minimum 
of 24 points. If using the Code 3 of 9 barcode type, 

make sure that you used the required beginning 
and ending asterisks in your barcode. 

4000 Scanner 

Errors 

4000 The scanner is not ready. Check to make sure it is 

connected correctly and that the power is turned 
on. 

  4001 No scanner is selected. A scanner cannot be used 

until it is selected in the Scanner Properties 
window. 

4100 TWAIN 

Errors 

4100 No TWAIN sources are available on your system. 

Make sure that sources (drivers) have been 
installed correctly. Check the documentation that 

came with your scanner for more details about 
installing it. 

  4101 Could not select the specified source (scanner). 

Check that the scanner has been installed correctly. 

  4102 Could not communicate with the TWAIN source 

manager. Make sure that the file TWAIN_32.DLL is 
in your Windows directory. 

  4103 Could not open the specified TWAIN source. Make 

sure that the scanner and scanner driver are 
installed correctly. 

  4104-

4105 

The specified source (scanner) is not compatible 

with Remark Office OMR. The scanner and Remark 
Office OMR are not compatible. 

  4106 Error transferring the image file to Remark Office 
OMR. Check to make sure there is enough memory 

and disk space on your computer. 

  4107 The specified source (scanner) is not compatible 
with Remark. The scanner is not capable of 

providing data to Remark in the appropriate format. 

  4108 The TWAIN source (scanner) returned an invalid 
image size (height or width set to zero). Reset the 

scanner‟s image size information on the scanner‟s 
TWAIN interface (Tools|Scanner Properties|Show 

TWAIN Interface). 
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  4109 Remark Office OMR and the TWAIN source have 
fallen out of sync. Close Remark Office OMR, reset 

the power on the scanner and retry. 

  4110 The TWAIN source did not close correctly. Reset the 
power on the scanner and check to make sure your 

scanner is installed properly. 

  4111-

4112 

The TWAIN32.DLL file could not be found. Make 

sure that the file TWAIN32.DLL is located in your 

Windows directory. 

  4113 The specified TWAIN source (scanner) could not be 

enabled. Not all TWAIN drivers allow 
showing/hiding of their TWAIN Interface. Try 

changing your selection for the Show TWAIN 

interface option in the Scanner Properties window. 

6000 Output File 

Errors 

6000 Error saving because the template grid contains no 

data. You cannot save an empty grid. 

  6001 Error saving the data because the specified data do 
not correspond to the selected form template file. 

The data may contain misplaced characters, such 
as: commas, periods, semicolons and parentheses. 

Use Find and Replace to remove any invalid 
characters for your database type. 

  6002-

6005 

Error saving the data in the selected file format 

because a cell exceeds the maximum size for 
storage. Edit the text in the grid or save to another 

file format. Some file formats maintain a maximum 
cell size, question number, etc. (See Section 8.6 

Saving Data.) 

  6006 Too many questions to save in dBase (.DBF) 
format. Maximum of 128 questions permitted. Try 

saving the data to another file format. 

  6007 Too much data to save in dBase (.DBF) format. 
Maximum of 4,000 bytes per record. Try saving the 

data to another file format. 

  6008-
6009 

Unable to save to Fixed (.SDF) file format because 
responses are not of a fixed size. Data in each 

column must contain the same number of bytes. 
For example, if the possible answers for a question 

are 
1 - 10, you should set the region up using the 

labels: 01, 02, 03... ...09, 10 so that each answer 
item will contain two bytes. 

6100 File Import 

Errors 

6100-

6104 

Error importing specified file format. Incompatible 

data encountered during the conversion. 
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  6105 The data contained in the data file do not 
correspond to your form template file. The data 

were truncated. The data file contains more grid 
columns than the current template grid. Make sure 

you have selected the correct form template and 

data file. 

  6106-

6108 

Error importing SPSS (.SAV) file format. Note that 

SPSS reformats data when saving; consequently, 
data saved as compressed in SPSS may not import 

back into Remark Office OMR. You must 

uncompress the data within SPSS before opening it 
in Remark Office OMR. 

  6109-
6110 

Error importing the Fixed (.SDF) format file. 

7000 Database 

Memory 

Errors 

7000 The application doesn't have enough memory or 

resources to complete the selected database 

operation. Close other applications, files and 
windows to free up more memory or restart 

Windows. Ensure that your computer meets the 
minimum system requirements. 

  7001 You have reached the limit on the number of files 

that can be opened at one time. Close one or more 
files, and then try the operation again. 

  7002 You have reached the limit on the number of tables 

and/or databases that can be opened at one time. 
Close one or more tables and then try the operation 

again. 

  7003 The database has reached its maximum size. To 

add data to this database, you must first reduce its 

size by deleting data. 

    7004 You tried to add new records to a Microsoft Excel 

version 3 or version 4 file, but the file is full. Files of 
these types can hold a maximum of 16,384 

records. 

  7005 You tried to perform a Btrieve operation that 
involves too many Memo or OLE object regions. 

Reduce the number of Memo and OLE object 
regions, and then try the operation again. 

  7006 You tried to perform an operation that involves 

more than 255 regions. Reduce the number of 
regions, and then try the operation again. 
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7100 Database 
Syntax 

Errors 

7100 A syntax error occurred. Check the data to make 
sure it was entered correctly. This error can occur if 

an incorrect value type is provided as part of an 
expression. For example, textual data entered into 

a numeric field. 

  7101 Unable to locate specified table, field or index. 
Check the name to make sure it was entered 

correctly and then retry the operation. 

  7102 The specified file, table or region name doesn't 
follow standard naming conventions. Enter a new 

name, and then try the operation again. Consult 
your database's documentation for information on 

valid names and naming limitations. 

7200 Database 
Read 

Errors 

7200 You tried to access a database that is currently in 
use by another user or application. Wait for the 

other user or application to finish working with the 
database, and then try the operation again. 

  7201 An error occurred updating the database. The 
database, file, table or field is defined as read-only. 

  7202 An error occurred accessing the specified path or 

filename. The path or filename is not valid. Check 
the name and path to make sure they were entered 

correctly then retry the operation. 

  7203 A permissions error occurred accessing the 
specified database, table or object. You don't have 

the necessary permissions. Contact the database 
administrator regarding access rights. 

  7204 A file, disk or network access error occurred. 

Resolve the error condition and then retry the 
operation. 

  7205 An error occurred attempting to create the 

database, table or object because it already exists. 
This error can also occur if an ODBC database 

contains several tables with the same name. 

  7206 An error occurred attempting to open or access the 
database file. The file is either invalid or corrupt. 

  7207 An error occurred trying to access a necessary 
database file or table. Resolve the error condition 

and then retry the operation. 

  7208 An attempt was made to import or attach to an 
empty text file. To import or attach a text file, the 

file must contain data. 

  7209 You tried to perform an operation that would have 

violated referential integrity rules for related tables. 
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  7210 The installable ISAM you are using does not allow 
updates and/or deletes to records in external 

tables. You can add new records, though. 

  7211 You cannot use ODBC to access an external 
Microsoft Access or ISAM database table. Use 

Remark Office OMR‟s direct support of the database 
instead. 

7300 ODBC 

Errors 

7300 Using ODBC, you tried to perform an operation on 

data in a SQL database. This error may occur when 
the SQL database is on a network drive and the 

network is not connected or when the path 
specified is invalid. 

  7301 An error occurred attempting to update the ODBC 

table. Possible causes could be the database is 
read-only, the database is on a network drive and 

the network is not connected or the update would 

have caused a rule violation. 

  7302 The ODBC remote query timeout expired. The 

ODBC server may not be properly installed, or a 
required network connection isn't active. Check the 

network connection or contact your system 
administrator, and then try the operation again. 

  7303 The ODBC table definition has changed since you 

created the link. End the current operation and then 
retry. 

  7304 An error occurred attempting to lock records in the 

ODBC database. All records in the database cannot 
be locked. 

7400 Database 
Index 

Errors 

7400 An error occurred attempting to create an index for 
the database because the index already exists. 

  7401 An error occurred trying to create an index because 
the index definition is invalid. 

  7402 An error occurred adding a record to the table or 

updating the table because the current record 
contains an invalid value in the region(s) defined as 

the primary key. 

  7403 An error occurred making changes to the table 

because of a duplicate value in a field that is the 
underlying table's primary key or an index that 

doesn't allow duplicates. The changes were 

unsuccessful. 
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  7404 The operation you attempted requires a (primary) 
database index. An index was not found. The 

operation was unsuccessful. Create a primary index 
for this database and then retry the operation. 

  7405 An error occurred creating the index. Possible 

causes: the key fields are named improperly, there 
are duplicate records based on this index or there 

were too many indexes already defined. 

  7406 An error occurred deleting the index. The current 
index cannot be deleted. 

7500 Database 
Registry 

Errors 

7500 An error occurred initializing the database engine 
due to invalid initialization or registry settings or an 

engine conflict. 

  7501 Unable to locate current record. Move to or select 
another record, and try the operation again. 

  7502 You tried to use a Paradox table, but the table's 

associated lock (.LCK) file is outdated. Delete the 
.LCK file and then try the operation again. 

  7503 An unexpected error occurred when you tried to 
access data in an attached Btrieve table. Try the 

operation again, or contact your system 
administrator or network administrator. 

  7504 You tried to perform an operation that requires the 

Btrieve engine. To access Btrieve files, you must 
have purchased and installed a copy of the stand-

alone Btrieve for Windows engine. This file must be 
in your Windows System directory. 

  7505 Cannot perform this operation with an unsupported 

database version. Convert the file you want to use 

to a supported version and/or data type and then 
retry the operation. 

  7506 The operation stopped before its normal 
completion. Some data changes may not have been 

saved. 

  7507 The external database driver returned an error. This 
error can be caused by performing an operation not 

supported on this type of external database. 

  7508 The database you are attempting to use has an 
unspecified problem and, as a result, it is marked 

as corrupt. Check your database‟s documentation 
for this error code. 

7600 Database 
Record 

Errors 

7600 The database you are attempting to use has an 
unspecified problem and, as a result, it is marked 

as corrupt. Check your database‟s documentation 

for this error code. 
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  7601 You defined a table with records larger than can be 
supported. Redefine the table by making some 

regions shorter or by removing unneeded regions. 

  7602 A field error occurred due to a data type conflict or 
an invalid data type. 

  7603 An error occurred saving a field value. The value 

specified is invalid. 

  7604 The specified table doesn't contain the specified 
field(s). Check the spelling of the region name(s) in 

the form template and ensure that they do not 
contain invalid characters (commas, parentheses, 

etc.). 

  7605 None of the import region names matches fields in 
the associated table. At least one region name in 

the import table and one field name in the 
appended table must match. 

  7606 An error occurred creating the table or appending 

the field because more than one field was defined 
with the same name. Each field name in a table 

must be unique. Check the region name(s) 
specified in the form template. 

  7607 You referred to a record that you deleted or that 

another user in a multi-user environment deleted. 
Move to another record, and then try the operation 

again. 

  7608 You attempted to import an invalid range of 

spreadsheet cells. 

  7609 The first row of data contains invalid region (field) 
names, such as quoted and unquoted strings in the 

same field name. Check the import table for 
properly matched quotation marks, and then try the 

import operation again. 

  7610 An error occurred creating the table or index 
definition because it does not contain any fields. 

  7611 An error occurred attempting to change a table or 
field definition because the object has already been 

appended to the corresponding object. 

  7612 An error occurred attempting to delete a field. You 

can‟t delete a field included in an index. To delete a 
field that is part of an index, you must first delete 

the index. 

  7613 Text file specification field separator matches 

decimal separator or text delimiter. Two or more 

delimiters settings used by the Text ISAM are the 
same. 
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9000 Miscellan- 
eous 

Program 
Errors 

9000 These miscellaneous errors signify an internal 
problem or undocumented error type. Please report 

any reproducible occurrences of these errors to 
Gravic Technical Support. Send a screenshot of the 

error and the steps you took leading up to the 

error. 

9100 DLL Errors 9100 The DLL file is in use by other applications and 

could not be opened. Close other applications and 
restart Windows. 

  9101 The DLL could not be loaded because it could not be 

located on your system. Make sure all required DLL 
files are in directories where they can be found. 

Uninstall and reinstall the software. 

9200 Clipboard 
Errors 

9200 This error indicates that a problem was encountered 
trying to copy or paste data to or from the 

Clipboard. This error could occur it too much data is 
requested or if an invalid object is being copied to 

the clipboard. 
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